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Important Notice

Allot Communications Ltd. ("Allot") is not a party to the purchase agreement under which
NetEnforcer or Service Gateway was purchased, and will not be liable for any damages of any kind
whatsoever caused to the end users using this manual, regardless of the form of action, whether in
contract, tort (including negligence), strict liability or otherwise.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED
FOR INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME
WITHOUT NOTICE, AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ALLOT
OR ANY OF ITS SUBSIDIARIES. ALLOT ASSUMES NO RESPONSIBILITY OR LIABILITY
FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS MANUAL,
INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Please read the End User License Agreement and Warranty Certificate provided with this product
before using the product. Please note that using the products indicates that you accept the terms of
the End User License Agreement and Warranty Certificate.

WITHOUT DEROGATING IN ANY WAY FROM THE AFORESAID, ALLOT WILL NOT BE
LIABLE FOR ANY SPECIAL, EXEMPLARY, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES OF ANY KIND, REGARDLESS OF THE FORM OF ACTION
WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY OR
OTHERWISE, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR ANTICIPATED
PROFITS, OR LOST BUSINESS, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Copyright
Copyright © 1997-2013 Allot Communications. All rights reserved. No part of this document may

be reproduced, photocopied, stored on a retrieval system, transmitted, or translated into any other
language without a written permission and specific authorization from Allot Communications Ltd.

Trademarks

Products and corporate names appearing in this manual may or may not be registered trademarks or
copyrights of their respective companies, and are used only for identification or explanation and to
the owners' benefit, without intent to infringe.

Allot and the Allot Communications logo are registered trademarks of Allot Communications Ltd.
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Chapter 1: Introducing NetXplorer

What is NetXplorer?

NetXplorer is a highly scalable Network Business Intelligence system that centrally
manages the NetEnforcer or Service Gateway product line. It enables strategic decision
making based on comprehensive network application and subscriber traffic analysis.

With the exponential growth in the use of the Internet, the business of today is how to
manage the network environment intelligently. NetXplorer enables real time monitoring
of network troubleshooting and problem analysis; it provides long term reporting for
capacity planning, tracking usage and trend analysis; it allows for the proactive
management of traffic and system-wide alarms; it allows for the collection and export of
auditing data for billing and quota purposes. NetXplorer configures the NetEnforcer or
Service Gateway device and a central catalog enables global Enforcement Policy
provisioning.

Business Network Intelligence assures the true alignment of network and business.
NetXplorer gives power to the network service provider or corporation to manage its
network and conduct business with intelligence.

Terms and Concepts

This section introduces some of the basic terms and concepts used in NetXplorer.

Catalog

Catalog entries, which are defined in the catalog editor, serve as conditions or actions in
the rules which make up a Enforcement Policy. In this way, they can be seen as the
building blocks of your Enforcement Policy. Once a catalog has been defined in the
catalog editor, it can be reused in different rules.

Line

A line is a logical entity within a Enforcement Policy and represents the highest level of
hierarchy. The total bandwidth running through the NetEnforcer or Service Gateway
can be divided into lines and each line can then be managed as if it were an independent
link. A line consists of a rule based on one or more sets of conditions and a set of
actions that apply when all of the conditions are met. The default fallback line exists in
every Enforcement Policy. Additional lines can then be added above the fallback line in
the Enforcement Policy table. The fallback line cannot be modified or deleted. Traffic
which is not classified in any of the lines above it in the hierarchy will be classified in
the fallback line. Every line, including the fallback line, contains one or more pipes.
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Pipe

A pipe is a logical entity within a Enforcement Policy. The total bandwidth running
through each line can be divided into pipes, and each pipe can then be managed
independently. Each pipe consists of a rule based on one or more sets of conditions and
a set of actions that apply when all of the conditions are met. By default, every line
contains at least one pipe — the fallback pipe. Additional pipes can then be added above
the fallback pipe in the Enforcement Policy table. The fallback pipe cannot be modified
or deleted, and traffic that is not classified into any other pipes within a given line will
be classified in the fallback pipe. Every pipe, including the fallback pipe, contains one
or more virtual channels.

Virtual Channel

A Virtual Channel (VC) is a logical entity within a Enforcement Policy and represents
the most granular level of Enforcement Policy hierarchy. The total bandwidth running
through each pipe can be divided into VVCs, and each VC can then be managed
independently. Each VC consists of a rule based on one or more sets of conditions and a
set of actions that apply when all of the conditions are met. By default, every pipe
contains at least one VC — the fallback VC. Additional VCs can then be added above the
fallback VVC in the Enforcement Policy table. The fallback VC cannot be modified or
deleted, and traffic that is not classified into any other VCs within a given pipe will be
classified in the fallback VC.

NetEnforcer

The NetEnforcer is a broadband optimization device which collects traffic statistics
from the network and can implement quality of service per application and per
subscriber. Traffic statistics are collected in order to provide both real-time and long-
term data about the network. As well as collecting detailed information about the traffic
passing through, it, the NetEnforcer can also shape that traffic, applying quality of
service parameters which have been pre-defined by the user.

Service Gateway

The Service Gateway is a platform for enhancing service optimization and service
deployment. The Service Gateway provides an open, carrier-grade solution for
broadband service providers to manage multiple 10 or 1 Gigabit lines and deploy value
added services in one integrated platform. Application and subscriber information
within the Service Gateway is identified for each traffic flow and subsequently the flow
is dispatched to an array of additional services and actions using a single DPI process.

1-2
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Subscriber Management Platform

Allot’s Subscriber Management Platform or SMP is an additional element of the Allot
solution which enables Service Providers to manage subscribers or, when integrated
with a PCRF in a mobile environment, to manage sessions.

AOS

The Allot Operating System or AOS is Allot’s state-0f-the-art infrastructure for
application identification and service optimization technologies. AOS provides a unified
software platform to be used on Allot’s newer devices, such as the NetEnforcer series
AC-500, AC-1400, AC-3000 and the Service Gateway series SG-Sigma and SG-Sigma
E.

Service Plan

Service Plans are used with Allot’s Subscriber Management Platform and contain QoS
Catalog entries that quickly and easily define key parameters for subscriber accounts,
for example, minimum and maximum bandwidth.

Service Plans may be created for Pipes or for VCs, depending upon the structure of the
Enforcement Policy table. It is possible to define a Pipe Service Plan, where each VVC is
defined in the Pipe Service Plan and handles a separate application, or to create
individual VC Service Plans for each VC.
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Chapter 2: Getting Started

Accessing NetXplorer

Once you have completed the initial setup as described in the NetXplorer Installation
and Administration Guide, you can access the NetXplorer via your Web browser. The
first time that you connect to the NetXplorer, you may be prompted to install Java 1.6.

To connect to NetXplorer:

1. In Internet Explorer, browse to http://<<NX IP>> and select
Launch NetXplorer in the NetXplorer Control Panel.

OR
Double click the shortcut icon on the desktop or in the system’s Start menu.

2. The Java Application Starting window is displayed.

3. The NetXplorer Log On dialog is displayed.

Server: 10.4.3.181 Version: NX 13.1.10

NetXplorer

User Name: l

Password: I

AIIO' | Log On H Cancel

communications

112 Alnt Carmmiiinicatinne +A 8l rinhte recaerved
Ula AHOoT Communications Ltd, &l rignts reserved

Figure 2-1 — NetXplorer Log On Dialog Box

4. Inthe User Name field, enter admin and in the Password field,
enter allot or the password that was established at set up. These are
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NOTE
NOTE

NOTE

the default user name and password. They may be different if you
changed them during the initial configuration.

5. Click Log On. The NetXplorer GUI is displayed.
It may take a few moments to display the NetXplorer GUI.

For additional security it is possible to require authentication on all
transactions between the NetXplorer Client and Server. For more
information, contact Allot Customer Support.

If a user tries to login to a particular account using the wrong
password within a configurable time period (the default is 1 hour),
then he can be "locked out" after a configurable number of failed
attempts (the default is 3 attempts). The user will be locked out for a
configurable length of time (the default is 1 hour). This feature is
disabled by default. Contact Allot Customer Support to enable the
feature and/or change any of the default values.

NetXplorer User Interface

The NetXplorer window is displayed when you open the program.

Menu
Bar Bsx@anaexzerannae ANQt
S A | $GS-10.17.1.100 x
[ Conon — |

File Edit View Actions Tools Window Help

Name | Warms s..[ nuse Intemal | Direction | _Exteral Senvice Time Access | Quallty of S.

Quick Access

Main 5 g Fallback a lAny = Jany AlSenice |Anime |Accept |Norma Line. Toolbar
= ort-Term Collector
&) Long-Term Collector
Toolbar
Navigation
Pane
|
(@ catalogs |
- Application
T repons Pane
& oo

& 1P Accounts Policy: $GS-10.17.1.100
Logs Pane L s
4 Mg HOW AT
Alarms Log
Ack | Date | Time | Severity [ AlarmDefinion__| Source Description

[@o[So[@o(@o[a0

Figure 2-2 — NetXplorer Window Components

This section describes the following NetXplorer window components:

e Menu Bar, page 2-3
e Main Toolbar, page 2-11
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e Quick Access Toolbar, page 2-13
¢ Navigation Pane, page 2-13

e Application Pane, page 2-14

e Logs Pane, page 2-14

Menu Bar

The NetXplorer menu bar provides easy access to the key functionality of the
NetXplorer applications. This section describes the available menus and options.

NOTE The options enabled in each of the NetXplorer menus vary according
to the currently active application.

File Menu

The File menu includes the following options:

OPTION DESCRIPTION

Reload Refreshes the display.

Save Saves ar_ld applies changes made in the various NetXplorer
applications

Print Prints the current report, graph or chart.

Exit Closes the NetXplorer window and exits NetXplorer.

Edit Menu

The Edit menu includes the following options:

OPTION DESCRIPTION
cut Enables you to cut an item or catalog entry in the active
window.
Co Enables you to copy an item or catalog entry in the active
Py window.
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OPTION DESCRIPTION
Paste Enables you to paste an item or catalog entry into the active
window.
Enables you to delete an item or catalog entry from the active
Delete -
window.
Select All Enables you to select all of the items in a table or list.
Find Enables you to perform a search for a specific item or
catalog.
View Menu

OPTION

The View menu includes the following options:

DESCRIPTION

Enables you to view real-time monitoring data. You can
manipulate the data and produce reports, as required.
Selecting Real-Time Monitoring displays a submenu

llfﬂec?r:;gﬁﬁg conta}inipg the available types of reports. ReaI—Time_
Monitoring must be enabled by entering an appropriate key.
(Refer to Chapter 7, Monitoring Reports for further
information.)
Enables you to collect and view Long-Term Reporting data.
You can manipulate the data and produce reports, as
Long-T_erm required. Selecting Long-Term Reporting displays a
Reporting '

submenu containing the available report types. (Refer to
Chapter 7, Monitoring Reports for further information.)

Mobile Analytics

Enables you to generate Mobile Analytics graphs. Selecting
Mobile Analytics displays a submenu containing the
available types of reports. Mobile Analytics requires an SMP
and must be enabled by entering an appropriate In-line
Platform key. (Refer to Chapter 7, Monitoring Reports for
further information.)
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OPTION

DESCRIPTION

Favorite View

Displays a saved arrangement of Monitoring windows as
your favorite view. (Refer to Chapter 7, Monitoring Reports
for further information.)

Enforcement Policy
Editor

Provides access to the Enforcement Policy Editor where you
define QoS Enforcement Policy using rules for Lines, Pipes
and Virtual Channels. (Refer to Chapter 5, Defining Policies
for further information.)

Online Charging
Policy

Provides access to the Online Charging Policy Editor where
you define Charging policies for use with the Subscriber
Management Platform. (Refer to SMP User Guide for further
information.)

Offline Charging
Policy

Provides access to the Offline Charging Policy Editor where
you define Charging policies for use with the Subscriber
Management Platform. (Refer to SMP User Guide for further
information.)

Catalogs

Provides access to the NetXplorer catalogs where you define
the possible values to be used in defining policies. Selecting
Catalogs displays a submenu containing the available
catalogs (Host, Service, Time, TOS, Encapsulation,
Quality of Service, Service Activation, DoS, Quota,
Service Plan, Interface, Charging Application, Charging
Plan and Mobile Device). (Refer to Chapter 4, Defining
Catalog Entries for further information.)

Alarms

Provides access to NetXplorer's Alarms catalogs where you
configure the actions to be taken in response to different
types of alarms. Selecting Alarm Definitions displays a
submenu containing the available Alarms catalogs (Alarm
Definition, Alarm Action Definition, and Event Types
Configuration). (Refer to Chapter 6, NetXplorer Alarms for
further information.)

Events

Displays the events log for a selected NetEnforcer or Service
Gateway, Line, Pipe or Virtual Channel. (Refer to Chapter 6,
NetXplorer Alarms for further information.)

Quota Events

Displays the Quota events log for a selected NetEnforcer or
Service Gateway, Line, Pipe or Virtual Channel. (This
feature is only available with the appropriate key.)

NetXplorer Operation Guide
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OPTION

Alarm Definition
Assignment List

DESCRIPTION

Displays the Alarm Definition Assignment list for the device
selected in the Navigation pane. (Refer to Chapter 6,
NetXplorer Alarms for further information.)

Collection
Configuration

Displays the Monitoring Collection Parameters for the
selected device.

SMP Groups
Subscribers
Capacity

Enables you to configure the number of Subscribers allowed
in each SMP Group and check how much of your capacity
you are using, by SMP or SMP Group. (This feature is only
available with the appropriate key.)

Enforcement Policy
Distribution

Distributes the Enforcement Policy table of the selected
machine NetEnforcer or Service Gateway to other selected
NetEnforcer or Service Gateways on the network. Refer to
Chapter 5, Defining Policies for more information)

Configuration

Enables you to specify server or NetEnforcer or Service
Gateway configuration and setup parameters in the
Configuration application. (Refer to Chapter 3, Configuring
NetXplorer for further information.)

Asymmetry
Configuration

Allows you to create Asymmetry Groups and assign devices
to each group.

2-6
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Actions Menu

The Actions menu includes the following options:

These Actions menu items appear when Network is highlighted in the
Navigation Pane. The menu items will change depending upon what
selection is made in the Navigation Pane.

OPTION

DESCRIPTION

New NetEnforcer

Enables you to add a NetEnforcer or Service Gateway to the
Network configuration.

New Collector

Enables you to add a Monitoring Data Collector to the
Network configuration.

New Collector

Enables you to add a Group of Monitoring Data Collector to

Group the Network configuration.
Enables you to add a Subscriber Management Platform to the
New SMP Network configuration. (This feature is only available with

the appropriate key.)

New SMP Group

Enables you to add a Group of Subscriber Management
Platforms to the Network configuration. (This feature is only
available with the appropriate key.)

New SMP Router

Enables you to add a Subscriber Management Platform
Router to the Network configuration when deploying a
distributed SMP topology. This configuration is only
applicable in specific situations, and for more information
contact Allot Customer Support at support@allot.com (This
feature is only available with the appropriate key.)

New Data
Mediation

Enables you to add a Data Mediator to the Network
configuration. (This feature is only available with the
appropriate key.)

New Catalog Entry

Enables you to add a new entry to a selected category. Refer
to Chapter 4, Defining Catalog Entries for further
information.

New Alarm/Action
Entry

Enables you to define a new Alarm or Action Definition.
(Refer to Chapter 6, NetXplorer Alarms for further
information.)

NetXplorer Operation Guide
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OPTION

New Report Entry

DESCRIPTION

Enables you to define a new report folder, new report or new
compound report. (Refer to Chapter 7, Monitoring & Reports
for further information.)

New Group

Enables you to define a customized group of entities for
monitoring purposes (New Line Group, New Pipe Group or
New Virtual Channel Group).

New Account

Enables you to add a new user Account to the NetXplorer.
(This feature is only available with the appropriate key.)

Properties

Displays the Properties window for the selected device or
catalog entry.

2-8
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Tools Menu

The Tools menu includes the following options:

OPTION

DESCRIPTION

NetXplorer
Application Server
Registration

Enables you to enter the key to activate NetXplorer Server
functionality (such as managing multiple NetEnforcers or
Service Gateways).

Import NetEnforcer

Enables you to add a NetEnforcer or Service Gateway
already installed on the Network to the NetXplorer.

Users Configuration

Enables you to define users for NetXplorer and determine the
scope of actions that they are authorized to perform in the
system. (This option is enabled for Admin users only.)

Restore Policies and
Catalogs

Restores the Enforcement Policy Table and Catalogs of
selected NetEnforcer or Service Gateways.

Protocol Updates

Enables you to configure the web-based updates of the
Service Catalog.

Display Language
Configuration

Enables you to change the language of the NetXplorer GUI.

Add and Activate
Subscribers

Enables you to add a new Subscriber to the network and
activate their account. (This feature is only available with an
SMP Server installed and the appropriate key enabling
Subscriber Management. This feature is not available if an
SMP Session Management key is used.)

Stop and Remove
Subscribers

Enables you to remove an existing Subscriber from the
network and deactivate their account. (This feature is only
available with an SMP Server installed and the appropriate
key enabling Subscriber Management. This feature is not
available if an SMP Session Management key is used.)

Subscriber Status

Displays the status and current service plan of a subscriber.
(This feature is only available with an SMP Server installed
and the appropriate key enabling Subscriber Management.)

Displays data concerning Cell usage for mobile traffic. This

ServiceProtector

:\Ini‘ggr::attion is relevant for CellWise functionality, described in Appendix
F of the SMP User Guide.
Open Opens the ServiceProtector GUI if a ServiceProtector is

defined in the Network tab (see page 3-39)

NetXplorer Operation Guide
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OPTION DESCRIPTION

Allows you to Distribute Files, such as updated white or

WebSafe black lists, to all devices using WebSafe.

Window Menu

The Window menu includes the following options:

OPTION DESCRIPTION

Closes the currently selected NetXplorer tab. (The name of
the tab is displayed in the option name.)

Close <current tab>

Close All Closes all currently active NetXplorer tabs.

Makes a specific NetXplorer tab active. (A separate menu
<tab name> option is displayed for each open tab. The active tab is
indicated by a bullet.)

Help Menu

The Help menu includes the following options:

OPTION DESCRIPTION

Index Provides access to online help.

About NetXplorer Provides NetXplorer version information.
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Main Toolbar

The following buttons provide access to key NetXplorer functionality from the Main
Toolbar.

BUTTON DESCRIPTION

B save Savgs cr_langes made in the currently selected active

application.

o Properties Displays the properties of the selected item or catalog entry.

R Delete Er_lables you to delete an item or catalog entry from the active

window.

@ Print Prints the current report, graph or chart.

Enables you to view real-time monitoring data. You can
manipulate the data and produce reports, as required. Selecting

)~ Real-Time Real-Time Monitoring displays a submenu containing the
Monitoring available types o_f reports. ReaI?Tlme Monitoring must be

enabled by entering an appropriate key. (Refer to Chapter 7,
Monitoring Reports for further information.)
Enables you to collect and view long-term reporting data. You

&- can manipulate the data and produce reports, as required.
Long-Term Selecting Long-Term Reporting displays a submenu
Reporting containing the available report types. (Refer to Chapter 7,

Monitoring Reports for further information.)
Enables you to generate Mobile Analytics graphs. Selecting
o)~ ) Mobile Analytics displays a submenu containing the available
MOb"e_ types of reports. Mobile Analytics requires an SMP and must
Analytics be enabled by entering an appropriate key. (Refer to Chapter 7,
Monitoring Reports for further information.)

) Displays a saved arrangement of Monitoring windows as your
Favorite favorite view. (Refer to Chapter 7, Monitoring Reports for
View further information.)

Provides access to the Enforcement Policy Editor where you

Enforcement | define QoS Enforcement Policy using Lines, Pipes, Virtual
Policy Editor | Channels and rules. (Refer to Chapter 5, Defining Policies for

further information.)

NetXplorer Operation Guide
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NOTE

BUTTON

DESCRIPTION

Provides access to the Online Charging Editor where you

= .
< Onllng define online (or real-time) credit control and quota
Chgrglng management for subscriber data sessions. (Refer to NetXplorer
Editor Charging Policy Editors on page 6-29 for further information.)
Provides access to the Offline Charging Editor where you
& Offline define the way that the NetXplorer works with charging data in
Charging the form of Charging Data Records (CDRs) and diameter
Editor accounting messages. (Refer to NetXplorer Charging Policy
Editors on page 6-29 for further information.)
Provides access to the NetXplorer catalogs where you define
_ the possible values to be used in defining policies. Selecting
@~ Catalogs Catalogs displays a submenu containing the available catalogs.
(Refer to Chapter 4, Defining Catalog Entries for further
information.)
Provides access to the Alarms Editor and the Alarms Log.
2k~ Alarms (Refer to Chapter 6, NetXplorer Alarms for further
information.)
Displays the events log for a selected NetEnforcer or Service
Zl Events Gateway, Line, Pipe or Virtual Channel. (Refer to Chapter 6,

NetXplorer Alarms for further information.)

#l Quota Events

Displays the quota events log for a selected NetEnforcer or
Service Gateway, Line, Pipe or Virtual Channel. (Only enabled
if SMP/Quota Management is enabled on the Server).

il Configuration

Enables you to specify system configuration and setup
parameters in the Configuration application. (Refer to Chapter
3, Configuring NetXplorer for further information.)

4 Exit

Closes the NetXplorer window.

2 Help Index

Provides access to online help.

The above buttons are enabled or disabled according to the current
selection or operation

2-12
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Quick Access Toolbar

The Quick Access Toolbar displays those buttons which are most relevant for the
operation currently active in the Applications Pane. For example, when the
Enforcement Policy Editor is active and a Pipe is selected, those buttons which can be
used to manage Pipes and VCs appear in the Quick Access Toolbar.

The Quick Access Toolbar appears on the upper right hand side of the GUI, below the

Menu Bar.
at B ANQt
50.8. > Quick Access
ditions Actions Toolbar
ction External Service Time Access Quality of Se...
Any All Service Anytime Accept Normal Line ...
Any AllIP Anytime Accept Normal Pipe ...
Any All 1P Anvtime Accept lgnore QoS
Figure 2-3: Quick Access Toolbar — Enforcement Policy
Editor

Navigation Pane

The Navigation pane is divided into two sections. The lower portion of the Navigation
pane enables you to select and open various NetXplorer applications. The upper portion
of the pane displays a tree-like list of subcomponents or entries according to the
application selected in the portion.

For example, when Catalogs is selected in the Navigation pane, the various catalogs are
listed in the Navigation tree. To view the details of a specific catalog, select the catalog
in the Navigation tree; the Application Details pane is updated accordingly.

>4

(@ carsiogs

A Eventsiiarms
B reports

2] Growes

a NPP Accournits.

Figure 2-4: Navigation Pane — Network
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Application Pane

& senvice Al
#-(3 DB Transactions

@ 3 File Systems

#-G3 File Transfer

®-(J Games

Figure 2-5: Application Pane

The Application Pane displays data regarding the currently active applications and
operations.

A tab is displayed at the bottom of the pane for each open application. You can navigate
easily between the open applications by clicking the tabs.

Logs Pane

& Alarms Log FORNET

Alarms Log
Ack. [ Date | Time _ Severly | AMampefinition [ Source | Desciption a3
Ju @l aa Data Source in 10.50.37.11 Is down

8 1050835
35

Aug 11,2010 24817 PM

Aug 11,2010 10:37:48 Al
Aug 11,2010 1026:19 Al
Aug 11,2010 1016:19 Al
Aug 11,2010 10:06:19 Al

ing: attribute type limiting type: number o
ing: attribute mber o
ing: aftribute mber o
License Waming: aftribute type: vc number, limiting type: numoer o... _

[o[s8[e0[e0[a7

Figure 2-6: Logs Pane displaying Alarms Log

The Logs Pane displays the Alarms Log, a list of the alarms triggered by the alarm
definitions. The Alarms Log is automatically refreshed every 30 seconds. The severity
of an alarm is indicated by the color of the icon (Info: light gray, Warning: dark gray;
Minor: blue; Major: yellow; Critical: red). A checkmark in the leftmost column
indicates that the alarm has been acknowledged. The status bar at the bottom of the
Alarms Log indicates the total number of active alarms, and provides their breakdown
according to severity. For further details on configuring and managing alarms, refer to
Chapter 6, NetXplorer Alarms.
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General NetXplorer Conventions

NetXplorer Application Icons

The following icons are used throughout NetXplorer to represent the NetXplorer
applications:

NOTE NPP Accounts is only available to those users with NPP installed.

B ERw G N

Network
Catalogs
Events/Alarms
Reports
Groups

NPP Accounts

Network Component Icons

The following icons are used throughout NetXplorer to represent the elements of the

network:

=+
X

Network

NetEnforcer

Short Term Monitoring Collector
Long Term Monitoring Collector

Extended Monitoring Collector

Data Mediator
SMP

SMP Group
Line

Pipe

Virtual Channel

Pipe Service Plan
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NetXplorer Language

i

Virtual Channel Service Plan

In the Navigation tree, the #= icon is added to Line, Pipe or Virtual Channel to

indicate that it is the fallback element of its type, as applicable. For example, E

represents the default pipe.

The severity of the most serious alarm for a system component) is indicated by the
addition of a color-coded alarm icon on the lower right portion of the device icon
(Warning: gray; Minor: blue; Major: yellow; Critical: red). For example, 'E_il), indicates
that a major alarm has occurred on the NetEnforcer or Service Gateway.

Accessibility problems are indicated by the addition of an icon in the upper right portion

of the device icon. For example, & | indicates that the NetEnforcer or Service Gateway
iS not accessible.

The populated severity of alarms for a system component or one of its sub elements is
indicated by the addition of a color-coded alarm icon on the upper left portion of the
device icon (Warning: gray; Minor: blue; Major: yellow; Critical: red). For example,

9';, indicates a critical alarm is open for one at least one of the subelements in the
network.

Catalog Icons

The following icons are used throughout NetXplorer to represent the different types of

catalogs:
12 Host
<}  Service
& Time
& ToS
-  Service Activation

el

i

Interface

Charging Plans

Encapsulation
Quality of Service

DoS

Quota

Service Plan
Charging Apps

Mobile Device

The NetXplorer GUI may be displayed in one of three languages, English, Korean or
Chinese. This language may be selected by the user and changed at any time.

2-16
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To set the language of the NetXplorer GUI:

1. Select Tools > Display Language Configuration from the
NetXplorer Menu bar.

The Display Language Configuration dialog box appears.

&) Display Language Configuration =

NetXplorer Display Language:
@ English
Korean
Chinese

‘ Save Cancel ]

Figure 2-7: Display Language Configuration Dialog
2. Select the appropriate language.

3. Click Save to enter the change and close the dialog box.
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Enabling NetXplorer Server

In order to manage more than one NetEnforcer or Service Gateway using NetXplorer,
NetXplorer Server must be enabled by entering the appropriate key. This key may be

entered at installation or at any time following.

To enable NetXplorer Server:

1. Select Tools > NetXplorer Application Server Registration

3.

Activation Key Details

from the NetXplorer Menu bar.

The NetXplorer Application Server Registration dialog box
appears.

General

Attributes

MNumber of Supported Devices:

NPP:

Met Accounting
APU
Tiered Senices:

Tiered Senices G

Quota Management:

Country Classification Subscription:

Mo of Active Elements:

Enabled

Mo of Active Elements:

Enabled

Enabled

Enabled

Disabled

Enabled

Active IP Sessions

Disabled

Activation Key: 1JIR41000VTA03RAIVT104RAJIVT105R1AVT107R A IRT 9999999V T109R 1J1R 71999998
Serial Number: abc

Key Version: 1

Marketing Version 17 Expiration Date Wed Jan 01 00:00:00 IST 2020

1000

1000

9999999 current value: 1 max 7 days value: 1

m

| save || Detete |[ cancel

Figure 3-1: NetXplorer Application Server Registration

Dialog

Enter the Activation Key and Serial Number provided by Allot to

enable the NetXplorer Server functionality.

A Key Version, Marketing Version and Expiration Date will be
generated automatically after clicking Save.
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4. The number of devices supported by the key is indicated.

5. If Enforcement Policy Provisioning is enabled by the key that has
been entered, it will be indicated (along with the maximum
number of accounts) after NPP. For more information, see the
NPP User Guide.

6. If Classification of Hosts by Country is enabled by the key that
has been entered, it will be indicated after Country Classification
Subscription.

7. If Accounting information is enabled by the key that has been
entered, it will be indicated after Net Accounting.

8. If Service Catalog updates via the web are enabled by the key that
has been entered, it will be indicated after APU.

9. If Subscriber Management is enabled by the key that has been
entered, it will be indicated by one of the following attributes
being enabled — e.g: Tiered Services or Quota Management. In
addition, the number of supported active subscribers, the current
number of subscribers and the highest number of subscribers over
the last 7 days will be indicated if relevant. This information is
provided on the system level (i.e: for all SMP Groups). For more
information, see the SMP Installation and Administration Guide.

10. If Session Management is enabled by the key that has been
entered, it will be indicated by at least one of the following
attributes being enabled — e.g: Tiered Services Gx, Volume
Reporting or Cell Awareness. In addition, the licensed maximum
number of active IP sessions, the current number of active IP
sessions and the highest number of IP sessions over the last 7 days
will be indicated if relevant. This information is provided on the
system level (i.e: for all SMP Groups). For more information, see
the SMP Installation and Administration Guide.

11. If Mobile Analytics is enabled by the key that has been entered, it
will be indicated by the following attribute being enabled: Mobile
Reports SMP. In addition, the number of active IP sessions, the
current number of IP sessions and the highest number of IP
sessions over the last 7 days will be indicated if relevant. This
information is provided on the system level (i.e: for all SMP
Groups). For more information, see the SMP Installation and
Administration Guide.

12. Click Save to enter the key and close the dialog box.

3-2 NetXplorer Operation Guide



Chapter 3: Configuring NetXplorer

Viewing the Network

NetXplorer enables the central monitoring, configuration and management of multiple
NetEnforcers or Service Gateways in your network. It enables easy access to devices

via the network Navigation tree.

To view network components:

Click Network in the lower portion of the Navigation pane to display the network

structure in the Navigation tree.

etwork

j Network
+-@8 AC1000

-
2l Servers
#-[F) GR1
= short-Term Collector
[E Long-Term Collsctor

Q Catalogs

} Events/alarms

Reports

dﬂ Groups.

a MPP Accounts

Figure 3-2: Navigation Pane — Network

The following icons are used throughout NetXplorer to represent the elements of the

network:

#  Network
o NetEnforcer or Service Gateway
= Short Term Monitoring Collector

() Long Term Monitoring Collector

Izl SMP

G  SMP Group

F= Line
=l Pipe

=2 Virtual Channel

NetXplorer Operation Guide
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NOTE

In the Navigation tree, the #== jcon is added to a Line, Pipe or Virtual Channr'g‘?

indicate that it is the fallback element of its type, as applicable. For example,

represents the fallback pipe.

The severity of the most serious alarms directly concerning a system component (or one
of its sub elements) is indicated by the addition of a color-coded alarm icon
(Information: light grey, Warning: gray; Minor: blue; Major: yellow; Critical: red). For
example, ‘E_‘il), indicates that a major alarm has occurred on the NetEnforcer or Service
Gateway.

Accessibility problems are indicated by the addition of an icon in the upper right portion

of the device icon. For example, = | indicates that the NetEnforcer or Service Gateway
is not accessible.

The populated severity of alarms for a system component or one of its sub elements is
indicated by the addition of a color-coded alarm icon on the upper left portion of the
device icon (Warning: gray; Minor: blue; Major: yellow; Critical: red). For example,

Evf, indicates a critical alarm is open for one at least one of the sub elements in the
network.

To expand the tree to view the subcomponents of a component, click [+
To collapse the tree to hide the subcomponents of a component, click [=l.

To view or edit the name and IP address of a NetEnforcer, select the component in the

Navigation tree and click -_3, or select Properties from the Action menu, or right-click
and select Properties from the popup menu.

To view or edit the configuration of a NetEnforcer or Service Gateway, select the

NetEnforcer or Service Gateway in the Navigation tree and click '#, or select
Configuration from the View menu, or right-click and select Configuration from the
popup menu.

Lines, Pipes and Virtual Channels cannot be added/deleted/changed
in the Network Tree. This must be done through the Enforcement
Policy editor.

Adding a NetEnforcer or Service
Gateway

In order for NetXplorer to manage a NetEnforcer or Service Gateway, it must be added
to the NetXplorer's network and properly configured. The IP address of the NetEnforcer
or Service Gateway is required for this procedure.

NOTE Initial configuration of the NetEnforcer or Service Gateway should be
performed on the device (via the CLI interface) before it is added to
the NetXplorer configuration. Refer to the hardware manual for the
specific model for details.
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To add a NetEnforcer or Service Gateway:

1. Inthe Navigation pane, right-click Network in the Network of the
Navigation tree and select New NetEnforcer from the popup
menu.

OR

Select Network in the Network pane of the Navigation tree and then select New
NetEnforcer from the Actions menu.

The NetEnforcer Properties - New dialog is displayed.

NetEnforcer Properties - New

Figure 3-3: NetEnforcer Properties — New Dialog

2. Enter the Name, Admin Password and the IP address of the
NetEnforcer or Service Gateway in the designated fields.

NOTE: The default admin password is ‘allot’ in all NetEnforcer and Service
Gateways

3. Assign a Monitoring Collector or Collector Group to the
NetEnforcer or Service Gateway from the drop down menus. This
means that the new NetEnforcer or Service Gateway will transmit
its monitoring data to that Collector or Group only. If it does not
matter which Collector is used, select <system defined>. If you
do not have any Monitoring Collectors on the Network, select No
Collector.

4. Click OK. The NetEnforcer or Service Gateway is added to the
Navigation tree. The Add NetEnforcer operation can take up to a
couple of minutes to complete.

To Import a NetEnforcer or Service Gateway:

1. A NetEnforcer or Service Gateway can be imported into
NetXplorer if it already exists on the network but has not
previously been part of this NetXplorer network or had
NetXplorer enabled. When a NetEnforcer or Service Gateway is
imported, its Enforcement Policy tables and catalogs remain intact
and are imported into the NetXplorer database.

2. Select Import NetEnforcer from the Tools menu.
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The NetEnforcer Properties - Import dialog is displayed.

Figure 3-4: NetEnforcer Properties — Import Dialog

3. Enter the Name, Admin Password and IP address of the
NetEnforcer or Service Gateway in the designated fields.

4. Enter the name of the NetEnforcer or Service Gateway and its IP
address in the designated fields.

5. In the Password field, enter the admin password of the
NetEnforcer or Service Gateway

NOTE: The default admin password is ‘allot’ in all NetEnforcer and Service
Gateways

6. Assign a Monitoring Collector or Collector Group to the
NetEnforcer or Service Gateway from the drop down menus. This
means that the new NetEnforcer or Service Gateway will transmit
its monitoring data to that Collector or Group only. If it does not
matter which Collector is used, select <system defined>. If you
do not have any Monitoring Collectors on the Network, select No
Collector.

7. Click OK. The NetEnforcer or Service Gateway is added to the
Navigation tree. The Import NetEnforcer operation can take up to
a couple of minutes to complete.
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Configuring a NetEnforcer or Service
Gateway

Once you have added a NetEnforcer or Service Gateway to the NetXplorer
configuration, you can modify the NetEnforcer or Service Gateway's configuration
parameters remotely via NetXplorer.

For information concerning adding NetEnforcers or Service Gateways and other Servers
to the network, see the NetXplorer Administration Guide.

To configure a NetEnforcer or Service Gateway:

1.

In the Navigation pane, select and right-click the NetEnforcer or
Service Gateway in the Navigation tree and select Configuration
from the popup menu.

OR

Select the NetEnforcer or Service Gateway in the Navigation tree and then
select Configuration from the View menu.

OR
Select the NetEnforcer or Service Gateway in the Navigation tree and then

click the Configuration icon & on the toolbar.

The Configuration window for the selected NetEnforcer or Service Gateway is
displayed.

Configure the NetEnforcer or Service Gateway parameters, as
required. For a detailed description of the parameter in each of the
NetEnforcer or Service Gateway Configuration tabs, refer to
NetEnforcer or Service Gateway Configuration Parameters, page
3-7.

Click El or select Save from the File menu to save the changes
to the NetEnforcer or Service Gateway configuration.

NetEnforcer or Service Gateway Configuration
Parameters

The parameters available in the NetEnforcer or Service Gateway Configuration window
are grouped on the following tabs:

General, page 3-8
Identification & Key, page 3-10
SNMP, page 3-14

Security, page 3-15
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e NIC, page Error! Bookmark not defined.
e Networking, page 3-20

e |IP Parameters, page 3-22

e Date/Time, page 3-25

e Service Activation, page 3-27

e Slots & Boards, page 3-28

Each tab includes parameters that can be configured as required. After modifying
configuration parameters, you must select Save in order for the changes to take effect.
The save process prompts a reset of the NetEnforcer or Service Gateway. Resetting is
sometimes required to ensure that some saved parameter values are committed and
activated on the NetEnforcer or Service Gateway.

NOTE The Slots and Boards tab will only appear when configuring a
NetEnforcer that utilizes blades or a Service Gateway.

General

The General tab includes parameters that provide system status information.

Sigma404 X
General | |dentification & Key | SNMP | Security | Interface | Networking | IP Properties | Date/Time | Senice Activation | Slols&Boards

State

Status: Active

Bypass Setting: Primary
Remote Bypass

Power Supply: 2 aclive outof 2

Fans 3 active out of 3

] Configuration: Network ®c «rul

Figure 3-5: Configuration — General Parameters
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PARAMETER

Status

The General tab includes the following parameters:

DEFINITION

Indicates whether or not the NetEnforcer or Service
Gateway is operating in Bypass mode (Active or Non-
bypass).

Bypass Setting

Indicates the current Bypass Setting.

Remote Bypass

If configured for redundancy, the role of the NetEnforcer or
Service Gateway in the redundancy configuration. (Not
applicable, Primary, or Secondary).

Power Supply

The number of active power supplies along with the total
number installed. For example, 2 active out of 4.

Fans

The number of active fans along with the total number
installed. For example, 8 active out of 8.

NetXplorer Operation Guide
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Identification & Key

The Identification & Key tab includes parameters that provide system information and

activate optional NetEnforcer or Service Gateway modules.

Sigmad04 * x

- Identification & Key | SNMP | Security | inteface | Networking | 1P Properties | DaterTime | Senvice Activation | Slots&Boards

Activation Key Details

General

Activation Key:

HZAQIMINZ2QIMANZ3QTMINZTQIMANZ10Q1M1Q3M20000NZ1102M4NZ 1302M4NZ 1402MANZ 15Q2MANZ 16Q2M4NZ 1T

Platform Type: Service Gateway Sigma Series
Software Version: Version AOS.5GS.13.1.10 Build 50
Protocol Pack: 3.26.33

Box Number. 80901372

Key Version: 1 Device Type SGSigma
Marketing Version: 17 Expiration Date: Wed Jan 01 00:00:00 IST 2020
Attributes
Qos: Enabled 3
Real Time Reporting Enabled
Long Term Reporting: Enabled
Number of VCs No of Active Elements Unlimited
Number of Pipes: No of Active Elements Unlimited M
Number of Lines: No of Active Elements Unlimited
APU: Enabled
WebS3afe Subscription: Disabled
Traffic Steering Enabled
Bandwidth (Mbps): 20000 i
IDs Bandwidth Capacity Limitations

Limitation Type: :\nbuund&DutbuundDeﬁnedmeSame v:

Maximum Bandwidth for Each (Kbps). |Max Allowed K‘Ila;(wad

i Configuration: Network| @) Configuration® Sigma404

Figure 3-6: Configuration - Identification & Key Parameters

PARAMETER

Activation Key

The Identification & Key tab includes the following parameters:

DEFINITION

The activation key enables the NetEnforcer or Service
Gateway. Enter the activation key supplied to you at
purchase. The functionality enabled by the key is
summarized in the fields below the key.

Serial Number

The Serial Number of the NetEnforcer or Service Gateway.

Key Version

For Internal Use Only

Marketing
Version

For Internal Use Only

3-10
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PARAMETER

Device Type

DEFINITION

The Type of NetEnforcer or Service Gateway.

Expiration Date

The expiration date of the entered Activation Key.

Quality of Service is enabled/disabled on the NetEnforcer or

QoS Service Gateway.
Real Time Real Time Reporting is enabled/disabled on the NetEnforcer
Reportin or Service Gateway. Real Time Reporting requires an

P g appropriate key to be enabled.
Lona Term Long Term Reporting is enabled/disabled on the NetEnforcer
Repgrting or Service Gateway. Long Term Reporting is enabled by

default.

Number of Lines

The maximum number of Lines that may be defined on the
NetEnforcer or Service Gateway. This field also indicates the
current number of lines and the highest number of lines
during the last seven days.

Number of Pipes

The maximum number of Pipes that may be defined on the
NetEnforcer or Service Gateway. This field also indicates the
current number of pipes and the highest number of pipes
during the last seven days.

The maximum number of Virtual Channels that may be
defined on the NetEnforcer or Service Gateway. This field

Number of VCs also indicates the current number of VCs and the highest
number of VCs during the last seven days.
Allot Protocol Update is enabled/disabled on the NetEnforcer
APU .
or Service Gateway.
WebSafe WebSafe is enabled/disabled on the NetEnforcer or Service
Gateway, listing the number of Core Controllers covered by
Enforcement -
the license.
WebSafe WebSafe is subscribed to the Internet Watch Foundation

Subscription

blacklist service. This subscription is optional

NetXplorer Operation Guide
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PARAMETER

Traffic Steering

DEFINITION

Port or URL Redirection is enabled/disabled on the
NetEnforcer or Service Gateway. For further information see
Service Activation Catalog on page 4-56. If Enabled, the
maximum Bandwidth (Mbps), No of Active Elements and
No of Subscribers on the system level appears.

SP Mitigation

Listing the number of Core Controllers enabled for Service
Protector as covered by the license. If this field lists a value
of 0, it indicates the service is not enabled by the current
license. A NetEnforcer will list this value as 1 if the service is
enabled.

SP Embedded
Sensors

Listing the number of Core Controllers enabled for SP
Embedded Sensors as covered by the license. If this field lists
a value of 0, it indicates the service is not enabled by the
current license. A NetEnforcer will list this value as 1 if the
service is enabled.

Mobile Reports

Listing the number of Core Controllers enabled for Mobile
Reporting as covered by the license. If this field lists a value
of 0, it indicates the service is not enabled by the current
license. A NetEnforcer will list this value as 1 if the service is
enabled.

Statistics Export

Listing the number of Core Controllers enabled for Statistics
Export as covered by the license. If this field lists a value of
0, it indicates the service is not enabled by the current
license. A NetEnforcer will list this value as 1 if the service is
enabled.

Listing the number of Core Controllers enabled for Tethering
as covered by the license. If this field lists a value of 0, it

Tethering indicates the service is not enabled by the current license. A
NetEnforcer will list this value as 1 if the service is enabled.
Listing the number of Core Controllers enabled for HTTP
CDRs as covered by the license. If this field lists a value of 0,
HTTP CDRs it indicates the service is not enabled by the current license. A
NetEnforcer will list this value as 1 if the service is enabled.
MediaSwift — The Cache Out bandwidth of the MediaSwift Service, in
Cache Out Mbps.

Platform Type

The platform series of the NetEnforcer or Service Gateway

3-12
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PARAMETER DEFINITION
Software The software version running on the NetEnforcer or Service
Version Gateway.

The Protocol Pack release and version loaded into the Service
Protocol Pack Catalog of the NetEnforcer or Service Gateway.
Box Number The ID number of the NetEnforcer or Service Gateway.
Bandwidth The way bandwidth limitations are imposed on the
Capacity NetEnforcer or Service Gateway; Inbound & Outbound
Limitations — Defined Separately, Inbound & Outbound Defined the
Limitation Type Same or Half Duplex.
Inbound The incoming bandwidth limitation of the NetEnforcer, in
Bandwidth Kbps. Select the Max Allowed checkbox to allow the
Limited to: maximum value to be passed.
Outbound The outgoing bandwidth limitation of the NetEnforcer, in
Bandwidth Kbps. Select the Max Allowed checkbox to allow the
Limited to: maximum value to be passed.
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SNMP

The SNMP tab includes parameters that enable you to configure SNMP-compatible
management functions.

Sigma404 X
General | Identification & Key| SNMP | Security | Interface | Networking | IP Properties | DatefTime | Service Activation | Slots&Boards

MiB

Contact:
Location:
System Name:

System Description: NetEnforcer. Allot Communications.

m \‘ﬂ Configuration S\gma4U4‘
Figure 3-7: Configuration - SNMP Parameters

The Simple Network Management Protocol (SNMP) is a commonly used network
management protocol that allows SNMP-compatible management functions such as
device discovery, monitoring and event generation. NetEnforcer or Service Gateway
support for SNMP includes MIB Il with standard MIB |1 traps.

The SNMP tab includes the following parameters:

PARAMETER DEFINITION

Contact The contact person, for SNMP purposes.
Location The location of system, for SNMP purposes.
System Name The name of the system, for SNMP purposes.

System Description | A description of the system, for SNMP purposes.
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Security

The Security tab includes parameters that enable you to specify security parameters as
well as control access to NetEnforcer or Service Gateway management functions by
specifying the names of hosts to whom you want to grant access permission.

General | Identification & Key | SNMP | Security | Interface | Networking | IP Properies | DatefTime | Senice Activation | Slots&Boards

Attributes

[] Enable Telnet

Enable Ping Reply

[7] Enable Enhanced TCP Security

Enable SSH

[] Enable S5L Between NetXplarer Server and Device

Enable LCD Editing on Netenforcer
Console or Telnet Connection Timeout (secs).
{Leave Blank for Unlimited Timeout)

Hosts Allowed to Access Device

@ Unrestricted Access Allowed
) Limit Access as Indicated (NetXplorer Server Included):

IP:

Allowed Hosts

i Configuration: Netwark| ) o' Sigmad04 |

Figure 3-8: Configuration - Security Parameters

PARAMETER

Enable Telnet

The upper section of the Security tab includes the following parameters:

DEFINITION

Select this checkbox to enable remote Telnet
communications with the NetEnforcer or Service

Gateway.

Enable Ping Reply

Select this checkbox to enable remote Ping
communications with the NetEnforcer or Service
Gateway.

Enable Enhanced TCP

Select this checkbox to enable enhanced TCP
Security. Enhanced TCP security is used to help

Security prevent attacks in the transport layer.
Select this checkbox to enable SSH
communications. SSH communications are used to
Enable SSH

help prevent DoS attacks on the NetEnforcer or
Service Gateway.

NetXplorer Operation Guide
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PARAMETER DEFINITION

Select this checkbox to enable SSL

Enable SSL Between communications. SSL communications are used to
NetXplorer Server and further secure connections between the NetXplorer
Device Server and each NetEnforcer or Service Gateway.

(NOTE: SSL v3.0 and TLS v1.0 are supported)

Enables the configuration of the NetEnforcer from
Enable LCD Editing on the LCD on the front of the unit. This feature is not
NetEnforcer available on the AC-1400, AC-3000, AC-5000,
AC-10000 and Service Gateway lines.

In seconds, the time lapse after which an idle
connection times out. A timeout of 0 (zero) means
the connection will remain open indefinitely.

Console or Telnet Connection
Timeout

The lower section of the Security tab includes a list of hosts who have access
permission to NetEnforcer or Service Gateway management functions. When the Hosts
Allowed to Access NetEnforcer list is empty, there is unrestricted access to the
NetEnforcer or Service Gateway management functions. When there are hosts in the
Hosts Allowed to Access NetEnforcer list, only those hosts are allowed access to the
NetEnforcer or Service Gateway management function.

WARNING If no hosts are defined, anyone can access NetEnforcer or Service

Gateway management functions.

To add a host to the list, specify the IP address of the host in the designated field and
click Add. The specified host is added to the Hosts Allowed to Access NetEnforcer
list.

You can add as many hosts as required.

WARNING If you want to restrict access to a NetEnforcer or Service Gateway, do

NOTE

NOTE

not forget to enter your own IP address as the first entry. This will
ensure that you do not accidentally lock yourself out.

Regardless of the specific hosts defined, the NetXplorer can always
access the NetEnforcer or Service Gateway.

To modify a host, select the host in the Hosts Allowed to Access NetEnforcer list to
display its details in the IP field. Modify the details as required and click Update.

To remove a host, select the host in the Hosts Allowed to Access NetEnforcer list to
display its details in the IP field and click Delete.

If the host that you selected is the only one in the Hosts Allowed to
Access NetEnforcer list, a system message is displayed advising you
that if you delete this host all hosts will be able to access the
NetEnforcer or Service Gateway.

3-16
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Interface

The Interface tab consists of two sub-tabs, NIC and Link Aggregation Groups (if
relevant).

NIC sub-tab

The NIC sub-tab includes parameters that enable you to configure the system interfaces
to either automatically sense the direction and speed of traffic, or use a predetermined
duplex type and speed.

If you are configuring an Allot SG-Sigma E14 or E6 a representation of the currently
installed blades appears at the top of the sub-tab. Select a blade in the image to see the
NICs for that blade.

SlgmaE40_40 x

General | Identification & Key | SNMP | Security| Interface | Networking | IP Properties | Date/Time | Service Activation | Slats&Boards

NIG | Link Aggregation Groups

Boards

-]
g
B
i
=
Ll
0 -
Name Physical Type Detecled setting  Action on failure  Usage Connected to LAG Edit
Link Down No action Network
SB_6_L2 Ethernet Link Down Mo action Network
SB_6_L3 Ethernet Link Down Na action Network
SB_6_L4 Ethemnet Link Down Mo action Network
SB_6_L5 Ethernet 10000 Mbps/Full d... |No action MNetwork
SB_6_L6 Ethernet 10000 Mbps/Full d... |No action MNetwork

[ Configuration: Network | fad C Sigma404| (g Confguration: Slgmag40_4o |

Figure 3-9: Configuration — Interface - NIC Sub-tab

NOTE In units supporting more than one Link, the interfaces are referred
to as INTERNAL <LINK NUMBER> and EXTERNAL <LINK
NUMBER>. For example, INTERNAL2 and EXTERNALZ2.

The NIC tab includes the following parameters for each port. To make changes to any
of these parameters, click the field or highlight the device row and click the Edit button:

PARAMETER DEFINITION
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PARAMETER DEFINITION
Name The name of the interface.
Physical Type The type of port (e.g: Ethernet).

The actual speed detected (Link Down, Auto, 10 Mbps, 100

Detected Setting Mbps, or 1000 Mbps),

The action to be taken automatically should the NIC fail.
Options are:

e No action — No action is taken if the NIC
fails.

e Fail paired port — If the NIC fails, the
system will shut down its counterpart. For
instance, if the NIC is an internal NIC, the
system will shut down its external
counterpart.

e Fail all — If the NIC fails, all NICs except for
the management port will be shut down.

Action on Failure

e Bypass device — If a NIC fails, the device is
bypassed by traffic.

The type of traffic handled by the port (Network, Media
Usage Swift Storage, External Switched Redirection, Cloned (HA)
or Asymmetry).

Indicates if this interface is included in a Link Aggregation

Connected to LAG
Group

Link Aggregation Group sub-tab

NetXplorer allows a Link Aggregation (LAG) interface to be defined on Service
Gateways. A LAG has two or more physical interfaces of the same speed. Traffic is
distributed over the LAG according to IP addresses or MAC addresses. If one of the
physical interfaces in the LAG fails, traffic is redistributed among the other active
interfaces of the LAG.
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General | Identification & Key | SNMP | Security| Interface | Networking | IP Properties | DatefTime | Senice Activation | Slots&Boards

Sigmad04 X

- Link Aggregation Groups
Name State[Active Ports] Minimum Active Ports Distribution Function Usage Edit
LAG1 Up[2] il Internal & External IP Indirect redirect
LAG2 Up[2] 1 Internal & External IP Indirect redirect
LAG3 Down[0] 1 Internal & External IP Indirect redirect
LAGH Downl0] 1 Internal & External IP Indirect redirect
LAGS Down[0] il Internal & External IP Indirect redirect
LAGE Down[0] il Internal & External IP Indirect redirect
LAGT Down(0] 1 Internal & External IP Indirect redirect
LAGS Downl0] 1 Internal & External IP Indirect redirect

1] Configuration: Network ) Configuration Slgma4u4‘

Figure 3-10: Configuration — Interface — Link Aggregation
Groups Sub-tab

The Link Aggregation Groups sub-tab includes the following parameters for each
group. To make changes to any of these parameters or to add ports to a group, click the
field or highlight the group row and click the Edit button:

PARAMETER

DEFINITION

Name

The name of the group.

State (active ports)

The current state of the group (Up or Down) and the number
of active ports in the group.

Minimum Active

The minimum number of active ports that can be included in

Ports the group for its state to be Up.

Distribution The only available setting is internal and external
Function IP.

Usage The type of steering handled by the group.

NetXplorer Operation Guide

3-19



Chapter 3: Configuring NetXplorer

PARAMETER DEFINITION

Connected to LAG Indicates if this interface is included in a Link Aggregation

Group
Networking
The Networking tab includes parameters that enable you to configure the network
topology.

Sigma404 x

General | Identification & Key | SNMP | Security | Interface | MNetworking | |P Properties | Date/Time | Senvice Activation | Slots&Boards

Aftributes

Support Spanning Tree Protocol
Enable Leaming Bridge
Enable External Router / Internal Server ‘Double Sessions
TAP Mode
Enable Bypass Unit
[] Enable HTTP User Defined Signatures
[] Enable Predictive DPI
Enable IPv6 Capabilities

Redundancy Mode Standalone -

m

Selective Bypass
[7] Enable Selective Bypass

Active Vian Group For Selective Bypass: |None

Tethering

[] Enable Tethering Detectian

m @l S\gmaam‘
Figure 3-11: Configuration - Networking Parameters

The Attributes area of the Networking tab includes the following parameters. Not all
parameters are available for all devices, and if unavailable will be grayed outs:

PARAMETER DEFINITION

Enables the use of a second NetEnforcer or Service

?ﬁgg;ﬁfg&?nmg Gateway as a backup system in a spanning tree
configuration.

Enable Learning Enables the use of a learning bridge, which maintains a

Bridge database of physical addresses.
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PARAMETER DEFINITION

Enable External
Router / Internal
Server 'Double
Sessions'

Enables Double Sessions, which are when a single
connection goes through the NetEnforcer or Service
Gateway as both Inbound and Outbound traffic. This
usually occurs due to a connection being redirected by an
external router.

TAP Mode

Enables TAP mode for Monitoring Only service.

Enable Bypass Unit

Enables the NetEnforcer or Service Gateway to go into
bypass mode.

Enable HTTP User
Defined Signatures

Allows the user to define signatures (UDS) for HTTP
content.

Enabled Predictive

For more information concerning Predictive DPI contact

DPI Allot Customer Support.

Allows IPv6 to be used by the selected in-line platform.
Enable IPV6 The In-line Platform must be moved into Bypass before
Capabilities enabling or disabling IPv6. Attempting to change IPv6

settings on an active platform will be denied and produce
a warning message.

Redundancy Mode

Indicates the Redundancy Mode to be used should one
NetEnforcer or Service Gateway fail (Standalone,
Parallel, Serial or Active).

NOTE Different redundancy schemes
are supported per Hardware
series. For more information
about the available redundancy
modes, see the appropriate
Hardware Guide

NetXplorer Operation Guide
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The Selective Bypass area of the Networking tab includes the following parameters.
Not all parameters are available for all devices, and if unavailable will be grayed outs:

PARAMETER DEFINITION

Enables the use of Selective Bypass. Selective Bypass

Enable Selective allows the user to select VLAN Groups that will not be
Bypass subject to QoS. This requires that you have at least one
VLAN Group configured.

Active VL.AN Group Defines VLAN Groups that will not be subject to QoS.
for Selective Bypass

The Tethering area of the Networking tab includes the following parameters. Not all
parameters are available for all devices, and if unavailable will be grayed outs:

PARAMETER DEFINITION
Enable Tethering Enables the identification of those mobile devices that
Detection are using tethering capabilities.

IP Properties

The IP Properties tab enables you to modify the IP and host name configuration of
your network interfaces, as well as the DNS and connection control parameters.
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General | Identification & Key | SNMP | Security | Interface | Networking | IP Properties | DateTime | Service Activation | Slots&Boards

Sigmad04 x

Qut-of-pand Management

NetEnforcer. (1-4094, or Blank). 4022

Host Naming

Host Name: Sigma-Vodafone
Domain Name: allotlocal
Primary Server: 172.17.0.10
Secondary Server: 172.18.1.10

Direct Access

Management IP per CC

IP Address: 10.4 .40 4 IP Address:

Network Mask: 255255 0 . 0 Network Mask:

Default Gateway. 0.4 0.1 Default Gateway:

Tag Management Traffic with VLAN ID. Warning: Incorrect Tag Management Traffic with VLAN ID. Warning: Incorrect

Setting will Cause Application Server to disconnect from Setting will Cause Application Server to disconnect from

Connection Control

NetEnforcer. (1-4094, or Blank):

()
=]

1 Configuration: Network| @) Configuration Sigmado.

4|

Figure 3-12: Configuration — IP Properties

The Out-of-Band Mana

PARAMETER

gement area of the tab includes the following parameters:

DEFINITION

IP Address

The IP address of NetEnforcer or Service Gateway.

Network Mask

The network subnet mask.

Default Gateway

The IP address of the default gateway.

The default gateway enables clients to access the NetEnforcer
or Service Gateway remotely and to provide a path if
NetEnforcer or Service Gateway is on a different subnet than
that of the client.

Tag Management
Traffic with VLAN
ID

Configures the NetEnforcer or Service Gateway to be
managed based on specified VLAN-tagged traffic.

NOTE Once this option is set and the
VLAN ID is specified, the
NetEnforcer or Service Gateway will
be waiting for management traffic
tagged with this specified VLAN.

NetXplorer Operation Guide
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The Connection Control area of the tab includes the following parameters:

PARAMETER

IP Address

DEFINITION

The IP address of the NetEnforcer or Service Gateway.

Network Mask

The network subnet mask.

Default Gateway

The IP address of the default gateway.

The default gateway enables clients to access the NetEnforcer
or Service Gateway remotely and to provide a path if the
NetEnforcer or Service Gateway is on a different subnet than
that of the client.

Tag Management
Traffic with VLAN
ID

Configures the NetEnforcer or Service Gateway to be
managed based on specified VLAN-tagged traffic.

NOTE Once this option is set and the
VLAN ID is specified, the
NetEnforcer or Service Gateway will
be waiting for management traffic
tagged with this specified VLAN.

The Host Naming area of the tab includes the following parameters:

PARAMETER

Host Name

DEFINITION

The host name of the NetEnforcer or Service Gateway.

Domain Name

The domain name.

Primary Server

The IP address of the primary domain name server.

Secondary Server

The IP address of the secondary domain name server.

3-24
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The Direct Access area of the tab includes the following parameter:

PARAMETER DEFINITION

This enables Distributed Collection which gives direct access
Management IP by | to the Core Controllers and is used in conjunction with the go
CcC config blade_mngt_ips-base_IP command to configure
distributed collection of statistics (when working with STC or
MED) and/or distributed FUP (when working with SMP)

Date/Time

The Date/Time tab includes the date, time and NTP server settings for the NetEnforcer
or Service Gateway.

S\gmadﬂa X
General | Identification & Key | SNMP | Security | Interface | Networking | IP Properties | Date/Time | Senice Activation | Slots&Boards

Date and Time on NetEnforcer
Date: 10/4/2013
Time: 12:44:28

Timezane: AsialJerusalem -

NTP Server

Primary Server. 10.4.80.110

1] Configuration” Network| ] ¢ i 4 ‘|

Figure 3-13: Configuration — Date/Time Parameters

The Date and Time area of the Date/Time tab includes the following parameters:
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PARAMETER DEFINITION

Date The date set on the NetEnforcer or Service Gateway.
Time The time set on the NetEnforcer or Service Gateway.
Timezone The time zone set on the NetEnforcer or Service Gateway.

The NTP Server area of the Date/Time tab includes the following parameters:

PARAMETER DEFINITION

The name of the primary NTP (Network Time Protocol)
Primary Server server that the NetEnforcer or Service Gateway receives the
date and time from.
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Service Activation

The Service Activation tab includes IP and Port Redirection Parameters to be defined

Sigmad04 X

General | Identification & Key | SNMP | Security | Interface | Metworking | IP Properties | Date/Time | Service Activation | Slote&Boards

IP Redirection

Service Timeout (1-240 sec): 15

ervice Period (1-240 sec) 60

ervice Retries (1-100 times) 5
er Timeout (1-240 sec). 15
ser Period (1-240 sec): 60

Server Retries (1-100 times) 5

Port Redirection

m

Enable Port Redirection

Captive Portal

Encryplion Passphrase een

Redirection Technique :Un Reply ':

VOIP Reports

VOIP Data Collection Enabled hd

SP Sensor i
Embedded Sensor: Enabled e

HTTP CDR

HDR Generation Enablement: Enabled e

HDR Generation Rate Limit: 2500

HDR File Compression GZIP -

fa) Configuration: Network| (3] Configuration S\gmawtt‘

Figure 3-14: Configuration — Service Activation Parameters
The IP Redirection area of the Service Activation tab includes the following parameters:

PARAMETER DEFINITION

The length of time, in seconds, that NetXplorer waits before
concluding that the service (for example, HTTP) is down.

Service Timeout

The length of time, in seconds, that NetXplorer waits

Service Period between attempts to contact the service.

The number of times NetXplorer tries to connect to the

Service Retries .
service.

The length of time, in seconds, that NetXplorer waits before

Server Timeout concluding that the server is down.

The length of time, in seconds, that NetXplorer waits

Server Period between attempts to contact the server.

The number of times NetXplorer tries to connect to the

Server Retries Server.
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The Port Redirection area of the Service Activation tab includes the following

parameters:

PARAMETER DEFINITION

Enable Port Enables the Port Redirection feature, which is configured
Redirection from the Service Activation catalog.

The Captive Portal area of the Service Activation tab includes the following
parameters:

PARAMETER DEFINITION
Encryption Allows you to enter a passphrase for encrypting
Passphrase communication with the Captive Portal.

e On request — Means that the
user is redirected to the
predefined portal when the
NE/SG sees the HTTP request.

e On reply — Means that the
NE/SG attempts to learn the
potentially asymmetric network
environment and thereafter
perfectly replicate the packet’s
encapsulation method. E.g: For
asymmetric encapsulation

Redirection environments such as MPLS,

Technique Allot recommends to use “On

reply” since the NE/SG will then

know which MPLS tag to attach
to the packet.

e Default — The recommended
option in most installations. The
NE/SG chooses by itself whether
to use “On request” or “On
reply” — It identifies per session
whether to make an effort to
learn each sessions’ two sided
encapsulations.

3-28 NetXplorer Operation Guide



Chapter 3: Configuring NetXplorer

The VolP Reports area of the Service Activation tab includes the following

parameters:

PARAMETER DEFINITION

VoIP Data Enables the VolP Minutes of Use report, see page
Collection 8-52.

The SP Sensor area of the Service Activation tab includes the following parameters:

PARAMETER DEFINITION

Enables a Core Controller blade to act as a

Embedded Sensor ServiceProtector sensor with the appropriate
license key installed. For more information,
contact Allot Customer Support..

Slots & Boards

The Slots and Boards tab is only available when configuring an Allot Service Gateway
or a NetEnforcer running AOS (Allot Operating System).

The tab displays the following information:

PARAMETER DEFINITION

Indicates graphically the Boards that are currently loaded into
the device.

Boards

Common Sensors Displays any open alarms that pertain to the entire device.

Selected Board

Displays all sensor readings that pertain to the selected board.
Sensors
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Sigmad04 x
General &Key | SNMP | Security | Interface g | IP Properiies | DatefMime | Senice Activation | StotsaBoards
Board: " Common Sensor
L ] L] L ]
min maj e
° 0
o 10t Sensor Value
» » lActive Connec... 96870 a
Active Lines 1 B
» »
EII EII lActive Pipes 4835
ActiveVCs 4836
!I !I CPU 0% Used
O » Connectionsl.. 3485
Fan oK L
Fan OK
Fan oK
Memory 0% Used
PowerSupply ~ Power Supply
PowerSupply  Power Supply
Selected Slot: 1
Boara Type: Server Registered Su... 702242 -
Board Status: Active |G R
Selected Board Sensors
Sensor Value
CPU 2% Used -
Wemory 9% Used [ |
Storage 17% Used
Temperature  31°C 3
Temperature  30°C 1
Temperature  37°C
Temperature  32°C
Temperature  36°C
Temperature  32°C a8

1ad Configuration: Network| (9] Configuration: Sigma404

Figure 3-15: Configuration — Slots and Boards — SG-Sigma
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Configuring the Network

You can configure the parameters of the SMTP server used to send reports and handle
alarm actions. In addition, secure SNMP communications can be configured to include
authentication and/or encryption.

To configure the Network:

1.

In the Navigation pane, right-click the Network in the Navigation
tree and select Configuration from the popup menu.

OR

Select the Network in the Navigation tree and then select Configuration from
the View menu.

OR

Select the Network in the Navigation tree and then click the Configuration
icon 1% on the toolbar.

Configure the Network parameters in the Network Configuration
window, as required.

Click =l or select Save from the File menu to save the changes
to the NetEnforcer or Service Gateway configuration.

Network Configuration Parameters

The parameters available in the Network Configuration window are grouped in the
following tabs:

Servers, 3-32

SNMP, page 3-33

SMP, page 3-35

SMP Domains, page 3-34
Accounting, page 3-37
Protocol Updates, page 3-38
Service Protector, page 3-39
Integrated Service, page 3-40
Net Awareness, page 3-43
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Servers

The Servers tab includes the parameters that enable the SMTP server to send reports

and handle alarm actions.

Servers ‘ SNMP | SMP I SMP Domains I NetAccuunlmgl Protocol updatssl Senice F'mtecmrl Integrated Servicsl Met | Mobile Dalal Data Menimmﬂl

SMTP Server
SMTP Server IP Address:
SMTP Server Port Address:

SMTP Server Authentication
["] Enable SMTP Server Authentication. Details Below:
SMTP User Name:

SMTP Password:

Confirm Password

Email Dispatch Address

Allowed Hosts

@ Allow All Hosts

@ Limitto the following hosts:

‘From’ Email Address for Dispatched Alarms & Reports:

Mo SMTP Server -]
2

NetXplorer@allot.com

Name P

Edit
Remove

v Configuration: Network

Figure 3-16: Network Configuration — Servers

PARAMETER

SMTP Server IP
Address and Port

The Servers tab includes the following parameters:

DEFINITION

The IP address and Port of the SMTP server that is used for
emailing alarms and reports.

Address

Enable SMTP Select this box to require the SMTP Server listed in the
Server field above to be authorized. Authorization details are
Authorization entered in the following fields.

SMTP User Name

The user name defined for the SMTP server.

SMTP Password

The password to be used for the defined SMTP username.

Confirm Password

The password to be used for the defined SMTP username.
(When assigning a password, the password is entered again
here for confirmation.)
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PARAMETER DEFINITION

‘From’ Email

Address for The Email address that will be shown as the source of any
Dispatched Alarms notifications of Alarms or Events.
& Reports

Defines those hosts that will be allowed CLI access to the
NX server. (Used for example, to define hosts for server
CLI. For more details see NetXplorer Installation and
Administration Guide Chapter 6)

Allowed Hosts

SNMP

The SNMP tab includes parameters that enable secure communications between
NetXplorer and the NetEnforcers or Service Gateways. Secure communications can be
configured to include authentication and/or encryption.

Upon saving any changes made in this SNMP panel, all NetEnforcer or Service
Gateway SNMP agents MUST have the same user name, passphrase for authentication
(if relevant), and passphrase for encryption (if relevant) as indicated in the panel. If not,
SNMP communications failure will result.

NOTE SNMP must be enabled on the individual NetEnforcer or Service
Gateways as well as on the network.

- SNWP | SWMP | SMP Domains | NetAccounting | Protocol Updates | Serice Protector | Integrated Service | Net Awareness | Mobile Data | Data Mediation |
SNMP Device Access NX Agent
SNMP v3 User Name: MD5 Community: | public
Security Level: Authentication Only, No Privacy
Trap Target
for Authentication: P Port Add..
Confirm Authentication F Edit
Passphrase for Encryption: Remove
Confirm Encryption Passphrase:
IP Target For Receipt Of SNMP Traps
@ Current Application Server
(©) Other IP Target
SNMP Timeout
SNMP Timeout (millisecs) 5000
& Configuration: Netwark

Figure 3-17: Network Configuration — SNMP
The SNMP tab includes the following parameters:
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PARAMETER DEFINITION
SNMP v3 User .
Name The user name defined for the SNMP Server.

The level of security for communications between the
NetXplorer and NetEnforcer or Service Gateways:
Authentication Only, No Privacy: Implements
authentication without requiring encryption.

No Authentication, No Privacy: Implements neither
authentication nor encryption.

Security Level

Passphrgse fOf The passphrase for authentication, entered twice for
Authentication / confirmation purposes.
Confirm

NOTE These parameters are enabled only if the

ﬁ\uther?tlcatlon selected security level includes
asspnrase authentication.
Passphrase for The passphrase for encryption, entered twice for
Encryption / confirmation purposes.
Confirm Encryption | NOTE These parameters are enabled only if the
Passphrase selected security level includes

encryption (Privacy).
IP Target for The Application Server where SNMP traps are to be sent.
Receipt of SNMP The current server can be selected or the IP address of
Traps another server can be entered.
SNMP Timeout The SNMP timeout may be entered, in milliseconds.

This field lists any NMS units that the NetXplorer will send
specific external traps to, as selected in Event Types

NX Agent Configuration (see page 7-2). To add an NMS, click the
Add button and enter the IP address and target port. These
values may be changed using the Edit button.

WARNING Upon saving any changes made in the SNMP panel, all NetEnforcer

or Service Gateway SNMP agents MUST have the same user name,
passphrase for authentication (if relevant), and passphrase for
encryption (if relevant) as indicated in the panel. If not, SNMP
communications failure will result. For information on how to set the
SNMP on the NetEnforcer or Service Gateway, contact Allot
Customer Support at support@allot.com.
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SMP

The SMP tab allows the definition of SMP IP Domains, Service Plans and Server
Parameters, for use with the Allot Subscriber Management Platform. You can also
define Session parameters and billing information from the SMP tab. For further
information see the SMP User Guide.

Network xF
Servers | SNMP | SMP | SMP Domains | MetAccounting | Protocol Updates | Service Protector | Integrated Service | Net Awareness | Mobile Data | Data Mediation
SMP Preferences -

General ‘ Palicy And Charging | Session Parameters I Billing Dnmain‘

Settings
Working Environment:  static Subscribers =
Domain Type IP Domain -

Waximum number of subscribers per SMP (Millions): |1

Default Domain N/A -
Default Senvice Plan: Default Service Plan -
IPsiSessions per Subscriber [Multiple IP/Session Per Subscriber v |

m

|| Block Unregistered Subscribers
IP TimeoutiSession

[] Enable IP Timeout IP Lease Time (sec) 43200

Enable Timeout Trap; Disable

Auto Subscribers Deletion

[] Enable Auto Deletion Subscriber Inactivity Time (hours)

i Confurstion:Network
Figure 3-18: Network Configuration - SMP tab

NOTE This feature is only available with the appropriate key.
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SMP Domains

The SMP Domains tab allows the definition of SMP IP Domains and SMP Subscriber
Domains, for use with the Allot Subscriber Management Platform. For further
information see the SMP User Guide.

Network xk
Servers | SNMP | SWP | SMP Domains | NetAccounting | Protocol Updates | Service Protector | Integrated Service | Net Awareness | Mobile Data | Data Mediation

SMP IP Domains

Domain Name Description IP Ranges/Subnets Add.
Edit

Remove

| 4 Confguration. Netwark |
Figure 3-19: Network Configuration - SMP Domains tab

NOTE This feature is only available with the appropriate key.
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NetAccounting

The NetAccounting tab has parameters for enabling and configuring NetXplorer’s
centralized accounting management system. NetAccounting collects and consolidates
data from multiple NetEnforcer or Service Gateway devices to enable users to produce
consolidated reports.

NetAccounting records contain the following information:
e Subscriber ID
e Service (i.e. HTTP, P2P, etc.)
e BytesiIn
e Bytes Out

stersl SNMPI SMPI SMPDumams‘ NetAccounting ‘ Protocol Updates I Service Prulectuvl Integrated Semvice I Net Awareness I Mobile Dmal Data Medialmnl

Operational State

"] Enabled Accounting

Mode
@ NetXplorer Accounting Mode (recommended

Legacy Accounting Made

Manager
Export Directory C:\Allottaccounting_export
Time to Keep (hours 24

Interval: Every 5 Minutes

(] Configuration: Network

Figure 3-20: Network Configuration - Accounting tab
NOTE This feature is only available with the appropriate key.

The Accounting tab includes the following parameters:

PARAMETER DEFINITION

) Enables Accounting if the correct key has been entered for
Enabled Accounting | the NetXplorer Server and the Accounting software has
been installed.
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PARAMETER DEFINITION

NetXplorer

Accounting Mode Activates the NetXplorer Accounting Mode.

Activates the NetEnforcer Accounting Mode. For more

Legacy Accounting information concerning Legacy Accounting see the
Mode appropriate NetEnforcer Hardware Guide for your
device(s).

) Defines the location of the Export Directory, where the
Export Directory processed files containing the collected Accounting
information are located.

Time to Keep The time period (in hours) that the Accounting Manager
holds the processed information (24 hour default).

Defines the time interval that the SMP accumulates the raw
Interval Accounting data before transferring it to the Accounting
Manager for processing (Every 5 minutes is the default).

Protocol Updates

The Protocol Updates tab includes parameters that select how often the Protocol
Update feature checks to see if a new Protocol Pack is available for the Service Catalog
of the NetXplorer and how those updates are handled.

Servers | SNMP | SMP | SMP Domains NetAccounting| Protocol Updates | Senice Protector | Integrated Senvice | Net Awareness | Mobile Data | Data Mediation

Protocol Pack
Protocol Pack: 3.25

Automatic Settings

Check Allot Web Site for New Updates (Periodic )

[7] Automatically Install New Updates to Netxplorer Server

i Configuration: Network ‘

Figure 3-21: Network Configuration — Protocol Updates tab
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NOTE This feature is only available with the appropriate key.

PARAMETER

DEFINITION

Protocol Pack

The Protocol Pack currently installed on the NetXplorer
Server.

Check Allot Web
Site for New
Updates (Periodic)

Defines how often the Allot Web Site is checked for new
updates.

Automatically
Install New Updates
to NetXplorer
Server

Enables NetXplorer to automatically install and new
Updates onto the Server (but not individual NetEnforcer or
Service Gateways).

Service Protector

The Service Protector tab allows a ServiceProtector unit to be defined for the Network.
Enter the IP, User Name and Password of the desired ServiceProtector.

Once a valid Service Protector has been entered in the Service protector tab, the GUI for
that device can be opened from the Tools menu by selecting Open ServiceProtector.

Network X

| sewvers | smP | siiP | sMP Domains | Netaccounting | Protocol Updates | Semvice Protector | Service | Net | Mobile Data | Data.

SenviceProtector Details:

IP:

User Name

Password

i) Configuration: Network

Figure 3-22: Network Configuration — Service Protector tab
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NOTES

NOTE

Integrated Service

The Integrated Service tab has parameters for enabling and configuring two services:
WebSafe and HTTP Monitoring. Both WebSafe and HTTP Monitoring are only
available on devices running AOS software.

WebSafe is only available with the appropriate key.

Both WebSafe and HTTP Monitoring are only available on
NetEnforcers or Service Gateways running AOS (Allot Operating

System).

WebSafe Blacklist Source Definition

Blacklist Source: IWE

Enable Download Autematic Schedule:

Enable Update Server Tracking Rate.

WebSafe User Defined Files Location

Enable Update Server Status Change SNMP Notification

Enable SNMP notification when Blacklist file update interval exceeds

Directory Path: /b 5.1.0.GA/server)

‘WebSafe Service Specific Configurations

Default Policy Action: | Policy Based

Captive Portal URL:

HTTP Moenitoring Service Specific Configurations
Default Policy Action: | Always Disabled

Action on Match: Block and send subscriber a warning page

Servers | SNMP | SMP | SMP Domains | MetAccounting | Protocol Updates | Service Protector| Integrated Service | Net Awareness | Mobile Data | Data Mediation

~  hours

< seconds

hours

) Configuration: Network

Figure 3-23: Network Configuration — Integrated Service tab

The Integrated Service tab includes the following parameters:

In order for the entire tab to be displayed, please close the Logs Pane
at the bottom of the GUI.
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PARAMETER

WebSafe Blacklist
Source Definition

DEFINITION

Manages available external sources for blacklists. Some of
these sources may require additional subscriptions.

Blacklist Sources: Select the checkboxes of
available Blacklists you wish to enable. If you have
purchased the license for a particular blacklist,
checking this blacklist source will enable your
NetXplorer to download this regularly updated list
from Allot.

Enable Download Automatic Schedule: Select the
checkbox if you wish the available blacklists to be
updated on a specific schedule. Use the drop down
menu to select how often they should be updated.

Enable Update Server Tracking Rate: Select the
checkbox to enable NetXplorer to regularly confirm
that the update server is available. Use the drop-
down menu to select how often the NetXplorer
attempts to contact the update server.

Enable Update Server Status Change SNMP
Notification: Select this checkbox to enable
NetXplorer to send a notification should the update
server be unavailable.

Enable SNMP notification when Blacklist file
update internal exceeds: Select this checkbox to
receive a notification via SNMP when the time
since the last blacklist update exceeds the value you
have set.

WebSafe User
Defined Files
Location

Defines the location of three user created files:

Black lists (operator_bl.url)
White lists (operator_wl.url)

Warning Page (warning.html) — the HTML file
displayed when a user is blocked or redirected.
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PARAMETER

WebSafe Service
Specific
Configurations

DEFINITION

Defines the behavior of WebSafe.

Default Enforcement Policy Action: Sets the
default behavior (Always Enabled, Always
Disabled, Enforcement Policy Based) of WebSafe.

Always Enabled: This service applies to all traffic
running through the NetEnforcer or Service
Gateway

Always Disabled: This service is currently not
applied to any traffic running through the
NetEnforcer or Service Gateway

Enforcement Policy Based: This service will only
be applied to Lines, Pipes or VCs for which the
service has been activated in the Enforcement
Policy

Action on Match: Defines what WebSafe does
when a URL is found on the Blacklist (Monitor
only, Block (drops the session), Block and send
subscriber a warning page, Block and redirect to a
captive portal).

Captive Portal URL.: Sets the location of the
Captive Portal. This path may include the
subscriber MSISDN
(www.captive.com/landpage?ms={
SUB_MSISDN}), an encrypted MSISDN
(www.captive.com/landpage?ms={
ENC_SUB_MSISDN} or the URI of the original
request (www.captive.com/landpage?ms={
ORIG_URI})
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PARAMETER DEFINITION
Defines the default behavior (Always Enabled, Always
Disabled, Enforcement Policy Based) of HTTP Monitoring.
e Always Enabled: This service applies to all traffic
running through the NetEnforcer or Service
Gateway
HTTP Monitoring e Always Disabled: This service is currently not
Service Specific applied to any traffic running through the
Configurations NetEnforcer or Service Gateway
e Enforcement Policy Based: This service will only be
applied to Lines, Pipes or VCs for which the service
has been activated in the Enforcement Policy.
The data collected by HTTP Monitoring can be seen in the
HTTP Report (see page 8-47)
WebSafe

If a user requests a forbidden page, WebSafe processes the request and extracts the
URL. The URL is then matched to the blacklist (which may be user defined, or
downloaded from a third party source such as the Internet Watch Forum, IWF). If the
URL is found on the blacklist AND is not on the whitelist, WebSafe performs an action
(for example, to block access to this URL and send a warning page).

The black list, white list and warning page together make up the Operation Files. If an
NX-WS-IWF license is purchased, and the IWF blacklist source is chosen from the
integrated service tab, the WebSafe Operation Files will be downloaded to the following
default directory on the NetXplorer server (which will be created the first time the files
are downloaded): \Allot\netxplorer\jboss-5.1.0.GA\server\allot\webSafe. You can
change the location from the WebSafe User Defined Files Location field in the
Integrated Service tab.

To manually update the blacklist:

1. Write a text file including the URLSs of those websites you wish to
block, following the format below
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www.badsite.com
http://otherbadsite.com
www.morebadsite.net/1/moviel.html
http://mybad.com:80/myBadDir/
http://www.badsite.com:8080

http://www.verybadsite.com:80/inde
xXs.html

*nn.com/*deo

Figure 3-24: WebSafe Blacklist/Whitelist Format

NOTE Any legal URLs are acceptable (there should be no white spaces
within paths). WebSafe considers www.badsite.com and badsite.com
to be different sites. The URL entered may be with or without the
http:// prefix. URL paths (after domain name) may include anything.
HTTPS and FTP sites are not currently supported.

“*” may be used as a wildcard at the start of a domain and/or path
only. The wildcard will match any HTTP request that has the
characters following the *in the domain or path depending on the
placement of the *. For example, the entry *nn.com/*deo above will
match cnn.com/video but not nba.com/video or cnn.com/sport. All
entries with wildcards in the Operator Blacklist, the Blacklist and the
Whitelist are limited to 50,000 characters in total.

2. Save the text file as operator_bl.url.

3. Create a new folder on the NX server (e.g:
C:\Allot\netxplorer\jboss-5.1.0.GA\server\allot\web Safe) and
enter the path to this folder in the directory path field on the
integrated service tab

4. Upload the blacklist file to the specified location

5. The NX Server then securely distributes this file to the Allot
NetEnforcer and Service Gateway units automatically.

To manually update the whitelist:

Write a text file including the URLSs of those websites you
wish to always allow, following the format in

1. Figure 3-24.
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NOTE Any legal URLs are acceptable (there should be no white spaces
within paths). WebSafe considers www.badsite.com and badsite.com
to be different sites. The URL entered may be with or without the
http:// prefix. URL paths (after domain name) may include anything.
HTTPS and FTP sites are not currently supported.

“*” may be used as a wildcard at the start of a domain or path only,
and will match any HTTP request that has the characters following
the *in the domain or path depending on the placement of the *. For
example, the entry *nn.com/*deo above will match cnn.com video but
not nba.com video or cnn.com/sport. All entries with wildcards in the
Operator Blacklist, the Blacklist and the Whitelist are limited to
50,000 characters in total.

2. Save the text file as operator_wl.url.

3. Upload the blacklist file to the location which you designated in
the directory path field on the integrated service tab

4. The NX Server then securely distributes this file to the Allot
NetEnforcer and Service Gateway units automatically.

Alternatively, if the appropriate license has been purchased, white and blacklists lists
can be updated automatically. WebSafe integrates with an external blacklist resource
(such as the IWF). The device license enables regular updates from the NetXplorer
Server and the NetXplorer then securely distributes the file to the Allot NetEnforcer or
Service Gateway units.

In addition to the automatic process which is defined in the Integrated Service tab and
determines how often black list and white list files are downloaded from an external
server (where relevant) and distributed to the NetEnforcer or Service Gateway devices,
the operator can also distribute the files manually at any fixed moment in time by
choosing Tools > Websafe > Distribute Operator Files. When working with an SG-
Sigma, the operator files will be distributed to each Core Controller blade.

The Blacklist source definition enables the operator to define an external blacklist
source, and then to determine how often to download the list and how to track the server
availability.

NOTE The operator_bl.url & operator_wl.url that you create on the
NetXplorer will appear without the “.url” suffix. Do not add the “.url”
suffix twice to the files twice.

To create a warning page:

The option to Block and send warning page refers to the warning page located on the
NetXplorer server.

1. Write an HTML file including the text you wish to appear when a
user tries to access a site on the blacklist.

NOTE Warning.html must be less than 900 bytes. Any HTML syntax may be
used (e.g: reference to scripts, images).
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2. Save the HTML file as warning.html.

3. Upload the warning page to the folder which you defined in the
directory path field on the integrated service tab (e.g:
C:\Allot\netxplorer\jboss-5.1.0.GA\server\allot\webSafe)

NOTE If you add a new warning.html file to the NetXplorer this will replace
the default Allot warning file with no option to revert to the default
warning page.

4. The NX Server then securely distributes this file to the Allot
NetEnforcer and Service Gateway units automatically.

Net Awareness

The Net Awareness tab allows SMP users to assign alternate Service Plans for when
their mobile networks indicate congestion. This feature is for users in SMP deployments
who have purchased a CellWise License. Net Awareness is only available on in-line
platforms running AOS software. For further information see the Appendix F in the
SMP User Guide.

Network xk
‘ starsl SHMP I SMP I SMP Domains I Ne!Ac:nunlmgl Protocol Updates I Senvice F'rnts:tnrl Integrated Ssrwcal Met Awareness ‘ Iobile Datal Data Mamation‘

General
Met Awareness Working Mode: | Disabled
Enable Network Unit auto learning mechanism
Metwork unit Bandwidth’s Monitoring Interval (min) 5
Measuring interval while Network unit is clear (min 5
Measuring interval while Network unitis Congested (min). |5 =
Cells definition

Upload File

Stand alone Congestion Senice Plan Definitions

Senvice Plan Congestion Service Plan

Remove

il Configuration: Network
Figure 3-25: Network Configuration — Net Awareness tab
NOTE This feature is only available with the appropriate key and on

NetEnforcers or Service Gateways running AOS (Allot Operating
System).
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Mobile Data

The Mobile Data tab allows users with a Mobile Analytics license to configure their
SGSN list as well as to enable and define data export parameters. This feature requires
the SMP and a license that enables Mobile Analytics.

e
Senvers | SNMP | SMP | SMP Domains | Netaccounting | Protocol Updates | Service Protector | Integrated Service | Net Awareness | Mobile Data | Data Mediation |
Mabile Reports
SGSN List
IP Address Description Add
Edit...
Remove
.‘);J Configuration: Network
Figure 3-26: Network Configuration — Mobile Data tab
NOTE This feature is only available with the appropriate key and on
NetEnforcers or Service Gateways running AOS (Allot Operating
System).

Data Mediation
The Data Mediation tab allows users with a Statistics Export and/or HTTP/CDR

license to enable and define data export parameters. This feature requires the SMP and a
license that enables Mobile Analytics.
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S ]
Servers | SNMP | SMP | SMP Domains | NetAccounting | Protocol Updates | Service Protector | Integrated Service | Net Awareness | Wobile Data| Data Mediation |

General | Data Definition

Output Record Structure

File Path

=DataExportConfig xminsxsi="http:/iwww.w3.0rg/2001/XMLSchema-instance” xsinoNan =
<l OutputStructure Version - should be ilncremented when structure is modified —= |
<I—The number of fields in the Outputper DataType — ‘:‘
<l Aftribute ID is global to the entire file and unique. The same ID cannot appear twic
<DataType name="HDR">
<FilteringRules defaultAction="include"/>
=QutputStructure version="4">

<Field ID="2"
=Field ID=
=Field ID=
<Field ID=
=Field ID=
=Field ID=
<Field ID=
=Field ID=
<Field ID=
<Field ID=
<Field ID="11"
<FialA IN-*47

@) Configuration: Network
Figure 3-27: Network Configuration —Data Mediation tab

NOTE This feature is only available with the appropriate key and on
NetEnforcers or Service Gateways running AOS (Allot Operating
System). For additional information see the Allot Data Mediator
Installation and Administration Guide.

Asymmetrical Traffic

NOTE Asymmetrical Traffic is only available on NetEnforcers or Service
Gateways running AOS (Allot Operating System) software.

In some network topologies the traffic flows of a single connection can take different
paths in the upstream and the downstream directions. This can lead to a situation where
one Service Gateway or NetEnforcer on the network sees one flow of the connection
while another Service Gateway or NetEnforcer that is located remotely sees the
complementary flow of the same connection. Since the DPI should inspect both flows
of the connection for maximum accuracy, this leads to a poor identification of the
applications running in the network.

Asymmetric Traffic is designed to significantly increase DPI accuracy by allowing
Service Gateway or NetEnforcer devices to share information concerning connections.
This will ensure that two different flows may be identified as part of the same
connection, even when their traffic is handled by different Service Gateways or
NetEnforcers. Ideally, using Asymmetric Traffic should provide the same percentage of
DPI accuracy with remotely located devices as is found when a single device sees both
sides of the connection.
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SG-Sigma #1

Internet
1L Server
- ] -
Asymmetric > —
Control
Traffic

Internet

i SG-Sigma #2 .
Figure 3-28: Asymmetry Network Diagram

Guidelines

Asymmetric Traffic information is synched between all NetEnforcers or Service
Gateways that belong to the same Asymmetric Device Group (ADG) which is
configured via NetXplorer. All NetEnforcers or Service Gateways in an ADG must be
assigned to the same NetXplorer installation and each NetXplorer may support up to
eight ADGs.

An ADG can include co-located devices (e.g. SG1 & SG2, SG3 & SG4) and remotely
located devices (devices in POP1 and devices in POP2). Co-located devices are
connected with intra-site asymmetric control link. This link passes control information
between the co-located devices to sync the DPI information while remotely located
devices are connected over an L2/L.3 network.

Each ADG may be configured with up to eight devices and has a group ID of 0 through
7. Each device configured to an ADG has a local 1D of 0 through 7. Therefore a Service
Gateway or NetEnforcer may have a local ID of 1 in ADG 0.

NOTE Tethering is supported in Asymmetric environments.

Asymmetric Configuration

The following steps must be taken in order to configure Asymmetric Traffic.
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To define an Asymmetric Device Group (ADG):

1. Right click on the Network in the Navigation pane and select
Asymmetry Configuration.

OR

Highlight the Network in the Navigation pane and select
Asymmetry Configuration from the View menu.

The Asymmetry Configuration dialog appears.

Asymmetry Configuration

Group Name Description
P i { pdd

Figure 3-29: Asymmetry Configuration dialog

2. Inthe Asymmetry Groups field you see any ADGs currently
configured on the NetXplorer. Select an ADG and click Edit to
alter the configuration, or add/remove devices from an existing
ADG.

3. To create a new ADG, click Add.

The Asymmetry Group — New dialog appears.
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Asymmetry Group - New @

Group Name: | asymmetry-Group1

Description:
Transport Type: Vians

Enable Health Check

Devices in Group

Number in Group Device Name Asymmetry Enabled
0 Sigma-1

1 None v

2 56-8lgma-2

3 alug:;a TR

4 None

5 None

B None

7 None

Figure 3-30: Asymmetry Group - New dialog

4. Enter a Group Name and Description in the appropriate fields.

5. Select the Enable Health Check checkbox if you wish NetXplorer
to automatically confirm the health of all devices in the ADG.

6. Select the devices to add to the group from the drop down menus.
An ADG may include up to eight devices. The Device ID will be
established based on the order you place them in inside the ADG.
For example, if the Sigma 1 selected as Number in Group 0 will
have a Device ID of 0 for the purposes of Asymmetry.

7. Select the Asymmetry Enabled checkbox for each device.

8. Click the VLans Settings button to edit the VLAN configuration.

The VLan Settings dialog appears.

L= VLans Settigns @

Asymmetry Group: Asymmetry-Group1

In order to set different values - double click on the cells.

VLans Table

j' Source  Device Name no. 0 no. 1
|0 Sigma-1 129
| 1 SG-Slgma-2 136

[ Save ] L Cancel J

Figure 3-31: VLans Settings dialog
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9. A VLAN must be set for each connection between any two devices
in the group. Each direction must have a VLAN to be used for
Asymmetric control messages (however the same number can be
used for both directions)

10. Double click in a field to enter a new VLAN number.

11. Click Save to save the information and return to the Asymmetry
Group — New dialog.

12. Click Save to save the new ADG.
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Working with Catalogs

Catalogs contain the values available when defining policies in the Enforcement Policy
Editor. For example, when selecting the Internal condition of a Pipe, Virtual Channel
or Filter, the possible values are the entries in the Host Catalog. You can add, change or
delete entries in Catalogs. Entries are comprehensive sets of parameters with logical
names. These logical names then become the possible values available in the
Enforcement Policy Editor.

A Catalog Entity, such as a specific host or Quality of Service definition, can be defined
once in the appropriate Catalog, and then used many times in the Enforcement Policy
Editor.

Catalog entries are defined for the entire system and are distributed to all devices in the
system. Any changes to the catalog are applied globally throughout the system. Host
catalog entries are the only entries that can be defined for specific devices as Private
Host entries. These Private Host entries are only distributed to that specific device.

Catalog entries can be managed only by users assigned Regular or Administrator
permissions.

NetXplorer includes the following Catalogs:

e Host Catalog: The entries in the Host Catalog are the possible
values for the Internal and External conditions defined for a Pipe,
Virtual Channel and Filter. The Internal and External define the
source and destination of the traffic. Refer to Host Catalog, page 4-
5.

e Service Catalog: The entries in the Service Catalog are the possible
values for the Service condition defined for a Pipe, Virtual Channel
and Filter. The Service represents the protocols relevant to a
connection. Refer to Service Catalog, page 4-18.

e Time Catalog: The entries in the Time Catalog are the possible
values for the Time condition defined for a Pipe, Virtual Channel
and Filter. The Time defines the applicability of a Pipe, Virtual
Channel or Filter during certain time periods. Refer to Time Catalog,
page 4-33.

e ToS Catalog: The entries in the ToS Catalog are the possible values
for the ToS condition defined for a Pipe, Virtual Channel and Filter.
The ToS is the ToS byte contained in the IP header of the packet.
ToS entries are also used in QoS Catalog entry definitions. In
addition, ToS is available as an Action in the Enforcement Policy.
Refer to Type of Service Catalog, page 4-35.
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e Encapsulation Catalog: The entries in the Encapsulation Catalog
are the possible GREs and VLAN ID and the User Priority. Refer to
Encapsulation Catalog, page 4-38.

e QoS Catalog: The entries in the QoS Catalog are the possible values
for the Quality of Service action defined for a Line, Pipe and Virtual
Channel. The Quality of Service allocates bandwidth and traffic
priority. Refer to Quality of Service Catalog, page 4-42.

e Service Activation Catalog: The entries in the Service Activation
Catalog define values for integrated services and enable you to
create service chains. They are only relevant if you have Traffic
Steering enabled. Refer to Service Activation Catalog on page 4-56.

e DoS Catalog: The entries in the DoS Catalog enable you to control
the number of connections and the rate of connections established
per Enforcement Policy. Refer to DoS Catalog, page 4-56.

e Quota Catalog: The entries in the Quota Catalog define Quota
Management parameters. These are only relevant if you have
Subscriber Management enabled. Refer to Quota Catalog on page 4-
74.

e Service Plan Catalog: The entries in the Service Plan Catalog
define Service Plans which may be assigned to individual
subscribers. These are only relevant if you have Subscriber
Management enabled. Refer to Service Plan Catalog on page 4-78.

e Interface Catalog: The entries in the Interface Catalog define
individual physical ports or groups of ports which may be assigned
to policies. Refer to Interface Catalog on page 4-89.

e Charging Application Catalog: The entries in the Charging
Application Catalog define applications and groups of applications
for the purpose of assigning them to charging plans. These are only
relevant if you have Session Management enabled. Refer to
Charging Application Catalog on page 4-92.

e Charging Plan Catalog: The entries in the Charging Plan Catalog
define Charging Plans to be used by service providers. These are
only relevant if you have Session Management enabled. Refer to
Charging Plan Catalog on page 4-94.

e Mobile Device Catalog: The Mobile Device Catalog allows you to
load and access a Mobile Device Database for use with the Mobile
Analytics Feature. This is only relevant if you have both Session
Management and Mobile Analytics enabled. Refer to Mobile Device
Catalog on page 4-96.

Each Catalog has its own editor where you can add new entries and modify existing
entries.
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Catalog Icons

The following icons are used throughout NetXplorer to represent the different types of

catalogs:

=
D
»
g

&

Service

Service Activation
Interface

Charging Plans

Accessing Catalogs

Catalogs can be accessed in the following ways:

By selecting the Catalogs tab in the Navigation pane and selecting
the required catalog from the list displayed in the Navigation pane.

Encapsulation
Quality of Service

DoS

Quota

Service Plan
Charging Apps

Mobile Device

By clicking 4P~ on the toolbar and selecting the required catalog
from the dropdown menu.

All Catalogs have some common fields and functionality, which are described in this

section. A sample Catalog is shown below:

Navigation
Pane

x
-3 Network Operation
i@ P2p
A evecesiiams
) reserts:
23 s
2 s
(&8 19 Accounes @ Policy: SGS-10.171.100| @ Catalog: Senvice
4 Marms Log K2RV
Ak | Date Tme | severty Alarm Definition | Descipion
[@c[ao[eo[ea[a0

Figure 4-1: Sample Catalog
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The Navigation pane displays a list of the current entries defined in the Catalog.
Selecting an entry in the Navigation pane displays the associated catalog entries in the
Application Details pane.

Buttons relevant to the active Catalog appear in the Quick Access Toolbar in the upper
right hand corner of the NetXplorer GUI.

4 ANQOt

communications

Figure 4-2: Quick Access Toolbar — Catalog Editor

Deleting Entries from a Catalog

You can delete unnecessary entries from a catalog.

NOTE Catalog entries that are referenced in a Enforcement Policy definition
cannot be deleted from a Catalog. In addition, certain reserved
entries also cannot be deleted.

To delete an entry from a Catalog:

1. Select and right-click the catalog entry in the Application Details
pane and select Delete from the popup menu.

OR

Select the catalog entry in the Application Details pane and then
select Delete from the Edit menu.

A confirmation message is displayed.

2. Click Yes to confirm the deletion. The entry is no longer displayed
in the Application Details pane.
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Host Catalog

The Host Catalog contains entries that are the possible values for the Internal and
External conditions of a Line, Pipe, Virtual Channel or Filter.

A Host Catalog entry’s scope can be defined for the entire system or for a specific
device.

A sample Host Catalog is shown below:

h Host x

MName | Description Scope Date Modified

= Any Global 12/30/04 12:00 AM
= Any IPv4 All 1Pv4 hosts Global 4/1012 10:01 AM
= Any IPve All 1Pv6 hosts Global 4/10M12 10:07 AM
8 Block Senvice Plan Service Plan Subscribers Host Group Global 2i28/07 12:00 AM
4 Default Service Plan Service Plan Subscribers Host Group Global 12/6/07 12:00 AM
i list1 Global 10/22112 8:07 PM
i stz Global 10/22112 9:24 PM
= London Global 10/22112 8:01 PM
¥ Unlimited Service Plan Service Plan Subscribers Host Group Global 11107 12:00 AM

Figure 4-3: Host Catalog

NOTE The Any, Any IPv4 and Any IPv6 entries are protected, meaning the
definitions for these entries cannot be modified.

Once you have defined the hosts in a host list, you can group several host lists together
in one Catalog entry called Host Group.

Defining Host Lists

A host list is a list of one or more hosts.

Hosts can be network IP addresses, IP address ranges, host names and IP subnet
addresses. Following are examples of host entries:

e Host Name: If NetXplorer is configured to support DNS, you can

use logical DNS names. Only supported on NetEnforcer AC-400 and
AC-800 units.

e |Pv4 Address: The IPv4 address of a host. For example,
172.16.1.31.
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NOTE

e IPv4 Range: A range of IPv4 addresses. For example, 10.1.2.3-
10.1.3.7 means the ranges 10.1.2.3-10.1.2.255 and 10.1.3.1-10.1.3.7.

e IPv4 Subnet: For example, 10.10.10.0 with a subnet mask of
255.255.255.0.

e MAC Address: The MAC address of a host. Only supported on
NetEnforcer AC-400 and AC-800 units.

e IPv6 Prefix: The IPv6 prefix of a host. For example,
2001:1234::/32.

e |Pv6 Prefix Range: A range of IPv6 prefixes. For example,
2001:1234::-2001:1234::/32.

It is possible to import large groups of hosts from an external text file. The user updates
this text file and the NetXplorer checks for changes every 10 minutes.

The default value of 10 minutes can be changed. Contact Allot
Customer Support to enable this change.

Types of Host Lists

There are 3 different methods for importing external text files. The user can create:
® A new external text file host list
® A new external text file host group
® A new dynamic external text file host group (IPv4 only)
The dynamic external text file host group functionality was developed to help customers

who wish regularly to use particularly large text files containing tens of thousands of
entries.

With the regular external text file host group we can only support a few thousand hosts,
but the Dynamic version enables us to support many more. Each NetXplorer can
support up to 1000 Dynamic External Host Files. Each NetEnforcer (or blade in a
Service Gateway) can support up to 750 Dynamic External Host Files.

There are however, several restrictions when using the dynamic mechanism:
® |t can only be used to support internal hosts.
e It only supports individual IPs (ranges and subnets will be ignored)
® [t only supports IPv4 entries (the other two methods support IPv4 or IPv6 entries)
® An IP may appear in only ONE Dynamic External Host File.
Note that another side effect of the dynamic system is that the IPs updated with the
Dynamic text file are deleted when the NetEnforcer or Service Gateway reboots. The
NetXplorer server will update the IPs again after approximately 10 minutes, but until

then there will be no rule matching to the pipes and VCs in the Enforcement Policy that
use those text files in their conditions.
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TYPE OF LIST OR NUMBER OF SUPPORTED TYPES OF
EXTERNAL GROUP ENTRIES IN FILE ENTRIES
TEXT FILE
External text file List Several thousand only IPv4 Address Internal
host list IPv4 Subnet External
External text file Group IPv4 Range
host group IPv4 Hostname
IPv6 Prefix
IPv6 Prefix
Range
Dyn?_rlni% external Group Up to 10,000 per file, up IPv4 Address Internal
text ile host group to 1000 files supported
per NetXplorer
(10,000,000 in total).

NOTE In addition, the following restrictions on total registered subscribers
per device apply:

SG-Sigma E6 & E14: 500-800,000 per CC-300 and 5-8,000,000
registered subscribers per SFB-300 (depending on the profile)

SG-Sigma: 500,000 per CC-200 and 2,000,000 per FB-200
AC-1400/3000: 160,000 per chassis

To define a host list:

1. Select and right-click Hosts in the Navigation pane and select
New Host List from the popup menu.

OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New Host L.ist from the popup menu.

The Host List Entry Properties dialog is displayed.
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NOTE

Host List Entry Properties M

Name: New Host List

Description:

Host item Type ] | Add..

|| Scope: |Global ] 7 Suppress distributed processing
[ save || Reset |[ cancel |

L

Figure 4-4: Host List Entry Properties — New Host List

The Suppress distributed processing checkbox should ONLY be
selected in situations where the host list is comprised of end users
all behind a single IP address, such as when a NAT is used or when
there are very few subscribers on the list. For more information,
contact Allot Customer Support.

2. Enter the name of the host entry in the Name field.

3. Click Add to add items to the Host List. The Add Host Item dialog
is displayed.

Edit Host Btem [

_
Host ltem Type: :|F"u'5 Prefix Range v:

From: 2001:bf8:0:0::/64

To: 20071 bfafif. i /64

I [ OK ][ Cancel ] |
;ﬁ

Figure 4-5: Add Host Item

4. From the Host Item Type dropdown list, select the type of item to
be included in the host list (Host Name, IPv4 Address, IPv4
Range, IPv4 Subnet, MAC Address, IPv6 Prefix or IPv6 Prefix
Range).

5. Define the additional parameters in the dialog. The parameters
change according to the selected Item Type. For example, if you
are configuring the IPv4 Address, the one additional parameter is
defined in the dialog - the IP Address; if you are configuring the
IPv6 Prefix Range, two parameters are defined — the From and To
IPv6 prefixes.

4-8
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NOTE IPv6 addresses should include the prefix length. In Figure 4-5 the
prefix length is /64.

6. Click Apply. The item is added to the Host List.
7. Click Close to return to the Host Properties dialog.

8. To set the scope of the entry to a specific device, click the Scope
browse button.

The Entry Scope Properties dialog is displayed.

Entry Scope Properties.

Entry Scope

o i Entry will be available for
© Giobat all devices

Entry usage will be limited to
selected device only

O Specific Device: |3 AllotAlpha198.203.223.2 %

Figure 4-6: Entry Scope Properties

NOTE Scope can only be disabled when defining a new host entry. After
saving a new Host Entry the scope field is inaccessible.

9. To make the entry available for all devices, select Global (the
default).

OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

10. Click OK. The Host Entry Properties dialog is redisplayed.

11. In the Host Entry Properties dialog, click Save to save the entry.

NOTE The list of entries in the Hosts List can be sorted by clicking on any
column header. For example, click Type to sort the list according to
item type.

12. To edit a Host List entry, select the entry in the Host Entry
Properties dialog and click Edit. Edit the properties in the Edit
Host Item dialog and click Save.

13. To delete a Host List entry, select the entry in the Host Entry
Properties dialog and click Remove.

To import an external host list:

1. Select and right-click Hosts in the Navigation pane and select
New External Text File Host List from the popup menu.

OR
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In the Application Details pane, right-click an entry in the Host
Catalog and select New External Text File Host List from the
popup menu.

OR

Select Hosts in the Navigation Pane select New External Text File
Host List from the Actions menu.

The External Text File Host List Entry Properties dialog is displayed.

[ —y|

External Text File Host List Entry Properties

Name: [New External Text File Host List]

Description:

File Path:

Hostitem Type

v

Scope: [NE34 ]

Figure 4-7: External Text File Host List Entry Properties

Edit the name of the group in the Name field, if required.
Enter a description of the Host Group in the appropriate field.

Enter the full file path of the external file. The file can be located
only on the local machine.

To set the scope of the entry, click the Scope browse button. The
Entry Scope Properties dialog is displayed.

To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

Click OK. The External File Host List Entry Properties dialog is
redisplayed.

In the External File Host List Entry Properties dialog, click Save to
save the entry.

4-10

NetXplorer Operation Guide



Chapter 4: Defining Catalog Entries

The file is automatically checked for any changes every five
minutes by the NetXplorer. The file will only be uploaded again
by the NetXplorer if a change is detected.

Grouping Hosts

A Host Group is a collection of previously defined Host Catalog entries of Host List
type grouped together in an additional entry. This eliminates the need to create several
similar Pipes, Virtual Channels or Conditions for hosts. For example, you can create a
group of hosts, called Division 1. Division 1 can contain three Host List catalog entries:
Department A (employees a, b and ¢), Department B (employees d, e and f) and
Department C (employees g, h and j).

Host Groups may be created from previously defined Host Catalog entries, or imported
as a text file.

To group Host Catalog entries:

1. Select and right-click Hosts in the Navigation pane and select
New Host Group from the popup menu.

OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New Host Group from the popup menu.

The Host Group Entry Properties dialog is displayed.

]
Name [New Host Group
Description:
Host Entry Mame Scope
Scope: |Glabal ]

Figure 4-8: Host Group Entry Properties
2. Edit the Name and Description fields, if required.

3. Click Add to add items to the Host List. The Add Group Items
dialog is displayed.

The Add Group Items dialog lists all available Host List catalog
entries that can be added to the host group.

4. Select one or more entries and click OK to add them to the Host
Group. The Host Group Entry Properties dialog is redisplayed.
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To set the scope of the entry to a specific device, click the Scope
browse button. The Entry Scope Properties dialog is displayed.

To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

Click OK. The Host Group Entry Properties dialog is redisplayed.

In the Host Group Entry Properties dialog, click Save to save the
entry.

To import a Host Group from an external text file:

1. Select and right-click Hosts in the Navigation pane and select

New External Text File Host Group from the popup menu.
OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New External Text File Host Group from the
popup menu.

OR

Select Hosts in the Navigation Pane select New External Text File
Host Group from the Actions menu.

The External File Host Group Entry Properties dialog is displayed.

Name

[New External Text File Host Group

Description:

File Path:

Name Host Item Type
~
¥
Scope: | 404_ITAI222 B

Save Cancel

Figure 4-9: External Text File Host Group Entry Properties
Edit the name of the list in the Name field, if required.
Enter a description of the list in the appropriate field.

Enter the full file path of the external file. The file can be located
on any machine that the NetXplorer Server can access.

To set the scope of the entry, click the Scope browse button. The
Entry Scope Properties dialog is displayed.
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To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

6. Click OK. The External Text File Host Group Entry Properties
dialog is redisplayed.

7. Inthe External Text File Host Group Entry Properties dialog,
click Save to save the entry.

The file is automatically checked every five minutes for any changes by the NetXplorer.
The file will only be uploaded again by the NetXplorer if a change is detected.

To import a Host Group from a dynamic external text file:

A Dynamic Host Group is recommended for very large Host Groups, in order to
improve system performance.

1. Select and right-click Hosts in the Navigation pane and select
New Dynamic External Text File Host Group from the popup
menu.

OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New Dynamic External Text File Host Group
from the popup menu.

OR

Select Hosts in the Navigation Pane select New Dynamic External
Text File Host Group from the Actions menu.

The External File Host Group Entry Properties dialog is displayed.

G5
Dynamic External Text File Host Group Entry Properties @
Name: [New Dynamic External Text File Host Group

Description:

File Path:

Scope: [10.50.1.101 )

Figure 4-10: Dynamic External Text File Host Group Entry
Properties

2. Edit the name of the list in the Name field, if required.

3. Enter a description of the list in the appropriate field.
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4. Enter the full file path of the dynamic external file. The file can be
located on any machine that the NetXplorer Server can access.

5. To set the scope of the entry, click the Scope browse button. The
Entry Scope Properties dialog is displayed.

To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

6. Click OK. The Dynamic External Text File Host Group Entry
Properties dialog is redisplayed.

7. Inthe Dynamic External Text File Host Group Entry Properties
dialog, click Save to save the entry.

The file is automatically checked for any changes every five minutes by the NetXplorer.
The file will only be uploaded again by the NetXplorer if a change is detected.

Creating a Host Text File

There are six types of hosts that can be created using the external data source feature:
IPv4 Address, IPv4 Subnet, IPv4 Range, IPv4 Hostname, IPv6 Address Prefix and IPv6
Address Range.

NOTE IPv4 Address is the only host type available when creating dynamic
host lists.

Create a file according to the guidelines defined below:

NOTE This method creates individual hosts with corresponding names
but they are all added to a single group. They cannot be separated.

® Delimiter: semicolon

® Text File Format:

TYPE ‘ FORMAT ‘ EXAMPLE

IPv4 address Name;IP IP1;1.1.1.1

IPv4 subnet Name;IP/Mask IP1;1.1.1.0/255.255.255.0
IPv4 range Name;IP-IP 1P2;5.5.5.5-6.6.6.6

IPv4 hostname Hostname; xxx.yyy.com host3;xxx.yyy.zzz
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IPv6_address_prefix

Name;IP\<prefix_length> Prefix_name;2001:1234::/

64

IPv6_address_range

Name;IP-1P\<prefix_length> Range name;2001:1234::-

2001:1234::/64

Creating a Host Group Text File

e Text File Format

I Hosts.txt - Notepad

IF1;1.1.1.1
IFL;1.1.1.
IFPL;1.1.1.
IPZ2;1.1.2.

5.5,

2
o
1
IPZ; 5. b

File Edit Format Yiew Help

£255.255.255.0
-6.6.6.6

Once added to the NetXplorer, the Host-Group outlined above will be created with two

Host-Lists - IP1 and IP2.

Subscriber Host Groups

To define a subscriber host group:

1. Select and right-click Hosts in the Navigation pane and select
New Subscriber Host Group from the popup menu.

OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New Subscriber Host Group from the popup

menu.

The Subscriber Host Group Entry Properties dialog is displayed.

Subscriber Host Group Entry Properties qg

Description:

Scope: ;VGIobaI

Name: New Subscriber Host Group}

Cancel

Figure 4-11: Subscriber Host Group Entry Properties

2. Edit the name of the group in the Name field, if required.

3. Enter a description of the Subscriber Host Group in the

appropriate field.
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4. To set the scope of the entry, click the Scope browse button. The
Entry Scope Properties dialog is displayed.

To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

5. Click OK. The Subscriber Host Group Entry Properties dialog is
redisplayed.

6. In the Subscriber Host Group Entry Properties dialog, click Save
to save the entry.

Country Classification

To define a country classification:

1. Select and right-click Hosts in the Navigation pane and select
New Country Classification from the popup menu.

OR

In the Application Details pane, right-click an entry in the Host
Catalog and select New Country Classification from the popup
menu.

The Country Classification Entry Properties dialog is displayed.

Country Classification Entry Properties 3]

Save Cancel

Figure 4-12: Country Classification Entry Properties
2. Edit the name of the group in the Name field, if required.

3. Enter a description of the Country Classification in the appropriate
field.
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4. Use the arrow keys to select the countries that will be included in
the new classification entry, moving countries from the Available
Countries list to the Selected Countries list.

5. To set the scope of the entry, click the Scope browse button. The
Entry Scope Properties dialog is displayed.

To make the entry available for all devices, select Global.
OR

To make the entry available to a selected device only, select Specific
Device and then select the device from the dropdown list.

6. Click OK. The Country Classification Entry Properties dialog is
redisplayed.

7. Inthe Country Classification Entry Properties dialog, click Save to
save the entry.

In order for Country Classification to operate, the NetXplorer Server must have an
active internet connection. If such a connection is not possible, use the following
procedure to enable Country Classification.

To define a country classification without an internet connection:

1. Erase all files from <Allot home folder>:\Allot\netxplorer\jboss-
4.0.2\server\allot\groups

2. Request the file IP-COUNTRY-FULL.zip from Allot Customer
Support at support@allot.com and unzip it into <Allot home
folder>:\Allot\netxplorer\jboss-4.0.2\server\allot\groups.

3. Stop & start the NetXplorer server service (Start>Control
Panel>Administrative Tools>Services).

4. Wait several minutes and then check the folder <Allot home
folder>:\Allot\netxplorer\jboss-4.0.2\server\allot\groups, and
make sure the files were extracted.

5. Re-open the NetXplorer GUI, and confirm that you can create
country classification entries. If not, contact support@allot.com.

Searching for Hosts

It is possible to search for a previously configured Host Entry.

To search for a Host Entry:

1. Select and right-click Hosts in the Navigation pane and select
Host Search from the popup menu.
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OR

In the Application Details pane, right-click an entry in the Host
Catalog and select Host Search from the popup menu.

The External File Host Group Entry Properties dialog is displayed.

g )
Host Search @
Search for
©Figsi
QIP:
D MAC
Search Results
| Matching Item Entry Reference

Figure 4-13: Host Search Dialog

A Host Entry can be searched for by Host Name, IP or MAC

address.

2. Click Search. Any results are shown in the Search Results list.

3. Click Close to close the dialog.

Service Catalog

The Service Catalog contains entries that are the possible values for the Service of a
Enforcement Policy. The Service defines the protocol of the connection passing through
a NetEnforcer or Service Gateway. The entries are applications or protocol
specifications, including network protocols, transport protocols and application

protocols.

The Service Catalog contains two types of objects: services and service groups.

Services are the protocol or application-based criteria for traffic classification. A
service can exist in only one location in the hierarchy at any given time. Depending on
the type of service, specific content entries can be defined in order to enable the
Enforcement Policy assignment and monitoring at the content level.

4-18
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Service Groups enable you to efficiently assign policies multiple services, instead of
having to define separate policies on a service-by-service basis. Service groups also
enable you to generate reports for specific groups of services. A Service Group can
contain services or additional Service Groups, but each service can appear in only one
group. You can create up to four group levels. For example, Service Group 1, might
comprise two Service Groups, A and B. The services in Service Group A could be
subdivided into another set of Service Groups, which in turn would contain services. In
addition, services can be assigned at various levels in the hierarchy.

NOTE The “Cache out” Service Group enables the user to configure a
different Enforcement Policy for MediaSwift cache out traffic (for
example: shaping P2P traffic on the internet link while enabling P2P
traffic which returns from the MediaSwift cache to pass directly to
subscribers without shaping). This capability is supported for both
internal and external MediaSwift.

Services are easily moved between Service Groups. Any content previously defined for
a service moves together with the service.

A sample Service Catalog is shown below:

& Senvice
+-(@ Cache Out
# . DB Transactions
+-3 File Systems
o (3 File Transfer
+-(3J Games
v LZ) Instant Messaging Applications
@ Mail
) .J Network Operation
+-G3 P2P Applications
o 3 Security
13 Streaming Applications
+ (@ Terminals
5-@3 volP
© 3 Web Applications
o AllIP
54 All Service
o AppleTalk
%3 Chat
o FINGER
23 GOPHER
2 IPVE
& IPX
% IPXOIP

5

& Catalog: Service

Figure 4-14: Service Catalog

From the Service Catalog, you can define the following:
e Service Groups
e Services
e Content (if supported, for the service type)
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The following icons are used to represent the different types of Service Catalogs entries:

+E} Service Group

4k Service
Content
3 HTTP UDS (Only available on devices running AOS software)

Defining a Service

Defining a Service enables you to assign policies to more than one service at a time. A
Service can contain services or additional service groups.

Applications are used to further define services. An application is a unique identifier.
For example, if HTTP is the application type and port X is configured as the standard
port for HTTP traffic, then by default the traffic on that port is classified as HTTP.
Application packet received on port Z is attributed to a different service.

Assigning applications to services enables NetXplorer to look for the best match and not
simply classify traffic according to the order of criteria in policies.

The port/service assignment can be manually configured or you can select from a
library of preconfigured entries.

To add a service:

1. Select and right-click Services in the Navigation pane and select
New Service from the popup menu.

OR

In the Application Details pane, select and right-click an entry in the
Services Catalog and select New Service from the popup menu.

OR
Select New Service from the Actions menu.

The Service Entry Properties dialog is displayed.
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Service Entry Properties i
Neme: [

Description:
Application Type: W Other TCP

Poits.
IP Protocol Identification Poits Add.

Library.

| Save Cancel |

Figure 4-15: Service Entry Properties
2. Complete the Name and Description fields, if required.

3. Select the basic application type from the Application Type
dropdown list. Other TCP is selected by Default.

4. For TCP or UDP-based protocols, manually configure the port
properties for the application by clicking Add. The Port Properties
dialog is displayed.

Ports Entry Properties 53
IP Protocol Entry Identification Method
IP Protocol: @ TCP Method: @ Default

Signature
UDP
Port Based
Ports
@ Port Number: 18
Port Range: From: 1p8
To: 168
All
ok J( Gancal |

Figure 4-16: Ports Entry Properties — New Service

5. Inthe IP Protocol area, select the relevant protocol type, TCP or
UDP.

6. Inthe Entry Identification Method area, select the method used to
identify traffic, as follows:

e Port-based: Identifies the traffic according to the destination port,
regardless of the application.

e Signature: Identifies the traffic according to the signature of origin,
regardless of the application.

e Default: Identifies the traffic by signature. If the signature is not
recognized, then the traffic is identified according to the port used,
regardless of the application.
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7. Inthe Ports area, configure the ports to be assigned to the service.
You can configure a single port by selecting Port Number and
entering the port number, or you can configure a range of
consecutive ports by selecting Port Range and entering the first
and last ports in the range in the From and To fields, respectively.

NOTE Multiple, non-consecutive ports must be configured separately.

8. The Predictive DPI field is disabled by default. For more
information contact Allot Customer Support.

9. Click OK. The Service Entry Properties dialog is redisplayed.

10. To select a publicly recognized port assignment for the
application, click Library... in Service Entry Properties dialog.
The Service Protocols Library dialog is displayed.

Narme Network Transport Port Range Description
1023TCP P TcP 1023 RESERVED A
[1cLsmcs P TcP 3091 1C1 SERVER MANAGEMENT
ICOM-AMP3 P TcP 629 3COM AMP3
3COM-NET-MGMT _|IP TcP 2301 3COM NET MANAGEMENT
3COM-NSD P TcP 1742 3COM-NSD
|3CoM-TSMUX P TcP 108 3COM-TSMUX
ICOM-WEBVIEW _|IP TcP 2339 3COM WEBVIEW
ICOMFAXRPC |IP TcP 3446 3COM FAXRPC PORT
3D-NFSD P TcP 2323 3D-NFSD
e P TcP 1538 305-LM
] 3 TcP 1511 UL ]
|3M-IMAGE-LM P TCP 1550 IMAGE STORAGE LICENSE MANAGER 3M COMP.
[4TIEROPMCLI __|IP TcP 2034 4-TIER OPM CLI
4-TIEROPMGW _|IP TcP 2933 4-TIER OPM GV
[4TALK & TcP 3284 4TALK
507TCP P TcP 59 ANY PRIVATE FILE SERVICE
6OTCP P TcP 60 UNASSIGNED
[7smop P TcP 75 ANY PRIVATE DIAL OUT SERVICE.
802-11-1APP P TcP 3817 IEEE 80211 WLANS WG IAPP
914C16 P TcP 211 11/TCP TEXAS INSTRUMENTS 814C/G TERMINAL
9PFS P TcP 564 PLAN 9 FILE SERVICE
81-B8 3 [Tcp 5603 ls1-B5 i

Figure 4-17: Service Protocol Library

11. Select an entry in the library and click Commit. The selected
entries are added to the Ports list in the Service Entry Properties
dialog.

12. Click Save in the Service Entry Properties dialog to save the
changes.

Defining a Service Group

Defining a Service Group enables you to define a Pipe or Virtual Channel so as to have
more than one service associated with it. A Service Group can contain services.

To define a service group:

1. Right-click Services in the Navigation pane and select Add
Service Group from the popup menu.

OR
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In the Application Details pane, right-click an entry in the Services
Catalog and select New Service Group from the popup menu.
OR

Select New Service Group from the Actions menu.
The Service Entry Properties dialog is displayed.
2. Edit the name of the entry in the Name field, if required.

3. Click Add to add items to the Service Entry Name List. The Add
Group Items dialog is displayed.

r

Add Group Items @
Select Entries to Add to Group:
Availahle Catalog Entries
|'<F 100BAO -~
|'<F 100GP2P
|k Abacast
|5k ALIENS
[k AP
|'sF All Service
[5F ANARCHY
|'sF Ants P2P
|'<F AppleTalk
|'sh Ares
'Sk ARP
|'<F Asherons Call B

Figure 4-18: Add Group Items

4. Select one or more services using standard Windows multiple
selection methods, and click OK. The services are added to the
Service Entry Name list in the Service Entry Properties dialog.

NOTE If you select a service that has already been assigned to another
group, itis moved to the new location together with all of its
associated content.

5. Click Save to save the new Service Group.

To remove a service from the Service Catalog:

1. Select and right-click the Service in the Service Catalog and then
select Delete from the popup menu.

OR
Select the Service and then select Delete from the Edit menu.

OR

Select the Service and then click A on the toolbar.

A confirmation dialog is displayed.
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2. Click Yes to confirm the deletion. The service is removed from
the Service Catalog.
Assigning Services to a Service Group
You can add or remove services from existing service groups.

If you add a service to a Service Group that is in use in an existing Enforcement Policy,
the Enforcement Policy is automatically updated to include the additional service.

To add a service to an existing Service Group:

1. Select and right-click the Service Group in the Service Catalog
and then select Properties from the popup menu.

OR

Select the Service Group and then select Properties from the Actions
menu.

The Service Entry Properties dialog is displayed.

2. Click Add to add additional service(s) to the Service Group. The
Add Group Items dialog is displayed.

3. Select one or more services using standard Windows multiple
selection methods, and click OK. The services are added to the
Service Entry Name list in the Service Entry Properties dialog.

NOTE If you select a service that has already been assigned to another
group, itis moved to the new location together with all of its
associated content.

4. Click Save to update the Service Group.

To remove a service from a Service Group:

1. Right-click the Service Group in the Service Catalog and then

select Properties from the popup menu.

OR

Select Service Group and then select Properties from the Actions
menu.

The Service Entry Properties dialog is displayed.

2. Select a service from the Service Entry Name list and click
Remove. The service is removed from the Service Entry Name
list in the Service Entry Properties dialog.

3. Click Save to save your changes.
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Changing the Location of a Service

You can move a service from one service group to another, or to outside groups
altogether.

To move a service:

1. Inthe Application Details pane, select and right-click the entry
you wish to move in the Services Catalog and select Move from
the popup menu.

= Move Service - Select Target @

Selectthe location to move selected entries

rod Senvice ~
(3 File Transfer [
L3 Games

~(3 Instant Messaging Applications

L3 Mail

(23 Network Operation

-3 P2P Applications 2

Cancel

Figure 4-19: Move Service Wizard — Select Source

The Move Service Wizard is displayed.

2. Select the target service or service group to which you wish to
move the service, and click Save The location of the service is
changed in the service hierarchy in the Service Catalog
accordingly.

Adding Content

NOTE

You can add or remove content from existing services, for example some file transfer
and VolP services, depending on the type of entry.

This feature is not available on In-line Platforms running AOS
software, with the exception of certain VolP protocols (RTP, SIP-
RTP and H.323-RTP) which can be classified by codec and HTTPS
which can be classified by server name.

If you add content to a service that is in use in an existing Enforcement Policy, the
Enforcement Policy is automatically updated to include the content.

To add content to service:

1. Right-click the Service root node or a Group node in the Service
Catalog and then select New Content from the popup menu.

OR
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Select the Service root node or a Group node and then select New
Content from the Actions menu.

OR
Select New Content from the Actions menu.

The Service Entry Properties dialog is displayed.

Content Entry Properties [z=]
Name:

Description:

Service: |54 100BAO v

Type Value |[ Add..

Edit
Predictive DPI: | Disabled
Save Reset Cancel

Figure 4-20: Service Entry Properties — New Content

2. Click Add to add content to the Service. The Content Properties
dialog is displayed.

3. Select the type of content from the Content Type dropdown list,
for example (relevant to the example shown), File Name or
Command.

NOTE The available content types vary according to the service type. For
example for FTP service the available content types are File Name
or Command. For HTTPS, you may enter the Server Name.

4. Select the content value from the VValue dropdown list.
OR

Click the Browse button and define the content values in the
Application Type Content Editor.

NOTE The format of the Value field varies according to the selected type
of content.
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Application Type Content Editor @
Content Type: Direction
|Upload » =
s
M

Figure 4-21: Application Type Content Editor

5. To define content values in the Application Type Content Editor,
click Add. The Content Value Properties dialog is displayed.

6. Enter the required value in the Value field and click OK. The
Application Type Content Editor is redisplayed.

7. Click OK in the Application Type Content Editor to redisplay the
Content Properties dialog. The new content value is now available
for selection from the Value dropdown list.

8. Verify that required value is selected and click OK. The Service
Entry Properties dialog is redisplayed.

9. The Predictive DPI field is disabled by default. For more
information contact Allot Customer Support.

10. Click Save in the Service Entry Properties to add the content.

To remove a content entry from the Service Catalog:

1. Right-click the Content entry in the Service Catalog and then
select Delete from the popup menu.

OR
Select the Content entry and then select Delete from the Edit menu

OR

Select the Content Entry and then click A on the toolbar.
A confirmation dialog is displayed.

2. Click Yes to confirm the deletion. The service is removed from
the Service Catalog.

Adding User Defined Signatures

You can create HTTP User Defined Signatures (UDS) that define certain HTTP or
content. Once defined a UDS is a service in its own right and is not part of another
service such as HTTP.
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NOTES This feature is only available on NetEnforcers or Service Gateways
running AOS (Allot Operating System).

Before creating a User Defined Signature the feature must be enabled
individually for each NetEnforcer from the Networking tab in the
NetEnforcer’s Configuration window. See p. 3-20 for details.

It is impossible to set priority between User Defined Signatures therefore
the UDS with the most content key matches has priority in most situations.
However, if two User Defined Signatures have the same number of
content key matches, the UDS with a content key match earlier in the
packet will have priority.

User Defined Signatures must conform to the following specifications:

e On In-line platforms running AOS versions earlier than 13.1,
UDS with content values larger than 128 characters cannot be
identified and classified.

e Upto 70 UDS content values, each with up to 320 characters,
may be configured

e A maximum of 16 different content keys may be defined per
uDS

e A maximum of 1024 different content services may be
defined per in-line platform

To create a UDS catalog entry:

1. Right-click Services in the Navigation pane and select Add HTTP
UDS from the popup menu.

OR

In the Details pane, right-click an entry in the Services Catalog and
select New HTTP UDS from the popup menu.

OR

Select New Catalog Entry > New HTTP UDS from the Actions
menu.

The Service Entry Properties dialog is displayed.
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HTTP UDS Entry Properties X

Name: Mew HTTP UDS|

Description: |

] Add

Remove

Figure 4-22: HTTP UDS Entry Properties
2. Enter a Name and Description if required.

3. Click Add to add Content Keys to the signature. Each time Add is
clicked, a new Content Key field is opened. Select the Content
Key desired from the drop down menu.
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H

TTP UDS Entry Properties

Name: |New HTTP UDS
Description: |
Content-Encoding 2 :
—-Remove
Content Key: | Content-Encoding [v. [:]
Available Values Selected Values
»
]
»
]
:Y‘

Figure 4-23: HTTP UDS Entry Properties -Add

4. Possible content keys include Content — Encoding, Content —
Length, Content — Type, Hosts, Location, Method, Referer, URL,

and User-Agent.

HEADER DESCRIPTION EXAMPLES VALUE
TYPE
Host The domain name of | www.cnn.com Free text
the server requested
WWW.ynetnews.com
NOTE Avoid adding overlapping services
to the Available Values list, such as
www.cnn .com and *cnn.com.

Method The desired action GET, CONNECT, POST Predefined
to be performed on values to
the resource select
identified by the
Request-URI
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HEADER DESCRIPTION EXAMPLES VALUE
TYPE
Referer This is the address When opening cnn.com from a google Free text
of the previous web | search the ‘“Referer” will show:
age from which a
ﬁn?( to the currently http://www.google.com/search?hl=en&g=c
requested page was nn.com&rlz=117RNTN_en <CR> <LF>
followed.
URL (URI) A Uniform When opening the Tolly Report from Free text
Resource Locator http://www.allot.com then the “URI” is:
(URL) is a Uniform | /Tolly_Report.html
Resource Identifier
(URI) that specifies
where an identified
resource is available
and the mechanism
for retrieving it
User-Agent Contains Browser e.g: Mozilla/5.0 Free text
information about _ Nt
the web-browser or Mobile handset e.g: “Nokia...
the type of mobile
handset originating
the request.
Content- The type of gzip Free text
Encoding encoding used on
the data
Content- The length of the 254 “greater
Length response body in then” or
octets (8-bit bytes) “lower
then”
Integer
Content-Type | The MIME type of | text/ntml Predefined
this content ) . values to
(Multipurpose image/gif select
Extensions)
Location An alternate location | http://edition.cnn.com Free text
for the returned data
http://www.bbc.co.uk/
NOTE Each field in a UDS may contain a maximum of 512 characters in NX13.1

and later versions. In versions earlier than NX13.1, the maximum number
of characters is 128.
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5. Each content key will have values listed in the Available Values
field. Use the arrow keys to move them back and forth from the
Selected Values field.

6. Click the Browse button next to the Content Key field to open the
Edit Content Values dialog and add custom values.

Edit Content Values X

Content Key: Content-Encoding
Add Yalue

Add...

Values

[ save |[ cancel |

Figure 4-24: Edit Content Values dialog
7. Click Remove to delete a selected Content Key.

8. Click Save to save the any changes to the Content Key and return
to the HTTP UDS Entry Properties dialog.

9. Click Save in the Service Entry Properties to add the content.

NOTE If you use an IPv6 address as the url for a UDS, note that browsers
are adding [ before the IP and ] after it. Since the Host field has
brackets in it, it's not identified as you wished.

Using brackets is part of the available syntax that UDS offers.
Brackets stand for ranges. For example, "[0-9]" means any character
between 0 to 9.

The HTTP header contains the IP address in brackets for (for
example: " Host: [2006:0:0:1::AAAA:1] "). Therefore, in order to
express the brackets as brackets, please express it with the hex
notation.in that case you should define the Host field value as
follows: \x5B2006:0:0:1::AAAA:1\x5D
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Wildcards

The following characters may be used as wildcards when entering Content Keys:

Any “Free text” defined in any of the keys will match the
relevant header if it starts with the same string (“abc” will
match any header starting with “abc”)

An asterisk “*”” may be added only to the beginning of a string
to indicate that the string may be any place in the header and
not only in the beginning ( “*abc” will match any header with
“abc” in it). Adding an asterisk at the end of a string, for
example, abc*, will NOT find all strings beginning with abc,
however.

“N\?” may be added to the string to match a single character
(“ab\\?¢” will match any header starting with “ab” which then
has a single character followed by the character “c”)

Time Catalog

The Time Catalog contains entries that are the possible values for the time condition of
a Pipe or Virtual Channel.

NOTE

The Anytime entry is Protected, meaning the definitions for this entry
cannot be modified.

Time periods can have ranges of hours and minutes in which they are active, or they can
be active during whole days. An entry in the Time Catalog has one or several time
periods when policies assigned this entry are active.

To define a time period:

1. Select and right-click Time in the Navigation pane and select New
Time from the popup menu.

OR

In the Application Details pane, right-click an entry in the Time
Catalog and select New Time from the popup menu.

The Time Entry Properties dialog is displayed.
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X

Time Entry Properties

Name: | RETSIE

| Defined Time Items ‘ m
.

‘ Cancel

Figure 4-25: Time Entry Properties
2. Edit the name of the entry in the Name field, if required.
3. Click Add. The Add Time Item dialog is displayed.

Add Time Item 3

Frequency When

O Daii O Al Day

@ Weekly @ From [08:00 AM % | Through [05:00 PM % | Coverage
O Monthly Recurrence

Annuall - =
O Y Every Monday 2

Figure 4-26: Add Time Item

4. Inthe Frequency area, select the frequency of the time period. The
options are as follows:

Daily A period of time that occurs on a daily basis.

Weekly A period of time that occurs on a weekly basis. For example,
Monday from 8:00 to 17:00.

Monthly A period of time that occurs on a monthly basis. For example, the
15™ day of the month.

Annually A period of time that occurs on an annual basis. For example,
January 1% may be defined as a yearly event.

The parameters in the When area vary according to frequency.

Select the time span according to the frequency selected in the

previous step, as follows:

If you set the frequency to Daily, select from the following options:
All day Sets the time period as active for the whole day.

From — Through Enables you to select the exact time that the period will
begin, and the exact time that it will end.
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If you set the frequency to Weekly, select the day of the week for
the time period from the dropdown list in the Day of Week field
and the time span from the dropdown list in the When field, as
described in step 5.

If you set the frequency to Monthly, select the day of the month
for the time period from the Day of Month field and the time span
from the dropdown list in the When field, as described in step 5.

If you set the frequency to Annually, select the month for the time
period from the dropdown list in the Month field, select the day
of the month from the Day of Month field, and the time span
from the dropdown list in the When field, as described in step 5.

5. Click OK. The specified time period is displayed in the Time
Entry Properties dialog.

6. Repeat steps 3 through 9 to add additional time periods as
required.

7. Inthe Time Properties Entry, click Save to save the entry.

NOTE You can edit or delete the time periods using the Edit and Remove
buttons in the Time Entry Properties dialog.

TIP Adding a new Enforcement Policy with time-dependent traffic
classification is effective only on new connection attempts. Any
existing connection that may fall under that Enforcement Policy
continues to pass under its original Enforcement Policy. If a Reject
or Drop action is specified, these actions are applied only to new
connection attempts.

NOTE A discrete time range cannot be created. For example, March 15,
2001 from 2:00 PM through 5:00 PM cannot be created. However, it
can be approximated by Yearly, March 15, 2:00 PM through 5:00 PM.

ToS (Type of Service) Catalog

The ToS Catalog contains entries that are the possible values for the ToS condition of a
Pipe, Virtual Channel or Filter. A sample ToS Catalog is shown below:
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NOTE

Figure 4-27: Sample ToS Catalog

All of the entries in Figure 4-27 are predefined public domain ToS
definitions and are protected, meaning that they cannot be modified.

The ToS is a byte in the IP header of a packet that contains information about routing
recommendations. The NetEnforcer or Service Gateway classifies traffic based on the
ToS byte marking contained in the IP headers of the packets passing through it.
Differentiated Services standard, for example, defines ToS byte marking for traffic
classification. Using Differentiated Services, the ToS header can have three major
traffic classes: Expedited, Assured Forwarding and Best Effort. Assured Forwarding
includes a priority class and drop precedence level (making a total of 12 combinations).
All of these ToS byte markings are predefined in the ToS Catalog.

Further information regarding ToS standards can be found at
www.ietf.org/rfc/rfc2475.txt.

NetXplorer also supports ToS classification by User Defined ToS Entry, which can be
used to classify traffic marked per Cisco Precedence Bits method.

In the ToS Catalog, you can view the properties of predefined entries and create entries
that classify the ToS byte using User Defined ToS Entry.

To view predefined entries:

1. Inthe ToS Catalog, select a predefined entry and then select
Properties from the Actions menu.

OR

In the Application Details pane, right-click a predefined entry in the
ToS catalog and select Properties from the popup menu.
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ToS Entry Properties

MName: | Assured-2-High

Selected ToS Byte Bit Settings:
O 00O

Decimal: 88 2| Hex
Figure 4-28:ToS Catalog — Predefined Entry Properties

NOTE Predefined public domain ToS entries cannot be modified.

User Defined ToS Entry

TosS classification using free format enables you to classify traffic marked according to
the Cisco Precedence Bits method.

To define a ToS using User Defined ToS Entry:

1. Select and right-click ToS in the Navigation pane and select New
ToS from the popup menu.

OR

In the Application Details pane, right-click an entry in the ToS
Catalog and select New ToS from the popup menu.

The ToS Entry Properties dialog is displayed.

ToS Entry Properties @

Name: | (ENARE

Selected ToS Byte Bit Settings:

8 7 6 5 4 3 2 1
slisjis)is]is]is)is)jis

1} 1} 0 0 0 0 0 0
Decimal: | 0% Hex 0zl

;

Figure 4-29: ToS Entry Properties
2. Edit the name of the entry in the Name field, if required.

3. Define the ToS by inserting bit values in one of the following
ways:

e Click the bit value field boxes (zero is indicated as gray and black as
one); the decimal equivalent is displayed in the Selected ToS Byte
Bit Settings area.
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e Enter the decimal or hexadecimal representation of the bit in the Dec
or Hex fields, respectively.

4. Click Save. The new entry is saved in the ToS Catalog.

Encapsulation Catalog

The Encapsulation catalog contains GRE and VLAN entities defined in the IEEE 802.1
Standard.

Defining VLANSs

NetEnforcer or Service Gateway supports VLAN traffic classification according to
VLAN ID (VLAN Identifier) tags, consisting of 12 bits, and according to tagging
priority bits, consisting of three bits. These definitions are set in the VLAN Catalog, as

shown below:

According to the policies you define, NetXplorer assigns each packet a mapping priority
and QoS definition.
The VLAN definition value is comprised as follows:

e Bits 1 - 12 specify the VLAN ID.

e Bit 13 is the reserved bit.

e Bits 14 — 16 specify the user priority (where 7 is highest priority, and

1 is lowest priority).

User can Create/Edit:

e Catalog that contains only User Priority without VLAN ID by
checking the Any VLAN ID check box.

e Catalog that contains only VLAN ID without User Priority by
checking the User Priority check box.

e Catalog that doesn’t contain VLAN ID or User Priority by checking
both boxes. (This is useful if user wants to edit the VLAN catalog
from the Enforcement Policy Editor to work with/without VLAN).

To create a VLAN Catalog entry:

1. Select and right-click Encapsulation in the Navigation pane and
select New VLAN from the popup menu.

OR
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In the Application Details pane, right-click an entry in the
Encapsulation Catalog and select New VLAN from the popup menu.

OR

Select Encapsulation in the Navigation pane when Catalogs are
displayed and select New VLAN from the Actions menu.

The VLAN Entry Properties dialog is displayed.

x|
lame: [New VLAN]
Descripti
Priotit VLAN ID:
16 15 14 12 unfwlalafz|efls]4]3 1
o|jojo gjgjojojgjoiojgjojojo|o
0 0 0 0 0 0 0
] Any Priority
[ Any VLAN 1D
Save

Figure 4-30: VLAN Entry Properties dialog
2. Complete the Name and Description fields, if required.

3. Confirm that the User Priority and/or Any VLAN ID checkboxes
are clear (default) to insert new bit values.

4. Insert bit values in one of the following ways:

e Insert a decimal value in the User Priority and/or VLAN ID
fields; the binary equivalent is displayed in the bit value
fields.

e Click the bit value field boxes (zero is indicated as gray and
black as one); the decimal equivalent is displayed in the User
Priority and VLAN ID fields.

5. Click Save. The new entry is saved in the Encapsulation Catalog.

Defining GREs

To create a GRE Catalog entry:

1. Select and right-click Encapsulation in the Navigation pane and
select New GRE from the popup menu.

OR

In the Application Details pane, right-click an entry in the
Encapsulation Catalog and select New GRE from the popup menu.
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OR

Select and Encapsulation in the Navigation pane and select New
GRE from the Actions menu.

The GRE Entry Properties dialog is displayed.

GRE Entry Properties =

Name: [New GRE

Description:

Internal IP: @ Any IP
IP Address:
External IP: @ AnyIP

IP Address:

Reset Cancel

Figure 4-31: GRE Entry Properties dialog
2. Complete the Name and Description fields, if required.

3. Define an Internal (source) IP for the GRE by selecting the
relevant radio button. You may select Any IP (which will include
GRE tunnels originating from all internal 1Ps) or enter a specific
IP.

4. Define an External (destination) IP for the GRE by selecting the
relevant radio button. You may select Any IP (which will include
GRE tunnels going to all external IPs) or enter a specific IP.

5. Click Save. The new entry is saved in the Encapsulation Catalog.

Defining Encapsulation Groups

To create an Encapsulation Group Catalog entry:

1. Select and right-click Encapsulation in the Navigation pane and
select New Encapsulation Group from the popup menu. Define
if you wish a New VLAN Group or a New GRE Group.

OR

In the Application Details pane, right-click an entry in the
Encapsulation Catalog and select New Encapsulation Group from
the popup menu. Define if you wish a New VLAN Group or a New
GRE Group.
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OR

Select Encapsulation in the Navigation pane and New
Encapsulation Group from the Actions menu. Define if you wish a
New VLAN Group or a New GRE Group.

Either the GRE Group Entry Properties or the VLAN Group Entry
Properties dialog is displayed.

Gre Group Entry Properties X

Name: New Gre Group)

Description:

Available Selected

GRE1
GRE 2

Reset Cancel

Figure 4-32: GRE Entry Properties dialog
2. Complete the Name and Description fields, if required.

3. Select GREs or VLANS in the Available list and use the arrow
keys to move them into the Selected list.

4. Click Save. The new Group entry is saved in the Encapsulation
Catalog.
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Quality of Service Catalog

The QoS Catalog contains entries that are the possible values for the Quality of Service
action. This is the QoS applied to traffic when it meets the definitions of a Enforcement
Policy. A list of the default QoS Catalogs is shown below:

Quality of Service

Name | Date Modified
W lgnore QoS 12/30/04 12:00 AM
f Line speed 113105 12:00 AM
W Normal Priotity - Pipe 12/30/04 12:00 AM
€ Normal Priority - Virtual Channel 12130/04 12:00 AM

W Catalog Quality of Service

Figure 4-33: Default QoS Catalog

NOTE The Ignore QoS, Line speed, Normal Priority — Pipe and Normal
Priority - Virtual Channel entries are protected, meaning the
definitions for these entries cannot be modified.

The QoS Catalog enables you to define QoS for a Line, Pipe or Virtual Channel. Six
different types of QoS Catalogs can be defined:

e Line QoS
e Pipe QoS
e Virtual Channel QoS
e Line Enhanced QoS
e Pipe Enhanced QoS
e Virtual Channel Enhanced QoS
If you are building a Enforcement Policy on a NetEnforcer or Service Gateway product

running AOS software (e.g: SG-Sigma or AC-10000 series) then you should use only
Enhanced Line, Enhanced Pipe and Enhanced Virtual Channel Catalogs.
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If you are building a Enforcement Policy on a NetEnforcer or Service Gateway that
does NOT run AOS software (e.g: AC-800 or SG-Omega series) then you should use
only Line, Pipe or Virtual Channel QoS.

In the Quality of Service Catalog, there is a pre-defined entry called Ignore QoS that
you cannot delete or create additional entries that ignore QoS.

You can give the same QoS definitions to both directions of traffic, or define QoS
parameters for both directions independently.

TIP A priority definition implies a relative bandwidth allocation
relationship to other defined priorities. It does not indicate absolute
bandwidth allocations. If you require absolute bandwidth allocation,
refer to the descriptions of the minimum, maximum and guaranteed
bandwidth fields.

Ignoring Quality of Service

The inbound and outbound traffic bypasses NetEnforcer or Service Gateway's QoS
mechanism if the Ignore QoS option is selected, thereby potentially saving physical
bandwidth for other traffic. However, using Ignore QoS in a Enforcement Policy
definition leads to an attempt to satisfy any bandwidth request. This may adversely
affect other bandwidth definitions.

TIP: This option is normally used in networks where internal traffic stays
within the LAN domain, for example, when DMZ-bound traffic stays
local and is not destined to go on the physical WAN bandwidth.

To view the Ignore QoS entry:

e Inthe Application Details pane, right-click Ignore QoS in the QoS
Catalog and select Properties from the popup menu. A warning is
displayed in the Definition pane of the QoS Catalog.

Defining QoS for Lines

Entries in the QoS Catalog that are defined for Lines are available when assigning QoS
to Lines in the Enforcement Policy Editor.

To define QoS for a Line:

NOTE If your NetEnforcers or Service Gateways are running AOS (Allot
Operating System), you should not use Line QoS Catalogs. Instead,
use Enhanced QoS Line Catalogs.

1. Select and right-click QoS in the Navigation pane and select New
Line QoS from the popup menu.

OR
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In the Application Details pane, right-click an entry in the QoS
Catalog and select New Line QoS from the popup menu.

The Line QoS Entry Properties dialog is displayed.

Line QoS Entry Properties

Name:

Description:

@ Priority (2 Lowest. 10 Highest)

Minimum Bandwidth (Kbps)

— Maximum
Maximum Bandwidth (Kbps) M siowea

If Minimum Line Bandwidth not Allocated: | Admit by Priority v

Figure 4-34: New Line QoS Entry Properties
2. Edit the name and description of the entry, if required.

3. From the Line-based QoS Coverage dropdown list select one of
the three options:

e Inbound and Outbound Defined the Same: Define QoS for both
the inbound and outbound traffic together. This option is normally
used in a symmetric environment where inbound and outbound
traffic requirements are identical.

e Each Direction Defined Separately: Define QoS for the inbound
and outbound traffic individually (instead of the General tab, the
Inbound tab and the Outbound tab appear).

e Half Duplex Line: Define QoS for a half-duplex Line.

4. Inthe Inbound and Outbound area, define the Quality of Service
as follows:

e Select Low Priority Traffic (Priority 1) or complete the Priority
field by selecting a priority between 2 and 10 (highest).

e (Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Pipe. As long as
there is traffic requiring bandwidth in this channel, the bandwidth
allocated will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority, should
there be competition for the bandwidth.

e (Optional) In the Maximum Bandwidth (Kbits/sec) field, enter the
maximum bandwidth assigned to the entire Pipe. The total
bandwidth of all traffic allocated in this Pipe will not exceed this
limit. The Maximum checkbox must be open in order to set this
value.
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e Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:

e Admit by Priority: Accept the new connection, but do not assign the
minimum bandwidth. The new connection gets bandwidth per priority.

o Reject: All packets are dropped. In TCP, an RST packet is sent to the
client and the user may see the message Connection Closed by Server.

o Drop: All packets are dropped. The user is disconnected and may see
the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKS).

5. Click Save The new entry is saved in the QoS Catalog.

To define Enhanced QoS for a Line:

NOTE Enhanced QoS should only be used for creating a Enforcement
Policy for NetEnforcers or Service Gateways running AOS (Allot
Operating System).

1. Select and right-click QoS in the Navigation pane and select New
Line Enhanced QoS from the popup menu.

OR

In the Application Details pane, right-click an entry in the QoS
Catalog and select New Line Enhanced QoS from the popup menu.

The Line Enhanced QoS Entry Properties dialog is displayed.

Line Enhanced QoS Entry Properties ==

Name: ew Line Enhanced QoS (3)

Description:

Line Based QoS Coverage: Inbound and Outbound Defined the Same -
Inbound and Outbound

Minimum Bandwidth (Kbps):
Maximum Bandwidth: @ Maximum Allowed

in Kops:

o Priority (Best Effort)

Priority (1 Lowest, 4 Highest) AR

If Minimum Line Bandwidth not Allocated: | Admit by Priority v

Save Reset | Cancel

Figure 4-35: Line Enhanced QoS Entry Properties
2. Edit the name and description of the entry, if required.

3. From the Line-based QoS Coverage dropdown list select one of
the options:
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e Inbound and Outbound Defined the Same: Define QoS for both
the inbound and outbound traffic together. This option is hormally
used in a symmetric environment where inbound and outbound
traffic requirements are identical.

e Each Direction Defined Separately: Define QoS for the inbound
and outbound traffic individually (instead of the General tab, the
Inbound tab and the Outbound tab appear).

4. In the Inbound and Outbound area, define the Quality of Service
as follows:

e  (Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Line. As long as
there is traffic requiring bandwidth in this channel, the bandwidth
allocated will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority, should
there be competition for the bandwidth.

e (Optional) In the Maximum Bandwidth field, you may opt to assign
this Line the maximum Bandwidth allowed, to enter the maximum
bandwidth that will be assigned to the Line in Kbits/sec, or to enter a
percentage of all the Bandwidth going through the NetEnforcer or
Service Gateway to assign to the Line. The total bandwidth of all
traffic allocated in this Line will not exceed this limit.

NOTE The ability to define the maximum bandwidth by percentage is
disabled and will not appear in the GUI by default. To enable this
feature contact Allot Customer Support at support@allot.com.

WARNING In order for the maximum bandwidth by percentage entry to operate
correctly on aline, there must some traffic running in at least one of
the lines for which bandwidth by percentage is NOT defined. If no
traffic is running on any of the other lines, the mechanism will not
work. In order to avoid this situation, Allot recommends to assign a
minimum QoS catalog entry together with the maximum percentage
entry (on the same line).

e Select Priority (Best Effort) or complete the Priority field by
selecting a priority between 1 and 4 (highest). If all objects in the
same Enforcement Policy level are set to Best Effort there will be
no prioritization between objects. The more traffic an object
requires, the more bandwidth that will be allocated to it, subject to
the amount of free bandwidth available.

NOTE Allot does not recommend using Priority (Best Effort) if other
elements have Priorities 1 to 4 assigned. In such situations an
element which has been assigned Priority (Best Effort) may receive a
very low percentage of the available bandwidth.

e Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:
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e Admit by Priority: Accept the new connection, but do not assign the
minimum bandwidth. The new connection gets bandwidth per priority.

o Drop: All packets are dropped. The user is disconnected and may see
the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKs).

5. Click Save The new entry is saved in the QoS Catalog.

Defining QoS for Pipes

Entries in the QoS Catalog that are defined for Pipes are available when assigning QoS
to Pipes in the Enforcement Policy Editor.

To define QoS for Pipes:

NOTE If your NetEnforcers or Service Gateways are running AOS (Allot
Operating System), you should not use Pipe QoS Catalogs. Instead,
use Enhanced QoS Pipe Catalogs.

1. Right click and then select New Pipe QoS from the popup menu.
The Quality of Service Entry Properties dialog is displayed.

Pipe QoS Entry Properties X
Nam:

Description:

Minimum Bandwidth (Kbps)

Maximum Bandwidth (Kbps) Elmf;r\;m

[ Minimum Bandwidth Reserved on Use

If Minimum Pipe Bandwidth not Allocated: | Admit by Priority ¥

Figure 4-36: Defining QoS for Pipes

2. Edit the name and description of the entry, if required.

3. From the Pipe-based QoS Coverage dropdown list select one of
the following options:

e Both Directions Defined the Same: Define QoS for both the
inbound and outbound traffic together. This option is normally used
in a symmetric environment where inbound and outbound traffic
requirements are identical. Continue with step 4 below.

e Each Direction Defined Separately: Define QoS for the inbound
and outbound traffic individually. Continue with step 4 below.

e Half Duplex Pipe: Define QoS for a half-duplex Pipe.
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4,

In the Inbound and Outbound area, define the Quality of Service
as follows:

Select Low Priority Traffic (Priority 1) or complete the Priority
field by selecting a priority between 2 and 10 (highest).

(Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Pipe. As long as
there is traffic requiring bandwidth in this channel, the bandwidth
allocated will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority, should
there be competition for the bandwidth.

(Optional) In the Maximum Bandwidth (Kbits/sec) field, enter the
maximum bandwidth assigned to the entire Pipe. The total
bandwidth of all traffic allocated in this Pipe will not exceed this
limit. The Maximum checkbox must be open in order to set this
value.

Select the Minimum Bandwidth Reserved on Use checkbox to
reserve the full minimum amount of bandwidth for any future traffic
in the Pipe, even when the full minimum bandwidth is not currently
required. The actual reservation occurs when the first connection is
established within a Pipe.

NOTE To specify a guaranteed bandwidth for a Pipe, specify the same
minimum and maximum bandwidth, for example, 100Kbps.

5.

For a Half-Duplex Pipe, define the Quality of Service as follows:

In the Priority field, select a priority between 1 (lowest) and 10
(highest).

In the Available Bandwidth (Kbits/sec) field, enter the bandwidth
assigned to the entire Pipe. The total bandwidth of all traffic
allocated in this Pipe will not exceed this limit.

Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:

Admit by Priority: Accept the new connection, but do not assign
the minimum bandwidth. The new connection gets bandwidth per
priority.

Reject: All packets are dropped. In TCP, an RST packet is sent to
the client and the user may see the message Connection Closed by
Server.

Drop: All packets are dropped. The user is disconnected and may
see the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKSs).
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7. Click Save. The new entry (entries) is saved in the QoS Catalog.

To define Enhanced QoS for Pipes:

NOTE Enhanced QoS should only be used for creating a Enforcement
Policy for NetEnforcers or Service Gateways running AOS (Allot

Operating System).
1. Select and right-click QoS in the Navigation pane and select New

4,

Pipe Enhanced QoS from the popup menu.

OR
In the Application Details pane, right-click an entry in the QoS

Catalog and select New Pipe Enhanced QoS from the popup menu.

The Pipe Enhanced QoS Entry Properties dialog is displayed.

Pipe Enhanced QoS Entry Properties =

Name: ew Pipe Enhanced QoS

Description:

Pipe Based QoS Coverage Inbound and Outbound Defined the Same -

Inbound and Outbound
Minimum Bandwidth (Kbps):

Maximum Bandwidth: @ Maximum Allowed

in Kbps:

@ Priority (Best Effort)

_) Priority (1 Lowest, 4 Highest) -

If Minimum Pipe Bandwidth not Allocated: | Admit by Priority «

Reset Cancel

Figure 4-37: Pipe Enhanced QoS Entry Properties
Edit the name and description of the entry, if required.

From the Pipe-based QoS Coverage dropdown list select one of
the following options:

Both Directions Defined the Same: Define QoS for both the
inbound and outbound traffic together. This option is normally used
in a symmetric environment where inbound and outbound traffic
requirements are identical. Continue with step 4 below.

Each Direction Defined Separately: Define QoS for the inbound
and outbound traffic individually. Continue with step 4 below.

In the Inbound and Outbound area, define the Quality of Service
as follows:
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e (Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Pipe. As long as
there is traffic requiring bandwidth in this channel, the bandwidth
allocated will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority, should
there be competition for the bandwidth.

e (Optional) In the Maximum Bandwidth field, you may opt to assign
this Pipe the maximum Bandwidth allowed, to enter the maximum
bandwidth that will be assigned to the Pipe in Kbits/sec, or to enter a
percentage of all the Bandwidth going through the Line to assign to
the Pipe. The total bandwidth of all traffic allocated in this Pipe will
not exceed this limit.

NOTE The ability to define the maximum bandwidth by percentage is
disabled and will not appear in the GUI by default. To enable this
feature contact Allot Customer Support at support@allot.com.

WARNING In order for the maximum bandwidth by percentage entry to operate
correctly on aline, there must some traffic running in at least one of
the pipes for which bandwidth by percentage is NOT defined. If no
traffic is running on any of the other pipes, the mechanism will not
work. In order to avoid this situation, Allot recommends to assigh a
minimum QoS catalog entry together with the maximum percentage
entry (on the same pipe).

e Select Priority (Best Effort) or complete the Priority field by
selecting a priority between 1 and 4 (highest). If all objects in the
same Enforcement Policy level are set to Best Effort there will be
no prioritization between objects. The more traffic an object
requires, the more bandwidth that will be allocated to it subject to the
amount of free bandwidth available.

NOTE Allot does not recommend using Priority (Best Effort) if other
elements have Priorities 1 to 4 assigned. In such situations an
element which has been assigned Priority (Best Effort) may receive a
very low percentage of the available bandwidth.

5. Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:

e Admit by Priority: Accept the new connection, but do not assign
the minimum bandwidth. The new connection gets bandwidth per
priority.

e Drop: All packets are dropped. The user is disconnected and may
see the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKS).

6. Click Save. The new entry (entries) is saved in the QoS Catalog.
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Defining QoS for Virtual Channels

Entries in the QoS Catalog that are defined for Virtual Channels are available when
assigning QoS to Virtual Channels in the Enforcement Policy Editor.

To define QoS for Virtual Channels:

NOTE If your NetEnforcers or Service Gateways are running AOS (Allot
Operating System), you should not use Virtual Channel QoS
Catalogs. Instead, use Enhanced QoS Virtual Channel Catalogs.

1. Select and right-click QoS in the Navigation pane and select New
Virtual Channel QoS from the popup menu.

OR

In the Application Details pane, right-click an entry in the QoS
Catalog and select New Virtual Channel QoS from the popup menu.

The Quality of Service Entry Properties dialog is displayed.

Virtual Channel QoS Entry Properties X
Name New Virtual Channel Qos|
Description
Virtual Channsl Bassd QoS Coverags: |Inbound and Outbound Defined the Sams v
Inbound and Outbound
Low Priority Traffc (P2P - Priority 1)
@© Priority {2 Lowest, 10 Highest) 43
Minimum Bandwidth (Kbps):
Maximum Bandwidth (Kops) (2 il
Alowed
Connections Allocations
Minimum Bandwidth (Kbps)
@®Burst  Maximum Bandwidth (Kbps) ":?JL:‘:‘;"‘
Burst Sizs (Kbps)
Guaranteed Bandwidth (Kbps)
O CBR:
Delay (Micrasecs)
if Minimum Virtual Channel Bandwidih not Allacated: [Admit by Priarity v

Figure 4-38: Virtual Channel QoS Entry Properties
2. Edit the name of the entry, if required.

3. From the Virtual Channel-based QoS Coverage dropdown list,
select whether you want to define QoS for inbound and outbound
together or separately. If you select Both Directions Defined the
Same, you define QoS for both the inbound and outbound traffic.
If you select Each Direction Defined Separately, you define
QoS for the inbound and outbound traffic individually.

TIP The Both Directions Defined the Same option is normally used in a
symmetric environment where inbound and outbound traffic
requirements are identical.
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NOTE

TIP

4,

In the Inbound and Outbound area, define the Quality of Service
as follows:

Select Low Priority Traffic (Priority 1) or complete the Priority
field by selecting a priority between 2 and 10 (highest).

(Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Virtual Channel. As
long as there is traffic requiring bandwidth in this channel, the
bandwidth will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority.

(Optional) In the Maximum Bandwidth (Kbits/sec) field, confirm
that the Maximum checkbox is clear and enter the maximum
bandwidth assigned to the entire Virtual Channel. The total
bandwidth of all traffic in this channel will not exceed this limit.

To specify a guaranteed bandwidth for a Virtual Channel, specify
the same Minimum and Maximum bandwidth, for example, 100Kbps.

When working with traffic that consists of very short connections
(one or two packets per connection), it is recommended to specify a
minimum bandwidth (such as 50Kbps) per Virtual Channel, rather
than specifying a priority (such as 6). This is because using
minimum bandwidth per Virtual Channel results in a more effective
QoS Enforcement Policy.

5.

In the Connections Allocations area, select either the Burst or
CBR (Constant Bit Rate) radio button to define how the traffic
will be shaped.

If you selected Burst in step 5, enter the following connection-
based information in the Connections Allocations area:

(Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
bandwidth that will be assigned to the connection. As long as there is
traffic requiring bandwidth in this connection, the bandwidth will
never be lower than this limit. Getting bandwidth above the
minimum, however, depends on the virtual channel priority.

(Optional) In the Maximum Bandwidth (Kbits/sec) field, confirm
that the Maximum checkbox is clear and enter the maximum
bandwidth assigned to the entire connection. The total bandwidth of
all traffic in this channel will not exceed this limit.

(Optional) In the Burst Size (Kbits/sec) field, enter the Burst size
for the connection. The Burst size setting allows the traffic to exceed
the maximum allotted bandwidth (to burst) for a certain fraction of a
second, as long as the traffic does not exceed the maximum during
the whole period of one second. For example, if you enter a Burst
size of 150Kbps and a maximum of 100Kbps, NetXplorer will allow
traffic to be 150Kbps for a fraction of a second, as long as the traffic
does not exceed the maximum of 100Kbps.
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TIP The Burst Size parameter is useful in environments such as satellite
communications, where bandwidth is an expensive resource that must
be utilized efficiently.

7. If you selected CBR in step 5, configure the following parameters
in the Connections Allocations area:

e The CBR (Constant Bit Rate) setting provides the ability to
smooth traffic. Traffic exits the NetEnforcer or Service Gateway at
a constant rate defined in the CBR, as long as the traffic entering
The NetEnforcer or Service gateway does so at a rate equal to or
greater than the CBR. This ensures smoothing for streaming
applications. Enter information in the fields, as follows:

e Inthe Guaranteed Bandwidth (KBits/sec) field, enter the
guaranteed bandwidth for the connection. Guaranteed Bandwidth is
the minimum bandwidth assigned to each connection in the Virtual
Channel. Guaranteed Bandwidth provides the most predictable
results for critical traffic and allows other connections to borrow the
bandwidth when it is not in use. Guaranteed Bandwidth always
supersedes the needs of other, non-guaranteed connections.

TIP This is useful in multimedia applications, such as Voice over IP.

e Inthe Delay (Microseconds) field, enter the delay value. The
default delay value is 1 second and is hidden. However, you can
specify any delay, as long as it does not exceed 1 second. If you
specify a delay other than the default, you need to know your
application’s buffering capability. The bigger the buffering
capability of your application, the larger the delay you can specify.
The optimum delay facilitates a better bandwidth management
because it sets a lower limit to the Quality of Service mechanism that
decides whether to throw away or keep a packet. The objective of
setting the optimum delay is to keep jitter at a minimum (0O at best).

8. Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:

e Admit by Priority: Accept the new connection, but do not assign
the minimum bandwidth. The new connection gets bandwidth per
priority.

e Reject: All packets are dropped. In TCP, an RST packet is sent to
the client and the user may see the message Connection Closed by
Server.

e Drop: All packets are dropped. The user is disconnected and may
see the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKSs).
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9. Click Save. The new entry is saved in the QoS Catalog.

To define Enhanced QoS for Virtual Channels:

NOTE Enhanced QoS should only be used for creating a Enforcement
Policy for NetEnforcers or Service Gateways running AOS (Allot

Operating System).

1. Select and right-click QoS in the Navigation pane and select New
Virtual Channel Enhanced QoS from the popup menu.

OR

In the Application Details pane, right-click an entry in the QoS
Catalog and select New Virtual Channel Enhanced QoS from the

popup menu.

The Quality of Service Entry Properties dialog is displayed.

Virtual Channel Enhanced QoS Entry Properties

x|

Name: lew Virtual Channel Enhanced QoS

Description:

Virtual Channel Based QoS Coverage: Inbound and Outbound Defined the Same
Inbound and Outbound

Minimum Bandwidth (Kbps):

C) Allowed

in Kbps:

© Priority (Best Effort)

Priority (1 Lowest, 4 Highest)

Expedited Forwarding

Drop Precedence: Application Based v

: If Minimum Virtual Channel Bandwidth not Allocated: = Admit by Priority v

Figure 4-39: Virtual Channel Enhanced QoS Entry Properties

2. Edit the name of the entry, if required.

3. From the Virtual Channel-based QoS Coverage dropdown list,
select whether you want to define QoS for inbound and outbound
together or separately. If you select Both Directions Defined the
Same, you define QoS for both the inbound and outbound traffic.
If you select Each Direction Defined Separately, you define
QoS for the inbound and outbound traffic individually.

TIP The Both Directions Defined the Same option is normally used in a
symmetric environment where inbound and outbound traffic

requirements are identical.

4. Inthe Inbound and Outbound area, define the Quality of Service

as follows:
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e (Optional) In the Minimum Bandwidth (Kbits/sec) field, enter the
minimum bandwidth that will be assigned to the Virtual Channel. As
long as there is traffic requiring bandwidth in this channel, the
bandwidth will never be lower than this limit. Getting bandwidth
above the minimum, however, depends on the traffic priority.

e (Optional) In the Maximum Bandwidth field, you may opt to assign
this VC the maximum Bandwidth allowed, to enter the maximum
bandwidth that will be assigned to the VC in Kbits/sec, or to enter a
percentage of all the Bandwidth going through the Pipe to assign to
this VC. The total bandwidth of all traffic allocated in this VC will
not exceed this limit.

NOTE The ability to define the maximum bandwidth by percentage is
disabled and will not appear in the GUI by default. To enable this
feature contact Allot Customer Support at support@allot.com

WARNING In order for the maximum bandwidth by percentage entry to operate
correctly on a VC, there must some traffic running in at least one of
the VCs for which bandwidth by percentage is NOT defined. If no
traffic is running on any of the other VCs, the mechanism will not
work. In order to avoid this situation, Allot recommends to assign a
minimum QoS catalog entry together with the maximum percentage
entry (on the same VC).

e Select Priority (Best Effort) or complete the Priority field by
selecting a priority between 1 and 4 (highest). If all objects in the
same Enforcement Policy level are set to Best Effort there will be
no prioritization between objects. The more traffic an object
requires, the more bandwidth that will be allocated to it subject to the
amount of free bandwidth available.

NOTE Allot does not recommend using Priority (Best Effort) if other
elements have Priorities 1 to 4 assigned. In such situations an
element which has been assigned Priority (Best Effort) may receive a
very low percentage of the available bandwidth.

NOTE To specify a guaranteed bandwidth for a Virtual Channel, specify
the same Minimum and Maximum bandwidth, for example, 100Kbps.

5. (Optional) Select the Expedited Forwarding checkbox when the
Virtual Channel is used for jitter or delay sensitive applications
such as VolIP. No buffering is used with Expedited Forwarding in
order to minimize jitter and delay. All traffic that cannot be
allocated the required bandwidth is dropped.

e Set the bandwidth to be used for the expedited forwarding in
the Expedited Forwarding Bandwidth field.

e Click Save. The new Expedited Forwarding QoS entry is
saved in the QoS Catalog
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Virtual Channel Enhanced QoS Entry Properties g

Name: VNéWVVi'nua'l'Channélréhhancedraos

Description:

Virtual Channel Based QoS Coverage: |Inhound and Outhound Defined the Same ‘v"

Inbound and Outhound

Expedited Forwarding Bandwidth (Kbps): |

Drop Precedence: No Buffering

If Minimum Virtual Channel Bandwidth not Allocated:  Drop

Save 2 Cancel

Figure 4-40: Virtual Channel Enhanced QoS Entry Properties
— Expedited Forwarding

6. Select a value for Drop Precedence, which will dictate the order
in which packets will be dropped, if required. If a packet is not
transmitted to the network, it will be dropped or buffered. Drop
precedence value determines the importance of the packet before
making the decision to buffer or not. Packets with higher drop
precedence values are discarded before packets with lower drop
precedence values.

Possible values are No Buffering, Low, Medium, High and
Application Based (default).

7. Configure the action to be taken if minimum bandwidth is not
allocated, by selecting one of the following options from the
designated dropdown list:

e Admit by Priority: Accept the new connection, but do not assign
the minimum bandwidth. The new connection gets bandwidth per
priority.

e Drop: All packets are dropped. The user is disconnected and may
see the message Connection timed-out.

NOTE The Drop option is provided for environments such as UDP where a
client does not expect acknowledgements (ACKS).

Click Save. The new entry is saved in the QoS Catalog.

Service Activation Catalog

The Service Activation catalog allows the user to define possible traffic or subscriber
steering actions that can be used in Enforcement Policy definitions.
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Currently redirection to physical port, VLAN, Captive Portal, Local Service or
Integrated Service is available, as well as the creation of an Integrated Service Chain.

Service Activation

X
Name Description | Type | Date Modified
@ HTTP Monitoring Integrated Service 141409 12:00 AM
& None Passasls 113105 12:00 AM
A) Port Redirection Port Redirection 143i07 12:00 AM
@ Ran Integrated Service 311010 4:48 PM
& RRR Integrated Service Chain 3M0M0 4:49 PM
@ websafe Integrated Service 141709 12:00 AM

Figure 4-41: Service Activation Catalog
Service Activation values can be assigned to any Line, Pipe or VC.

After the relevant entries are created in the Service Activation catalog, the user should

create policies and assign to each Enforcement Policy the appropriate Service
Activation entry.

Port Redirection

NOTE Port Redirection is only available to those users with the appropriate
license key entered to enable the feature.

If you are working with a NetEnforcer or Service Gateway that supports port redirection
(e.g: AC-2540), there is no need to define a new catalog entry. The port redirection
catalog entry is pre-defined. However, you do need to enable Port Redirection from the
Service Activation tab of the device Configuration screen (see 3-27 for details).
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Captive Portal

The Captive Portal action is used as part of a rule to redirect traffic to a specific URL.
Typically, this action is used in the context of quota based service plans. If a subscriber
uses up the assigned daily or monthly quota, that subscriber will be reassigned to a
different service plan until the time period is reset, or the subscriber purchases a top-up.
Many service providers include a rule in this new service plan which redirects all HTTP
traffic to a captive portal. This captive portal can then be used for example to present
the subscriber with a new offer to “top up” his existing plan, or perhaps to purchase a
new one.

It is possible to have traffic sent to the Captive Portal identified by MSISDN as well as
by URI of origin through the use of macros.

For security reasons, the portal may utilize a secured connection (SSL / HTTPS). In
such scenarios, the administrator should set the Redirection Protocol to HTTPS.

To define Captive Portal redirection:

1. Select and right-click Service Activation in the Navigation pane
and select New Captive Portal from the popup menu.

OR

In the Application Details pane, right-click an entry in the Service
Activation Catalog and select New Captive Portal from the popup
menu.

The Captive Portal Entry Properties dialog is displayed.

Captive Portal Entry Properties £3
Mame: Mew Captive Portal
Description:
URI:
Redirection Protocol:  |HTTP -
Hitp Redirection Fail Action: | Drop -
Reset |m|

Figure 4-42: Captive Portal Entry Properties - HTTP
2. Edit the Name and Description fields, if required.
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3. Enter the URI of the portal that traffic is to be redirected to,
containing the domain name and the path of the Captive Portal.

Example:
www.captive.com/landpage?ms=

If you wish the traffic sent to the Captive Portal to be identified by
MSISDN (subscriber phone number) a macro needs to be added to
the URI as follows:

Example:
www.captive.com/landpage?ms={MSISDN}

To identify the original URI of traffic sent to the Captive Portal
(so that the traffic may be returned there when released from the
Captive Portal) a macro needs to be added to the URI as follows:

Example:
www.captive.com/landpage?ms= {ORIG_URI}

Traffic sent to the Captive Portal may be identified by MSISDN
and URI of origin both as follows:

Example:
www.captive.com/landpage?ms={MSISDNHORIG_URI}

4. Inthe Redirection Protocol field, select either HTTP or HTTPS
from the drop down menu. If HTTP is selected, you will be
prompted to enter an IPv4 or an IPv6 address
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Captive Portal Entry Properties | 22|
Mame: Mew Captive Portal

Description:

LRI

Redirection Protocol: | HTTPS -

Portal IPvd address:

Portal IPvE address:

Hitp Redirection Fail Action: :Drnp v:

Save Reset Cancel

Figure 4-43: Captive Portal Entry Properties - HTTPS

NOTE: When using HTTPS, only requests directly designated to the captive
portal are supported. An indirect request from the captive portal to
other sites is not supported.

5. Inthe Http Redirection Fail Action field configure what will be
done with non-HTTP traffic passing through this particular pipe or
VC (i.e: VoIP traffic). If you select Pass As Is from the drop
down menu then it will be allowed to pass and reach is destination
(i.e: allow VolP sessions, but redirect HTTP traffic to the active
portal). If you select Drop then non-HTTP traffic will be blocked.

6. Click Save. The new entry is saved in the Service Activation
Catalog.

NOTES The “redirect to captive portal” action will only redirect the HTTP
traffic which is classified into the particular rule to which this action
is assigned. If some types of HTTP traffic (e.g: HTTP downloads or
particular user defined signatures) are classified into other rules with
different actions, then this traffic will not be redirected. Allot
therefore recommends that “All Services” be chosen as the service
condition for the redirect to captive portal action.

If there is traffic that you do not wish to be redirected to the Captive
Portal, be sure that the VCs containing such traffic are above the
Captive Portal VC in the Pipe.
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The same approach may be used if you wish certain HTTP sites to
remain available to users who are being redirected to the Captive
Portal. Simply assign the URL you wish to remain accessible to a
UDS (see Adding User Defined Signatures on page 4-27), then assign
the UDS to a VC above the Captive Portal VC.

VLAN Redirection

To define VLAN redirection:

1. Select and right-click Service Activation in the Navigation pane
and select New VLAN Redirection from the popup menu.

OR

In the Application Details pane, right-click an entry in the Service
Activation Catalog and select New VLAN Redirection from the

popup menu.
The VLAN Redirection Entry Properties Entry Properties dialog is
displayed.
Narme: {NéwVLAN"Rédirecfion ]
Description: \ \
Target
Load Balancing Policy: Hash by Intemal P [v]
Tracking Interface: (In-hand [v]
Tracking Method: MNone v’
Rate Limit [No Limit vl
Rate Limit Value: [ |
Senvice Unavailability Action: Bypass vl
No Server Action: |Bypass E'
Number of Redundant Servers: ‘
Tracking Interval (sec): |
Tracking Timeout (sec): [
Servers:
[IP VLAN ID || Add..
|

Figure 4-44: VLAN Redirection Entry Properties
2. Edit the Name and Description fields, if required.
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3. Select a Load Balancing Enforcement Policy (Hash by Internal
IP or Hash by External IP).

4. Select Tracking information in which you can define how the
NetXplorer confirms that a service is available on a certain server,
including the Tracking Interface (In-Band or Management) and
the Tracking Method (None, Bidirectional Forwarding Detection
or Ping).

5. Select the Rate Limit you wish on the traffic being redirected (No
Limit, Block Server or Rate Limit (kbps), which can be set in the
field below).

6. Select a Service Unavailability Action in case it is not possible to
redirect the traffic to the proper server (Bypass or Drop).

7. Select a No Server Action, to tell the NetXplorer what to do with
any packets when redirection is not possible (Bypass, Rehash by
Available Servers or Drop).

8. Set the Number of Redundant Servers, as well as the Tracking
Interval (The length of time, in seconds, that NetXplorer waits
between attempts to contact a server) and Tracking Timeout
(The length of time, in seconds, that NetXplorer waits before
concluding that a server is down).

9. Under Servers, click Add to enter the IP and VLAN ID of the
target VLAN server.

Add Server @

IP Address: j

YLAN ID:

[ OK H Cancel ]

Figure 4-45: Add VLAN Server

10. Click Save. The new entry is saved in the Service Activation
Catalog.
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Integrated Services

An Integrated Service is made up of one or more Local Services, each of which is assigned to a
specific NetEnforcer or Service Gateway. Once all required Local Services have been added to an
Integrated Service, the Integrated Service may then be used in Policies.

To define a Local Service:

NOTE This feature is only available on NetEnforcers or Service Gateways
running AOS (Allot Operating System). In addition, a traffic steering
license is required if traffic is to be steered to external services.

1. Select and right-click Service Activation in the Navigation pane
and select New Local Service from the popup menu.

OR

In the Application Details pane, right-click an entry in the Service
Activation Catalog and select New Local Service from the popup
menu.

The Local Service Entry Properties dialog is displayed.
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rl.DEal Service Entry Pmpm ! j ‘ i ﬂ1
Mame: Proxy Redirection Local Service
Description: I
Target |
Device Name: | AC-3K-10.4.3.11 -
Senvice Type: :Generic Proxy Redirection v:
Service Admin Status: :Active v:
Load Balancing Method: :Hash by Internal IP v:
Server Failure Action: :Elypass v:
Service Unavailability Action: :Elypass v:
Tracking Method: Ping(in-band) | Fort
I IPv4 Support: Enabled
IPvi Support Enabled -
Local IPv4 Address Internal: 192.168.11 . 1
Local IPv4 Address External: 192.168.22 . 1
| Local IPvE Address Internal: fd00:1234:5678:0001::0001
Local IPvE Address External: fd00:1234:5678:0002::0001
Tracking Intervals{zec): 1 =
Tracking Retries: 3 -
Server Capacity Reached Action: :Elypass v:
I Minimum Active Servers: 1 =
I Servers:
Name Server Deployment Add..
Edit
I Remaove

v

Figure 4-46: Local Service Entry Properties
Edit the Name and Description fields, if required.
Select the Device Name the Local Service will be assigned to.

Select the Service Type (Generic Transparent Redirection,
Generic Proxy Redirection, Generic Mirroring, MediaSwift or
VideoClass).

Select the Service Admin Status (Active or Inactive).

Select a Load Balancing Method (Cyclic, Hash by Internal IP or
Hash by External IP). Cyclic load balancing is sometimes referred
to as “round-robin”
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7. Select a Server Failure Action, to tell the NetXplorer what to do
with any packets when redirection to the selected server is not
possible (Bypass, Re-dispatch to Other Server or Block).

8. Select a Service Unavailability Action in case there is no
possible server to redirect the traffic to (Bypass or Block).

9. Select Tracking information in which you can define how the
NetXplorer confirms that a service is available on a certain server,
including the Tracking Interface (None, BFD, Ping (In-Band) or
HTTP Request) and the Tracking Method (None, Bidirectional
Forwarding Detection, Ping or HTTP Request). If you selected
HTTP Request enter a Port number in the relevant field.

NOTE When adding a MediaSwift Local Service, the Tracking Method is
automatically set to Bidirectional Forwarding Detection. This option
cannot be changed by the user.

10. Enter a Local IP Address for use in tracking service availability. If
Generic Transparent Redirection has been chosen in the Service
Type field, then only IPv4 fields will appear.

11. Set the Tracking Interval (The length of time, in seconds, that
NetXplorer waits between attempts to contact a server) and
Tracking Retires (How many times the NetXplorer will attempt
to contact a server before concluding that a server is down).

12. Select a Server Capacity Reached Action, to be performed when
the maximum redirection capacity has been exceeded (Bypass,
Redispatch or Block), the Minimum Active Servers and the Flow
Direction. The feature will be implemented in future releases.

13. Under Servers, click Add to enter the details of any target servers.

NOTE Up to 128 servers may be added per Service.
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General
Name: SRV
Admin Status: | Active -

Deployment: :External Switched v:

Server slot: 9

Network Configuration

Internal External
Mac: AATAATAATAAAAL BE:BE:BE:BB:BE:BE
I IPud: 192.168.11 . 2 192.168.22 . 2
IPvE:
Interface Connectivity
Internal External

SFCPortldiLine: |SERVICE1 »| [SERVICE1 |
VLAN TagIPvd: |11 S $
VLAN Tag IPv: |1 H |1

Alternative Connectivity
Enable Alternative Connectivity

Internal External
SFC PortldiLine: |SERVICEA SERVICEA
OK H Cancel

Figure 4-47: Edit Server

NOTE The fields which appear in this dialog will be dependent on the
Deployment options chosen

® Enter a Name for the server and set the Admin Status to
Active or Inactive.

e Set the Deployment for Internal, External Switched or
External Direct.

® The Management IP is entered to enable communication
with the NMS.

e If the Deployment is set to Internal, then the Server Slot (9-
14) needs to be defined.
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® Set Network, Interface and Alternative Connectivity (if
relevant) for both the Internal and External connection on
the server.

® Monitoring IP is used for server tracking and is relevant
only for servers whose Deployment is set to External
Switched or External Direct. It is not relevant when the
tracking method is set to Bidirectional Forwarding
Detection.

® MediaSwift Servers are transparent devices on the network
so Mac Internal and External are not supported in these
cases.

14. Click Save. The new entry is saved in the Service Activation
Catalog.
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Device Mame:

Senice Type:

Service Admin Status:

Load Balancing Method:
Server Failure Action:
Senvice Linavailability Action:
Tracking Method:

Local IPv4 Address Internal:
Local IPvd Address External:
Wirtual IPvd Addresses:
Tracking Intervalsi(sec):
Tracking Retries:

Minimum Active Servers:

Local Service Entry Properties . )
Mamea: |Wapr |
Description: | |
~Target

| Sigma404

|Nnn Transparent Proxy

[m:ljve

‘Hash by Internal IP

‘Block

‘Block

[H'I‘I’F' Request v] Port:

| 192.168. 6 .

| 192.168. 7 .

|‘192.‘1EB.4.2; 192.168.4.3

1

Seners:

Mame Senver Deployment

quid ad N
Squid2 External Switched Edit

Save ][ Reset ][ Cancel ]
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I

Edit Server I&\
General
Mame: Squidi
|| | Admin Status: | Active - I
' Deployment: :External Switched v:
Senver Slot: 9
Metwork Configuration
Internal External
Mac: Proro IR
IPw: 192168, 6 . 3 192 168. 7 . 3
IPviE:
Interface Connectivity
Internal External
SFC PortIdiLine: | LAG1 »| |LAG2 -
VLAM Tag IPvd: |5 = & =
WVLAM Tag IPvE: 1 : 1
Alternative Connectivity
[T] Enable Alternative Connectivity
Internal External
SFC Port ldiLine: | LAGA LAGA
I [ OK H Cancel

To define an Integrated Service:

NOTE This feature is only available on NetEnforcers or Service Gateways
running AOS (Allot Operating System). In addition, a traffic steering
license is required if traffic is to be steered to external services.

1. Select and right-click Service Activation in the Navigation pane
and select New Integrated Service from the popup menu.

NetXplorer Operation Guide 4-69



Chapter 4: Defining Catalog Entries

OR

In the Application Details pane, right-click an entry in the Service
Activation Catalog and select New Integrated Service from the

popup menu.

The Integrated Service Entry Properties dialog is displayed.

Integrated Service Entry Properties

(e

Name: [New Integrated Service

Description:

Senvice Type: |Select Type...

Available

New Local Service

Selected

»

4«

Cancel

Figure 4-48: Integrated Service Entry Properties

Edit the Name and Description fields, if required.

Select the Service Type (Generic Transparent Redirection,
Generic Proxy Redirection, Generic Mirroring, MediaSwift or

VideoClass).

Select the Local Services you wish to add from the Available list.
Use the arrow keys to move them to the Selected list.

Click Save. The new entry is saved in the Service Activation
Catalog and may be used in Policies.
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To define an Integrated Service Chain:

An Integrated Service Chain is an optional series of Integrated Services which occur in
order and may be assigned to a Enforcement Policy like any other Integrated Service

1. Select and right-click Service Activation in the Navigation pane
and select New Integrated Service Chain from the popup menu.

OR

In the Application Details pane, right-click an entry in the Service
Activation Catalog and select New Integrated Service Chain from
the popup menu.

The Integrated Service Chain Entry Properties dialog is displayed.

Integrated Service Chain Entry Properties =N
Mame: Mew Integrated Service Chain
Description:
Available In Group
WehSafe Services:
HTTP Manitoring
Ordered Senvices:
]
‘ L |
[» ) U
"

Figure 4-49: Integrated Service Chain Entry Properties
2. Edit the Name and Description fields, if required.

3. Highlight any Integrated Services in the Available list and use the
arrow keys in the middle of the dialog to transfer them to the In
Group list.

NOTE Local Services may not be added directly to an Integrated Service
Chain. They must first be added to an Integrated Service then that
Integrated Service can be added to an Integrated Service Chain.

4. Within the In Group list, those Integrated Service listed in the
Services field are always active and do not need to be put in any
order.

NetXplorer Operation Guide
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5. Using the arrow keys on the left hand side of the dialog, you may
adjust those services in the Ordered Services field, to decide
which of them take effect first in the chain. The lowermost service
in the list will be the first implemented.

NOTE When added to a Service Chain, WebSafe will always be implemented
first, regardless of the order.

6. You may set the Scope of the Integrated Service Chain in the
lower left corner of the dialog box. Click the Browse button to
open the Scope dialog box and select if you wish the Integrated
Service Chain to be global, available to all devices on the
network, or only a specific Device.

Ty
Entry Scope Properties x
Entry Scope

Entry will be available for
all devices

Entry usage will be limited to
selected device only

Cancel

Figure 4-50: Integrated Service Entry Properties

7. Click Save. The new entry is saved in the Service Activation
Catalog.
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DoS Catalog

The DoS (Denial of Service) Catalog enables you to control the number of connections
and the rate of connections established per Enforcement Policy.

A sample DoS Catalog is shown below:

MHame | Date Modified

“E ddos 22008 2:04 AM
“E DnumBOKcer2k 20/06 11:19 AM
“E dos4 20/06 10:35 AM
“E doss 20/06 10:35 AM
£ lgnore dos 1205 10:00 PM
B MAMC:20000 22008 217 AM

“dE Catalog DoS

Figure 4-51: DoS Catalog

Each entry indicates the maximum number of connections that can be established, the
maximum rate of connections established and what action should be taken if the
maximum establishment exceeded or when the maximum of connections exceeded.

You can control the connection rates by setting specific values and assigning the entry
to a Line, Pipe or Virtual Channel. For example, you can limit the number of
simultaneous connections for specific users by creating a catalog entry and applying the
Enforcement Policy to those users.

To define a DoS entry:

1. Select and right-click DoS in the Navigation pane and select New
DoS from the popup menu.

OR

In the Application Details pane, right-click an entry in the DoS
Catalog and select New DoS from the popup menu.

The DoS Entry Properties dialog is displayed.
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DoS Entry Properties

Name [

Description

Maximum Number o

Figure 4-52: DoS Entry Properties
2. Edit the name of the entry in the Name field, if required.

3. Enter the maximum number of concurrent connections that can be
established in the Maximum Number of Connections field.

4. Enter the number of connections that can be established per second
in the Maximum Connections Establishment Rate field.

5. Select the action to be taken if the maximum number of
connections or maximum rate of establishing new connections is
exceeded from the designated dropdown list:

e Reject: All packets are dropped. In TCP, an RST packet is sent to
the client and the user may see the message Connection Closed by
Server.

e Drop: All packets are dropped. The user is disconnected and may
see the message Connection timed-out.

6. Click Save. The new entry (entries) is saved in the DoS Catalog.

Quota Catalog

NOTE

Quotais only available to those users with the Subscriber
Management Platform (SMP) installed and the appropriate license
key entered to enable the feature.

Quotas are usually defined to work in tandem with Service Plans. Defining and
enforcing Quotas without different QoS minimum and maximum bandwidths
parameters being used in combination only offers restrictive opportunities for SPs to
optimize their ARPU. A Quota can be defined based on VVolume or based on Time.

For example, if a Monthly quota of 40Gb is selected (based on a Service Plan that also
offers a QoS speed of 256 Kbs up to 40 Mb maximum), is exceeded on the 19th day of
the month, the Service Plan would only allow the subscriber to have internet access to a
maximum of 64 Kbps from the 20th to the 30th of the month. On the 1st of the next
month, the subscriber would return to the 256 Kbps speed until the 40 Mb quota is
reached.

The Quota Entry Properties dialog default settings are as follows:
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e Monthly period starting on the first day of the month
e Quota covering a full month
e Direction of file flow — both in (download) and out (upload)

A Quota Entry may be based on the volume of traffic, or the amount of time the quota
lasts.

To define a Volume Based Quota entry:

1. Select and right-click Quota in the Navigation pane and select
New Quota from the popup menu.

OR

In the Application Details pane, right-click an entry in the Quota
Catalog and select New Quota from the popup menu.

The Quota Entry Properties dialog is displayed.

Quota Entry Properties X

Name: fNew Quota

Description: |

Quota Type

() Volume Based O Time Based

Time Coverage

Period Details
@ Monthly Startat 012 of Every Month
) Daily

(®) Quota Covers the Full Manth

() Quota Covers: Sun . |Through| Sat = |of Each YWeek
Capacity
Direction: | Both (In+Out) v
Amount: | iVVGB\rtes v\

Figure 4-53: Volume Based Quota Entry Properties
2. Edit the Name and Description fields, if required.
3. Select the Volume Based radio button.

4. Enter the time period to be covered by the Quota, Monthly or
Daily.
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5. If Monthly is selected the following parameters can be selected in
the Details area.

e Start at X of Every Month — Select the date in the month
when the Quota first takes effect.

e Quota Covers the Full Month — The Quota covers the
entire month.

e Quota Covers X Through X of Each Week — Select the
days of the week that the Quota is applied (i.e. Monday
through Friday).

6. If Daily is selected the following parameters can be selected in the
Details area.

e Quota Covers the Full Day — The Quota covers the
entire day.

e Quota Covers X Through X of Day — Select the hours of
the day that the Quota is applied (i.e. 8:00 AM through
5:00 PM).

7. Select the direction of traffic the Quota applies to from the drop
down menu: Both (In + Out); Incoming Only; or Outgoing Only.

8. Enter the amount of traffic the Quota covers, in GBytes, Mbytes or
Kbytes.

9. Click Save. The new entry (entries) is saved in the Quota Catalog.

To define a Time Based Quota entry:

1. Select and right-click Quota in the Navigation pane and select
New Quota from the popup menu.

OR

In the Application Details pane, right-click an entry in the Quota
Catalog and select New Quota from the popup menu.

The Quota Entry Properties dialog is displayed.
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3

Quota Entry Properties X
Narme: \New Quota
Description: |

Quota Type

(O Volume Based

Time Coverage

Period Details
(@ Monthly Startat |01 3 of Every Month
O Daily

(®) Quota Covers the Full Month
(O Quota Covers: j Sun jThrough‘ Sat. ”‘ofEach Week

Time Limit
Quantity: ‘ 03 Days 03 Hours 03 Minutes

e Cancel

Figure 4-54: Time Based Quota Entry Properties

2. Edit the Name and Description fields, if required.
3. Select the Time Based radio button.

4. Enter the time period to be covered by the Quota, Monthly or
Daily.

5. If Monthly is selected the following parameters can be selected in
the Details area.

e Start at X of Every Month — Select the date in the month
when the Quota first takes effect.

e Quota Covers the Full Month — The Quota covers the
entire month.

e Quota Covers X Through X of Each Week — Select the
days of the week that the Quota is applied (i.e. Monday
through Friday).

6. If Daily is selected the following parameters can be selected in the
Details area.

e Quota Covers the Full Day — The Quota covers the
entire day.
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e Quota Covers X Through X of Day — Select the hours of
the day that the Quota is applied (i.e. 8:00 AM through
5:00 PM).

7. Inthe Time Limit area, enter the maximum amount of time the Quota
can cover, in Days, Hours and Minutes.

8. Click Save. The new entry (entries) is saved in the Quota Catalog.

Daily Quota Time Synchronization

Allot’s NetXplorer Server settings allow you to define then deploy peak and other hour
ranges based on GMT synchronization to the “local” time where the SMP Server are
located.

Quota Enforcement Thresholds

Allot’s Servers read and collate data every 5 minutes and the maximum time between
subscribers reaching and then violating their defined quota is 5 minutes.

Service Plan Catalog

NOTE Service Plans are only available to those users with the Subscriber
Management Platform (SMP) installed and the appropriate license
key entered to enable the feature.

Service plans (with or without quotas) contain QoS Catalog entries that quickly and
easily define key parameters for subscriber accounts, for example, minimum and
maximum bandwidth.

Service Plans may be created for Pipes or for VCs, depending upon the structure of
Enforcement Policy tables. It is possible to define a Pipe Service Plan, where each VC
is defined in the Pipe Service Plan and handles a separate application, or to create
individual VVC Service Plans for each VC.

To create a Pipe Service Plan:

1. Select and right-click Service Plan in the Catalogs tab of the
Navigation pane and select New Pipe Service Plan from the
popup menu.

OR

In the Application Details pane, right-click an entry in the Service
Plan Catalog and select New Pipe Service Plan from the popup
menu.

OR
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In the Actions menu, select New Catalog Entry > New Pipe Service
Plan.

The Pipe Service Plan Entry Properties dialog is displayed open to
the General tab.

MName: Mew Pipe Service Plan

Description:

General Cundwtiunsmcliuns|App|icati0ns Gx Usage

@ Mo Quota

©) Quota: Available Quotas Selected Quotas

"

Plan on Quota Completion: |Unlimited Service Plan LI

Figure 4-55: Pipe Service Plan Entry Properties - General

2. Edit the Name and Description fields, if required.

3. Inthe General tab, define the quota capacity of the Service Plan.
You can also select a different service plan that the Enforcement
Policy editor enables when the defined Quota threshold is reached.

MName Mew Pipe Senice Plan
Description:
- Conditions/Actions Applicatinngl Gx Usage
Conditions
External Senice Time ToS Encapsulati... Interface Tethering Add...

Anytime Ignore ToS Ignore Ignore

Actions

Access: _ED Accept - Tos: E Ignore ToS -
Qualty of Service: |4 Normal Pipe QoS - Das: | 4g Ignore dos -
Senvice Activation: a' MNone v

Figure 4-56: Pipe Service Plan Entry Properties —
Conditions/Actions
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Open the Conditions/Actions tab to set Conditions and Actions for the Service

Plan.

Multiple Conditions may be set, with the first on the list being checked first,
then the second, and so on. Up to 50 conditions may be set per Service Plan.

4. Click Add to open the Condition Properties — Add dialog.

Conditions

External; =] Any -
Service: ey AlLIP -
Time: &3 Anytime -
ToS: a8 Ignore ToS -
Encapsulation: IE;Z,& lgnore -
Interface: D:ﬂ, Any -
Tethering: () Ignore -

| DK | | Cancel

Figure 4-57: Condition Properties — Add dialog

e Conditions can be set for the Pipe as follows:

External: Defines the source of the traffic, such as Any
IPv4, Any IPVv6, another Service Plan or Any (default).

Service: Defines the protocols relevant to a connection.
Protocols may be TCP and UDP IP type, non-TCP and
non-UDP type or non-IP type. TCP and UDP IP protocols
are defined based on port type. HTTP protocols may include
content definitions, such as specific Web directories, pages,
or URL patterns. The default value is All IP which covers
all protocols.

Time: Defines the time period during which the traffic is
received. For example daily between 8.00 AM and 6.00 PM,
Sundays between 12.00 AM and 12.00 PM or on the 1% and
15" of the month. The default value is Anytime which
covers traffic at any time.
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e ToS: Defines the ToS byte contained in the IP headers of
the traffic. The default value is Any which covers any ToS
value.

e Encapsulation: Defines VLAN traffic classification
according to VLAN ID (VLAN Identifier) tags, consisting
of 12 bits, and according to tagging priority bits, consisting
of three bits. Alternatively can be used to classify by GRE
tunnel.

e Interface: Defines the physical interface or group of
interfaces on the In-line platform.

e Tethering: Defines whether the rule classifies tethered
traffic (set to yes), non-tethered traffic (set to no) or
classifies traffic irrespective of whether it is tethered or not
(set to ignore, the default value)

e Actions can then be set for when the Conditions of the Service
Plan are met, as follows:

e Access: This action determines the access given to traffic. If
the Access Control for a Line, Pipe or Virtual Channel is
specified as Reject or Drop, all traffic meeting the
Conditions of the Line, Pipe or Virtual Channel is dropped
and no other Quality of Service or Connection Control
actions are applied. If the Access Control for a Line, Pipe or
Virtual Channel is specified as Bypass all traffic meeting
the Conditions of the Line, Pipe or Virtual Channel goes
through but no Quality of Service is applied to it and it does
not appear in any monitoring graphs.

e Quality of Service: This action determines the QoS given
to traffic. The default Enhanced Quality of Service action
for Lines, Pipes or Virtual Channels is Normal Priority,
which has Best Effort priority, no bandwidth definitions, no
ToS marking and no connection limitations.

e Service Activation: This action steers the traffic to a pre-
defined integrated service, Port or URL, when possible.

e ToS: The ToS is a byte in the IP header of a packet that
contains information about routing recommendations.
NetEnforcer classifies traffic based on the ToS byte marking
contained in the IP headers of the packets passing through
it.

e DoS (Denial of Service): This action enables you to limit
the frequency and number of connections, thereby giving a
level of protection from attacks on the network resources

NetXplorer Operation Guide 4-81



Chapter 4: Defining Catalog Entries

(such as internally connected servers). NetXplorer analyzes
the distribution of traffic across the various protocols and
ports, and admits or drops excess traffic when predefined
thresholds have been exceeded.

Pipe Service Plan Entry Properties x|

MName: MNew Pipe Service Plan

Description:

| General | conditionsiActions | Applications | Gx Usage

Name Access Qos Quota Subscriber Quota Insert...

Figure 4-58: Pipe Service Plan Entry Properties —
Applications

5. Open the Applications tab to set Applications for the Service Plan.

You add applications to a Pipe Service Plan by inserting Virtual Channel (VC)
rows into the Applications area of the Pipe Service Plan Properties dialog:

Using the Arrow buttons in the Applications tab you can:

e Insert applications in the Applications table above or below an existing
row.

e Edit application properties.
e Remove applications from the table.
e Move application up and down in the table.

6. Enter the details of Application based VCs into a Pipe Service
Plan by clicking Insert in the Applications area to open the
Application Properties dialog (see Figure 4-59)
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MName:
@ Mo Quota
) Quota: Available Quotas Selected Quotas
- »
4
“
Conditions
External Senvice Time Tos Encapsulati.. Interface Tethering Add...
Any AllP Anytime Ignore ToS lgnore Any |Ign0re Edit
Remove
Actions
Access: :|::> Accept v: ToS: E lgnore ToS v:
Quality of Service: | g Normal Virtual Ghannel QoS v DoS: | 4 Ignore dos 7
Service Activation: :@- MNone v:
Include in Subscriber Cuota
Plan on Quota Completion: |Unlimited Service Plan J
OK ] [ Cancel ]

Figure 4-59: Service Plan Application Properties

e For details concerning defining Quota, Conditions and
Actions for the VC, see steps 3 and 4.

The Include in Subscriber Quota checkbox is selected by
default. Uncheck this box if you do not wish this
application’s traffic to be counted against a subscriber’s
quota.
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Pipe Service Plan Entry Properties =]
MName: MNew Pipe Service Plan
Description:
| General | Conditions/Actions I Appl\cations| Gx Usage
Charging Applications (Session Usage Excluded) Edit...

Figure 4-60: Pipe Service Plan Entry Properties — Gx Usage

7. Open the Gx Usage tab to set charging applications to be excluded
from volume reporting in this Service Plan (if relevant).

Click Add to add Charging Applications to the Service Plan.
The Select Charging Applications dialog opens.

Available Selected
55 Facebook
=5 Twitter

55 streaming

“

[ oK ] [ Cancel

Figure 4-61: Select Charging Applications

8. Use the arrow buttons to move pre-defined Charging Applications
from the Available to the Selected lists.

Click OK to return to the Gx Usage tab.
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9. Click SAVE to save the Pipe Service Plan to the Service Plan
catalog.

To create a VC Service Plan:

1. Select and right-click Service Plan in the Catalogs tab of the Navigation pane
and select New VC Service Plan from the popup menu.

OR

In the Application Details pane, right-click an entry in the Service Plan Catalog
and select New VC Service Plan from the popup menu.

OR
In the Actions menu, select New Catalog Entry > New VC Service Plan.

The VC Service Plan Entry Properties dialog is displayed open to the General
tab.

Mame: Mew Virtual Channel Service Pla

Description:

General | Conditions/Actions | Gx Usage

@ Mo Quota

@ Quota: Available Quotas Selected Quotas

"

Plan on Quota Completion: |Unlimited Service Plan J

Figure 4-62: VC Service Plan Entry Properties - General

2. Edit the Name and Description fields, if required.

3. Inthe General tab, define the quota capacity of the Service Plan. You can also
select a different service plan that the Enforcement Policy editor enables when
the defined Quota threshold is reached.
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Name MNew Virtual Channel Service Pla

Description

General| ConditionsiActions | Gx Usage|

Conditions

External Senvice Time ToS Tethering Add

Any ‘»\\II IP |Any1ime |Ignure To3 |\gnure Edit
Remove

Actions

Access: :.::> Accept Tos: E Ignore ToS v:

Quality of Service: -@ Normal Vifual Channel QoS DoS: "«.u: lgnore dos v:

Senice Activation: | None

Figure 4-63: VC Service Plan Entry Properties —

Conditions/Actions

Open the Conditions/Actions tab to set Conditions and Actions for the Service

Plan.

Multiple Conditions may be set, with the first on the list being checked first,

then the second, and so on.

4. Click Add to open the Condition Properties — Add dialog.

Conditions

External: Q Any
Service: sk AILIP
Time: 1:3 Anytime
ToS: E Ignore ToS

Encapsulation: E,& lgnore
Interface: @J Any

Tethering: O lgnore

[ DK ][ Cancel ]

Figure 4-64: Condition Properties — Add dialog

e Conditions can be set for the VC as follows:
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e External: Defines the source of the traffic, such as Any
IPv4, Any IPv6, another Service Plan or Any (default).

e Service: Defines the protocols relevant to a connection.
Protocols may be TCP and UDP IP type, non-TCP and
non-UDP type or non-IP type. TCP and UDP IP protocols
are defined based on port type. HTTP protocols may include
content definitions, such as specific Web directories, pages,
or URL patterns. The default value is All IP which covers
all protocols.

e Time: Defines the time period during which the traffic is
received. For example daily between 8.00 AM and 6.00 PM,
Sundays between 12.00 AM and 12.00 PM or on the 1% and
15" of the month. The default value is Anytime which
covers traffic at any time.

e ToS: Defines the ToS byte contained in the IP headers of
the traffic. The default value is Any which covers any ToS
value.

e Encapsulation: Defines VLAN traffic classification
according to VLAN ID (VLAN Identifier) tags, consisting
of 12 bits, and according to tagging priority bits, consisting
of three bits. Alternatively can be used to classify by GRE
tunnel.

e Interface: Defines the physical interface or group of
interfaces on the In-line platform.

e Tethering: Defines whether the rule classifies tethered
traffic (set to yes), non-tethered traffic (set to no) or
classifies traffic irrespective of whether it is tethered or not
(set to ignore, the default value)

e Actions can then be set for when the Conditions of the Service
Plan are met, as follows:

e Access: This action determines the access given to traffic. If
the Access Control for a Line, Pipe or Virtual Channel is
specified as Reject or Drop, all traffic meeting the
Conditions of the Line, Pipe or Virtual Channel is dropped
and no other Quality of Service or Connection Control
actions are applied. If the Access Control for a Line, Pipe or
Virtual Channel is specified as Bypass all traffic meeting
the Conditions of the Line, Pipe or Virtual Channel goes
through but no Quality of Service is applied to it and it does
not appear in any monitoring graphs.
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e Quality of Service: This action determines the QoS given
to traffic. The default Enhanced Quality of Service action
for Lines, Pipes or Virtual Channels is Normal Priority,
which has Best Effort priority, no bandwidth definitions, no
ToS marking and no connection limitations.

e Service Activation: This action steers the traffic to a pre-
defined integrated service, Port or URL, when possible.

e ToS: The ToS is a byte in the IP header of a packet that
contains information about routing recommendations.
NetEnforcer classifies traffic based on the ToS byte marking
contained in the IP headers of the packets passing through
it.

e DoS (Denial of Service): This action enables you to limit
the frequency and number of connections, thereby giving a
level of protection from attacks on the network resources
(such as internally connected servers). NetXplorer analyzes
the distribution of traffic across the various protocols and
ports, and admits or drops excess traffic when predefined
thresholds have been exceeded.

MName: Mew Virtual Channel Service Plan

Description:

| General | conditionsiactions | Gx Usage

Charging Applications (Session Usage Excluded) Edit...

Reset Cancel
Figure 4-65: VC Service Plan Entry Properties — Gx Usage

5. Open the Gx Usage tab to set the charging applications to be
excluded from volume reporting for this Service Plan (if relevant).
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Click Add to add Charging Applications to the Service Plan.

The Select Charging Applications dialog opens.

Available Selected
= Facebook
= Twitter

=5 streaming

"

[ oK ] [ Cancel

Figure 4-66: Select Charging Applications

6. Use the arrow buttons to move pre-defined Charging Applications
from the Available to the Selected lists.

Click OK to return to the Gx Usage tab.

7. Click SAVE to save the VC Service Plan to the Service Plan
catalog.

Interface Catalog

The Interface Catalog enables you to define individual physical ports or groups of ports
(called Interface Groups) on your NetEnforcer or Service Gateway for use in policies.

NOTE This Catalog is only available on NetEnforcer and Service Gateways
running AOS11.2 and after.
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A sample Interface Catalog is shown below:

Name Description Date Modified

1 1/23/11 229 PM
U“fg Any Default Interface port catalog 10/10/10 12:00 AM
@ New Interface Group 1/26/11 420 PM
<3 TAC_SGS_SFC_A_L2 TAC SGS SFC A L2 112611 4:20 PM

@ Catalog: Interface !

Figure 4-67: Interface Catalog

To define a physical port:

1. Select and right-click Interface in the Navigation pane and select
New Physical Port from the popup menu.

OR

In the Application Details pane, right-click an entry in the Interface
Catalog and select New Physical Port from the popup menu.

OR

Select Interface in the Navigation pane when Catalogs are displayed
and select New Physical Port from the Actions menu.

The Physical Port Entry Properties dialog is displayed.

r T
Physical Port Entry Properties R

Name: New Physical Por

Description:

Device: |[TAC SGS-10.17.1.100 v"

Pot  [SFC_A_L1 -

Figure 4-68: Physical Port Entry Properties
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4.

Select the NetEnforcer or Service Gateway you wish to define a
port on in the Device drop-down menu.

Select the individual port on the selected NetEnforcer or Service
Gateway in the Port drop-down menu.

Click Save. The new entry is saved in the Interface Catalog.

To define an interface group:

1.

2.

3.

Select and right-click Interface in the Navigation pane and select
New Interface Group from the popup menu.

OR

In the Application Details pane, right-click an entry in the Interface
Catalog and select New Interface Group from the popup menu.

OR

Select Interface in the Navigation pane when Catalogs are displayed
and select New Interface Group from the Actions menu.

The Interface Group Entry Properties dialog is displayed.

Interface Group Entry Properties R
Name: ew Interface Group (2)
Description:
Available Selected
1
TAC_SGS_SFC_A_L2
»
]
[ »
«“
Save Reset Cancel

Figure 4-69: Interface Group Entry Properties

Select previously defined physical in the Available list and use the
arrow keys to move them into the Selected list.

Click Save. The new entry is saved in the Interface Catalog.
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Charging Application Catalog

NOTE Charging Applications are only available to those users with the
Subscriber Management Platform (SMP) installed and the appropriate
ChargeSmart license key entered to enable the feature. For more
information contact Allot Customer Support at support@allot.com.

Charging Applications contain individual Services or Groups of Services which may be
assigned to Charging Plans.

For more information about defining Charging Policies in NetXplorer, see the SMP

User Guide.
Charging Application x|
Name Description Date Modified
=5 App1 4/6/11 6:09 PM
== App10 4/10/11 2:36 PM
=5 App11 4110111 2:36 PM
5 App12 4/10/11 2:37 PM
55 App13 4/10/11 2:37 PM
== App14 4/10/11 2:37 PM
=5 App15 4/10/112:238 PM
=5 App16 4/10/11 2:38 PM
=L App17 4111111 11:37 AW
== App2 4/6/11 2:07 PM
55 App3 4/6/112:07 PM
5 App4 4/10/111 235 PM
E= App5 4/10/111 235 PM
== App6 4/10/11 2:35 PM
s App7 4/101112:35PM
=5 App8 4/10/11 2:36 PM
55 App9 4/10/111 2:36 PM
= doctest 513111 3.53 PM
=5 Session Session level charaing 2/8/11 10:00 AM
5 Catalog: Charging Application ‘

Figure 4-70: Charging Application Catalog

To create a Charging Application:

1. Select and right-click Charging Application in the Catalogs tab
of the Navigation pane and select New Charging Application
from the popup menu.

OR

In the Application Details pane, right-click an entry in the Charging
Application Catalog and select New Charging Application from the
popup menu.

OR

In the Actions menu, select New Catalog Entry > New Charging
Application.

The Charging Application Entry Properties dialog is displayed.
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P
Charging Application Entry Properties

Name:

Description:

Application ID

Offline Units: | Volume and Time v

| Senvice Entry Name Add...
Remove...
Reset Cancel

Figure 4-71: Charging Application Entry Properties
2. Edit the Name and Description fields, if required.

3. Inthe Application ID field, enter the unique 1D number that will
identify this Charging Application. The number selected must be
coordinated with the other elements of your online and offline

charging solution.

4. Select an Offline Unit from the drop down menu, defining on
what basis the user will be charged for this Charging Application.
Available values are Volume, Time or Volume and Time. This is
only relevant in Offline Charging, as in Online Charging this
value is defined by an external Server.

5. Add Services to the Charging Application by clicking the Add
button.

The Add Application Service Items dialog is displayed.

Selected Senices

| [ ok ][ cancel

Figure 4-72: Add Application Service ltems

6. Use the Arrow buttons to move Services or Service Groups from
the Available Services list to the Selected Services list. Click OK
to return to the Charging Application Entry Properties dialog.

7. Click Save to save the Charging Application.
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Charging Plan Catalog

NOTE

Charging Plans are only available to those users with the Subscriber
Management Platform (SMP) installed and the appropriate
ChargeSmart license key entered to enable the feature. For more
information contact Allot Customer Support at support@allot.com.

Charging Plans are the building blocks used to create Online and Offline Charging
Policies. Each Charging Plan can contain any number of Charging Applications,
defining what Services are covered by the Plan.

For more information about defining Charging Policies in NetXplorer, see the SMP
User Guide.

Charging Plan X
| Name Description Date Modified
:\E, No-Plan 2/8/11 10:00 AM
|EL plan1 4126111 10:53 AM
EIE; plan2 514111 11:48 AM

|55 Catalog: Charging Plan ‘

Figure 4-73: Charging Plan Catalog

The Charging Plan catalog contains one default Charging Plan called No-Plan that may
not be edited. The No-Plan Charging Plan contains no charging information.

To create a Charging Plan:

1. Select and right-click Charging Plan in the Catalogs tab of the

Navigation pane and select New Charging Plan from the popup
menu.

OR

In the Application Details pane, right-click an entry in the Charging
Plan Catalog and select New Charging Plan from the popup menu.

OR

In the Actions menu, select New Catalog Entry > New Charging
Plan.
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The Charging Plan Entry Properties dialog is displayed.

Charging Plan Entry Properties

Figure 4-74: Charging Plan Entry Properties
2. Edit the Name and Description fields, if required.

3. From the Session Monitoring drop down menu, you may Enable
or Disable the monitoring of this Charging Plan.

4. In the Session Rating field, enter the unique ID number that will
identify this Charging Plan. The number selected must be
coordinated with the other elements of your online and offline
charging solution.

5. Add Charging Applications to the Charging Plan by clicking the
Add button.

The Add Charging Application Item dialog is displayed.

Add Charging Application Item X

Charging Application: | EL, App1 -
Session Exclusion: Exclude Enforcement and Monitoring v
Monitor Status: on v

Rating Group:

[Gancel ]

Figure 4-75: Add Charging Application Item dialog

6. Inthe Charging Application field, select a predefined Charging
Application from the drop down menu.

7. In the Session Exclusion field, use the drop down menu to define
how the metering of the Charging Application will be handled by
the Online or Offline Charging Policy. Options are Exclude
Enforcement and Monitoring, Exclude Enforcement, Exclude
Monitoring or Off. For more information concerning these
options, see the SMP User Guide.

8. In Monitor Status, turn monitoring of this Charging Application
On or Off. If it is Off and the Charging Plan this Charging
Application is assigned to has Session Monitoring set to Enable,
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this Charging Application will not be monitored along with the rest
of the Charging Plan.

9. In the Rating Group field enter a unique number to identify this
Charging Application in the Charging Policy. This number is
different from the Application ID entered when the Charging
Application itself was created. The Rating Group number selected
must be coordinated with the other elements of your online and
offline charging solution. For more information see the SMP User
Guide.

10. Click OK to add the Charging Application to the Charging Plan.
The Charging Application will now appear in the Applications list.

11. Charging Applications in the Applications list may be removed
from the Charging Plan or changed using the Remove and Edit
buttons.

12. Click Save to add the Charging Plan to the Charging Plan catalog.

13. Clicking Reset removes any changes made to the Charging Plan
since the last save.

Mobile Device Catalog

NOTE The Mobile Device Catalog is only available to those users with the
Subscriber Management Platform (SMP) installed and the appropriate
Mobile Analytics license key entered to enable the feature. For more
information contact Allot Customer Support at support@allot.com.

The Mobile Device catalog lists the contents of the Mobile Device Database assigned to
this NetXplorer.

For more information about using the Mobile Device Catalog in NetXplorer and how to
assign a Mobile Device Database, see the SMP Installation and Administration
Guide.
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Mobile Device x
I Name | Date Modified
@ Wobile Device DB 10/23/11 3:25PM

Figure 4-76: Mobile Device Catalog
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NOTE Protocol Updates are only available to those users with a valid
support contract. The feature is enabled by key.

Overview

Service Catalog entries may be updated from Allot Communication Website where the
latest available Service Catalog information is maintained. Each Protocol Pack is
identified by Protocol Pack number and build number number. For example, PP3.19.10.
The Protocol Pack is 3.19 and the build number is 10.

NetXplorer periodically checks Allot’s website for the latest available Protocol Packs.
You can then update Service Catalog entries on the NetXplorer Server and install any
changes on selected or all NetEnforcer or Service Gateway platforms, as required.

The NetXplorer’s installation of Protocol Pack updates may be configured to be done
automatically or manually.

NetXplorer provides a rollback mechanism that enables you to return to a previous
version of the appropriate Service Catalog entries.

The Protocol Update procedure involves two tasks:
e Updating the NetXplorer Service Catalog entries with changes in application
types, services and service groups via a Protocol Pack

e Updating the NetEnforcer or Service Gateway device protocol changes
installed on the NetXplorer

To update Service Catalogs, you select the appropriate option from the NetXplorer
Tools menu, and the Protocol Update wizard guides you through the NetXplorer Server
and NetEnforcer or Service Gateway update processes:

Where necessary, you can also update Service Catalog entries from local media, such as
CDs and disc drives.

Viewing the Protocol Pack Version

Before you update a Protocol Pack, you can view which Protocol Pack is currently
loaded on the NetXplorer and which Protocol Pack build is installed on an In-line
Platform.

To view the Protocol Pack version running on the NetXplorer:

1. Open NetXplorer.
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2. In the Navigation pane, right-click the Network in the Navigation
tree and select Configuration from the popup menu. The tabbed
Network window is displayed.

3. Open the Protocol Updates tab.

Protocol Pack
Protocol Pack: 3.23

Automatic Seltings

Check Allot Web Site for New Updates (Periodic )

[T Automatically Install New Updates to Nefiplorer Server

vl Configuration: Network
Figure 5-1: Service Catalog Web Updates Configuration tab

4. The Protocol Pack currently installed on the NetXplorer is
displayed. For example, PP3.21.

NOTE Build numbers are not listed on the Protocol Updates tab as a
Protocol Pack release may include different builds for different In-line
platforms.

To view the Protocol Pack version running on an In-line Platform:

1. Inthe Navigation pane, right-click the appropriate device in the
Navigation tree and select Configuration from the popup menu.
The tabbed Network window is displayed.

2. Choose the Identification & Key tab:

3. The Protocol Pack installed on the device appears in the IDs area
of the window.

Each Protocol Pack is defined on the In-line Platform by Protocol
Pack number and build number. For example, PP3.21.10.
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Updating the NetXplorer Server

Automatic NetXplorer Protocol Updates

You can configure NetXplorer to check the Allot Website periodically for new Protocol
Packs and automatically update NetXplorer Server.

The system default is “Check Allot Website for New Updates (Periodically)” option.
By retaining this option, whenever new Service Catalog entries are available,
NetXplorer send an alert message to the Alarms Log.

The frequency of the checks is system defined and cannot be configured by users.

The NetXplorer Protocol Update mechanism allows users to automatically update the
NetXplorer Server with new Service Catalog information. However, to update
NetEnforcer or Service Gateway Devices, you need to update selected NetEnforcer or
Service Gateway device(s) manually.

Although the “Update Wizard” can guide you through both update processes, you
maintain control of update versioning on the NetEnforcer or Service Gateway(s).

To configure automatic Protocol Updates:
1. Open NetXplorer.

2. In the Navigation pane, right-click the Network in the Navigation
tree and select Configuration from the popup menu. The tabbed
Network window is displayed.

3. Open the Protocol Updates tab.

Protocol Pack

Protocol Pack: 3.23

Automatic Settings

Check AllotWeb Site for New Updates (Periodic )

[C] Automatically Install New Updates to NetXplorer Server

] Configuration: Network

Figure 5-2: Service Catalog Web Updates Configuration tab

The Protocol Pack currently installed on the NetXplorer is
displayed.
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4. Select the Check Allot Web Site for New Updates (Periodic)
option to allow the NetXplorer to automatically check if a more
recent Protocol Pack is available. This option is selected by
default.

5. If you wish to have downloads automatically installed on the
NetXplorer Server, select the Automatically Install New
Updates to NetXplorer Server....option.

(If you wish to manually install packages to the NetXplorer Server
using the Service Catalog Web Update Wizard, do not select this
option).

6. Click Save in the Toolbar to save any changes.

When you select the “Automatically Install....” option, an alarm advice entry appears in
the Alarms Log when a new Protocol Pack is installed.

Manual NetXplorer Protocol Updates

The NetXplorer Protocol Update mechanism allows users to manually update the
NetXplorer Server with new Protocol Pack information.

To enable this option, clear the Automatically Install New Updates on the NetXplorer
Server option.

By retaining the Check Allot Web Site for New Updates (Periodically)” option,
whenever new Service Catalog entries are available, NetXplorer sends an alert message
to the Alarms Log.

After viewing this Info alert in the Alarms Log, you can decide when to update the
NetXplorer Server’s Service Catalog entries.

The “Update Wizard” guides you through manually updating the NetXplorer Server and
maintaining version control when updating SRCs on selected NetEnforcer or Service
Gateway(s).

Updating the NetXplorer

Once you have received an Alert advising that NetXplorer Service Catalog updates are
available, you perform the Protocol Update by using the appropriate NetXplorer Tools
menu options.

The Protocol Update mechanism enables you to perform updates on both the
NetXplorer Server and any NetEnforcers or Service Gateways using the Update Wizard.

Whenever you use the Update Wizard, NetXplorer checks the Service Catalogs on both
the NetXplorer Server and NetEnforcer or Service Gateway(s). If the most current
versions have already been installed on NetXplorer Server and NetEnforcer or Service
Gateway Devices, you are informed that there is no need to continue the update.
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To perform Protocol Updates from the Allot website:

1. After you view the Alarm Log advice that ““...new Web updates
are available for download....” line, click on the Network icons
and choose the From Allot Website option from the Tools
Protocol Updates sub-menu.

The Service Catalog Update Wizard Introduction window is
displayed.

2. To check the last Protocol Pack on the NetXplorer Server (and
NetEnforcer or Service Gateways) click the Check for Updates
button.

The Protocol Update Wizard Pending Changes window is displayed:

Protocol Updates Wizard - Pending Changes =]

Pending Changes @

The Following Senvice Catalog Changes will be Downloaded and Installed to Net{plorer Server
Upon Selecting "Update Mow” below
=&l Protocol pack; 3.24
B Application
E@ Create
@ Update
= Senice
-5 Create
¢ @52 Update
23 Senice Group
@ Update

[ Update Mow = ][ Close

Figure 5-3: Protocol Update — Pending Changes

3. Toinstall the pending update on the NetXplorer Server, click the
Update Now button.

NOTE You cannot select individual packages to be installed here. To cancel
the update, click the Close button.

4. After clicking the Update Now button, the Wizard Installation to
NetXplorer Version Summary window is displayed detailing the
results of the update/install operation:
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Protocol Updates Wizard - Installation to NetXplorer S5erver Summary =]
Installation to MetXplorer Server Summary - All Updates Succeeded @
=% Success
+-E5 Application
a Create

£ Update
44 Senice

| @5 Create

. @52 Update
203 Senice Group
@ Update

Figure 5-4: Protocol Update — Installation to NetXplorer
Server Summary

5. To complete the NetXplorer Server update, click Next.
The Protocol Update Wizard Summary window is displayed.

6. At this stage you can stop the “Update to the NetXplorer Server”
process by clicking the Close button in the wizard.

7. Click Save.

Updating the Service Catalog from a Local Source

If the NetXplorer does not have Internet connectivity, first download the protocol pack
from Allot's website and then install it on the NetXplorer Server manually. In this case,
please follow this procedure:

To download and install a Protocol Pack from a local source:

1. Login to http://www.allot.com/support.html. From the
“registrations” tab, open the registration for the relevant device. If
an APU is available you can click on the “download APU” field.

2. Copy the APU files from the relevant APU folder to the
NetXplorer server and place them in C:\APU (create the folder if
needed)
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3. Confirm that there is a file named web_update_site.xml in the
same location. This file defines the current Protocol Pack and the
next one to be installed.

4. On the NetXplorer GUI select Tools > Protocol Updates > From
Local Package.

The Protocol Updates Wizard — Introduction dialog appears.

Protocol Updates Wizard - Introduction B3

Introduction ‘@

This Wizard will Update Mew and Changed Service Catalog Entries from a Local Package

Update Package Location on the MetXplorer Server:

Figure 5-5: Version to Install to Device
5. Type in the Protocol Pack path (C:\APU) and click Next.
The Protocol Update Wizard Pending Changes window is displayed:
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Protocol Updates Wizard - Pending Changes =]

Pending Changes @

The Following Service Catalog Changes will be Downloaded and Installed to Met¥plorer Server
Upon Selecting "Update Mow™ below

=& Protocol pack: 3.24
B Application

i E} Create

¢ @57 Update

-5 Senvice

N a Create

¢ @5 Update

23 Senice Group
&-57 Update

[ Update Mow = H Close

Figure 5-6: Protocol Update — Pending Changes

6. Toinstall the pending update on the NetXplorer Server, click the
Update Now button.

NOTE You cannot select individual packages to be installed here. To cancel
the update, click the Close button.

7. After clicking the Update Now button, the Wizard Installation to
NetXplorer Version Summary window is displayed detailing the
results of the update/install operation:
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Protocol Updates Wizard - Pending Changes =]

Installation to MetXplorer Server Summary - All Updates Succeeded @

=% Success
=B Application
a Create
£ Update
44 Senice
| @5 Create
. @52 Update
203 Senice Group
@ Update

Figure 5-7: Protocol Update — Installation to NetXplorer
Server Summary

8. To complete the NetXplorer Server update, click Next.
The Protocol Update Wizard Summary window is displayed.

9. At this stage you can stop the “Update to the NetXplorer Server”
process by clicking the Close button in the wizard or click Next to
distribute the upgrade to one or more In-line Platforms.

Updating In-line Platforms

After updating the Protocol Pack on the NetXplorer Server, you can distribute this
Protocol Pack to one or several NetEnforcers or Service Gateways, as required. Each
Protocol Pack is identified by Protocol Pack number and build number. For example,
PP3.19.10. The Protocol Pack is 3.19 and the build number is 10.

You install updates to NetEnforcer or Service Gateway(s) in one of two different ways:

e Selecting the Install to Device option from the Tools Protocol
Updates sub-menu. This option will allow you to install a
more recent Protocol Pack. For example, selecting PP3.20.10,

will upgrade Protocol Pack 3.19 or earlier, regardless of build
number.
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e Selecting the Redistribute Protocol Signatures to Devices,
will install a different build of the same major and minor
release. This may be an earlier or a later Protocol Pack build
than what is currently installed on the In-line Platform. For
example, selecting PP3.20.10 which will overwrite ANY
PP3.20.x currently installed, including later builds.

Installing a Protocol Update on an In-line Platform

1. Click on the Network icon in the Network navigation pane and
choose the Install to Devices or the Redistribute Protocol
Signatures to Devices... option from the Tools Service Catalog
Web Updates sub-menu.

The Protocol Update Wizard — Installation to Devices window is

displayed:
Protocol Updates Wizard - Installation to Devices =]
Installation T Devices @
Device' AG-3K-10.4.311. Current Version: 3.19
Wersion to be Installed: 3.23
Device: AC-500-10.4.3.12. Current Version: 3.19
Wersion to be Installed: 3.23
Select All Deselect All

Figure 5-8: Protocol Update Wizard — Installation to Devices

BUTTON DETAILS

Advanced Displays the Version to Install Device dialog that contains
details of the pending changes for the Protocol Pack to be
installed on the selected box. You can select specific boxes
by selecting or clearing the Device check box:

Select Devices to Install Changes to

Device 1. Current version: 2. Version to be Installed: 12
[l Device 2. Current version: 2. Version to he Installed: 12
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BUTTON DETAILS

Select All Select all Devices and Protocol Packs in the “Installation to
Devices” window.

Deselect All Clear selection of all Devices and Protocol Packs in the
“Installation to Devices” window.

Install Now To install the Protocol Pack to be installed to specific
NetEnforcer or Service Gateway(s). Depending on the size
and number of updates, there may be a time delay before
the “Summary” window is displayed.

2. Toinstall the latest Protocol Pack to the selected NetEnforcer or
Service Gateway device(s), click the Install Now button.

The Service Catalog Web Update Wizard - Installation to NetXplorer Server —
Summary window is displayed.

3. To complete the NetEnforcer or Service Gateway Service Catalog
update, click Next.

The Protocol Update Wizard Summary window with “Update Completely
Successful....... ” is displayed.

4. Click Close and enable a Save option.

If you select the Install to Devices option from the Tools Protocol Updates sub-menu,
and an update has already taken place, the Wizard will inform you that there are no
devices to update.
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Redistributing a Protocol Update to In-line
Platforms

1. Click on the Network icon in the Network navigation pane and
choose the Redistribute Protocol Signatures to Devices... option
from the Tools Service Catalog Web Updates sub-menu.

Protocel Updates Wizard - Redistribute Protocol Signatures to Devices - Import Package ==

Import Protocol Signatures Package @

This Wizard will import Protocol Signatures from a local Package and/or redistrbute to Devices

Protocol Signatures Package Location on the MetXplorer Server:

Figure 5-9: Protocol Update Wizard — Installation to Devices

The Protocol Update Wizard — Redistribute Protocol Signatures -
Import Package dialog appears.

2. Enter the location of the desired Protocol Pack and click Close. If
you click Skip the most recent Protocol Pack build located on the
NetXplorer Server will be selected.

3. The Protocol Update Wizard — Installation to Devices window is
displayed:
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r ™
Protocol Updates Wizard - Redistribute Protocol Signatures to Devices M

Redistribute Protocol Signatures to Devices ‘t@

This Wizard will Redisfribute Protocol Signatures to the selected devices.

Select Devices to Redistribute Protocol Signatures:

I Device: 10.10.10.11. Current Protocel Signatures version: 3.18.0. Redistribute version: 3.18.2.
Device: 10.10.10.12. Current Protocol Signatures version: 3.18.1. Redistribute version: 3.18.2.
] Device: 10.10.10.13. Current Protocol Signatures version: 3.18.3. Redistribute version: 3.18.2.
] Device: 10.10.10.14. Current Protocol Signatures version: 3.17.1. Redistribute version: 3.17.3.

[”] Device: 10.10.10.15. Current Protocol Signatures version: 3.17. Redistribute version: 3.17.3.

|
[ selectal || Deselectal |

Figure 5-10: Protocol Update Wizard — Redistribute Protocol
Signatures to Devices

BUTTON DETAILS

Advanced Displays the Version to Install Device dialog that contains
details of the pending changes for the Protocol Pack to be
installed on the selected box. You can select specific boxes
by selecting or clearing the Device check box.

Select All Select all Devices and Protocol Packs in the “Installation to
Devices” window.

Deselect All Clear selection of all Devices and Protocol Packs in the
“Installation to Devices” window.

Install Now To install the Protocol Pack to be installed to specific
NetEnforcer or Service Gateway(s). Depending on the size
and number of updates, there may be a time delay before
the “Summary” window id displayed.

4. To install the selected Protocol Pack to the selected NetEnforcer or
Service Gateway device(s), click the Install Now button.

The Service Catalog Web Update Wizard - Installation to NetXplorer Server —
Summary window is displayed.
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5. To complete the NetEnforcer or Service Gateway Service Catalog
update, click Next.

The Protocol Update Wizard Summary window with “Update Completely
Successful....... ” is displayed.

6. Click Close and enable a Save option.

Advanced Protocol Updating on In-line Platforms

You can use the Advanced button in the Protocol Update Wizard — Installation to
Devices window to install a specific version on a selected NetEnforcer or Service
Gateway. In the case, for example, where several Protocol Packs have been loaded on
the NetXplorer Server and only one of these is needed to be downloaded to a specific
NetEnforcer or Service Gateway.

The Version to Install to Device allows you to:
e Choose the Protocol Pack you wish to install
e View the details of the update

To view the details of the changes, you selected the required version using the combo-
box direction arrows.

To install a specific Protocol Pack on a NetEnforcer or Service Gateway:

1. Click on the Network icon in the Network navigation pane and
choose the Install to Devices option from the Tools Service
Catalog Web Updates sub-menu.

The Protocol Update Wizard — Installation to Devices window is displayed.

2. Select (or clear) the Device check box and click the Advanced
button.

The Version to Install to Device dialog is displayed.
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Wersion to Install to Device 2 |

Current Installed Version is 3.19

Available Versions are 3.20 Through 3.23

-

Version to Install: 3.23=

Pending Changes for Version 3.23

=& Protocol pack: 2.20 -
Er Application
--a Create
E% Lpdate
EH4s} Service
--?‘.@ Create &
@? Update
=L@ Senice Group

@? Update
=& Protocol pack: 3.21
B Application
: --?‘.@ Create

@? Update
S5 Senvice -

m

Ok ] [ Cancel

Figure 5-11: Version to Install to Device Dialog

3. To view previous Protocol Packs, click on the up or down combo-
box direction arrows.

The details in the Pending Changes for Version ...will change accordingly.

4. To confirm the Pack that you wish to install on NetEnforcer, click
OK.

You return to the Catalog Update Wizard — Installation to Devices window.
5. Toinstall the selected version, click Install Now.

The Protocol Update Wizard - Installation to NetXplorer Server — Devices
Summary window is displayed.

6. Tocomplete the NetEnforcer Service Catalog update, click Next.
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The Protocol Update Wizard Summary window with “Update Completely
Successful....... ” is displayed.

7. Click Close and enable a Save option.

Rollback Operations

NetXplorer provides a rollback mechanism that enables you to return to the previous
version of the appropriate Service Catalog entries.

The Services Catalog Web rollback allows you to:
¢ Rollback the NetXplorer Server Service Catalog entries

e Rollback the NetEnforcer or Service Gateway Device Service Catalog entries

To rollback to a previous Protocol Pack on the NetXplorer Server:

1. Select the Network icon in the NetXplorer Navigation pane and
choose the Rollback NetXplorer Server to Previous Version
option from the Tools Protocol Updates sub-menu.

The Protocol Update Wizard — Rollback NetXplorer Rollback to
Previous Version window is displayed.

2. Click the Next button and the NetXplorer Server Service Catalog
validation check is enabled.

The Protocol Update Wizard — Rollback NetXplorer — Pending Changes
window is displayed.

3. To restore the previous version click the Rollback Now button.

The Rollback to Previous Version Summary window is displayed showing a
successful result.

4. Click the Next button.

The Protocol Update Wizard — Summary “Rollback Completely successful”
window is displayed.

5. To exit the wizard, click Close.

6. Click Save.

To rollback to a previous Service Catalog on a NetEnforcer or Service
Gateway Device:

1. Select the appropriate Device(s) in the NetXplorer Navigation
pane and choose Rollback Devices to Previous Version from the
Tools > Protocol Updates sub-menu.
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The Protocol Update Wizard Rollback to Previous Version
window is displayed.

Protocol Updates Wizard - Rollback Devices - Rollback to Previous Version L |

Rollback to Previous Version ‘@

This Wizard will Rollback Sernvice Catalog Entries to the Previous Update Version

Select Devices to Rollback

Device: AC-500-10.4.3.12. Current Version: 3.19.

SelectAll | [ DeselectAl

Figure 5-12: Protocol Update Wizard — Rollback Devices —
Rollback to Previous Version

2. Click the Next button.

The Protocol Update Wizard — Rollback NetXplorer — Pending Changes
window is displayed.

3. Toreturn to the previous Service Catalog, click the Rollback
Now button.

The Rollback to Previous Version Summary window is displayed showing a
successful result.

4. Click the Next button and to exit the wizard, click Close in the
Wizard’s Rollback to Previous Version Summary window.

5. Click Save.
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NetXplorer Enforcement Policy

Overview

NetXplorer enables you to classify traffic and enforce Quality of Service according to
high-level, easy-to-understand concepts. Traffic can be logically grouped into categories
such as Mission Critical, Timing Critical, or Low Priority. These result in the desired
network actions when matched to network traffic.

QoS Enforcement Policy consists of a set of Conditions and a set of actions that apply
as a consequence of the conditions being satisfied. Traffic is classified using Lines,
Pipes and Virtual Channels. A Line, Pipe or Virtual Channel are defined by one or more
Conditions and a set of actions. A Line includes one or more Pipes. A Pipe includes one
or more Virtual Channels.

A sample Enforcement Policy showing the relationship between Lines, Pipes, Virtual
Channels and Conditions is illustrated below:

” Identification ‘ Conditions ‘ Actions
MName Alarms As. InUse Internal Direction External Service Time Tethering Access Quality of 5.
= P~ COMA Al Trafi v Any e Any AlllP Anytime Ignore Accept Normal Line...
=58 aaae mym K4 @ aazemy.. | Any All P Anytime lgnore Accept Normal Pip
=& Encrypt] ;ﬂ Any ter] Any SSL Anytime Ignore Accept MNormal Virtu.
[ Tetheri | Any (= \Any Tethering_TM |Anytime lgnore Accept MNormal Virtu...
=& Android # Any ter] Any Android Mar... Anytime Ignore Accept Narmal Virtu
=& Pandor| # Any ter] Any Pandora Anytime Ignore Accept MNormal Virtu.
[ Facebal | Any (= \Any Facebook G... Anytime lgnore Accept MNormal Virtu...
& Email ;ﬂ Any ter] Any Mail Anytime Ignore Accept MNormal Virtu.
-8 File Tra I} Any et ‘Any File Transfer |Anytime Ignore Accept MNormal Virtu..
[ Stream ] Any > Any Streaming_... Anytime lgnore Accept Normal Virtu...
& Stream ;ﬂ Any ter] Any Streaming A._|Anytime Ignore Accept MNormal Virtu.
[ Browsi | Any (= \Any \Web Applica... Anytime lgnore Accept MNormal Virtu...
& Fallbac & Any ey Any All Service Anytime lgnore Accept MNormal Virtu
51 agafmyme ﬂ @ aaaf mym.. |2 Any AllIP Anytime Ignore Accept Normal Pip
gl aaag.mym: | @ aaag.my.. [ Any AP Anytime Ignore Accept MNarmal Pip..
=) Fallback ;ﬂ Any ter] Any All Service Anytime Ignore Accept MNormal Pip
7\3 iﬁ Fallback # Any ter] ‘Any Al Service Anytime Ignore Accept MNormal Line..
= Fallback ] Any = Any All Service  |Anytime Ignore Accept Normal Pip.

Figure 6-1: Line/Pipe/Virtual Channel/Condition Relationship

NetXplorer searches the Enforcement Policy table from the top down. As soon as a Line
Condition is found to match the connection, NetXplorer looks at no more Lines. Within
the matched Line, as soon as a Pipe Condition is found to match the connection,
NetXplorer looks at no more Pipes. Similarly, within the matched Pipe, as soon a
Virtual Channel Condition is found to match the connection, NetEnforcer looks no
further.
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In short, the process of Condition matching is as follows:
e Find the Line Condition that the connection matches.

e Within that Line, find the Pipe Condition that the connection
matches.

e Within that Pipe, find the Virtual Channel Condition that the
connection matches.

Currently, only one Line is defined for each NetEnforcer, Fallback Line. All traffic for
the NetEnforcer matches the Fallback Line. A default Pipe is defined for each line,
Fallback Pipe. If a connection does not match the Conditions of any other Pipes, it
matches the Fallback Pipe. Furthermore, every Pipe includes a default Virtual Channel,
Fallback. If a connection does not match the Conditions of any other Virtual Channels
within a Pipe, it matches the Fallback Virtual Channel.

The Conditions of the Fallback Line, Fallback Pipe and Fallback Virtual Channels
cannot be deleted or modified. They allow all traffic to and from all hosts, all of the
time.

Actions of Fallback Lines, Pipes, and Virtual Channels can be changed, however. For
Pipes & Virtual Channels, all Actions can be changed. For Fallback Line, only the QoS
value can be changed.

Enforcement Policy Elements

Lines

A Line represents a physical or logical connection in the system. A Line provides a way
of classifying traffic that enables you to divide the total bandwidth and then manage
every Line as if it was an independent link. A Line consists of one or more sets of
Conditions and a set of actions that apply when any of the Conditions are met.

A Line can aggregate several Pipes, acting like a container of Pipes from a QoS point of
view. The Condition of the Fallback Line cannot be modified or deleted. A connection
coming into NetEnforcer is matched to a Line according to whether the characteristics
of the connection match any of the Conditions of the Line. The connection is then
further matched to the Conditions of a Pipe under the Line. The actions defined for the
Line influence all the Pipes under the Line. The actions defined for a Pipe are enforced
together with the actions of the Line.

NOTE When working with the AC-400 or AC-800 series NetEnforcers, no
conditions can be set at the line level. The action will be applied
when the conditions of the pipes beneath the line are met.
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Pipes

A Pipe provides a way of classifying traffic that enables you to divide the total
bandwidth and then manage every Pipe as if it was an independent link. A Pipe consists
of one or more sets of conditions (Conditions) and a set of actions that apply when any
of the Conditions are met. A Pipe can aggregate several Virtual Channels, acting like a
container of Virtual Channels from a QoS point of view. When you add a new Pipe, it
always includes at least one Virtual Channel, the Fallback Virtual Channel. The
Condition of the Fallback Virtual Channel cannot be modified or deleted. A connection
coming into NetXplorer is matched to a Pipe according to whether the characteristics of
the connection match any of the Conditions of the Pipe. The connection is then further
matched to the Conditions of a Virtual Channel under the Pipe. The actions defined for
the Pipe influence all the Virtual Channels under the Pipe. The actions defined for a
Virtual Channel are enforced together with the actions of the Pipe.

Virtual Channels

A Virtual Channel provides a way of classifying traffic and consists of one or more sets
of conditions (Conditions) and a set of actions that apply when any of the Conditions
are met. A Virtual Channel is defined within a Pipe. A connection matched to a Pipe is
further matched to a Virtual Channel according to whether the characteristics of the
connection match any of the Conditions of the Virtual Channel.

Conditions

Conditions can be defined at Line level, Pipe level or Virtual Channel level. NetXplorer
matches connections to Conditions, first at the Line level, then at the Pipe level and then
at Virtual Channel level within a Pipe.

e Alarms Assignment: Indicates if any alarms have been assigned to
that object.

e In Use: Enables or disables the relevant object.

e Internal: Defines the source of the traffic. For example, specific IPs,
MAC addresses, a range of IP addresses, IP Subnet addresses, or
host names. The default value is Any which covers traffic from any
source.

e Direction: The direction of the traffic between the selected source
and destination (bidirectional, 'Internal to External’, or 'External to
Internal’). The default value is bidirectional.

e External: Defines the destination of the traffic. For example,
specific IPs, MAC addresses, a range of IP addresses, IP Subnet
addresses, or host names. The default value is Any which covers
traffic to any destination.
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e Service: Defines the protocols relevant to a connection. Protocols
may be TCP and UDP IP type, non-TCP and non-UDP type or non-
IP type. TCP and UDP IP protocols are defined based on port type.
HTTP protocols may include content definitions, such as specific
Web directories, pages, or URL patterns. The default value is All
which covers all protocols.

e Time: Defines the time period during which the traffic is received.
For example daily between 8.00 AM and 6.00 PM, Sundays between
12.00 AM and 12.00 PM or on the 1% and 15" of the month. The
default value is Anytime which covers traffic at any time.

e Tethering: This condition does not appear by default and must be
added by right clicking in the Enforcement Policy Table, choosing
the Table Column Configuration... menu item and selecting the
Tethering checkbox. In addition, this option will only appear if
supported by the in-line platform and will be greyed out if the in-line
platform’s current license does not support tethering. If selected,
tethering appears as a column in the policy table with the following
three possible values for each Line, Pipe or VC: Yes i.e: if this traffic
is tethered, No i.e: if this traffic is not tethered or Ignore i.e: not a
condition

NOTE Tethering is supported in Asymmetric environments.

e ToS: Defines the ToS byte contained in the IP headers of the traffic.
The default value is Any which covers any ToS value.

e Encapsulation: Defines VLAN traffic classification according to
VLAN ID (VLAN Identifier) tags, consisting of 12 bits, and
according to tagging priority bits, consisting of three bits.
Alternatively can be used to classify by GRE tunnel.

e Interface: Defines the physical interface or group of interfaces on
the In-line platform.

When a new Line, Pipe or Virtual Channel is created, it is assigned a default Condition
with default values for each condition and you can modify these values as required.

The possible values for each condition are defined in the Catalog entries in the Catalog
Editors. A Catalog Editor enables you to give a logical name to a comprehensive set of
parameters (a Catalog entry). This logical name then becomes a possible value for a
condition. Catalog Editors are described in detail in Chapter 4, Defining Catalog
Entries.

TIP If you classify traffic by a specific connection source (Internal) or
connection destination (External), make sure your definition applies
to both directions, from the Source to the Destination and from the
Destination to the Source. For example, if you define HostName as
the Connection Source and Any as the Connection Destination, make
sure that the Condition is bi-directional, so that traffic from Any to
HostName is also covered.
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Actions

Lines, Pipes and Virtual Channels include a set of actions that is assigned to traffic once
it meets any of the Conditions defined for the Line, Pipe or Virtual Channel. Only
Quality of Service actions can be defined for a Line. There are six actions that can be
defined for a Pipe or Virtual Channel: Access Control, Quality of Service, ToS
Remarking, DoS, Connection Control and Quota.

The following action types are available, depending on the network element selected:

e Access: This action determines the access given to traffic. If the
Access Control for a Line, Pipe or Virtual Channel is specified as
Reject or Drop, all traffic meeting the Conditions of the Line, Pipe
or Virtual Channel is dropped and no other Quality of Service or
Connection Control actions are applied. If the Access Control for a
Line, Pipe or Virtual Channel is specified as Bypass all traffic
meeting the Conditions of the Line, Pipe or Virtual Channel is routed
to its destination but no Quality of Service is applied to it and it does
not appear in any monitoring graphs.

e Quality of Service: This action determines the QoS given to traffic.
The default Enhanced Quality of Service action for Lines, Pipes or
Virtual Channels is Normal Priority, which has Best Effort priority,
no bandwidth definitions, no ToS marking and no connection
limitations.

e ToS Remarking: The ToS is a byte in the IP header of a packet that
contains information about routing recommendations. NetEnforcer
classifies traffic based on the ToS byte marking contained in the IP
headers of the packets passing through it.

e DoS (Denial of Service): This action enables you to limit the
frequency and number of connections, thereby giving a level of
protection from attacks on the network resources (such as internally
connected servers). NetExplorer analyzes the distribution of traffic
across the various protocols and ports, and admits or drops excess
traffic when predefined thresholds have been exceeded.

e Service Activation: This action steers the traffic to a pre-defined
integrated service, Port or URL, when possible.

e Quota: This action imposes a volume or time-based limit on
subscriber activity. The quota may be daily or monthly.

The possible values for each type of action are defined in a Catalog entry in the Catalog
Editor. Catalog Editors are described in detail in Chapter 4, Defining Catalog Entries.
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Using Lines, Pipes, Virtual Channels and
Conditions

The following examples show how Lines, Pipes and Virtual Channels might be used:

e An Internet Service Provider sells slices of bandwidth to customers
(defined in a Pipe template), each based on the Quality of Service
granted to that category of customer (such as Gold, Silver and
Bronze customers).

e A university wants to control Internet traffic congestion across the
network involving students and faculty, in particular, to limit FTP
use and give preferential bandwidth allocation to faculty during
weekday hours. The university defines Virtual Channels for faculty
usage, student usage, and student usage during night hours. A further
Condition is then defined under the student usage Virtual Channel
that specifies a different service for students accessing FTP.

e An organization has several links to the Internet. Only one
NetEnforcer is required with Pipes defined for every link enabling
traffic to be managed on every link independently.

NetXplorer includes a default starting database that contains common types of traffic
written in sample Pipes, Virtual Channels and Conditions. You can edit, disable or
delete these as required.

Using Templates

Templates enable you to create a "master"” Pipe or Virtual Channel that upon saving will
create multiple Pipes or Virtual Channels very similar to each other. Templates work
with host entries defined in the Host Catalog. For example, if you had a Host Group
type entry in the Host Catalog called Gold Customers that consisted of Company X,
Company Y and Company Z, you could define a Pipe template to be expanded for Gold
Customers. This would result in Pipes being created for Company X, Company Y and
Company Z when the Enforcement Policy Editor is saved.

With Host List type entries, templates are only effective when the Host List entry
includes more than one host or IP address or a range of IP addresses. For example,
creating a Pipe template based on a Host List type entry that includes a range of IP
addresses generates a Pipe instance for each IP in the range.

Templates are defined in the process of inserting a Pipe or Virtual Channel. For further
details, refer to Defining Pipes, page 6-13.
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Order of Enforcement Policy Definitions

Lines, Pipes and Virtual Channels should be defined so that those that are more specific
are defined before those that are more general. This is because NetXplorer searches the
Enforcement Policy table from the top down. Thus as soon as a Line Condition is found
to match the connection, NetEnforcer stops looking at Lines. Similarly, within the
matched Line, as soon as a Pipe Condition is found to match the connection, NetXplorer
looks no further. For example, if you define a Virtual Channel that includes all HTML
(*.html) files, that Virtual Channel must come after a Virtual Channel with a Condition
that specifies a specific HTML file. Otherwise, NetXplorer will always arrive at the
general Condition first, assign the action defined in the Virtual Channel according to
that Condition, and not assign the action defined for the more specific Condition.

NetXplorer Enforcement Policy Editor

You set your QoS Enforcement Policy by defining Lines, Pipes and Virtual Channels in
the NetXplorer Enforcement Policy Editor.

To access the Enforcement Policy Editor:
1. From the View menu, select Enforcement Policy Editor.

OR

Click on the toolbar.
OR

Select and right-click a network element in the Network Tree and
select Enforcement Policy Editor from the popup menu.

The Enforcement Policy Editor is displayed:

MHE-Central x
Conditions Actions

Narmne Alarms InUse | Internal | Directi.. | Edternal | Serice | Time ToS VLAN | Access | Quality

El-§E Fallback [} Any ey Any All Service Anytime  |Any Ay Accept  [Line sp
EI 4= Fallback .ﬂ Ay ] Ay Al Bervice |Anytime  Any Ay Accept Marmal ...

{48 P2P Applications [} Any = Any F2F App.. [Anytirne  |Ary Any Accept  [Mormal
{8 valP iy # Ary = Ary WalP Anwtirme  |Any Ary Accept  |Mormal ...
-8 Weh Applications 7 Ay = Ay iieh App..|Anvtime  Any Ay Accept  |Mormal ...
--{d8 Streaming Applications [} Any ] Any Strearni.. [Anytirne  |Any Any Accept  [Normal ...
=& Instant Messaging 7 Ay = Ay Instant ... Anvtime  Anry Ay Accept  |Mormal ...

-8 Mail [} Any = Any Mail Anwtirme Ay Any Accept  [Normal
=& File Transfer A i} Aty e Aty File Tran... Anytime Ay Aty Accept  |Mormal .

--{d8 Network Operation [} Any = Any Network . [Anytirne  |Ary Any Accept  [Mormal
-4 Fallback .ﬂ Ay =] Ay Al Service Anvtime  Any Ay Accept Marmal ...

@ Folicy NE-Central

Figure 6-2: Enforcement Policy Editor
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2.  When the Enforcement Policy Editor is open and a Line, Pipe or Virtual
Channel is selected, a set of Quick Access icons appear on the menu bar.

3. The first Condition in the Enforcement Policy Table for any Line, Pipe or VC,
Alarms Assignment, indicates if there is currently an open alarm assigned to
that object. Double click in the Alarms Assignment field to add or edit the
Alarms Assignments for that object.

4. The second Condition for any Line, Pipe or VC, In Use, indicates if the object
is currently enabled. Double click in the field to enable or disable a Pipe or VC
(Lines cannot be disabled).

The Enforcement Policy Editor displays a tree-table of the Line, Pipes and Virtual
Channels currently defined in your NetXplorer. Each condition fragment in the line in
the table represents a single Condition. A Pipe can be defined by one of more
Conditions and can include one or more Virtual Channels. A Virtual Channel can be
defined by one or more Conditions.

There is always one default Line, called Fallback Line, in the Enforcement Policy
Editor. In addition, there is always one default Pipe, called Fallback Pipe. The
Conditions of the default Line and Pipe cannot be modified or deleted.

Every Pipe has a default Virtual Channel called Fallback. The conditions or Condition
of this default Virtual Channel cannot be modified or deleted, but you can delete the
Pipe entirely.

You can expand/collapse a NetEnforcer, Line, Pipes or Virtual Channels in the
Enforcement Policy Editor by clicking the # or = on the left of a Pipe or Virtual
Channel, or by pressing <Shift + right arrow> or <Shift + left arrow> on your keyboard.

Pipes or Virtual Channels may be moved up or down in the Enforcement Policy Editor
by right clicking on the entity you wish moved and selecting Move Up or Move Down
from the menu.

Relevant buttons to the object you have selected in the Enforcement Policy Editor
appear in the Quick Access Toolbar in the upper right hand corner of the GUI.
View Options

You can modify the Enforcement Policy Editor view by opting to hide or display the
available columns.

To customize the Enforcement Policy Editor view:

1. From the Actions menu, select Table Column Configuration.
The Enforcement Policy Columns Visibility dialog is now
displayed.

6-8
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Figure 6-3: Enforcement Policy Columns Visibility dialog

2. Select the checkboxes to the left of the columns you want to

display in the Enforcement Policy Editor.

3. Click Save.

Defining Enforcement Policy

The typical workflow for configuring your QoS Enforcement Policy is shown in the

following diagram:

NetXplorer Operation Guide
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Define Your Network
Reqmrements
< Define Lines >
< Define Pipes >
Gefine Virtual Channels>

Figure 6-4: Defining Enforcement Policy Workflow

Each step of the workflow is described in the following sections. You can also define
Pipes and Virtual Channels using templates.

Defining Your Network Requirements

Before defining Lines, Pipes or Virtual Channels, you must determine the type of traffic
flowing through your network. Using NetXplorer’s Monitoring functions (described in
Chapter 7, Monitoring Reports) you can determine your current network application
patterns, and define the necessary QoS classification and actions.

The following are examples of traffic patterns and required QoS Enforcement Policy:

e Applications on your network that you consider “mission-critical”
applications. These may be special applications that are time and/or
resource sensitive. You may want to provide increased bandwidth or
Server resources.

e Items on your network that you consider low priority. These may
include traffic that you consider non-time and/or response sensitive,
or applications that you wish to limit during busy hours, such as FTP
traffic.

e Applications that you do not want used on your network during
certain times, such as new file-sharing applications that enable
clients in your network to function as servers, thereby drastically
increasing outbound traffic volume.

e Background tasks that are important, but can be performed at a
slower rate. These may include email traffic or certain file transfers.

e Time-sensitive network applications. These may include streaming
applications such as real-time audio or video.

e Customers or groups of customers categorized into various “tiered”
levels. For example, you may wish to have Gold-level customers.

6-10
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Once you have classified your network traffic, you can define your QoS Enforcement
Policy.
Defining Lines

Each Line is defined by at least one Condition, and any traffic meeting those conditions
is channeled to that Line. The actions defined for the Line are then applied to the traffic.

NOTE Multiple lines are not supported by AC-1000 Series and AC-2500
Series models.

To add a Line:

1. Select a Line in the Enforcement Policy table and select Insert
Line from the Actions menu

OR

Select a Line in the Enforcement Policy table and click the Insert
Line icon on the Quick Access Toolbar.

OR

Right-click a Line in the Enforcement Policy table and select Insert
Line from the popup menu.

The Enforcement Policy tab of the Insert Line dialog is displayed.

Line Properties - Insert =]
Name

Description:

Policy | Alarm Assignments

Conditions
InUse Internal Direction  External Service Time Tos Encapsu... Quota Interface  Tethering Add.

ﬂ |Any ‘<‘F(> ‘Any ‘MI P |Anytime |\gnare ToS |\gnore | ‘Any |\gnore

Actions

Access: _l=(> Accept )
Quality of Service: % Normal Line QoS+
Service Activation: :@- MNone v:
ToS & 1gnore Tos -

DoS (% 1gnore dos =

Figure 6-5: Insert Line Dialog — Enforcement Policy Tab

A new Line is added above the selected Line. The new Line contains
a default Pipe (Fallback), and has default values for its Conditions
(conditions) and actions.
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2. Enter a new name for the Line, if required. Assigning a logical
name to the Line helps you to classify your traffic.

3. Modify the Conditions of the Line by double-clicking the cell in
the relevant column and selecting the required condition from the
dropdown list that is displayed.

NOTES You can view and edit all of the parameters of a Condition by

clicking Edit to display the Condition Properties dialog (
Conditions Properties - Add =]

InUse

Internal: 1= Any v

Direction: = Bidirectional -

External: = Any \

Service: i AlLIP =)

Time: D Anytime M

Tos: 38 1gnore Tos \

Encapsulation: _ch_' lgnore -]

Interface: \#J Any i

Tethering: .Ignore -

[ ok || cancel

Figure 6-12).

To remove a Condition from a rule, select the Condition in the
Conditions list and click Remove.

4. Modify the actions of the Line by selecting the required action
from the dropdown list for each of the actions as follows:

Access

Quality of
Service

Service
Activation

ToS
DoS

The access given to traffic. The default value is Accept

The quality of service applied to traffic given access. The QoS
determines priority, minimum and maximum bandwidth and
traffic-shaping techniques (CBT or Burst). The default value is
Normal Priority.

Sets if the connection should be passed as is, or steered to a
pre-defined integrated service, Port or URL, when possible.
The default is Pass As Is.

Sets the ToS Priority for the Line. The default is Any.

Sets the Denial of Service attack Enforcement Policy for the
Line. The default is Ignore DoS.

6-12
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5. Click OK to return to the Enforcement Policy Table.

6. Click 3 or select Save from the File menu to save the new Line.
TIP You can also add a new Line by copying and pasting an existing Line
and modifying its definition.
Defining Pipes

Each Pipe is defined by at least one Condition, and any traffic meeting those conditions
is channeled to that Pipe. The actions defined for the Pipe are then applied to the traffic.

To add a Pipe:

1. Select a Pipe in the Enforcement Policy table and select Insert
Pipe from the Actions menu

OR

Select a Pipe in the Enforcement Policy table and click the Insert
Pipe icon on the Quick Access Toolbar.

OR

Right-click a Pipe in the Enforcement Policy table and select Insert
Pipe from the popup menu.

The Enforcement Policy tab of the Insert Pipe dialog is displayed.

Pipe Propertics - Insert =]
Name: [ew Pipe]

Description:

Policy | Alarm Assignments

Conditions
InUse Internal Direction  External Semice Time ToS Encapsu... Quota Interface Tethering Add...

[l ‘A\ny ‘Cﬁ) |An~f ‘A\H P ‘Anylime |\gnore To2 ‘\gnme ‘ |An~f |Ignore

Actions

Access: = Accept -
Quality of Senvice: |G Normal Pipe QoS ~ |
Service Activation: |3 Mane -

Tos 22 1gnore Tos. -

DoS % 1gnore dos -

Figure 6-6: Insert Pipe Dialog — Enforcement Policy Tab

A new Pipe is added above the selected Pipe. The new Pipe contains
a default Virtual Channel (Fallback), and has default values for its
Conditions (conditions) and actions.
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2. Enter a new name for the Pipe, if required. Assigning a logical
name to the Pipe helps you to classify your traffic.

3. Modify the Conditions of the Pipe by double-clicking the cell in
the relevant column and selecting the required condition from the
dropdown list that is displayed.

NOTES You can view and edit all of the parameters of a Condition by

clicking Edit to display the Condition Properties dialog (
Conditions Properties - Add =]

InUse

Internal: 1= Any v

Direction: = Bidirectional -

External: = Any \

Service: i AlLIP =)

Time: D Anytime M

Tos: 38 1gnore Tos \

Encapsulation: _ch_' lgnore -]

Interface: \#J Any i

Tethering: .Ignore -

[ ok || cancel

Figure 6-12).

To remove a Condition from a Pipe, select the Condition in the
Conditions list and click Remove.

4. Modify the actions of the Pipe by selecting the required action
from the dropdown list for each of the actions as follows:

Access

Quality of
Service

Service
Activation

ToS
DoS

The access given to traffic. The default value is Accept

The quality of service applied to traffic given access. The QoS
determines priority, minimum and maximum bandwidth and
traffic-shaping techniques (CBT or Burst). The default value is
Normal Priority.

Sets if the connection should be passed as is, or steered to a
pre-defined integrated service, Port or URL, when possible.
The default is Pass As Is.

Sets the ToS Priority for the Pipe. The default is Any.

Sets the Denial of Service attack Enforcement Policy for the
Pipe. The default is Ignore DosS.

6-14

NetXplorer Operation Guide



Chapter 6: Defining Policies

5. Click OK to return to the Enforcement Policy Table.

6. Click = or select Save from the File menu to save the new Pipe.

TIP You can also add a new Pipe by copying and pasting an existing Pipe
and modifying its definition.

Adding Pipe Templates

Pipe templates enable you to automatically add instances of the same Pipe for each host
in a selected Host Catalog entry. This eliminates the need to define individual Pipes
when the only difference between them is the IP address in the source or destination.
Pipe templates are added at the same hierarchy level as Pipes.

To add a Pipe Template:

1. Select a Pipe in the Enforcement Policy table and select Insert
Pipe Template from the Actions menu

OR

Select a Pipe in the Enforcement Policy table and click the Insert
Pipe Template icon on the Quick Access Toolbar.

OR

Right-click a Pipe in the Enforcement Policy table and select Insert
Pipe Template from the popup menu.

The Enforcement Policy tab of the Insert Pipe Template dialog is
displayed.

Pipe Template Properties - Insert
Name [uew Pipe]

Description:

Policy | Alarm Assignments

Template Settings

g

Expand by: @ Internal () External

Conditions

In Use Internal Direction External Service Time TeS Encapsu.. Quota Interface Tethering

[ |Any |<‘;(> |Anv ‘AH P ‘Anytims ‘\gnnreToS ‘Ignnre ‘ ‘Anv |\gnnrs

Remaove

Actions

Access: = Accept )
Quality of Service: | @ Normal Pipe Qo8 ~ |
Senvice Activation: | None |
ToS -] lgnore To3 |

DoS: % Ignore dos -

Figure 6-7: Insert Pipe Template Dialog — Enforcement Policy
Tab
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A new Pipe Template is added above the selected Pipe. The new Pipe
Template contains a default Virtual Channel (Fallback), and has
default values for its Conditions (conditions) and actions.

2. Enter a new name for the Pipe Template, if required. Assigning a
logical name to the Pipe Template helps you to classify your
traffic.

3. Inthe Template Settings area, you may decide if the Template
instances will expand as Internally or Externally.

Select Internal if you wish a new instance to be generated for
each new Internal connection (default).

Select External if you wish a new instance to be generated for
each External connection.

4. Modify the Conditions of the Pipe Template by double-clicking
the cell in the relevant column and selecting the required condition
from the dropdown list that is displayed.

NOTE You can view and edit all of the parameters of a Condition by
clicking Edit to display the Condition Properties dialog (
Conditions Properties - Add =]
InUse
Internal: = Any d
Direction: &= Bidirectional -
External: = Any M
Senvice: 5 AlLIP x|
Time: 3 Anytime \d
Tos: 2 1gnore Tos d
Encapsulation: | Ignore ~
Interface: {,5';1, Any x|
Tethering: Ignore -
[ ok ][ cancel
Figure 6-12).

There is one and only one rule in atemplate. The user cannot add
additional ones.

5. Modify the actions of the Pipe Template by selecting the required
action from the dropdown list for each of the actions as follows:

Access The access given to traffic. The default value is Accept
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Quality of
Service

Service
Activation

ToS
DoS

The quality of service applied to traffic given access. The QoS
determines priority, minimum and maximum bandwidth and
traffic-shaping techniques (CBT or Burst). The default value is
Normal Priority.

Sets if the connection should be passed as is, or steered to a
pre-defined integrated service, Port or URL, when possible.
The default is Pass As Is.

Sets the ToS Priority for the traffic. The default is Any.

Sets the Denial of Service attack Enforcement Policy. The
default is Ignore DoS.

6. Click OK to return to the Enforcement Policy Table.

7. Click 3 or select Save from the File menu to save the new Pipe.

NOTE When adding a Pipe Template, Pipes identical to the Pipe Template
but with a different Connection Source or Connection Destination are
created for every member of the selected Host Catalog entry upon
saving the Enforcement Policy Editor. These Pipes are not displayed
in the Enforcement Policy table. A Pipe Template is represented by

the & icon.

Adding Pipe Service Plan Templates

NOTE Service Plans are only available to those users with the Subscriber
Management Platform (SMP) installed and the appropriate license
key entered to enable the feature.

Pipe service plan templates enable you to automatically add the same Service Plan to
instances of the same Pipe for each host in a selected Host Catalog entry.

To add a Pipe Service Plan Template:

1. Select a Pipe in the Enforcement Policy table and select Insert
Pipe Service Plan Template from the Actions menu

OR

Select a Pipe in the Enforcement Policy table and click the Insert
Pipe Service Plan Template icon on the Quick Access Toolbar.

OR

Right-click a Pipe in the Enforcement Policy table and select Insert
Pipe Service Plan Template from the popup menu.

The Pipe Service Plan Properties - Insert dialog is displayed.

NetXplorer Operation Guide
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(D Pipe Service Plan Properties - Insert

Pipe Service Plan Catalog Entry: gBIock Service Plan :_|

Description:

Figure 6-8: Pipe Service Plan Properties — Insert Dialog

2. Select the pre-existing Service Plan to be used for the template
from the drop down menu. Service plans may be created in the
Service Plan catalog.

3. Enter a description of the template, if relevant.

4. Click OK to return to the Enforcement Policy Table.

5. Click = or select Save from the File menu to save the new Pipe.

Defining Virtual Channels

A Virtual Channel is added to a Pipe. A Virtual Channel is defined by at least one
Condition and any traffic meeting those conditions is channeled to that Virtual Channel.
The actions defined for the Virtual Channel are then applied to the traffic.

In addition, Virtual Channel templates enable you to automatically add instances of the
same Virtual Channel for each host in a selected Host Catalog entry. This eliminates the
need to define individual Virtual Channels when the only difference between them is
the IP address in the source or destination. Virtual Channel templates are added at the
same hierarchy level as Virtual Channels.

NOTE The actions of the Pipe influence all the Virtual Channels under that
Pipe and are enforced together with the Virtual Channel's actions on
every connection that is matched to the Pipe.

To add a Virtual Channel:
1. Select a Virtual Channel in the Enforcement Policy table and
select Insert Virtual Channel from the Actions menu
OR
Select a Virtual Channel in the Enforcement Policy table and click
the Insert Virtual Channel icon on the Quick Access Toolbar.
OR
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Right-click a Virtual Channel in the Enforcement Policy table and
select Insert Virtual Channel from the popup menu.

The Enforcement Policy tab of the Virtual Channels Properties dialog
is displayed.

Virtual Channel Properties - Insert [=]
Name

Description:

Policy | Alarm Assignments

Conditions

InUse Internal Direction  External Service Time To3 Encapsu... Quota Interface Tethering Add...

# ‘Any’ |<2:(> ‘Any’ |NI P ‘Any‘hme |\gnnrs ToS ‘Ignnre | |Any |Ignnre
Actions

Access: = Accept -

Quality of Service: | Normal Virlual Channel QoS ~
Senvice Activation: | & None ~

Tos: -] Ignore ToS -

Dos: "¢ Ignore dos -

Figure 6-9: Virtual Channel Properties Dialog

A new Virtual Channel is added to the selected Pipe, or to the Pipe to which
the selected Virtual Channel belongs. The new Virtual Channel has default
values for its Conditions and actions.

2. Enter a new name for the Virtual Channel, if required. Assigning a
logical name to the Virtual Channel helps you to classify your
traffic.

3. Modify the Condition of the Virtual Channel in the same way as
for a Pipe, as described on page 6-14.

4. Modify the actions of the Virtual Channel in the same way as for a
Pipe, as described on page 6-14.

5. Configure the template settings for the Virtual Channel in the same
way as for a Pipe.

6. Click |3 to save the new Virtual Channel.
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NOTE If you add a Virtual Channel template, Virtual Channels identical to
the Virtual Channel template but with a different Connection Source
or Connection Destination are created for every member of the
selected Host Catalog entry upon saving the Enforcement Policy
Editor. These Virtual Channels are not displayed in the Enforccent

Policy table. A Virtual Channel template is represented by the
icon.

TIP You can also add a new Virtual Channel by copying and pasting an
existing Virtual Channel and modifying its definition.

Adding Virtual Channel Templates

Virtual Channel templates enable you to automatically add instances of the same Virtual
Channel for each host in a selected Host Catalog entry. This eliminates the need to
define individual Virtual Channels when the only difference between them is the IP
address in the source or destination. Virtual Channel templates are added at the same
hierarchy level as Virtual Channels.

To add a Virtual Channel Template:

1. Select a Virtual Channel in the Enforcement Policy table and
select Insert Virtual Channel Template from the Actions menu

OR

Select a Virtual Channel in the Enforcement Policy table and click
the Insert Virtual Channel Template icon on the Quick Access
Toolbar.

OR

Right-click a Virtual Channel in the Enforcement Policy table and
select Insert Virtual Channel Template from the popup menu.

The Enforcement Policy tab of the Virtual Channels Template
Properties dialog is displayed.
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Virtual Channel Template Properties - Insert
Name rew v

Description:

Policy | Alarm Assignments

M= |

Template Settings

Expand by: @ Internal ) External

Conditions

In Use Internal Direction  External Semice Time Tos Encapsu... Quota Interface Tethering Add.

i |Any |<‘F(> |Any |AIHF' ‘Anvtime ‘\gnareToS ‘\gnare ‘J\nv |\gnore r—
Remove

Actions

Access = Accept ~

Quality of Senvice: |l Normal Virual Channel QoS ~

Senvice Activation: | & None e

ToS 38 Ignore Tos -

DoS: %E Ignore dos -

Figure 6-10: Virtual Channel Template Properties Dialog
A new Virtual Channel is added to the selected Pipe, or to the Pipe to which

the selected Virtual Channel belongs. The new Virtual Channel has default

values for its Conditions and actions.

2. Enter a new name for the Virtual Channel, if required. Assigning a
logical name to the Virtual Channel helps you to classify your

traffic.

3. Inthe Template Settings area, you may decide if the Template

instances will expand as Internally or Externally.

Select Internal if you wish a new instance to be generated for

each new Internal connection (default).

Select External if you wish a new instance to be generated for

each External connection.

4. Modify the Condition of the Virtual Channel Template in the same

way as for a Pipe, as described on page 6-15.

5. Modify the actions of the Virtual Channel in the same way as for a

Pipe, as described on page 6-14.

6. Configure the template settings for the Virtual Channel in the same

way as for a pipe, as described on page 6-15.

7. Click E to save the new Virtual Channel.
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NOTE

NOTE

When adding a Virtual Channel template, Virtual Channels identical
to the Virtual Channel template but with a different Connection
Source or Connection Destination are created for every member of
the selected Host Catalog entry upon saving the Enforcement Policy
Editor. These Virtual Channels are not displayed in the Enforccent

Policy table. A Virtual Channel template is represented by the
icon.

Adding Virtual Channel Service Plan Templates

Service Plans are only available to those users with the Subscriber
Management Platform (SMP) installed and the appropriate license
key entered to enable the feature.

Virtual Channel service plan templates enable you to automatically add the same
Service Plan to instances of the same VC for each host in a selected Host Catalog entry.

To add a VC Service Plan Template:

1. Select a VC in the Enforcement Policy table and select Insert
Virtual Channel Service Plan Template from the Actions menu

OR

Select a Pipe in the Enforcement Policy table and click the Insert
Virtual Channel Service Plan Template icon on the Quick
Access Toolbar.

OR

Right-click a Pipe in the Enforcement Policy table and select Insert
Virtual Channel Service Plan Template from the popup menu.

The Virtual Channel Service Plan Properties - Insert dialog is
displayed.

Q Virtual Channel Service Plan Properties - Insert

Virtual Channel Service Plan Catalog Entry: iBlock Service Plan ﬂ

Desctiption:

[ OK H Cancel ]

Figure 6-11: Virtual Channel Service Plan Properties — Insert
Dialog

2. Select the pre-existing Service Plan to be used for the template
from the drop down menu. Service plans may be created in the
Service Plan catalog.

3. Enter a description of the template, if relevant.

4. Click OK to return to the Enforcement Policy Table.
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5. Click I3 or select Save from the File menu to save the new
Virtual Channel.

Adding Conditions

When traffic meets a Condition, it is assigned to that Condition. The actions assigned to
the traffic are the actions defined for the rule — Line, Pipe or Virtual Channel — to
which the Condition belongs.

To add a Condition:

1. Add a Condition in one of the following ways:

e Select a Pipe or Virtual Channel in the Enforcement Policy table and
from the Actions menu, select Properties.

e Right-click a Pipe, Virtual Channel or Condition in the Enforcement
Policy table and select Properties from the popup menu.

The Conditions Properties dialog is displayed.

2. Toadd a Condition, click Add in the Conditions area. The
Condition Properties dialog is displayed.

Cenditions Properties - Add =]
#InUse
Internal: = Any =
Direction: <= Bidirectional -
External: =] Any -
Service: =y AllIP hd
Time: 3 Anytime =
Tos: b= Ignore ToS w7
Encapsulation: | FZ Ignore -
Interface: {74 Any -
Tethering: lgnore -
’ OK ] | Cancel |

Figure 6-12: Condition Properties Dialog
3. Configure the following parameters:

In Use The status of the Condition. The Condition is enabled when
the checkbox is selected.

NetXplorer Operation Guide 6-23



Chapter 6: Defining Policies

Internal

Direction

External

Service

Time
ToS

Encapsulation

Interface

Tethering

The source of the connection. The default value is Any.

NOTE When creating a template based on an
internal Host entry, the value of the Internal
Condition cannot be set to Any.

The direction of the traffic between the selected source and
destination (bidirectional or unidirectional). The default value

is bidirectional, .
The destination of the connection. The default value is Any.

NOTE When creating a template based on an
internal Host entry, the value of the External
Condition cannot be set to Any.

The protocol relevant to a connection. The default value is All
Service.

The time of the connection The default value is Anytime.
The ToS marking of the connection. The default value is Any.

The VLAN or GRE encapsulation value used. The default
value is Ignore.

The physical interface via which the connection enters/leaves
the in-line platform

Whether or not the connection originates from a tethered
mobile device

4. Click OK. A new Condition is added to the selected Pipe or
Virtual Channel, or to the Pipe or Virtual Channel to which the
selected Condition belongs.

5. Specify the conditions for the Condition in the same way as for a
Pipe, as described on page 6-14.

Enforcement Policy Table Order

You should define Lines, Pipes and Virtual Channels so that those that are more specific
are defined before those that are more general. Similarly, the Conditions defined for a
Line, Pipe or Virtual Channel should follow this order. This is because NetXplorer
searches the Enforcement Policy table from the top down. Thus as soon as a Pipe
Condition is found to match the connection, NetXplorer looks at no more Pipes.
Similarly, within the matched Pipe, as soon a Virtual Channel Condition is found to
match the connection, NetXplorer looks no further.

Using cut and paste or by using the up/down buttons, you can change the order of the
Enforcement Policy table, as follows:
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e Change the order of Pipes within the Enforcement Policy table
e Change the order of Virtual Channels within Pipes
e Change the order of Conditions within Pipes or Virtual Channels
You cannot change the position of Lines, Fallback Lines, Fallback Pipes or Fallback

Virtual Channels. The Fallback Pipe is always at the bottom of the Enforcement Policy
table and the Fallback Virtual Channel is always the last Virtual Channel in a Pipe.

Copying a Enforcement Policy Element

You can apply the same Enforcement Policy element to more than one NetEnforcer by
copying and pasting the Enforcement Policy from one NetEnforcer to another.
Similarly, you can copy Virtual Channel policies from one pipe to another, in the same
NetEnforcer or across NetEnforcers.

Copying a Enforcement Policy entity copies item all of its subentities as well. For
example, if you copy a Pipe, the Pipe is copied together with any associated Virtual
Channels.

To copy a Enforcement Policy:

1. Inthe Enforcement Policy Editor, right-click the Enforcement
Policy (Pipe, or Virtual Channel) to be duplicated and select Copy
from the popup menu,

OR

Select the Enforcement Policy in the Enforcement Policy Editor and
select Copy from the Edit menu.

2. Select the NetEnforcer, Line or Pipe to which you want to copy the
Enforcement Policy and select Enforcement Policy Editor from

the View menu or click on the toolbar.

3. Right-click the component in the tree in the Enforcement Policy
Editor and select Paste from the popup menu or select Paste from
the Edit menu. The Properties dialog for the selected Enforcement
Policy is displayed.

4. Click OK to save the Enforcement Policy with the identical
parameters,

OR

Edit the Enforcement Policy parameters, as required, and then click
OK to save the Enforcement Policy.

NOTE The name of the Enforcement Policy must be unique within any given
branch of the Network tree.
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NOTE

NOTE

Enforcement Policy Distribution

Using the Enforcement Policy Distribution feature it is possible to update the policies of
one unit and then distribute the new policies to other NetEnforcer or Service Gateway

units on the Network. All NetEnforcers must be of the same Series and running the
same major software version.

To distribute policies

1.

In the Navigation pane, right-click a NetEnforcer or Service
Gateway in the Navigation tree and select Enforcement Policy
Distribution from the popup menu.

OR

Select a NetEnforcer in the Navigation tree and then select Enforcement
Policy Distribution from the View menu.

The NetEnforcer selected in the Navigation Pane will serve as the

source NetEnforcer. Its Enforcement Policy table will be distributed
to other NetEnforcers.

The Enforcement Policy Distribution dialog is displayed.
1 poly Dbt I

Sour

x|

404_ITAI222
Series & SMW Version AC-400 series, Version: E7.3

wribution  NetEnforcer Time | Messal ge

404Alex

Figure 6-13: Enforcement Policy Distribution Dialog

The Targets list will populate with all NetEnforcers on the
network that policies can be distributed to. Each relevant
NetEnforcer is listed by name, with the time it received the new
policies and any system messages.

Policies can only be distributed to NetEnforcers from the same
series, running the same software version.

3.

Click the Distribute checkbox to include that NetEnforcer in the
distribution or select a NetEnforcer and use the Check and
Uncheck buttons.

Select a NetEnforcer and click Up or Down to change its location
in the distribution order.
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5.

NOTE

Select a NetEnforcer and click Remove to delete the NetEnforcer
from the targets list or Clear Messages to delete any system
messages.

Select the Abort on First Error checkbox to instruct NetXplorer
to cancel the entire Enforcement Policy Distribution operation on
the first error.

Click Distribute to distribute the Enforcement Policy Table of the
source NetEnforcer to all selected NetEnforcers. The Enforcement
Policy Tables of the NetEnforcers selected will be overwritten in
order, starting at the top of the list.

Click Abort at any time to stop the process or Print to print the
Results list.

Aborting the distribution will not roll back the Enforcement Policy

Catalogs of any NetEnforcers already overwritten.

9.

Click Close to close the Enforcement Policy Distribution dialog
box.

Restore Enforcement Policy and Catalogs

Using the Restore Enforcement Policy and Catalog feature it is possible to restore the
saved image of the Enforcement Policy Table and catalogs which is stored on each
NetEnforcer or Service Gateway and updated periodically. This feature should be used
if a NetEnforcer or Service Gateway becomes corrupted or its policies and catalogs
become damaged, requiring a roll back to a previous, working configuration.

To restore policies and catalogs:

1.

Select Restore Enforcement Policy and Catalogs from the Tools
menu.

The Restore Enforcement Policy and Catalogs dialog is displayed.
40 Restore Policy and Catalogs @V

Restore NetEnforcer Time Message
] 1050.7.100 |

Check
Uncheck

[¥] Abort on First Error

LastMessage:

C e ) oo )

Figure 6-14: Restore Enforcement Policy and Catalogs Dialog
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NOTE

2.

The NetEnforcer Devices list will populate with all NetEnforcers
and Service Gateways on the network. Each relevant NetEnforcer
or Service Gateway is listed by name, with the time it received the
new policies and any system messages.

Click the Restore checkbox to include that NetEnforcer or
Service Gateway in the restoration or select a NetEnforcer or
Service Gateway and use the Check and Uncheck buttons.

Select a NetEnforcer or Service Gateway and click Up or Down
to change its location in the distribution order.

Select a NetEnforcer or Service Gateway and click Remove to
delete the NetEnforcer or Service Gateway from the list or Clear
Messages to delete any system messages.

Select the Abort on First Error checkbox to instruct NetXplorer
to cancel the entire Enforcement Policy Distribution operation on
the first error.

Click Restore to restore the saved Enforcement Policy table and
catalogs to each device. The NetEnforcers or Service Gateways
selected will be restored in order, starting at the top of the list.

Click Abort at any time to stop the process or Print to print the
Results list.

Aborting the restoration will not roll back the Enforcement Policy
Tables or Catalogs of any devices already overwritten.

9.

Click Close to close the Restore Enforcement Policy and Catalogs
dialog box.

NetXplorer Charging Policy

Overview

NOTE All Charging Policies require the Subscriber Management Platform
and a specific ChargeSmart license. For further information, please
contact Allot Customer Support at support@allot.com.

NetXplorer enables you to classify two different sorts of Charging Policies: Online and

Offline.
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e An Online Charging Policy provides online (or real-time)
credit control and quota management for subscriber data
sessions. Quota management in this situation may include
multiple data sessions where the subscriber's usage and
remaining quota balance is monitored. Online Charging
Policies may be used to support Enforcement Policies for both
pre-paid and post-paid subscribers.

¢ An Offline Charging Policy uses charging data in the form of
Charging Data Records (CDRs) and diameter accounting
messages about services the subscriber has already used. An
Offline Charging Policy does not have an active, real-time
role in the processing of charges.

Each Online or Offline Charging Policy is made up of Rules. Each Rule is connected to
a Service Plan and includes a Charging Plan.

Charging Policies are defined using the Online and Offline Charging Policy Editors.

For more information about defining Charging Policies in NetXplorer, see the SMP
User Guide.

Online Charging Poli X
| Conditions Adtions
Name [ Description | Senvice Plan | Charging Plan

& Rulet gold = plan2

& Fallback Fallback rule Any & No-Plan

{5 Catalog: Charging Plan| [ Online Charging Policy

Figure 6-15: Online Charging Policy Editor

NetXplorer Charging Policy Editors

You set your Charging Policy by using either the Online Charging Policy Editor or the
Offline Charging Policy Editor.

To access the Online/Offline Charging Policy Editors:

1. From the View menu, select Online Charging Policy or Offline
Charging Policy.

OR
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Cli‘@ E on the toolbar to open the Online Charging Policy Editor

or to open the Offline Charging Policy Editor.
OR

Select and right-click a network element in the Network Tree and
select Online Charging Policy or Offline Charging Policy from the
popup menu.

The Online or Offline Charging Policy Editor is displayed:

ging Poli
| Conditions Actions
I Name Description Service Plan Charging Plan I

& Fallback Fallback rule Any & No-Plan

& Catalog: Charging Plan | %3 Online Charging Policy| [# offine Charging Policy

Figure 6-16: Offline Charging Policy Editor

2. Each Charging Policy is made up of a series of Rules. Each Rule connects a
Charging Plan to a Service Plan and they are triggered in order starting from
the top of the table.

3. There is always one default Rule, called Fallback, in a Charging
Policy Editor. The Fallback rule is configured by default with Any
Service Plan and No-Plan Charging Plan. The Charging Plan may
be changed, but not the Service Plan so as to ensure that all
subscribers fall into a Rule in the Charging Policy.

4. When a Charging Policy Editor is open a set of Quick Access
icons appear on the menu bar which allow you to insert Rules and
moves Rules up and down.

To add a Rule to a Charging Policy:

1. Select a Rule in the Charging Policy Editor and select Insert Rule
from the Actions menu

OR

Select a Rule in the Charging Policy Editor and click the Insert
Rule icon on the Quick Access Toolbar.
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OR

Right-click a Rule in the Charging Policy table and select Insert
Rule from the popup menu.

The New Charging Policy Rule dialog is displayed.

New Charging Policy Rule =

Name: New Rule

Description:

Conditions
Senvice Plan

1G Any

5 Block Senvice Plan
&E bronze

% Default Senvice Plan
k& gold

k£ silver

4G Unlimited Service Plan

Actions

Charging Plan: [E5 No-Plan _'J

Figure 6-17: New Charging Policy Rule Dialog
2. Enter a name and description (if required) for the Rule.

3. Select a pre-defined Service Plan for the Rule in the Conditions
area. Service Plans are defined in the Service Plan catalog.

4. Select a pre-defined Charging Plan for the Rule in the Actions
area. Charging Plans are defined in the Charging Plan catalog.

5. Click Save.
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Overview

NetXplorer enables you to not only monitor the state of the system, but also to receive
alarms when certain thresholds and conditions are met.

NetXplorer includes a pre-defined list of events that are recorded in the Events Log and
can be used to monitor the occurrence of system events in the Network. You can view
the events for specific devices in the Events Log or you can configure specific events to
generate alarms that are displayed in the Alarms Log,

In addition, user-defined alarms can be configured so that an alarm is sent to help you
identify excessive connections or abnormal behavior on a Line, Pipe or Virtual Channel.
For example, you can set an alarm to identify when the bandwidth for a particular
link/customer is close to reaching its maximum. In order for a user defined alarm
definition to generate an alarm, it must first be assigned to a specific NetEnforcer or
Service Gateway, Line, Pipe or Virtual Channel in the Network. User-defined alarms
are displayed in the Alarms Log. For details on configuring alarms, refer to Configuring
User-defined Alarms on page 7-8.

The Alarms Log is displayed in the Logs Pane and provides a list of all open alarms
generated by the system (user-defined and event-based). An alarm remains open until
the condition that generated it is no longer valid or until it is manually removed by an
operator. For details on managing alarms, refer to Managing Alarms on page 7-22.

Alarm Object Indicators

In the Network tab of the Navigation Pane, the severity of the most serious alarm for a
system component) is indicated on a network object by the addition of a color-coded
alarm icon on the lower right portion of the device icon (Warning: gray; Minor: blue;
Major: yellow; Critical: red). For example, =3, indicates that a major alarm has
occurred on the NetEnforcer or Service Gateway.

Accessibility problems are indicated by the addition of an icon in the upper right portion
of the device icon. For example, = , indicates that the NetEnforcer or Service Gateway
is not accessible.

The populated severity of alarms for a system component or one of its sub elements is
indicated by the addition of a color-coded alarm icon on the upper left portion of the
device icon (Warning: gray; Minor: blue; Major: yellow; Critical: red). For example,
9';, indicates a critical alarm is open for one at least one of the subelements in the
network.
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Navigation Pane

It is easy to review current Alarm settings by opening the Alarms/Events pane in the
Navigation Pane.

Events/Alarms
LA Alarms
Q Alarm Definition

(> Alarm Action Definition

' @ Event Types Configuration

j Metwork
@ Catalogs
Reports

ﬁd Groups
a MPP Accounts
Figure 7-1: Events/Alarms Pane

From the Events/Alarms pane it is possible to review, configure and add and delete
Alarm Definitions, Alarm Action Definitions and Event Types.

Configuring Alarms, Traps and Actions
on Events

Events are specific occurrences that are recorded for network elements.
NetXplorer is provided with a set of pre-defined events. All events are
automatically logged by the system and can be viewed in the Events Log. In
addition, if an event is configured to trigger an alarm, the event alarm is
displayed in the Alarms Log.

NetXplorer is provided with predefined Event Types. You can configure the event to
trigger an alarm and set the severity of the alarm that is generated. The resulting alarms
are displayed in Alarms Log.

To configure an event alarm, trap or action:

1. Select Events/Alarms in the Navigation pane, and then select
Event Types Configuration in the navigation tree,
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OR

From the View menu, select Alarms| Event Types
Configuration,

OR

On the toolbar, click the Alarms icon and select Event Types
Configuration from the popup menu.

The Event Types Configuration application is displayed.

Event Types Configuration
Event Type Name [ Severity | Alarmable | External Trap J Action

Device Configuration [ID=3] 2 Info O O "_‘;
Line Policy Change [ID=4] 2 Info O O

Pipe Policy Change [ID=5] 2 Info O B

Virtual Channel Policy Change [ID=6] J Info Y O O

Catalog Entry Change [ID=7] J Info ] 0

Link Down [ID=14] 2 Major 4

Cold Start ID=16] J Info O O

NetEnforcer IP Address Change [ID=19] 2 Info O O

Device Status Down [ID=21] 2 Major a

Server Unreachable [ID=100] @ Critical 4

Device Unreachable [ID=102] @ Critical a

Device Hardware Change [ID=107] 2 Info O O

Asymmetric remote device configuration changed ID=142] ) Major (] 0

Asymmetric remote device HealthCheckStatus changed [ID... ) Major a 4] ]

Blacklist server status up [ID=146] ) Cleared O O

Blacklist server down [ID=147] 2 Major 4 O

Collector Reported Device Unreachable ID=200] @ Critical a

Long Term Collector Reported Short Term Collector Unreac... @ Critical Pry

SMP provision error trap ID=404] 2 Major O O

SMP multi fail trap ID=405] 2 Major O O

SMP high availahility trap ID=406] 2 Major O O

SMP system trap ID=407) 2 Major O O

Disk Storage trap [ID=500] 2 Major 4 ™ .4 [v]
{ Actions on Alarms ]
‘ No Event Type selected

Figure 7-2: Event Types Configuration

2. Set the severity of a specific alarm type by selecting the required
level from the Severity dropdown list.

3. Configure an event to generate or not generate an alarm by
selecting or clearing the Alarmable dropdown list as required.

4. Select the External Trap checkbox for any event you wish to send
a trap to an external NMS Server (see page 3-14).

5. Select the Action checkbox for any event you wish to trigger a
script action. Configure the script action by right clicking the event
and selecting New Alarm Action Definition from the drop down
menu.

The Action Alarm Definition Entry Properties dialog opens.
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Alarm Action Definition Entry Properties =]
Name: New Alarm Action Definition

Description:

Action When Alarm Occurs: | ScriptAction v

Alarm Script Path:

Cancel Alarm Script Path:

Figure 7-3: Action Alarm Definition Entry Properties

6. Edit the name and description of the entry in the relevant fields, if
required.

7. Inthe Action When Alarm Occurs dropdown list, the only option
available here is Script Action which runs a predefined Script
when the Alarm triggers.

NOTE To configure an alarm to send an email as its action, see Defining an
Alarm Action Definition on page 7-14.

8. Enter an Event Script Path which points to the alarm script in the
relevant fields.

9. Click Save to save the alarm action entry.

Once assigned, the action will appear in the Action on Alarm field
at the bottom of the Event Type Configuration window when the
relevant event is selected. An alarm action can be deleted, edited
and copy/pasted to another event.

10. From the File menu, select Save or click Save & on the toolbar to
save the new configuration.

NOTE: The NetXplorer sends device ID, line ID, pipe ID, VC ID and Mediator
Device (SMP/STC) ID for use in the script. The parameters are sent in
the order and format shown below:

DEV_ID:<id> LINE_ID:<id> PIPE_ID:<id> VC_ID:<id> MD_ID:<id>

In case a particular parameter is not defined, a value of “none” will be
returned. So an example of the parameters sent might be:

DEV_ID:16 LINE_ID:1 PIPE_ID:6 VC_ID:0 MD_ID:none
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Viewing Events

You can view the events log entries for a specific network component.

To view event log entries:

1.

2.

In the Navigation pane, right-click the network component in the
Navigation tree and select Events from the popup menu.

OR

Select the network component in the Navigation tree and then select Events
from the View menu.

OR

Select the network component in the Navigation tree and then click the Events
icon % on the toolbar.

The Events Date Coverage dialog is displayed.

G N
Events Date Coverage @

® Sho

115 || days e

From DatefTime To DatelTime

3 Bune 22, 2006 2
= =
£

12:00 AM s 11:18PM

v

(O Show Events in Range:
June 22, 2006

Figure 7-4: Events Date Coverage

To view events from the current time and earlier, select the Show
Events for Last radio button. Then enter the relevant quantity of
time and select the unit of time (weeks, days, hours, minutes) in
the designated fields.

OR

To set a definite starting and end point for events, select the Show Events in
Range radio button. Then enter the relevant dates and times in the From
Date/Time and To Date/Time areas.

Click OK. The events for the designated time period are displayed
in the Application Details pane.
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Ahal60
| D Date Time Severity Type Category Description

340 Jun12,2.. 3:04:05 PM ) Cleared Device Reachabl... Application se... AllotAlpha199.203.223.2  isreacha...
13399 Jun12,2.. 3:03:39 PM () Info NetEnforcer Conf... Application se... NetEnforcer configuration imported fr...
3397 Jun12, 2., 3:03:38 PM ) Info Cold Start [I[D=16] Device configu... Cold Start

3396 Jun12,2.. 3:02:20 PM @ Critical Device Unreacha... Application se... AllotAlpha199.203.223.2  is unreac...
13275 Jun11,2.. 4:15:20PM ) Cleared LinkUp [ID=15]  Device configu... Link EXTERNAL is up: admin status i...
13273 Jun11,2.. 4:15:18 PM () Info MNetEnfarcer Conf... Application se... NetEnforcer configuration imported fr...
3274 Jun11,2.. 41518 PM ) Cleared Link Up [ID=15] Device configu... Link INTERNAL is up: admin status i...
3269 Jun11, 2. 41517 PM ) Info Cold Start [ID=16] Device configu... Cold Start

13270 Junt1,2.. 41517 PM ) Cleared Automatic Alarm ... Application se... Automatic Alarm purge performed by ..
13271 Jun11,2.. 41514 PM ) Major Link Down [ID=14] Device configu... Link INTERNAL is down: admin statu...
3272 Jun11, 2. 4:15:14 PM ) Major Link Down [ID=14] Device configu... Link EXTERNAL is down: admin stat...
3244 Jun11,2.. 4:06:07 PM ) Info MNetEnfarcer Conf... Application se... NetEnforcer configuration imported fr...
13243 Jun 11, 2. 3:54:07 PM " Major External Data So... Security Data Source in 199.203.223.2 isd..

4 Alarms Event Types Configuration| () Events AllotAlphal 99.203.223.2

Figure 7-5: Sample Events Log

Events Log Toolbar Options

The following icons are added to the NetXplorer toolbar when you click in the
Events Log.

Button Description

U4 start of Navigates to the first page of the Events Log.

Events

D

Page Events  Navigates to the previous page.

Backward

&)

Page Events  Navigates to the next page.

Forward
M End of Navigates to last page of the Events Log
Events
@ Find Enables you to search for events according to the content
included in a specific parameter. Refer to Searching for
Alarms, page 7-21.
27 sort Enables you to sort the alarms in the Alarms Log according to

the headers in the log. Refer to Sorting Alarms, page 7-18.

Enables you to redefine the range of time for the events
displayed.

Events Date
Coverage
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Sorting Events

You can sort the events in the Events Log according to the headers in the log
(date, time, type category, description, and so on).

To sort the events in the Events Log:

1. Click the header according to which you want to sort the events.
OR

Right-click in the Events Log and select Sort from the popup menu.
OR

Click "~ on the toolbar. Then select the header from the submenu.

2. The events are sorted according to the selected header.

Searching for Events

You can search for events in the Events Log according to the headers in the
log (ID, Date, Time, Severity, Type, Category, and Description).

To find an event:

1. From the Edit menu, select Find,
OR

Right-click and select Find from the popup menu,
OR

Click ® in the toolbar.
The Find dialog is displayed.
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Find: ‘|

In Column: Date i

Figure 7-6: Find Dialog

2. Enter the text string (full or partial) that you want to search for in
the Find field.

3. Select the parameter in which the text should appear from the In
Column dropdown list.

4. Click Previous to go back to the last found match.

5. Click Next to begin the search from the currently selected row. If
a match is found, the first match is highlighted in the Events log.

6. Click Next again to search for an additional match. (Repeat as
required to view subsequent matches.)

Configuring User-defined Alarms

User-defined alarms can be triggered according to conditions existing in a
NetEnforcer or Service Gateway, or in a selected Line, Pipe or Virtual
Channel. When an alarm is triggered, it is displayed in the Alarms Log. You
can also send notification of alarms by email.

The Alarms Editor enables you to define the conditions that trigger alarms
(Alarm Definitions) as well as the action to be taken when an alarm is
generated.

Configuring Alarm Definitions

Defining an alarm entry enables you to configure threshold alarms and
determine the action to be taken when an alarm is generated by the system.

An alarm action is the action to be taken when an alarm is generated. You can
configure alarms to be sent to a specific email address.
Working with Alarm Definitions

You can view and edit the configured alarms in the Alarm Definition List.

To view alarm definitions:

1. Select Alarm in the Navigation pane, and then select Alarm
Definition in the navigation tree,
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OR

From the View menu, select Alarms | Alarm Definition,
OR

On the toolbar, click the Alarms icon and select Alarm
Definition from the popup menu.

The Alarm Definition tab displays a list of the currently
configured alarms.

Alarm Definftion X
Name Description Type Severity Date Modified

P bw Bandwidth |® Major 11/30/06 1:38 PM

4 Disk overflow Disk Overflow Disk Usage @ Ciitical 11405 12.00 AM

j Memory overflow Memory overflow Memory Usage @ Critical 1/1/05 12:00 AM

4\ Alarms: Alarm Definition

Figure 7-7: Alarm Definition

2. To view the properties of a specific alarm, right-click the alarm in
the entries list and select Properties from the popup menu or
double-click the alarm entry.

Alarm Definition Entry Properties @

Name: bw

Description: [

Type: | 1

Direction: \

Units: | |

Severity: ;a Major i v|

Alarm SetWhen Bandwidth: | Greater Than 10 | Khps

Alarm Removed YWhen Bandwidth Reaches: 1] Kbps

[ Save ][ Reset ][ Cancel ]

Figure 7-8: Alarm Definition Entry Properties Dialog

To edit alarm definitions:

1. Select and right-click the alarm entry in the Alarm Entries List
and select Properties from the popup menu or double-click the
alarm entry. The Alarm Entry Properties dialog is displayed.
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2. Edit the alarm parameters, as required. It is possible to edit the

alarm name, severity, relation and threshold values.

3. Click Save to save the changes to the alarm entry.

Adding Alarm Entries

You can configure alarm entries for the following alarm types:
e Bandwidth
e Disk Usage (device only)

e Memory Usage (device only)

e Number of Active Pipes (device only)

e Number of Active Virtual Channels (device only)

e  Number of Dropped Connections

e Number of Live Connections

e Number of New Connections
e Number of Active Lines (AC-400/AC-800 only)

The procedure for defining an alarm entry and the specific parameters defined vary

according to the alarm type selected as indicated in the Type field.

Alarm Entry Type

Bandwidth (not
device)

Disk Usage (device
only)

Memory Usage
(device only)

Number of Active
Pipes (device only)

Number of Active
Virtual Channels
(device only)

Number of Dropped
Connections (not
device)

Number of Live
Connections (not
device)

Direction Units Severity
v v v

v

Threshold Values
v

v
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Alarm Entry Type Direction Units Severity Threshold Values
Number of New v v
Connections (not
device)

Number of Active v v
Lines
In the example given here, a Bandwidth type alarm entry is defined.
To add an alarm definition:
1. Right-click in the Alarms Definition List and select New Alarm
Definition from the popup menu.
The Alarm Definition Entry Properties dialog is displayed.
Nare:
Description:
Type: Bandwidth -
Direction: | Total 7E]
Units: Unknown M|
Severity. | @ Critical v‘
Alarm SetWhen Bandwidth: | Greater Than v | | 0
Alarm Removed When Bandwidth Reaches: 0
S¢
Figure 7-9: New Alarm Definition Entry Properties
2. Edit the name of the entry in the Name field, if required.
3. Click the browse button adjacent to the Type field. The Alarm
Wizard - Select Alarm Type dialog is displayed.
' Alarm Wizard - Select Alarm Type
Alarm Type: | T - |
[ Next = ] [ Finish J [ Cancel ]
Figure 7-10: Select Alarm Type
4. Select the type of alarm from the Alarm Type dropdown list.
5. Click Finish to return to the Alarm Definition Entry Properties
dialog box
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OR

Click Next to open the Alarm Wizard -Select Direction dialog
box.

Alarm Wizard - Select Direction

Direction: v/

[ < Back ” hext = ][ Finish ][ Cancel ]

Figure 7-11: Select Direction

6. Select the required direction from the Direction dropdown list
(Total, Inbound or Outbound).

Click Finish to return to the Alarm Entries Entry Properties dialog
box

OR

Click Next to open the Alarm Wizard - Select Units dialog box.

Alarm Wizard - Select Units

units: ([TER |

[ <Back | [ Mext> ][ Finish ][ cancel

Figure 7-12: Select Units

7. Select the unit of measurement for monitoring from the Units
dropdown list (Kbps or Number of Packets).

8. Click Finish to return to the Alarm Entries Entry Properties dialog
box

OR

Click Next to open the Alarm Wizard -Select Severity dialog box.

Alarm Wizard - Select Severity

Severity: 'O Critical 7\»}

[ <Back | [ nedt= ][ Finish ][ cancel |

Figure 7-13: Select Severity
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9. Select the required level of severity from the Severity dropdown
list (Critical, Major, Minor or Warning).

10. Click Finish to return to the Alarm Entries Entry Properties dialog
box

OR

Click Next to open the Alarm Wizard -Select Values dialog box.

Alarm Wizard - Select Values

Alarm Set\When Bandwidth: | Greater Than v | | 0 | Khps

Alarm Removed When Bandwidth Reaches: |0 | Kbps

>
Figure 7-14: Select Values

NOTE The parameters configured in the Alarm Wizard - Select Values
dialog are determined by the selected Alarm type.

11. In the Alarm Set When.... field, define the condition that must
exist before an alarm is generated by selecting Greater than, Less
than, Equal to or Not Equal to from the dropdown list and
entering the relevant quantity in textbox.

12. In the Alarm Cleared When...reaches field, define the condition
that must exist before an alarm is cleared.

13. Click Finish. The Alarm Definition Entry Properties dialog for the
selected type of entry is displayed. For example, Figure 7-9 shows
the Alarm Definition Entry Properties dialog for the Bandwidth
alarm type.

14. Click Save to save the Alarm Definition Entry definition.

Configuring Alarm Actions

Viewing and Editing Alarm Action Definitions

You can view the configured alarm action definitions in the Alarm Action Definition
List

To view alarm action definitions:

1. Select Events/Alarms in the Navigation pane, and then select
Alarm Action Definition in the navigation tree.
OR

From the View menu, select Alarms | Alarm Action Definition,
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OR
On the toolbar, click the Alarms icon and select Alarm Action
Definition from the popup menu.

The Alarm Action Definition List is displayed.

Defining an Alarm Action Definition

You can define an alarm action definition. When an alarm that is configured to take this
action is triggered, an email notification may be sent to the address defined in the alarm

action definition, or a pre-defined script may be run.

To define an alarm action:
1. Right-click Alarms Action Definition in the Navigation tree and
select New Alarm Action Definition from the popup menu.
The Alarm Action Definition Entry Properties dialog is displayed.
2. Edit the name of the entry in the Name field, if required.
3. Select the action to be taken in response to the alarm from the
Action When Alarm Occurs dropdown list, as follows:

e Send Email to: Sends notification of an alarm to a configured
email address.

r 3
Alarm Action Definition Entry Properties @

Name: New Alarm Action Definition

Description:

Action When Alarm Occurs: | Send Emailto v

Email:

Save Cancel

Figure 7-15: Alarm Action Definition Entry Properties — Send
Email to

e Script Action: Runs a predefined Script when the Alarm triggers.

Alarm Action Definition Entry Properties VZK'
Name: New Alarm Action Definition

Description:

Action When Alarm Occurs: | ScriptAction v

Alarm Script Path:

Cancel Alarm Script Path:

Reset | [L.Gancel.]

Figure 7-16: Alarm Action Definition Entry Properties —
Script Action
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4. Configure the alarm action parameters as follows:
e If Send Email to was selected, enter the email address to which the
alarm is to be sent in the Email field.
e If Script Action was selected, enter the paths to the alarm script and
the cancel alarm script in the relevant fields.
5. Click Save to save the alarm action entry.
NOTE The NetXplorer sends device ID, line ID, pipe ID, VC ID and Mediator

Device (SMP/STC) ID for use in the script. The parameters are sent in
the order and format shown below:

DEV_ID:<id> LINE_ID:<id> PIPE_ID:<id> VC_ID:<id> MD_ID:<id>

In case a particular parameter is not defined, a value of “none” will
be returned. So an example of the parameters sent might be:

DEV_ID:16 LINE_ID:1 PIPE_ID:6 VC_ID:0 MD_ID:none

To edit an alarm action entry:

1.

2.
3.

Select and right-click the alarm action entry in the Alarm Action
Definition List and select Properties from the popup menu or
double-click the action alarm entry. The Alarm Action Definition
Entry Properties dialog is displayed.

Edit the alarm action parameters, as required.

Click Save to save the changes to the alarm action entry.

Assigning Alarms

In order for an alarm entry to generate an alarm, it must first be assigned to a specific
NetEnforcer or Service Gateway, Line, Pipe or Virtual Channel in the Enterprise.

Viewing Alarm Assignments

You can view a list of the alarm entries assigned to a specific NetEnforcer or Service
Gateway, Line, Pipe or Virtual Channel.

To view alarm assignments:

1.

In the Navigation pane, right-click the NetEnforcer or Service
Gateway in the Network tree and select Alarm Definition
Assignments | Alarm Definition Assignment List.

OR

In the Enforcement Policy Editor, right-click the Line, Pipe or Virtual Channel
and select Alarm Assignment.
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OR

In the Enforcement Policy Editor, double-click in the Alarms Assignment
column.

The Alarm Assignments tab is displayed for the selected entity.

Assigning Alarms

To assign an alarm:

1.

In the Navigation pane, right-click the NetEnforcer or Service
Gateway in the Network tree and select Alarm Definition
Assignment | New Alarm Definition Assignment.

OR

In the Enforcement Policy Editor, right-click the Line, Pipe or Virtual Channel,
and select Alarm Assignments | Add Alarm Assignment.

OR

In the Enforcement Policy Editor, double-click in the Alarms Assignment
column.

The Alarm Definition Assignment Editor dialog is displayed.

Alarm Definition Assignment Editor - New @

(& Alarm Definition: ¥

Action When Alarm Occurs

© BA Alarm Definition Action: |24

(® No Alarm Action (Record in Alarm Log Only)

Save Cancel

Figure 7-17: New Alarm Definition Assignment Editor

Select the required alarm from the Alarm Definition dropdown
list.

Set the action to occur when alarm is generated by selecting the
Alarm Definition Action or No Alarm Action radio button. If
you select Alarm Action, select the type of action from the
dropdown list.

Click Save. The alarm is added to the Alarm Definition
Assignment list for the selected NetEnforcer or Service Gateway.
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Viewing the Alarms Log

Located in the Logs

Pane in the lower portion of the NetXplorer window, the Alarms

Log displays a list of the alarms triggered by either assigned alarm entries or alarmed

event types.

4 Alarms Log %

Ack | Date |

H2RB3 %V
Alarms Log

Time [ Severity Alarm Definition | Source | Description |

Aug 11,2010 24817 PW 2 Major - @l sa Data Source in 10.50.37.11 is down

Aug 11,2010 10:37:48 AM J Major - (53 10.50.8.35 License Warning: attribute type: vc number, limiting type: number o.
Aug 11,2010 10:26:19 AM J Major - &3 1050835 License Warning: attribute type: vc number, limiting type: number o.
Aug 11,2010 10:16:19 AM J Major - ] 50.8.35

Aug 11,2010 10:06:19 AM 2 Major - =3 35

License Waming: attribute type: vc number, limiting type: number o.
License Waming: alfribute type: vc number, limiting type: numbero... _

[@0 3108 [@0 @0[az

Figure 7-18: Alarms Log

The Alarms Log is automatically refreshed every 30 seconds and provides the
following information for each alarm:

Ack

Date
Time

Severity

Alarm Definition

Source

Description

A checkmark in this column indicates that the alarm has been
acknowledged. Acknowledging an alarm re-arms the alarm
definition so that NetEnforcer again checks to see if the alarm
condition exists. Acknowledged alarms are ignored when
establishing severity indicators in the Network Tree.

The date on which the event triggering the alarm occurred.
The time when the event triggering the alarm occurred.

The severity of the alarm. The color of the severity icon reflects
the severity as follows:

Warning: Gray
Minor: Blue
Major: Yellow
Critical: Red
Information: White

This is the name of the assigned alarm definition in the Alarm
Definition list associated with the alarm. This will be blank if the
alarm occurred as a result of an alarmable event type.

The type of object where the event triggering the alarm occurred
followed by and underscore and the object’s name. The possible
object types are: NE (NetEnforcer), Line, Pipe, VC (Virtual
Channel), Network, Collectors, SMP, Long-Term Monitoring
or Short-Term Monitoring.

Example: pipe_mail

A summary of the event triggering the alarm.

NetXplorer Operation Guide
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Alarms Log Toolbar

The following buttons appear at the upper right hand corner of the Logs Pane when an
Alarms Log is open:

BUTTON ‘ DESCRIPTION

A Acknowledge Enables you to indicate that you have seen the alarm. It does
not indicate that any action has been taken in response to the
alarm. Refer to Acknowledging Alarms, page 7-22.

2 Remove Enables you to remove an alarm, removing it from the active
Alarms Log. Refer to Removing Alarms, page 7-23.

& Find Enables you to search for alarms according to the content
included in a specific alarm parameter. Refer to Searching for
Alarms, page 7-21.

%27 sort Enables you to sort the alarms in the Alarms Log according
to the headers in the log. Refer to Sorting Alarms, page 7-18.

“F Filter Enables you to apply a filter to _the Alarms Log so t_hat (_)nly
alarms matching the filter are displayed. Refer to Filtering
Alarms, page 7-19.

Sorting Alarms

You can sort the alarms in the Alarms Log according to the headers in the log
(date, time, severity, source, and so on).

To sort the alarms in the Alarms Log:
1. Click the header according to which you want to sort the events.
OR
Right-click in the Events Log and select Sort from the popup menu.
OR
Click "™ on the toolbar. Then select the header from the submenu.

The listed alarms are sorted according to the selected header.
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Filtering Alarms

You can apply a filter to the Alarms Log so that only alarms matching the

filter are displayed. This is particularly useful because the Alarms Log may
include up to 1,000 alarms.

To define afilter:

1. Right-click in the Alarms Log and select Filter from the popup

menu or click ¥ in the toolbar. The Alarm Log Filter Definitions
dialog is displayed:

Alarm Log Filter Definitions (L]
O Show All Alarms (No Filter)
© Bhow Filtered Alarms. Limit 1o}
Severity | Acknowledge | Type | Date & Time | Names & Description:

Limitto Alarms with Severities
[ critical

] Major
[ Minor
[ Waming
[info

(Coomenr ]

Figure 7-19: Alarm Log Filter Definitions: Severity Tab
2. Select Show Filtered Alarms.

Define the filter parameters in the different tabs as follows:

e In the Severity tab, select the Severity levels as required: Critical,
Major, Minor, Info, Warning.

e Inthe Acknowledge tab, select Acknowledged or Unacknowledged
to include acknowledged and/or unacknowledged alarms.

Alarm Log Filter Definitions 3]
© Show Al Alarms (No Filter)
© Ehow Filtered Alarms. Limitto}
Severity| Acknowledge | Type | Date & Time  Names & Description
Limitto Alarms with Acknowledgement States
] Acknowledged
[ Unacknowledged

Figure 7-20: Alarm Log Filter Definitions: Acknowledge Tab

e Inthe Type tab, select the type of alarms to be shown, TCA
(threshold alarms) or Non-TCA alarms.
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Aarm Log Filter Definitions 3]

O Show All Alarms (No Filter)

© Brow Fitered Alarms. Uit fo}
Severity  Acknowledge | TYPe | Date & Time Names & Description
Limit to Alarms of Type:

OTca
© Include All TCAS

O Limit to Alarm Entries Definitions Containing

] Non-TCA

Figure 7-21: Alarm Log Filter Definitions: Type Tab

e Inthe Date & Time tab, configure the dates and time for which you
want to view alarms.

Alarm Log Filter Definitions ®
© Show All Alarms (No Filter)
© Bhow Filtered Alarms. Uit to}
Severity | Acknowledge  Type | Date &Time | Names & Description
Limit to Alarms Within Dates & Times:
[Jinclude Dates & Times: | LaterThan ¥
Date (@aimmiyyyy: (01 v f[01 v s (2004 v

Time (hh:mm). 00 v |00 v

Figure 7-22: Alarm Log Filter Definitions: Date & Time Tab

e Inthe Names & Description tab, enter the following types of
specifying key words as required: Source Names Containing and
Descriptions Containing.

Alarm Log Filter Definitions 3]

© Show All Alarms (No Filter)
© EhowFitered Alarms. Limit o]
Severity Acknowledge | Type| Date & Time | Names & Description
Limit Atarms to:
[ Source Names Containing:

[[] Descriptions Containing

Figure 7-23: Alarm Log Filter Definitions: Names &
Description Tab

3. Click OK. The filter is applied. Only the alarms that match the
filter parameters are displayed in the Alarms Log and Filtered is
displayed in the status bar.

7-20 NetXplorer Operation Guide



Chapter 7: NetXplorer Alarms

NOTES To clear any filters, the user should reenter the Filters dialog box and
select “Show All Alarms (No Filter)” radio button, then click OK. The
log then refreshes without any filter.

If two or more filter parameters are selected, the results will include
all alarms that answer at least one of the parameters.

Viewing Alarm Properties

You can view the configured properties of an alarm in the Alarms Log.

To view alarm properties:

Right-click an alarm in the Alarms Log and select Properties from the popup menu or
double click the alarm. The Alarm Properties dialog is displayed.

Alarm Properties L3}

Genera

Date & Time of Alarm:
Severity.

Alarm Definition Name:
Event Type
Acknowledged

Description

Alarm Source Detalls
NetEnforcer.

Line:

Pipe.

Virual Channel:

Monitoring Collector

Dec 3,2006 10:48:11 AM

Major

Link Down ID=14]

No

Link EXTERNAL Is down: admin status Is up and operational

state is down

10.50.7.102

Close

Figure 7-24: Alarm Properties Dialog

Searching for Alarms

You can search for alarms according to the content included in a specific

alarm parameter.

To search for an alarm:

1. From the Edit menu, select Find,

OR

Right-click and select Find from the popup menu,

OR

Click G4 in the toolbar.

The Find dialog is displayed.

NetXplorer Operation Guide
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Find |

In Column: Date N

Figure 7-25: Find Dialog

2. Enter the text string (full or partial) that you want to search for in
the Find field.

3. Select the parameter in which the text should appear from the In
Column dropdown list.

4. Click Next to begin the search. If a match is found, the first match
is highlighted in the Alarms Log.

5. Click Next again to search for an additional match. (Repeat as
required to view subsequent matches.)

6. Following your first match, the Previous button appears. Click it
to go back to the last match.

Managing Alarms

As part of the system monitoring process, you can view, acknowledge and
remove alarms in NetXplorer.

Acknowledging Alarms

Acknowledging an alarm indicates only that you have seen the alarm. It does not
indicate that any action has been taken in response to the alarm.

NOTE Once an alarm has been acknowledged, its severity is no longer
reflected in the Object icon in the Network tree.

To acknowledge specific alarm(s):
1. Select the alarm(s) in the Alarms Log.

2. Right-click and select Acknowledge Selected Alarms from the
popup menu or click Hin the toolbar.

3. The alarm is acknowledged and a checkmark is displayed in the
Ack column for the alarm in the Alarms Log.

To acknowledge all alarms:

Right-click an alarm in the Alarms Log and select Acknowledge All Alarms from the
popup menu. All alarms are acknowledged and a checkmark is displayed in the Ack
column for each alarm in the Alarms Log.
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Removing Alarms

Removing an alarm removes the alarm from the system and from the Alarms Log. You
remove an alarm that is insignificant or that resulted from a problem that has since been
resolved.

To remove specific alarm(s):
1. Select the alarm(s) in the Alarms Log.

2. Right-click and select Remove Selected Alarms from the popup
menu or click# on the toolbar. A system message is displayed.

3. Click Yes to confirm. The removed alarm is removed from the
Alarms Log.

To remove all alarms:

1. Right-click an alarm in the Alarms Log and select Remove All
Alarms from the popup menu. A system message is displayed.

2. Click Yes to confirm.

Monitoring & Reports

The Alarms Log provides direct access to relevant real-time monitoring and long-term
reporting graphs. This enables you to quickly access a monitoring graph for closer
inspection of a problematic situation. For example, if an alarm is triggered on a
particular Pipe because the number of live connections in the Pipe has exceeded a
specified amount, you can access the real-time monitoring graphs for the Pipe to
understand more clearly if there is a problem or if your QoS Enforcement Policy
requires modification.

To access monitoring graphs from the Alarms Log, right-click an alarm and select from
the options displayed. The monitoring graphs available vary according to the object type
selected.

For further information on monitoring and reports, refer to Chapter 7, Monitoring
Reports.
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Monitoring Reports Options

NetXplorer's monitoring and reporting options enable you to monitor applications, protocols,
policies, hosts and subscribers in real time and to verify enforcement of the most suitable QoS
Enforcement Policy.

Different applications, such as e-Business, ERP and real-time applications require performance
guarantees. Other mission-critical applications may suffer from a shortage of bandwidth, while
non-critical Web browsing and batch traffic, such as mail and FTP, may use up network
resources. In other network setups, some users require a higher level of service than others. For
example, internationally dispersed branch offices have expensive narrow WAN links to
headquarters and many different users share the same bandwidth. On campuses, students
overload network resources (WAN connection, caches, servers) with excessive requests for
service (audio traffic), while the administration suffers from reduced available bandwidth and
longer response time. Therefore, your ability to monitor network performance determines your
success in fine-tuning network performance based on your business requirements. The
monitoring tools are designed to help you fine-tune your network performance.

When and where your network has peaks, bursts and bottlenecks is hard to predict. NetXplorer
enables you to see these peaks in both real time and historically, which is crucial to managing
these unwanted phenomena.

Monitoring Reports in NetXplorer are generated from the GUI by using the following tools:

Real-Time Monitoring

NOTE

NetXplorer's real-time monitoring tool provides real-time data, enabling you to monitor
applications, protocols, users and servers and to enforce the most suitable QoS Enforcement
Policy. Real-time monitoring enables you to identify possible problems and traffic peaks as
they occur so that corrective actions can be taken in a timely manner.

In Real-Time Monitoring, data is available for four hours at 30 second resolution and for two
days at five minutes resolution. When a 30 second resolution graph is chosen, the graph will
auto-refresh once the “restart” short cut button in the short-cut tool bar has been clicked.

The Real-Time Monitoring application is an optional component of NetXplorer. You can opt
to use Real-Time Monitoring with one, some or all of the NetEnforcers or Service Gateways in
your network. The Real-Time Monitoring application is licensed separately per NetEnforcer,
or per Core Controller on a Service Gateway, and is enabled by entering an appropriate key on
each device.

Real-Time Monitoring graphs are licensed per core controller blade on the
Service Gateway. The license is required for all CC blades in the SG-Sigma
platform in order to enable real time monitoring.
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NOTE

Real-Time Monitoring graphs in a 30 seconds resolution are not available when a
Service Gateway has been configured to work with the “subscriber” reduction
profile. For more details, see the NetXplorer Installation and Admin Guide,
Chapter 5.

Long-Term Reporting

NOTE

The ability to monitor applications and users over a long period of time is crucial in order to
employ traffic priorities based on business requirements. NetXplorer's Long-Term Reporting
application enables you to monitor your network'’s activity and identify trends over an extended
period of time by storing monitoring data and sending the graphs to the designated recipient by
email.

In Long-Term Reporting, data is available for three months at one hour resolution and for one
year at daily resolution.

When you select a NetEnforcer (or one of its subcomponents) in the Navigation
tree, the Monitoring and Reporting options are enabled or disabled according to
whether or not the selected NetEnforcer has been licensed for the proper
option.

Mobile Analytics

NOTE

A special set of reports available on the Network level, specifically designed for Mobile
Operators. Mobile Analytics reports provide information concerning mobile data use with the
ability to generate graphs concerning mobile subscribers, devices and signaling information.

Mobile Analytics is only available when the following requirements are met:
e Allot’s Subscriber Manager Platform is deployed in PCC Mode
e At least one STC is installed

e A special license key for Mobile Analytics has been purchased for
the in-line platforms. Contact Allot Customer Support for details.

Ad-hoc generation of each of Mobile Analytics graphs can take a significant amount of time,
depending on the size of your network and the amount of mobile traffic, therefore Allot
recommends that they be generated as pre-scheduled User Defined Reports.

For instructions regarding configuring and enabling Mobile Analytics, consult the SMP
Installation and Administration Guide Chapter concerning Mobile Analytics.

By default, the entirety of the data for Mobile Analytics only becomes available
after 25 hours. Any report which is created which displays information for the last
25 hours will contain partial data (open sessions are not shown). In some cases,
depending on the specific deployment parameters, this time period can be
lessened by configuration. Contact support@allot.com if this is necessary.
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Monitoring Interface

The maximum number of graphs that may be open in the GUI at any one time is 15.

Different graphs are available at each level in the Network, consequently the submenu options
available for Real-Time Monitoring and Long Term Reporting vary according to the item
selected.

Mobile Analytics graphs are only available on the Network level.

Quick Access Toolbar

[==]E=]

EoyEEEdndnE a3  ANQOL

<ommnications

Mobile Analytics .
— Quick Access
Localization ‘ TO (0] I b ar

Figure 8-1: Quick Access Toolbar — Monitoring Reports
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The following icons are displayed in the NetXplorer Quick Access Toolbar when a monitoring
graph is open:

BUTTON DESCRIPTION

Displays monitoring data according to total, incoming
or outgoing bandwidth, incoming or outgoing packets,
or live, new or dropped connections. Refer to Data
Display Options, page 8-118.

= Show Data by

Displays the graph in Chart View. Refer to Graph
© Chart Style Views, page 8-16.

37 Toggles the Legend for the open graph.
~ Hide Legend

= L ess Point Displays fewer points on the open graph
ess Points

1+ Displays more points on the current graph.
More Points
[Ek Enables you to hide/show the grid, configure the
Display legend convention, hide/show All Others data, switch

between bandwidth units, show the values in the
actual graph (pie graphs only), show the values in the
legend or show the full name in the X-Axis.

NOTE Arrows buttons appear in the
upper border between the
graph and legend which may
also be used to show and
hide the legend information.

5 Displays the graph in Table View. Refer to Graph

@

Table View Views, page 8-16.
@ Displays a log file of any errors connected to the
" Errors Log selected report.
« Displays the graph data for the previous graph period,

Backward and continues from that point onward.

Redisplays the graph data to reflect the real-time data.
Forward (This option is enabled if a previous sample period has
been displayed in a graph.)

3
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BUTTON DESCRIPTION

% Restart Automatic
Update

Starts the visual update of the graph (which is off by
default). Once the graph is being automatically
updated, this button is replaced by the Stop
Automatic Update button. While a graph is being
automatically updated, this icon appears by the title of
the graph. (This option is enabled for real-time
monitoring graphs only.)

] Stop Automatic
Update

Suspends the visual update of the graph. (This option
is enabled for real-time monitoring graphs only.)

5 ¥ . .
“T Add to Favorites View

Adds the current Monitoring graph to Favorite View.

B Add to Reports

Adds the current Monitoring graph to Reports.

- Graphs List

Displays a list of the currently open graphs in the
Monitoring system, enabling you to easily navigate
between the open graphs.

& Tile

Tiles all open graphs

J Cascade

Displays all open graphs as a Cascade

NetXplorer Operation Guide
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Menu Options

The following options are available when you select a graph in the Application Details area
and open the Action menu from the Menu Bar, or Right-click on an open graph:

BUTTON DESCRIPTION ACTION
MENU
Show Data | Displays monitoring data according to incoming «/
by or outgoing bandwidth, incoming or outgoing
packets, or live, new or dropped connections.
Refer to Data Display Options, page 8-118.
Chart Displays the graph in the selected type of Chart «/
Style View. Refer to Graph Views, page 8-16.
Display Enables you to hide/show the grid, configure the v
legend convention, hide/show All Others data,
switch between bandwidth units, show the values
in the actual graph (pie graphs only), show the
values in the legend or show the full name in the
X-AXis.
NOTE Arrows buttons appear in the upper
border between the graph and
legend which may also be used to
show and hide the legend
information.
Table Displays the graph in Table View. Refer to v
View Graph Views, page 8-16.
Errors Log | Displays a log file of any errors connected to the v
selected report.
Backward | Displays the graph data for the previous graph, v
and continues from that point onward.
Forward Displays the next sample. v
Stop Suspends the visual update of the graph. Click v
Update Stop Update again to restore the visual update.

(This option is enabled for real-time monitoring
graphs only.)
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BUTTON DESCRIPTION ACTION
MENU
Drill Down | Drills down within any displayed graph to view a X
cross-section of data for a specific entity
represented in the graph. For example, upon
examining a Pipes Distribution graph for a
specific NetEnforcer, you may want to view the
breakdown of utilization for a specific pipe.
Edit Opens the Enforcement Policy Editor to edit the X
selected NetEnforcer or Service Gateway, Line,
Pipe or VC in the graph.
Add to Adds the current graph to the Favorite View v
Favorite setup.
View
Add to Adds the selected Monitoring graph to Reports. N
Reports
Export Allows you to export the current graph as a .csv, v
xml, .png, .pdf. .jpg or .html file.
NOTE If the graph has asliding
horizontal axis, the exported .jpg
will be scaled to show the entire
graph.
Exportto | Allows you to export a text file which contains v
CLI the Monitoring CLI command for generating the
current graph. This command may then be edited
to change the properties of the graph.
Print Prints the current graph.
Close Closes the selected graph.
Full Enlarges the graph to full size of your screen. v
Screen Double click the full screen graph to return to its
previous dimensions.
Properties | Displays the report/graph definition properties v
for the specific graph, enabling you to modify the
definition, as required.

NetXplorer Operation Guide
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Navigation Pane

It is easy to review and generate predefined reports by opening the Reports pane in the
Navigation Pane.

=@ System Reports
B Daily Most Active Protocols
B Hourly Most Active Protocols
B3 Daily Most Active Hosts by Protocols
= Hourly Most Active Hosts by Protocols
Daily Network Statistics
= Hourly Network Statistics
=@ User Defined Reports
[ test statistic

g VNetwork
@ Catalogs

} Events/alarms
b’t.’ Groups

a MPP Accounts

Figure 8-2: Reports Navigation Pane

From the Reports navigation pane, it is possible to access three specific forms of reports.

e System Reports — Key indices that are automatically defined by the NetXplorer. The
following System Reports are available by default:

e Daily Most Active Protocols on the Network level

e Hourly Most Active Protocols on the Network level

e Daily Most Active Hosts stacked by protocol on the Network level
e Hourly Most Active Hosts stacked by protocol on the Network level
e Daily Network Statistics

e Hourly Network Statistics

User Defined Reports — Customized reports that are defined and stored by the
user for quick access. For more information see Network Usage

This report shows the mobile network usage over a set period of time by device model or
device model category.
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The Session Duration Report may be viewed as a Stack Area Graph or as a Table.

MNetwork Usage per Device Category

Total Banduvicth

Total Bandwidth (Mbps)

0200 10:00 11:00 12:00 13:.00 14:00

Apr17 2008 08:00:00 To Apr17 2008 17.00:00

15:00

Device Category
[0 Samsung

16:00

Figure 8-124: Network Usage Report

To configure a Network Usage Report:

You may configure the parameters of your report using the three tabs of the dialog

box; Time, Limits and Display.

by Device — Stack Area Graph

rDate & Time Range

@ Show Data for Last:

() Ending at report generation time

@ Ending at midnight at days prior to report generation

) Show Data in Range: | From Date/Time “To Date/Time
|November 28, 2012 [+{[@] | | |November 28, 2012 [2{[3]
| 2AM: | | 01PM 2]

7 Show in Hours: r From Ty
| 1200 AM % | 01:00PM %

Ending prior to report generation time

@ Ending days prior to report generation

Data Resolution:

~Time Scope

[] Limit to Specific Days and Hours: E]

Figure 8-125: Mobile Analytics: Network Usage, Time dialog
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1. Inthe Time dialog, the following fields are displayed:

e To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

e To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

e Toseta period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

e Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.

e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Time S2ope Selection . - —— - ‘ & ]

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

.

Figure 8-126: Mobile Analytics: Time Scope Selection dialog box
2. Inthe Limits dialog the following fields are displayed:
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Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category:

) &

[ Device Model:

Figure 8-127: Mobile Analytics: Network Usage, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories

BrickPhone Category [Regular Phone Category

SmartPhone Category

OK [ Cancel

k= |

Figure 8-128: Mobile Analytics: Device Models Selections dialog

3. Inthe Display dialog the following fields are displayed:

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on: % Number of Sessions i

Show "All Others’in Graph

Data Splitting

Display Separately for Each
~) Stack Results by: 4% Device Model v

© None

Figure 8-129: Mobile Analytics: Session Duration, Display dialog

e Inthe Data Structure area, only one option, Data for the Period as a
Whole, is available.
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (% Number of Sessions or Number of
Sessions).

e Inthe Data Splitting area you may select None or to stack results by
Device Model. You can also select here how many devices to stack
by. None is selected by default.

e Scheduling a Report on page 8-105.

e Compound Reports — Reports that include more than one User Defined Report,
designed to be generated automatically at the same time. Compound Reports are
indicated by an orange Report icon. For more information see Compound Reports on
page 8-116.

Report Folders

Folders can be defined in the Reports Navigation pane in order to make User-Defined reports
easier to categorize. The folders allow the user to categorize the reports by any criteria they
wish.

To create a Report Folder:
1. Open the Reports Navigation pane.
2. Select Actions > New > Report Folder

3. The Report Folder Properties dialog box opens, allowing you to enter a
name for the folder.

Click Save to add the folder to the Reports navigation pane.
4. The new folder appears in the Reports navigation pane.

5. To delete a folder, right click on the folder and select Delete. This will
also delete any reports stored in the folder.

Graph Views

By default, Monitoring Reports are displayed in a chart or graph. However, you can also
display the values in table format. These different views are called Chart View and Table
View.
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Mast Active Pratacals on NetEnforcer 55-400
Based on: Total Bandwidth

Protocol Total Bandwidth (Kbps) In Bandwidth (Kbps) Qut Bandwidth (<bps)
o4 All Others 72086.4 72086.4 00
ot FTF 48115 4811.5 00
o) FTP-DATA 48115 48115 00
i MSG-ICP [IPTCP:28] 48062 48062 00
o} PRIV-MAIL [IPTCP:24] 48063 48063 00
< SMITP 48114 18114 00

Mast Active Protocals on NetERforcer 55-400
Based on: Total Bandwidth

4816

4128
23440 Protocal
S EFTP-DATA
e Orte
z WsmTe
5 2064 Omse-icp
= WPRN-MAIL
E1378

639

Feb 012006 15:14:31 To Feb 01 3006 15:19:30

Figure 8-3: Graph Views

When in Chart View, you can alternate the layout style of the graph between a Bar chart and a
Pie chart, or between a Line chart and a Stack Area chart. Different graphs have different
styles. For example, a Pipes Distribution graph can be displayed as a Line chart or Stack Area
chart. A Most Active Hosts graph can be displayed as a Bar chart or Pie chart. These different
graph styles are reflected by icons in the upper right hand corner of the Reporting dialog box.

NOTE Graph appearance may vary slightly depending upon the graphics
settings of the client computer.

Following are examples of different graph styles.

Host

= 0000

= 230.265.256.250

- fioz:cz

0 = fioz1:2/128
= zan0.s1

B
=

0ct 172012 17:23:01 To Oct 172012 17:3300

Figure 8-4: Bar Chart

Figure 8-6: Line Chart Figure 8-7: Stack Area
Chart
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Monitoring Reports Graphs

This section describes the graph functionality that is available in Real-time monitoring and
Long-Term Reporting in NetXplorer. The following Monitoring Report subjects are available.

Core Graphs

Using one or more graphs from the core graphs category will give you a full picture of your
network statistics and its behavior. Those graph display the bandwidth so you can see it as if
you are inside the physical line. This category contains the following graphs:

e Statistics Reports: Displays traffic statistics.

e Protocols Reports: Displays data concerning specific protocols or groups
of protocols on the Network.

e Policy Entities Reports: Displays data concerning a specific Policy Entity
or type of Entity on the Network. These include NetEnforcers/Service
Gateways, Lines, Pipes and Virtual Channels.

e Hosts/Conversations Reports: Display the most active host objects over
the period defined or the distribution of selected hosts over the period
defined.

Additional Graphs

Using the additional graphs allows you to go in depth when investigating your network, and to
adjust your view to see specific details in your network. This category contains the following
graphs:
e Utilization Reports: Displays how much of an object’s available
bandwidth is being used.

e Typical Time Reports: Display the average of selected parameters over a
typical day or a typical week, over the selected time period. All standard
Real-Time and Long-Term graphs may be generated as Typical Time
reports.

e Popularity Reports: Displays data concerning the popularity of certain
objects or a type of object on the Network.
e Pipe Popularity Reports: Display the most popular Pipes on your
network.

e VC Popularity Reports: Displays the most popular VCs on your
network.

e Average Protocol Popularity (Average Most Popular Protocols):
Displays the most popular Protocols, based on an average of all
subscribers.

e Services Reports: These reports pertain to services available on the
NetXplorer.
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WebSafe Traffic: Displays the amount of traffic being used by the
WebSafe service.

HTTP: Displays very detailed information on domain hames access
distribution by various parameters.

Integrated Services: Displays detailed information on Integrated Services
use.

Asymmetry Traffic Report: Displays the amount of traffic being sent via
Asymmetry links.

Percentile Reports: These reports express usage by percentile for billing
and analysis purposes.

95™ Percentile: The 95% value (metered bandwidth) is used for billing by
most Tier-1 operators and carriers.

Bandwidth Usage Percentiles: Displays the average usage for different
subscriber groups according to the percentile of the used bandwidth.

Percentile Protocols: Displays the protocol distribution of the average
bandwidth per specific subscribers/hosts group.

VolIP Report: Indicates the amount of time VoIP applications are used on
your network.

Subscriber Graphs

SMP Graphs are only available when an SMP is enabled on the network.

SMP Reports: These reports are only available if both SMP and Quota
Management are enabled. They are available as both Real-Time and Long-
Term Reports.

SMP Reports include the following:
Subscriber Reports

Subscriber Usage Reports

Service Plans Usage Reports
Service Plans Popularity Reports
Quota Analysis Reports

Cellwise Reports

Mobile Analytics Reports: These reports are only available if both an
SMP in PCC mode and Mobile Analytics are enabled. They are not
available through Real-Time Monitoring or Long-Term Reporting but only
via the Mobile Analytics feature.

Mobile Analytics include the following reports:
Session Signaling

NetXplorer Operation Guide
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e Roaming Out Volume

e Service Plans Metrics

e Service Plans Transits

e Subscriber Volume Percentiles
e Session Bitrate

e Session Duration

e Network Usage

Report Descriptions

Core Graphs

NOTE

Statistics Reports

Statistics reports display the bandwidth consumed by the entire network or specific entities in
your network (NetEnforcers, Lines, Pipes or Virtual Channels). Statistics reports can be
generated as Real Time Monitoring graphs or Long-Term Reporting reports

Although default statistics reports indicate total bandwidth consumption,
the graph display can be modified to display data based on inbound or
outbound bandwidth consumed; live or new connections; or inbound or
outbound packets transmitted.

To generate a Statistics Report

1. Inthe Navigation pane, right-click an entity in the Navigation tree for
which you want to generate a graph and select Real-Time Monitoring or
Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Real-Time Monitoring or Long Term Reporting from the View menu.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then click the Real-Time Monitoring or Long Term Reporting button on the
toolbar.

The graphs submenu is displayed.

2. Select Statistics. The Real-Time Monitoring: Statistics or Long Term
Reporting: Statistics Properties dialog is displayed. The Statistics Report
icon is displayed in the upper right hand corner of the dialog box.

8-18
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The Time tab is open by default.

Real-Time Monitoring: Statistics x|
— e 8
Time | Display st
Date & Time Range
@ Show Data for Last: 10+ Minutes x|
@ Ending at report generation time
Ending at midnightat | 115 days prior to report generation
") Show Data in Range From Date/Time To DateiTime
May 29, 2012 @ vays, wn H@
12:00 AM = 09:43 AM
Show in Hours: From To
12:00 AM - 09:00 AM -
3) Ending prior to report generation time
Ending 15| days prior to report generation
Data Resolution: 30 Seconds -

Figure 8-8: Real-Time Monitoring: Statistics dialog, Time tab

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

NOTE When generating a long-term monitoring report, the available options are (1
hour, 1 day, 1 month).

5. Click the Display tab. The following dialog is displayed.

NetXplorer Operation Guide 8-19



Chapter 8: Monitoring Reports

Real-Time Monitoring: Statistics =2 |
s
Time | Display Lﬁu{g:ﬂ
Data Structure
Data for the Period as a Whole
@ Data Qver Time
Default Data View
Open Graph on: Total Bandwidth -
Show "All Others’ in Graph
Data Splilting
Display Separately for Each
Stack Results by: s
8 None
Data Mode
Show Data by:
@ Rate Volume

Figure 8-9: Real-Time Monitoring: Statistics dialog, Display tab

6. Inthe Data Structure area, there are two possible options:

e Data for the Period as a Whole: This option is used with Most
Active reports and will generate a pie chart which shows the
proportionate distribution of traffic over different objects, where
100% represents all of the objects chosen.

e Data Over Time: This option is used with Distribution reports and
will generate a graph that presents the distribution of traffic over a
set period of time.

7. From the Default Data View dropdown list, select the parameter you
wish to see Statistics about (Total Bandwidth, In Bandwidth, Out
Bandwidth, Live Connections (30 Second intervals only), New
Connections, Dropped Connections, In Packets or Out Packets).

8. In the Data Splitting area, you can opt to see the stats for specific
network entities separately.

9. Inthe Data Mode area, you can opt to display data by Rate or Volume.
10. Click OK to generate the graph.

8-20 NetXplorer Operation Guide



Chapter 8: Monitoring Reports

MetErforcer
MetEnforcer 10.4.25.15 - Statistics O10.4.25.15

In Bandwicth

500

In Bandwidth (Mbps)
w =
= s
2 5]

)
=
=

=
=

i}

14:05:00 14:15:00 14:25:00 14:35.00 14:45:00

|
Apr30 2008 11:00:00 To Apr 302008 16:01:30

Figure 8-10: NetEnforcer Statistics

Protocol Reports

Protocol reports display information concerning specific Protocols in your network.
Protocol reports can be generated as Real Time Monitoring graphs or Long-Term Reports.

There are two types of Protocol Reports:

e A Most Active Protocols which indicates the most popular protocols on a
Network or Object level. This report can be displayed as a bar chart, or as a
line/stack area chart showing the distribution of protocols over time.

Long-Term Reporting X

Frotocol
EgitTorrent Enc
CIHTTP_Browsing
EeitTorrent

Network - Most Active Protocols

Based on: Total Bandwicth
Displaying: Total Bandwicth

EHTTP_File_Transfer
BHTTP_Streaming

Cebonkey Enc

Total Bandwidth (Gbps)

Jul 28 2010 09:00:00 To Jul 28 2010 13:59:58

Figure 8-11: Most Active Protocols on Network — Bar Chart

e A Distribution of Specific Protocols report which shows the selected
protocol’s traffic over a set period of time. This report can be displayed as
a line/stack area chart, or as a pie chart which shows the proportionate
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distribution of different services or service groups, where 100% represents
all of the services or service groups chosen

Network - Protocols Distribution Hebonkey

Total Bandwicth EFre

W\weatherBug
W ouTube

= = =

Total Bandwidth (Mbps)

@

4

1}
10:46:00 10:46:45 10:47:30 10:4815 10:43:00 10:49:45 10:50:30

Anr17 2008 10:46:00 To Apri17 2008 10:50:30

Figure 8-12: Distribution of Specific Protocols on Network — Data
Displayed Over Time

Long-Term Reporting

Network - Protocols Proportion Distribution Evorp
Crzp Applications
Displaying: % Total Bandwicth (%) EFie Transfer
Wrail

333 [Cietwork Operation

Eleb Applications

WD Transactions

EFile Systems

HGames

Oinstant Messaging Applications
Blstreaming Applications

May 16 2010 15:00:00 To May 17 2010 14:59:59

Figure 8-13: Distribution of Specific Protocols on Network — Data
Displayed for Period as a Whole
To generate a Protocol Report:

1. Inthe Navigation pane, right-click a level in the Navigation tree for
which you want to generate a graph and select Real-Time Monitoring or
Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Real-Time Monitoring or Long Term Reporting from the View menu.

OR
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Select an entity in the Navigation tree for which you want to generate a graph and
then click the Real-Time Monitoring or Long Term Reporting button on the

toolbar.

The graphs submenu is displayed.

2. Select Protocols from the drop down menu.

The Real-Time Monitoring or Long Term Reporting dialog is displayed. The Stacked

Bar Report icon is displayed in the upper right hand corner of the dialog box.

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display. Once minimum parameters have been
defined, a report may be generated at any time by clicking the OK button

The Time tab is open by default.

linn1

Figure 8-14: Long-Term Reporting: Protocols dialog box, Time tab

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of

a specific day previously).

OR

Time | Objects | Limits | Display |
Date & Time Range
@ Show Data for Last: 105 | Hours -
Ending at report generation time
@ Ending at midnight at 1% days prior to report generation
Show Data in Range: From Date/Time To DateiTime
May 29, 2012 z May 29, 2012 z
12AM = 09 AM
Show in Hours: From To
12:00 AM - 09:00 AM -
Ending prior to report generation time
3) Ending 1 days prior to report generation
Data Resolution: 1 Hour -
’ OK ] | Cancel |
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To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

NOTE When generating a Long-Term Report, the available options are 1 hour, 1
day or 1 month.

5. Click the Obijects tab. The following dialog is displayed.

Real-Time Monitoring: Protocols

. ~ I
| Time | Obiects | Limits | Display | ‘ﬂ—lﬂﬂ‘—l

Protocols

© 5% Most Active Protocols Based on: | Total Bandwidth T
") Specific Protocols
Select Objects for Graph

Available Protocols Selected Protocols

) Senvice

m

File Transfer

Games
Instant Messaging Apg «“
| Mail
B Network
P2P

Security

Operation

plications

B e e e e e e e

| Qiraaminn Annliratinne
(1] »

[ OK H Cancel ]

Figure 8-15: Real-Time Reporting: Protocols dialog, Objects tab

6. There are two different Protocols graphs that may be generated, based on
selection on the Objects tab:

e To generate a Most Active Protocols report select the upper radio
button, set the number of objects you wish listed, and set the
parameter you wish the report to be based on (Total Bandwidth, In
Bandwidth, Out Bandwidth, Live Connections (30 Second intervals
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only), New Connections, Dropped Connections, In Packets or Out
Packets).

e Select the Specific Protocol radio button to generate a graph

showing only the protocols selected in the Select Objects for Graph
area.

7. Use the arrow keys in the Select Objects for Graph area to move
individual services or service groups from the Available list to the
Selected list. The Service Groups are all located at the top of the list.
(This step is not available when defining a Most Active Protocols graph)

NOTE It is not recommended to generate Protocols Distribution reports on very
large Pipes or VC templates in order not to decrease performance.

8. Click the Limits tab. The following dialog is displayed.

| Time | Objects | Limits \ Display | [I—”IM

Scope Limits
Limit Scope *10.50.27.220" Further to:

[C] | Line v

[ Internal Host:
["] External Host:
[7] Protocol:

[T cel:

HHBBE

[ oK H Cancel ]

Figure 8-16: Long-Term Reporting: Protocols dialog, Limits tab

9. Use the Scope Limits parameters to refine your report to include only
certain objects.

Click the appropriate check box, and click the ... button to browse the
list of available objects of that type. Use the arrow keys to move objects
from the Available list to the Selected list.

If you are filtering by Internal or External Host, you may click the ...

NetXplorer Operation Guide
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button to open the Host Selection dialog box. If you wish to limit your
selections to either IPv4 or IPv6 hosts, select the Limit Scope check box
and select the relevant radio button. To add hosts, click Add to open the
Add Item dialog box and define the objects to add to the report. If you
are selecting Hosts, you may choose to add Hosts by name, by IPv4
address or by IPv6 Prefix in the Host Item Type field.

-

Add Host ltem

Host ltem Type: :|P\|'5 Prefix

IP Address: fio0:c28

[ Apply ][ Close ]

Figure 8-17: Real-Time Reporting: Add Host Item

10. Click the Display tab. The following dialog is displayed.

Real-Time Monitoring: Protocols

| Time | objects | Limits | Display

Data Structure

@ Data for the Period as a Whole
() Data Over Time

Default Data View

[ Show Al Others' in Graph

Data Splitting

Display Separately for Each
(7 Stack Results by:

@ None

Data Mode
Show Data by:

@ Rate () Volume

Open Graph on: ‘Total Bandwidth

H Cancel ]

Figure 8-18: Long-Term Reporting: Pipes dialog, Display tab

11. In the Data Structure area, there are two available options:
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e Data for the Period as a Whole: When you have specified
protocols in the Objects tab, this radio button will generate a pie
chart which shows the proportionate distribution of different services
or service groups, where 100% represents all of the services or
service groups chosen. When you have specified most active
protocols in the Objects tab, this radio button will generate a bar
chart for the whole period selected.

e Data Over Time: When you have specified protocols in the Objects
tab, this radio button will generate a graph presents the distribution
of these protocol’s traffic over a set period of time. When you have
specified most active protocols in the Objects tab, this radio button
will present the distribution over time of the most active protocols as
calculated in the specified time period.

12. From the Default Data View area, open the Open Data On dropdown
list and select the parameter you wish to see Statistics about (Total
Bandwidth, In Bandwidth, Out Bandwidth, New Connections, Dropped
Connections, In Packets or Out Packets).

13. Select the Show “All Others” in Graph radio button to display all
elements not selected in a single “All Others” category.

14. In the Data Splitting area, you can opt to see the stats for specific
network entities separately.

15. In the Data Mode area, you can opt to display data by Rate or Volume.
16. Click OK to generate the selected graph.

Policy Entity Reports

Policy Entity reports display information concerning specific entities in your network
(NetEnforcers/Service Gateways, Lines, Pipes or Virtual Channels). In addition, Policy Entity
reports can show information concerning anything below the selected entity in the network
hierarchy. For example, if you select a NetEnforcer or Service Gateway, you can also create
reports that deal with its Lines, Pipes and VCs.

Policy Entity reports can be generated as Real Time Monitoring graphs or Long-Term Reports.

To generate an Policy Entity Report

1. Inthe Navigation pane, right-click a level in the Navigation tree for
which you want to generate a graph and select Real-Time Monitoring or
Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Real-Time Monitoring or Long Term Reporting from the View menu.
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OR

Select an entity in the Navigation tree for which you want to generate a graph and
then click the Real-Time Monitoring or Long Term Reporting button on the
toolbar.

The graphs submenu is displayed.

Select the entity type you wish to generate a report concerning. For example, right
clicking a Line and selecting Protocols from the drop down menu will generate
reports about Protocols on that Line.

The Real-Time Monitoring or Long Term Reporting dialog is displayed. The Stacked
Bar Report icon is displayed in the upper right hand corner of the dialog box.

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display. Once minimum parameters have been
defined, a report may be generated at any time by clicking the OK button

The Time tab is open by default.

Time | Objects | Limits | Display| “]_[ﬂ'm

Date & Time Range
@ Show Data for Last: 10 |Hours A
Ending at report generation time
@ Ending at midnight at 1% days prior to report generation
Show Data in Range: From Date/Time To Date/Time
May 29, 2012 z May 29, 2012 =
12AM 09 AM
Show in Hours: From To
12:00 AM = 09:00 AM =
Ending prior to report generation time
@) Ending 11 days prior to report generation
Data Resolution: 1 Hour -
[ OK ] | Cancel |

Figure 8-19: Long-Term Reporting: Pipes dialog box, Time tab

To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
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period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

5. Click the Obijects tab. The following dialog is displayed.

Long-Term Reporting: Pipes @
| Time | Objects | Limits | Display “].'.ﬂ.‘]_l
Pipes
o 5-% Most Active Pipes Based on: | Total Bandwidth v

Specific Pipes
Select Objects for Graph

Available Pipes Selected Pipes

& Network Item Type

4«

[ OK H Cancel ]

Figure 8-20: Long-Term Reporting: Pipes dialog, Objects tab

6. To generate a Most Active... report, select the upper radio button, set the
number of objects you wish listed, and set the parameter you wish the
report to be based on (Total Bandwidth, In Bandwidth, Out Bandwidth,
Live Connections (30 Second intervals only), New Connections,
Dropped Connections, In Packets or Out Packets).
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7. To generate other reports based on objects of the type selected, click the
Specific Objects radio button.

Use the arrow keys to move objects from the Available list to the
Selected list.

NOTE It is not recommended to generate distribution reports on very large Pipes
or VC templates in order not to decrease performance.

8. Click the Limits tab. The following dialog is displayed.

Long-Term Reporting: Pipes

B3
i Time l Objects ‘ Limits Display [I_m}

Scope Limits

Limit Scope *10.4.3.10" Further to:

[7] Line v D
[ Internal Host: |:]
[7] External Host: |j
|| Protocol: E]
[7] Subscriber: Ij

[ OK H Cancel J

Figure 8-21: Long-Term Reporting: Pipes dialog, Limits tab

9. Use the Scope Limits parameters to refine your report to include only
certain objects, Internal Hosts, External Hosts, Protocols or Subscribers
(if available).

Click the appropriate check box, and click the ... button to browse the
list of available objects of that type. Use the arrow keys to move objects
from the Available list to the Selected list.

If you are filtering by Internal or External Host, you may click the ...
button to open the Host Selection dialog box. If you wish to limit your
selections to either IPv4 or IPv6 hosts, select the Limit Scope check box
and select the relevant radio button. To add hosts, click Add to open the
Add Item dialog box and define the objects to add to the report. If you
are selecting Hosts, you may choose to add Hosts by name, by IPv4
address or by IPv6 Prefix in the Host Item Type field.
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- "
Add Host Item =5
Host ltem Type: :|F'\|'5 Prefix v:

IP Address: ff00:c28
[ Apply ] [ Close ]
— ——

Figure 8-22: Real-Time Reporting: Add Host Item
10. Click the Display tab. The following dialog is displayed.

Long-Term Reporting: Pipes (A
i Time | Objects l Limits | Display m—m—l
Data Structure

@ Data for the Period as a Whole
Data Over Time
Default Data View

Open Graph on: Total Bandwidth v

[7] Show *All Others’ in Graph

Data Splitting

Display Separately for Each
_) Stack Results by: NetEnforcer v
©@ None

Data Mode
Show Data by:

@ Rate ) Volume

[ OK ]l Cancel ]

Figure 8-23: Long-Term Reporting: Pipes dialog, Display tab

11. In the Data Structure area, there are two possible options:

e Data for the Period as a Whole: This option is used with Most
Active reports and will generate a pie chart which shows the
proportionate distribution of traffic over different Entities, where
100% represents all of the objects chosen.

e Data Over Time: This option is used with Distribution reports and
will generate a graph which presents the distribution of traffic over
the selected Entities during a set period of time.

12. From the Open Graph On dropdown list, select the parameter you wish
to see Statistics about (Total Bandwidth, In Bandwidth, Out Bandwidth,
New Connections, Dropped Connections, In Packets or Out Packets).
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13.

14.

15.
16.

Select the Show “All Others” in Graph radio button to display all
elements not selected in a single “All Others” category.

In the Data Splitting area, you can opt to see the stats for specific
network entities separately.

In the Data Mode area, you can opt to display data by Rate or Volume.

Click OK to generate the graph.

Hosts/Conversations Reports

Hosts/Conversations reports can be used to display the most active host objects over the period
defined or the distribution of selected hosts over the period defined. These can include All
Hosts, Internal Hosts, External Hosts and/or Conversations.

NetEnforcer AC-3K-10.4.3.11 - Most Active Hosts Host

Selection Based on: Total Bandwidth = 0000
Displaying: Total Bandwidth 0 239,255,255,250
= Oz 128
j m fF02:1:20128
= 224.0.0,251

Total Bandwidth {kbps)

0.0

Oct 17 2012 17:23:01 To Oct 17 2012 17:33:00

Figure 8-24: Most Active Hosts Report

Host/Conversations reports can be generated as Real Time Monitoring graphs or Long-Term
Reports.

To generate an Host/Conversations Report

1.

In the Navigation pane, right-click a level in the Navigation tree for
which you want to generate a graph and select Real-Time Monitoring or
Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Real-Time Monitoring or Long Term Reporting from the View menu.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
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then click the Real-Time Monitoring or Long Term Reporting button on the
toolbar.

The graphs submenu is displayed.

2. Select the Host/Conversation type you wish to generate a report concerning. For
example, right clicking a Service Gateway and selecting Hosts from the drop down
menu will generate reports about Hosts on that Service Gateway.

The Real-Time Monitoring or Long Term Reporting dialog is displayed. The Stacked
Bar Report icon is displayed in the upper right hand corner of the dialog box.

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display. Once minimum parameters have been
defined, a report may be generated at any time by clicking the OK button

The Time tab is open by default.

Real-Time Monitoring: Hosts x|

Time | Objects | Limits | Display| \ﬂ—lﬂﬂ—l

Date & Time Range
@ Show Data for Last: 10 _Minutes =
@ Ending at report generation time
Ending at midnight at 14| days prior to report generation
Show Data in Range: From Date/Time To DateiTime
May 29, 2012 = @ May 29, 2012 = @J
12:00 AM = 09:58 AM =
Show in Hours: From To
12:00 AM - 09:00 AM -
2) Ending prior to report generation time
Ending 1| days prior to report generation
Data Resolution: 30 Seconds -
’ oK ] I Cancel ‘

Figure 8-25: Real-Time Reporting: Hosts dialog box, Time tab

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).
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OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to

Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report

is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the

graph from the Data Resolution dropdown list.

5. Click the Obijects tab. The following dialog is displayed.

Real-Time Monitoring: Hosts

\ Time | Objects ‘ Limits l Display \
A Hosts e

° 55| MostActive Hosts Based on: | Total Bandwidth
Specific Hosts

Select Objects for Graph

| Item Type

3

i

l

OK

| [ cancel ]

Figure 8-26: Real-Time Reporting: Hosts dialog, Objects tab

6. To generate a Most Active... report, select the upper radio button, set the
number of objects you wish listed, and set the parameter you wish the
report to be based on (Total Bandwidth, In Bandwidth, Out Bandwidth,
Live Connections (30 Second intervals only), New Connections, In

Packets or Out Packets).

7. To generate other reports based on objects of the type selected, click the

Specific <OBJECT> radio button.
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Click Add to open the Add Item dialog box and define the objects to add
to the report. If you are selecting Hosts, you may choose to add Hosts by
name, by IPv4 address or by IPv6 Prefix in the Host Item Type field.

P B
Add Host Item [
Host ltem Type: :IP\«'B Prefix v:

IP Address: ff00:cM28
[ Apply ] [ Close ]

Figure 8-27: Real-Time Reporting: Add Host Item
8. Click the Limits tab. The following dialog is displayed.

Real-Time Monitoring: Hosts e

- Objects ‘7 Limits 7 Display \ H]_M

Scope Limits
Limit Scope “10.4.3.10" Further to:

[T] Line v
[“]Internal Host:
["] External Host:

[~] Protocol:

BDOOBE

[] Subscriber:

[ ok || cancel |

Figure 8-28: Real-Time Reporting: Hosts dialog, Limits tab

9. Use the Scope Limits parameters to refine your report to include only
certain Policy Entities, Internal Hosts, External Hosts or Protocols or

Subscribers (if available).
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Click the appropriate check box, and click the ... button to browse the list of available
objects of that type. Use the arrow keys to move objects from the Available list to the

Selected list.

If you are filtering by Internal or External Host, you may click the ...
button to open the Host Selection dialog box. If you wish to limit your
selections to either IPv4 or IPv6 hosts, select the Limit Scope check box
and select the relevant radio button. To add hosts, click Add to open the
Add Item dialog box and define the objects to add to the report. If you
are selecting Hosts, you may choose to add Hosts by name, by IPv4
address or by IPv6 Prefix in the Host Item Type field.

-
Add Host ltem

Host ltem Type:

IP Address:

IPV6 Prefix

00128

[

Apply

Figure 8-29: Real-Time Reporting: Add Host Item

10. Click the Display tab. The following dialog is displayed.

Real-Time Monitoring: Hosts

| Time | Objects

| Limits |

Data Structure

Data Over Ti

Open Graph on:

Data Splitting

@ None

Data Mode
Show Data by:

@ Rate

me

Default Data View

() Stack Results by:

Display
L

© Data for the Period as a Whole

Show ‘All Others’ in Graph

Display Separately for Each:

Volume

2 |

I

H Cancel ]

Figure 8-30: Real-Time Reporting: Hosts dialog, Display tab

11. In the Data Structure area, there are two possible options:
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o Data for the Period as a Whole: This option is used with Most
Active reports and will generate a pie chart which shows the
proportionate distribution of traffic over different objects, where
100% represents all of the objects chosen.

e Data Over Time: This option is used with Distribution reports and
will generate a graph presents the distribution of traffic over a set
period of time.

12. From the Open Graph On dropdown list, select the parameter you wish
to see Statistics about (Total Bandwidth, In Bandwidth, Out Bandwidth,
New Connections, Dropped Connections, In Packets or Out Packets).

13. Select the Show “All Others” in Graph radio button to display all
elements not selected in a single “All Others” category.

14. In the Data Splitting area, you can opt to see the stats for specific
network entities separately.

15. In the Data Mode area, you can opt to display data by Rate or Volume.
16. Click OK to generate the graph.

Additional Graphs

Utilization Reports

The Utilization Report is available for Lines, Pipes and Virtual Channels. It displays the
inbound and outbound bandwidth consumed by the selected Line, Pipe or Virtual Channel, in
relation to the minimum and maximum bandwidth defined for a NetEnforcer or Service
Gateway or the selected Line, Pipe or Virtual Channel.

The Utilization graph is displayed as two horizontal bars representing inbound and outbound
bandwidth. You cannot change this display. The bandwidth consumed is displayed in the
horizontal bar and, above the horizontal bar, the consumed bandwidth as a percentage of the
maximum bandwidth is displayed.

NOTE The Utilization graph is not available for a Line, Pipe or Virtual Channel for
which no maximum bandwidth has been defined (in the QoS Catalog entry
selected as the value for the QoS of the Line, Pipe or Virtual Channel).

To generate a Utilization Report

1. Inthe Navigation pane, right-click a Line, Pipe or Virtual Channel in the
Navigation tree for which you want to generate a graph and select Real-
Time Monitoring or Long Term Reporting.

OR
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Select a Line, Pipe or Virtual Channel in the Navigation tree for which you want to
generate a graph and then select Real-Time Monitoring or Long Term Reporting
from the View menu.

OR

Select a Line, Pipe or Virtual Channel in the Navigation tree for which you want to
generate a graph and then click the Real-Time Monitoring or Long Term Reporting
button on the toolbar.

The graphs submenu is displayed.

2. Select Utilization. The Real-Time Monitoring: Utilization or Long Term
Reporting: Utilization Properties dialog is displayed. The Utilization
Report icon is displayed in the upper right hand corner of the dialog box.

—
) —
e | ——
Date & Time Range
@ Show Data for Last: 105 |Minutes -
@ Ending at report generation time
Ending at midnight at 1=~ days prior to report generation
Show Data in Range: From Date/Time To DateiTime
May 29, 2012 : May 23, 2012 E
12:00 AM 10:00 AM
Show in Hours: From i
12:00 AM 10:00 AM
2 Ending prior to report generation time
Ending 1| days prior to report generation
Data Resolution: 30 Seconds -

’ OK H Cancel |

Figure 8-31: Real-Time Monitoring: Utilization dialog box

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

8-38 NetXplorer Operation Guide



Chapter 8: Monitoring Reports

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

NOTE When generating a Long-Term Report, the available options are 1 hour, 1
day or 1 month.

5. Click OK to generate the graph.

Typical Time Reports

A Typical Time report represents the traffic in a typical time interval based on an average
calculated over the selected time period. For example, in order to plan their network capacity a
Service Provider may wish to see the bandwidth consumption of a specific protocol or group
of protocols from hour to hour over a typical day, to see at what hours demand is highest.
Alternatively, using a Typical Week report a Service Provider can view differences between
weekday and weekend consumption over a typical week.

Typical Time Reports are available for all graph types and both Real-Time Monitoring and
Long Term Reporting.

To display a Typical Time report:

1. Inthe Navigation pane, right-click the entity in the Navigation tree for
which you want to generate a monitoring graph and select Real-Time
Monitoring or Long Term Reporting.

OR

Select the entity in the Navigation tree and then select Real-Time Monitoring or
Long Term Reporting from the View menu.

The Real-Time Monitoring or Long Term Reporting submenu is displayed.
2. Select Typical Time to display the submenu.

3. Select the required type of graph from the submenu. The Typical Tine
report dialog is displayed.

The Time tab is open by default.
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Time | Objects | Limits | Display | “]—m—l

Date & Time Range
@ Show Data for Last: 10 |Days -
Ending at report generation time
@ Ending at midnight at 1% days prior to report generation
Show Data in Range: From Date/Time To Date/Time
May 29, 2012 = May 29, 2012 z
12:00 AM - 11:59 PM -
Typical Time
Graph Type Time Scope
@) Typical Day @ Full Week
Typical Week Specific Days and Hours |:|
’ oK ] | Cancel |

Figure 8-32: Long Term Reporting Typical Time dialog box — Time tab

4. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

5. You may opt to display a graph to display a Typical Day or a Typical
Week from the selected time period using the radio buttons in the Graph
Type area.

6. Select the Typical Time to be displayed. Set the Scope to Full Week or
Specific Days or Hours. Click the ... button to open the Time Scope
Selections dialog box.
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r S
Time Scope Selection @

Indicate Days and Hours to be Graphed:

DayfHour | 00| 01| 02| 03| 04| 05 06| 07 | 08 ) 09 ) 10 11.) 12 ) 13 14 15 ] 16| 17| 18] 19| 20| 29'| 22| 23
ey |

Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Figure 8-33: Time Scope Selections dialog box

7. Highlight the times to be included in the Typical Time Report and click
OK.

8. All other Tabs (Objects, Limits and Display) are configured as they are
in other Object reports, see page 8-27.

9. Click OK to open the graph.

Popularity Reports

Rather than quantifying objects by bandwidth or packets, Popularity Reports evaluates traffic
by number of subscribers or IPs. A Popularity Report concerning subscribers is only available
if the Subscriber Management Platform is enabled.

Popularity Reports are available in Long-Term Reporting only.

Most Popular graphs include:

Long-Term Reporing x

Metwork - Most Popular Pipes [ TrueHISP - Lowspeed nonP2p
I TrueHISP - LowSpeed nonPzp
Based on; Subscribers W TrueHISP - P2
[ TrueHIsP - P2P
160000 [CITrueHIsP - pzp

140000
120000
100000

80000

Subscribers

60000

40000

20000

1]

Apr29 2008 15:00:00 To Apr29 2008 19.59:59

Figure 8-34: Most Popular Pipes on Network — Bar Chart

e Pipe Popularity: This option generates a Most Popular Pipes monitoring
graph which displays the most popular Pipes based on the number of
subscribers. This graph is available on the Network, NetEnforcer and Line
levels.
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Virtual Channel Popularity: This option generates a Most Popular VCs
monitoring graph which displays the most popular VVCs based on the
number of subscribers. This graph is available on the Network,
NetEnforcer, Line and Pipe levels.

Average Protocol Popularity (Average Most Popular Protocols): This
monitoring graph displays the most popular Protocols, based on an average
of all subscribers. This graph is available on the Network and
NetEnforcer/Service Gateway levels for those devices that have first
enabled “service” bucket collection. For more information see the CLI
chapter in the Hardware Guide for that device.

To generate an Popularity Report

1.

In the Navigation pane, right-click a level in the Navigation tree for
which you want to generate a graph and select Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Long Term Reporting from the View menu.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then click the Long Term Reporting button on the toolbar.

The graphs submenu is displayed.

Select Pipe Popularity, Virtual Channel Popularity or Average Protocol Popularity
from the submenu.

The Long Term Reporting dialog is displayed. The Report Type icon is displayed in
the upper right hand corner of the dialog box.

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display. Once minimum parameters have been
defined, a report may be generated at any time by clicking the OK button

The Time tab is open by default.
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Long-Term Reporting: Pipe Popularity =

Time | Objects | Limits | Display | [I_[EJ]J

Date & Time Range
@ Show Data for Last: 1045 \Hours ]
1 Ending at report generation time
@ Ending at midnight at 1= days prior to report generation
Show Data in Range: From Date/Time To Date/Time
May 23, 2012 = May 23, 2012 =
12.AM = 10 AM =
") Show in Hours: From To
12:00 AM = 10:00 AM =
Ending prior to report generation time
2) Ending 1| days prior to report generation
Data Resolution: 1 Hour A
’ OK ] I Cancel ‘

Figure 8-35: Long-Term Reporting: Pipe Popularity dialog box, Time
tab

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

5. Click the Obijects tab. The following dialog is displayed.
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Long-Term Reporting: Pipe Popularity ‘7§
Time ! Objects [ Limits l Display ‘ mmﬂ—l
| ~Pipes
) 5% Most Active Pipes Based on: _Internal IP Hosts =
~ Specific Pipes
Select Objects for Graph
Available Pipes Selected Pipes
@ 10.43.10 [ item Type
-4 Fallback
»
q
«
4 mn »
[ OK ] [ Cancel ]

Figure 8-36: Long-Term Reporting: Pipe Popularity dialog, Objects tab

6. To generate a Most Active... report, select the upper radio button, set the
number of objects you wish listed, and set the parameter you wish the
report to be based on. In Pipe Popularity and Virtual Channel Popularity
reports only Internal IP Hosts is available, and in Average Protocol
Popularity reports only Internal Subscribers is available.

7. To generate other reports based on objects of the type selected, click the
Specific <OBJECT?> radio button.

Use the arrow keys to move objects from the Available list to the
Selected list.

8. Click the Limits tab. The following dialog is displayed.
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Long-Term Reporting: Pipe Popularity [ =]

‘ Time T Objeds"“ Limits \ Disp,gyﬁ‘ I |I I\

Scope Limits
Limit Scope "10.4.3.10" Further to:

[] | Line v
["]Internal Host:
["] External Host:

[~] Protocol:

DDDO0

["] Subscriber:

[ ok || cancel |

Figure 8-37: Long-Term Reporting: Pipe Popularity dialog, Limits tab

9. Use the Scope Limits parameters to refine your report to include only
certain Policy Entities, Internal Hosts, External Hosts or Protocols or
Subscribers (if available).

Click the appropriate check box, and click the ... button to browse the list of available
objects of that type. Use the arrow keys to move objects from the Available list to the
Selected list.

10. Click the Display tab. The following dialog is displayed.
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| Time | objects ] Limits | Display

Long-Term Reporting: Pipe Popularity

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on: Internal IP Hosts v
Show "All Others' in Graph
Data Splitting
Display Separately for Each
Stack Results by: NetEnforcer v
@ None
[ ok

] [ Cancel ]

Figure 8-38: Long-Term Reporting: Pipe Popularity dialog, Display tab

11. In the Data Structure area, there are two available options:

e Data for the Period as a Whole: This radio button will generate a
pie chart which shows the proportionate distribution of traffic over
different objects, where 100% represents all of the objects chosen.
When you have specified most active objects in the Objects tab, this
radio button will generate a bar chart for the whole period selected.

e Data Over Time: This radio button will generate a graph presents
the distribution of traffic over a set period of time. When you have
specified most active objects in the Objects tab, this radio button will
present the distribution over time of as calculated in the specified

time period.

14. Click OK to generate the graph.

12. From the Open Data On dropdown list, select the parameter you wish to
see Statistics about. In Pipe Popularity and Virtual Channel Popularity
reports only Internal IP Hosts is available, and in Average Protocol
Popularity reports only Internal Subscribers is available.

13. In the Data Splitting area, you can opt to see the stats for specific
network entities separately.
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Asymmetry Traffic Report

e )]
: Remote Device in Group

[ no. 0 (NetEnforcer_1)
O no. 1 (NetEnforcer_2)
Asymmetry In Bandwidth M no. 2 (NetEnforcer_3)
no. 3 (NetEnforcer_4)
[ no. 4 (NetEnforcer_S)
[ no. 5 (NetEnforcer_6)
[ no. 6 (NetEnforcer_7)

NetEnforcer SIM-201 - Asymmetry Group Bandwidth Distribution
Source Device no. 7 (S5IM-201); Group: myTestGroup

symmetry In Bandwidth {Mh

09:36 09:37

Feb 152010 09:35:02 To Feb 152010 09:37:02

Figure 8-39: Asymmetry Traffic Graph

This report, which is only available for AOS devices, shows the traffic being used by each
device in an Asymmetry Device Group (ADG). This report is available on the device level
(as long as a device has Asymmetry enabled) as a Long-Term or Real Time Distribution
graph, showing Asymmetry In Bandwidth, Asymmetry Out Bandwidth and Number of
Asymmetry Sessions.

To generate an Asymmetry Traffic Report

1. Inthe Navigation pane, right-click a level in the Navigation tree for
which you want to generate a graph and select Real-Time Monitoring or
Long Term Reporting.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then select Real-Time Monitoring or Long Term Reporting from the View menu.

OR

Select an entity in the Navigation tree for which you want to generate a graph and
then click the Real-Time Monitoring or Long Term Reporting button on the
toolbar.

The graphs submenu is displayed.
2. Select Asymmetry Traffic from the submenu.

The Real-Time Monitoring or Long Term Reporting dialog is displayed. The Stacked
Bar Report icon is displayed in the upper right hand corner of the dialog box.

You may configure the parameters of your report using the two tabs of the dialog box;
Time and Display. Once minimum parameters have been defined, a report may be
generated at any time by clicking the OK button
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The Time tab is open by default.

Date & Time Range
@ Show Data for Last: 10 - | Minutes A
@ Ending at report generation time
Ending at midnight at | 115-| days prior to report generation
Show Data in Range: From Date/Time To DateiTime
May 23, 2012 = May 29, 2012 =
12:00 AM = 09:49 AM
Show in Hours: From To
12:00 AM 09:00 AM -
8 Ending prior to report generation time
Ending || L1 days prior to report generation
Data Resolution: 30 Seconds  ~
Figure 8-40: Real-Time Reporting: Asymmetry Traffic dialog box,

Time tab

3. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

5. Click the Display tab. The following dialog is displayed.
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9.

Real-Time Monitoring: Asymmetry Traffic

‘ Time ‘\_ Display \

Data Structure
Data for the Period as a Whole
@ Data Over Time
Default Data View
Open Graph on: Asymmetry In Bandwidth v
Show "All Others® in Graph
Data Splitting
Display Separately for Each
Stack Results by
9 None
Data Mode

| | Show Data by:

@ Rate Volume

[ OK ] { Cancel ]

Figure 8-41: Real-Time Reporting: Asymmetry Traffic dialog, Display
tab
In the Data Structure area, only one option is available:

e Data Over Time: This radio button will generate a graph presents
the distribution of traffic over a set period of time.

From the Open Graph On dropdown list, select the parameter you wish
to see Statistics about (Asymmetry In Bandwidth, Asymmetry Out
Bandwidth, Asymmetry Sessions).

In the Data Splitting area only one option, None, is available and it is
selected by default.

In the Data Mode area, you can opt to display data by Rate or Volume.

10. Click OK to generate the graph.

Services Reports
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A series of service reports are available on AOS devices only. The different reports are
detailed below.

: Network
Network - WebSafe Traffic N
MNetwork

llegal URLs

80 {

60 1

lllegal URLs {(numisec)
N
o

09:32 09:33 09:34 09:35 09:36

Feb 152010 09:31:45 To Feb 152010 09:36:45

Figure 8-42: WebSafe Traffic

o \WebSafe Traffic: This report shows the HTTP traffic being checked and filtered by
WebSafe (if WebSafe is enabled). This report is available on a device or network level as a
Long —Term or Real Time Report, showing Inspected Requests and Illegal URLs per

second.
o X
4 Domain Name
NetEnforcer SIM-201 - Most Active Domain Names k )
Odomainiame_7
Based on: Total Bandwidth Egoma!nName_S
Displaying: Total Bandwidth omainName_3
Hdomainiame_2
12 Odomainiame_9
W
o
=
£
< 8
Z
Z
=
5 4
m
o
=l
Eo
Feb 152010 09:31:43 To Feb 152010 09:37:12

Figure 8-43: HTTP

e HTTP: This report shows the most active domain names for the Enforcement Policy entities
on which HTTP Monitoring is selected as an action (when working in “Enforcement Policy
based mode” when it is assigned to each NetEnforcer or Service Gateway individually via
the Enforcement Policy Editor) or for all Enforcement Policy entities (when working in
“always enabled” mode, when it assigned to all NetEnforcers or Service Gateways
automatically).

The default HTTP Monitoring behavior may be set to Always Enabled, Always Disabled or
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Enforcement Policy Based from the Integrated Service tab in the Network Configuration
window. See page 3-40 for details.

The report is available on a device level (as long as URL Monitoring is enabled) as a Long-
Term or Real Time “Most Active” graph, showing In Bandwidth, Out Bandwidth, Total
Bandwidth, Live Connections, New Connections, Packets In, Packets Out and Number of
Subscribers.

Integrated Service Server

NetEnforcer SIM-201 - Most Active Integrated Senvices

Dintegrated Service 1__isServer 0|
" DIntegvated Service 1__isServer_1

B}ased pn: Total Bandw@h .Integrated Service 1__isServer_2 ’
Dispiaying Total Bandywidi Integvated Service 1__isServer 3

Dlntegrated Service 1__isServer_4 ’

g100 Ointegrated Service 1__isServer_S
§ 20 DIntegvated Service 1__isServer_6
= g W integrated Service 1__isServer_7 —
T 60 X %
= t .Integrated Service 2__isServer_0
Z 40 Eintegrated Service 2__isServer_1
% 20 DIntegrated Service 2__isServer_2
g r @Integrated Service 2__isServer_3
= 0= Mintegrated Service 2__isServer_4
DIntegrated Service 2__isServer_S
.Integvated Service 2__isServer_6
.Integrated Service 2__isServer_7

.Integvated Service 3__isServer_0
= Integrated Service 3__isServer_1
Ointegrated Service 3__isServer_2
.Integrated Service 3__isServer_3

Integrated Service 1
Integrated Service 2
Integrated Service 3
Integrated Service 4
Integrated Service &
Integrated Service &
Integrated Sarvice 71
Integrated Service &

Feb 152010 09:33:46 To Feb 152010 09:39:15 BlIntegrated Service 3__isServer_4

Integvated Service 3__isServer 5 |

Figure 8-44: Integrated Services

® Integrated Services: This report shows the traffic which is steered to the various Integrated
Services deployed. The report is available on a device level (as long as Integrated Services
are enabled) as a Long-Term or Real Time graph. Most Active Integrated Services, Most
Active Integrated Services by Server, Integrated Services Distribution and Integrated
Services Server Distribution graphs are available, showing Total Bandwidth, In Bandwidth,
Out Bandwidth and Live Connections.

Percentile Reports

Percentile reports break down traffic use as a percentage of the whole.

MetEnforcer 10.50.1.100 - Bandwidth Usage Percentiles

Based on: Hosts Avg Bandwidth

Clpercenties 90-100 (447)
Clpercenties 95-100 (224)

Hosts Avg Banawidth (<bps)

Mar 30 2008 11:01:00 To Mar 30 2008 11:05:00

Figure 8-45: Bandwidth Usage Percentiles
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NOTE

Bandwidth Usage Percentiles: This report shows the average usage for different

subscriber groups according to the percentile of the used bandwidth. Based on the

samples measured for each subscriber, the report will show the average bandwidth
per different subscriber groups that contain 5%, 10%, 25%, 50%, 90% and 95% of
the most active subscribers. This report is available based on either subscribers or

IPs.

Protocal (Number of hosts)
P2P Applications [Training NetEnforcer] Pe es 95-100 - Protocols [l

Based on: Hosts Aug Bandwidth

orrent ()
DHotline (13

Hosts Avg Bandwidih (<bng)

Apr14.2008 13:39:30 To Apr14 2008 134400

@ Real-Tirne Monitoring

Figure 8-46: Percentile Protocols

Protocols Percentile Distribution: This report allows viewing protocol distribution
of the average bandwidth per specific subscribers/hosts group as described in the
“Bandwidth Usage Percentiles” report. This report is available based on either
subscribers or IPs.

The report can be opened from the right click menu on the Network Tree or as a
drill down into one of the bars from the “Bandwidth Usage Percentiles” report.

95™ Percentile Report: The 95% value (metered bandwidth) is used for billing by
most Tier-1 operators and carriers. The 95" percentile value is calculated based on 5
minutes samples over 1 day for real-time graphs, and on 1 hour samples over 1
month for long-term graphs. This report can be generated on the Line, Pipe, or VC
level.

VolP Reports

VolIP reports provide tools for identifying trends and tracking usage volume of OTT VolIP
applications. VVolIP reports can be generated on the Network level only as Real Time
Monitoring graphs or Long-Term Reporting reports.

This report must be enabled from the Service Activation tab of the
NetEnforcer Configuration screen.

To generate a VolP Minutes of Use Report

In the Navigation pane, right-click the Network in the Navigation tree

and select Real-Time Monitoring or Long Term Reporting.

OR
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Select the Network in the Navigation tree and then select Real-Time Monitoring or
Long Term Reporting from the View menu.

OR

Select the Network in the Navigation tree and then click the Real-Time Monitoring
or Long Term Reporting button on the toolbar.

The graphs submenu is displayed.

Select VolIP Minutes of Use. The Real-Time Monitoring: VolP Minutes
of Use or Long Term Reporting: VolP Minutes of Use Properties dialog
is displayed. The Report Type icon is displayed in the upper right hand
corner of the dialog box.

The Time tab is open by default.

g s

) EENREERRE
Time | Limits | Display | easumml e
Date & Time Range
@ Show Data for Last: 0= _I'v'linutes x|
@ Ending at report generation time
Ending at midnight at 1| days prior to report generation
Show Data in Range: From Date/Time To Date/Time
May 29, 2012 = @ May 29, 2012 = @
12:00 AM > 10:10 AM -
Show in Hours: From To
12:00 AM - 10:00 AM -
@) Ending prior to report generation time
Ending 1| days prior to report generation
Data Resolution: 5 Minutes hd

’ oK H Cancel ‘

Figure 8-47: Real-Time Monitoring: VolP Minutes of Use dialog box,
Time tab

To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

NetXplorer Operation Guide

8-53



Chapter 8: Monitoring Reports

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

4. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

NOTE When generating a Long-Term Report, the available options are 1 hour, 1
day or 1 month.

5. Click the Limits tab. The following dialog is displayed.

Real-Time Monitoring: VOIP Minutes of Use

i Y

Time J Limits Display ‘ it e

Scope Limits

Limit Scope ‘Network' Further to:
[ Protocol: [:]

[] Semvice Plan:

[ OK H Cancel J

Figure 8-48: Real-Time Monitoring: VolP Minutes of Use dialog,
Limits tab

6. Use the Scope Limits parameters to refine your report to include only
certain Protocols or Service Plans.
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Click the appropriate check box, and click the ... button to browse the list of available
objects of that type. Use the arrow keys to move objects from the Available list to the
Selected list.

7. Click the Display tab. The following dialog is displayed.

Real-Time Monitoring: VOIP Minutes of Use X |
"0
e [ | o | =
Data Structure

Data for the Period as a Whole
@ Data Over Time

Default Data View

Open Graph on: Total Calls Minutes of Use i
Show "All Others® in Graph

Data Splitting

Display Separately for Each
Stack Results by

) None

[ OK ][ Cancel |

Figure 8-49: Real-Time Monitoring: VolP Minutes of Use dialog,
Display tab

8. Inthe Data Structure area, only Data Over Time is available for this
report.

9. From the Open Data On dropdown list, only Total Calls Minutes of Use
is available for this report.

10. In the Data Splitting area, you can opt to see the stats for specific
network entities separately.

11. Click OK to generate the graph.
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Figure 8-50: VolP Minutes of Use Report

Subscriber Graphs
SMP Reports

SMP Reports display aspects of Subscriber behavior and are only available when an SMP unit
is installed and the SMP has been enabled by entering the appropriate key in the NetXplorer.

When working with a “session management” license, the Most Active Subscribers graph is
disabled. Subscriber distribution graphs are supported, with data aggregated from each session
into a single subscriber element.

Subscribers Reports

These reports, which are available from both the Real-Time Monitoring and the Long Term
Reporting menus, allow the monitoring of subscriber bandwidth. Depending on the
“subscribers” setting in the Objects tab, the reports can be displayed in two ways:

e Most Active Subscribers: This report shows the most active subscribers
based on total bandwidth, in/out bandwidth, new connections or in/out
packets.

NOTE The Most Active Subscribers graph cannot be created and will be unavailable
from the Objects tab when the SMP is working in Session Management mode
and when Single IP Session per APN or Multiple IPs per Subscriber has been
selected in the IPs/Sessions per Subscriber Field on the Network Configuration
SMP tab.

e Subscribers Distribution: This report shows the bandwidth distribution over
time for selected subscribers.
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NOTE When the SMP is performing session management (integrated with a PCRF
over a Gx interface) and the system is configured for “Multiple PDP
sessions are allowed; single IP session per APN” or “Multiple PDP
sessions are allowed; multiple IP sessions per subscriber” modes, the
“Most Active Subscriber” report is disabled. The Subscriber distribution
report will work as usual.

Subscriber Usage Reports

NOTE These reports will only appear in the GUI if Quota Management is enabled
in the server license.

These reports, which are only available as Long Term Reports on the network level, allow the
monitoring of quota usage on a selected service plan per subscriber. Depending on the “service
plan subscribers” setting in the Objects pane, the report can be displayed in two ways:

e Most Active Subscribers for a Given Service Plan: This report shows the
most active subscribers for a given service plan based on the monthly or daily
guota usage. For each subscriber, the report can be defined to display either a
percentage of the available quota, or a total quota volume.

e Subscribers Usage Distribution: This report shows the quota usage
distribution over time for selected subscribers for whatever service plan they
have been assigned.

{Service Plan Subscriber
Network - Subscribers Usage ' Bsub-10
(In+Out) Quota Volume E:EE:F
~.3200 Esub-20
cgo' Osub-21
22400 Osub-2
E Osub-30
%1500 Msub-3
§ 800
= 4l
Oct 28 Oct 29 Oct 30
Oct 27 2008 01:59:59 To Oct 30 2008 01:59:59
Figure 8-51: Subscribers Usage Report
Service Plans Usage Report
NOTE This report will only appear in the GUI if Quota Management is enabled in

the server license.

This report, which is only available as a Long Term Report and can only be run on the network
entity, allows the monitoring of the actual usage of selected quota-based service plan(s) over a
selected period of time. This report may be based on volume or bandwidth usage.
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: Service Plan

Network - Service Plans Usage BronzeSP

Goldsp

(In+Out) Quota Usage(avg) ®silversp

=)
o

=
o

{In+0ut) Quota Usage{avag) (%)
=
e
L

o

ot 28 oct 29 oct 30

Oct 27 2008 01:59:59 To Oct 302008 01:59:59

Figure 8-52: Service Plan Usage Report
Service Plans Popularity Reports

These reports, which are available as both Real-Time and Long Term Reports, can only be run
on the network entity. They display the popularity of selected service plan(s) over a selected
period of time. Service Plan popularity is measured by the number of active subscribers.
Depending on the “service plan subscribers” setting in the Objects pane, the report can be
displayed in two ways:

e Most Popular Service Plans: Showing the most popular service plans for the
defined time period

e Service Plans Popularity Distribution: Showing the distribution of the
selected service plan(s) over the defined time period

Jservice Plan

Network - Service Plans Popularity Distribution Meronzesp

Oecoldse
Wsiversp
Eunlimited Service Plan

Subscribers

[ w
=] o

Subscribers

o

Oct 26 Oct 27 Oct 28 Oct29 Oct30

Oct25 2008 01:59:59 To Oct30 2008 01:59:59

Figure 8-53: Service Plan Popularity Distribution

Quota Analysis Reports

NOTE These reports will only appear in the GUI if Quota Management is enabled
in the server license.
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The three quota analysis graphs are particularly useful where Service Plans have been defined
which include multiple quota catalogs. For example, in a pipe service plan, different daily
quotas may be defined for ingoing or outgoing traffic at different times of the day. These
graphs enable a Service Provider to analyze and compare how different quotas have been
utilized within a specified Service Plan.

e Service Plan Quota Usage Analysis: This report, which is available as a Long
Term Report and can only be run on the network entity, displays the average (daily
or monthly) quota usage over all the subscribers for a selected service plan. Average
guota usage is displayed as a percentage of the assigned quota for that service plan.
If the selected service plan includes several different quotas, the graph will display
data for each quota definition.

:In Quota (Amount)
Oripe Level - peakin_01-08 (200 GB)

In Quota Usage(ava) ; Limited to: GoldSP Daily Quota MPipe Level - peakin_10-12 (200 GB)
Eripe Level - peakIn_14-16 (400 GB)

40 [Cripe Level - peakIn_18-20 (400 GEB)
EFTP - peakin_10-12 (200 GB)

GoldSP - Service Plan Quota Usage Analysis

20

In Quota Usage(avi) (%)

0
Apr 2009 May 2009 Jun 2009 Jul 2009

Apr 012009 02:59:59 To Jun 222009 08:59:59

Figure 8-54: Service Plan Quota Usage Analysis

e Service Plan Quota Volume Analysis: This report, which is available as a Long
Term Report and can only be run on the network entity, displays the average (daily
or monthly) quota volume over all the subscribers for a selected service plan. If the
selected service plan includes several different quotas, the graph displays data for
each quota definition of the selected Service Plan.

In Quota (Expected per Day)

Cripe Level - peakin_01-08 (200 GB)
Wripe Level - peakin_10-12 (200 GB)
Eripe Level - peakin_14-16 (400 GB)

800 CIFTP - peakin_10-12 (200 GB)

GoldSP - Service Plan Quota Volume Analysis

In Quota Volume(avg) ; Limited to: GoldSP Daily Quota

In Quota Yolume(avg) (MB)

Feb 102009 01:59:59 To Feb 18 2009 13:59:59

Figure 8-55: Service Plan Quota Volume Analysis
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e Service Plan Quota Popularity Analysis: This report, which is available as a Long
Term Report and can only be run on the network entity, displays the number of
active subscribers for a selected service plan. The data is displayed over the time
period selected with a daily resolution for daily quotas and a monthly resolution for
monthly quotas. If the selected service plan includes several different quotas, the
graph will display data for each quota definition

In Quota

Oripe Level - peakIn_01-08
Mripe Level - peakin_10-12
Eripe Level - peakin_14-16

CIFTP - peakin_10-12

GoldSP - Service Plan Quota Popularity Analysis

In Quota Active Subscribers ; Limited to: GoldSP Daily Quota

In Quota Active Subscribers

0
Feh 15 Feh 16 Feh 17 Feb 18

Feb 152009 01:59:59 To Feb 18 2009 14:59:59

Figure 8-56: Service Plan Quota Popularity Analysis

NOTE It is possible to right click on a Quota Based SMP graph and choose to see
“details” of the Service Plan. It reveals a “read-only” version of the service
plan for you to remind yourself.

Cellwise Reports
CellWise reports are only available to SMP users with a Cell-Aware license.

o Cell Distribution: This report shows the distribution of bandwidth over time across
the mobile network.

NetEnforcer Sigma - Cells Distribution
%

Total Bandwidth

1000

@
=3
S

=3
=3
S

Total Bandwidth (Mbps)
.
S
8

"
=1
=)

0
11:27 11:28 11:29 11:30 1:31 11:32 11:33 11:34 11:35 11:36

Feb 07 2011 11:27:00 To Feb 07 2011 11:36:30

Figure 8-57: Cell Distribution Report

e Most Active Cells: This report presents the cells carrying the most bandwidth
during the selected time period.
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NetEnforcer Sigma - Most Active Cells

Based on Total Bandwidth 2
Displaying Total Bandwicth

Feb 07 2011 11:26:31 To Feb 07 2011 11:36:30

Figure 8-58: Most Active Cells Report

Mobile Analytics Reports

These 8 mobile analytics graphs process vast amounts of data in order to produce meaningful
and highly accessible representations of your mobile traffic. They are designed to be
configured and scheduled in advance as “User Defined Reports”. While it is possible to
generate these reports manually on an ad-hoc basis from the “Mobile Analytics” menu or
shortcut button, keep in mind that ad-hoc generation of each of these graphs can take a
significant amount of time depending on the size of your network and the amount of mobile
traffic.

When generating these graphs in the NetXplorer GUI, both as an online report, or as a
scheduled report (using the “user defined reports” functionality), the total time-period covered
in the report may be up to 7 days.

Mobile Analytics Reports are available on the Network level only when enabled by license.

NOTE Mobile Analytics can be produced about data dating from 36 hours or longer after
SDRs first began being generated. Therefore if you enabled SDR generation at
1:00 PM on the 1* of January, only the data generated from 1:00 AM on the 3" of
January and after can be used in Mobile Analytics. All data from the previous 36
hours is permanently unavailable.

To schedule a Mobile Analytics Report:

1. Click Actions in the Tool bar and select New Report Entry > New
Report.

OR

Select Reports in the Navigation Pane and right-click on User Defined
Reports. Select New Report from the popup menu.

The Report Identity dialog of the Report Definition Wizard is displayed.
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Report Definition Wizard - New Report
Indicate name and description ] |]
Report Name: Report1]
Description:
Nest2 Cancel

Figure 8-59: Report Identity Window

2. Enter the name of the report and a brief description of the report in the
designated fields, and click Next.

The Report Topic dialog of the Report Definition Wizard is displayed.

Report Definition Wizard - New Report 2
Indicate Network tree entity or Group item on which report will be based. I | I I

® Network Tree Entity

|87 Network

=& AC-3K-10.43.10

&= MOD_Test
464 VLAN200
# &2 VLAN100
462 Fallpack

4 % Fallback

-8 AC-3K-1043.11

Group:

<Back Next > e Cancel

Figure 8-60: Report Topic

3. Select Network entity and click Next. The Report Subject dialog of the
Report Definition Wizard is displayed.
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Report Definition Wizard - New Report 2

Indicate topic of report, and if its short or long-term based ‘I l“]

Report Subject

Session Signaling

Roaming Out Volume

Senvice Plans Metrics

Service Plans Transits

Top Protocols

Subscriber Volume Percentiles
Session Bitrate

Session Duration

Report Term
Real-Time Long-Term © Mobile
Real_Time Typical Time Long-Term Typical Time
<Back Next> | Cancel

Figure 8-61: Report Subject — Mobile Analytics
4. Inthe Report Term area, select Mobile.
5. In the Report Subject area, select the topic of the report.

6. Click Next. The first configuration tab of the Report Definition Wizard
relevant for your selected Mobile Analytics Report is displayed.

7. Click Next to continue to each configuration dialog until you reach the
Schedule dialog.

Report Definition Wizard - New Report 2

Indicate details for the report run, output format and email dispatch I |u] 1

Schedule Detalls
Periodic Reporting: |Hourly v at | 0/ Minutes Into the Hour
Spedific Date & Time for Report 11:59PM = January 3, 20125103

@ Dont Schedule Report

Report Format oo v

Send Report as Email to:

[ <Back Next> Save Cancel

Figure 8-62: Report Schedule

8. Inthe Schedule Details area you may opt to select a time for this report
to be consistently generated on an hourly, daily, weekly or monthly
basis, a specific date and time for this report to be generated, or to leave
the report unscheduled at this time.

9. A Report Format (JPG, PNG, CSV, XML, HTML or PDF) must be
selected from the drop down menu and an email for the report to be sent
to must be entered.
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NOTE An email can only be sent if an SMTP server is properly configured.

10. Click Next. The Report Definition Summary dialog of the Report
Definition Wizard is displayed.

11. Click Save. The scheduling information is saved and the new report
definition is added to the list of available customized reports.

To generate a Mobile Analytics Report manually:

1. Inthe Navigation pane, right-click the Network and select Mobile
Analytics.

OR

Select the Network in the Navigation tree and then select Mobile Analytics from the
View menu.

OR

Select the Network in the Navigation tree and then click the Mobile Analytics button
on the toolbar.

The graphs submenu is displayed.
2. Select the Mobile Analytics report you wish to generate from the submenu.
The Mobile Analytics dialog is displayed.
3. Use the on screen tabs to change configuration dialogs.
4. Click OK to generate the report.
Mobile Analytics Report Definition

Session Signaling

This report shows the average number of signaling events per active subscriber. A Signaling
Events refers to either a session start or session stop (RADIUS) message. The report shows the
amount of signaling events over time.

The Session Signaling Report may be viewed as a Bar Graph or as a Table.
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Network.
Network - Session Signaling ENstwork

Session Signaling per Active Subscriber

Session Signaling per Subscriber
~
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Figure 8-63: Session Signaling Report — Bar Graph

T A Ciamcice
Network - Session Signaling

| Table Time |

! Device Model Session Signa...| Number of Number of
|Oct 17 2011 04:59:59 Category per Active Session Signa...| Active Subscri...
Oct 17 2011 05:59:59 Subscriber Events

Oct17.2011 06:59:59 | grickPhone Category 15 300 200

83 :_7, gg:: g;gggg Regular Phone Category 15 600 400
Oct17 2011 09:59:59 SmartPhone Category 15 900 600

Oct17 2011 10:59:59
Oct 17 2011 11:59:59
Oct 17 2011 12:59:59

13:59:59

Oct 17 2011 13:00:00 To Oct17 2011 13:59:59

Figure 8-64: Session Signaling Report — Table

To configure a Session Signaling Report:

You may configure the parameters of your report using the three tabs of the dialog
box; Time, Limits and Display.
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1.

Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-65: Mobile Analytics: Session Signaling, Time dialog

In the Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Figure 8-66: Mobile Analytics: Time Scope Selection dialog box
2. Inthe Limits dialog the following fields are displayed:

Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category: E]

[ Device Model:

Figure 8-67: Mobile Analytics: Session Signaling, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories

BrickPhone Category [Regular Phone Category

SmartPhone Category

oK Cancel

k= |

Figure 8-68: Mobile Analytics: Device Models Selections dialog

3. Inthe Display dialog the following fields are displayed:

Data Structure

Data for the Period as a Whole
© Data Over Time

Default Data View

Open Graph on: Session Signaling per Subscriber v
Show ‘All Others' in Graph

Data Splitting

Display Separately for Each
() Stack Results by: :Device Model Category =

@ None

Figure 8-69: Mobile Analytics: Session Signaling, Display dialog

e Inthe Data Structure area, only one option, Data Over Time, is
available.
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (Number of Active Subscribers, Number
of Signaling Events or Session Signaling per Subscriber).

e Inthe Data Splitting area you may select None or to stack results by
Device Model Category. None is selected by default.
NOTE The available Device Model Categories are defined in the TAC file.

Roaming Out Volume

This report shows the volume consumed by roaming out subscribers vs. the volume consumed
by local subscribers.
e Roaming Out refers to those subscribers who have connected
remotely through another operator network, therefore incurring
Roaming charges.

e Local refers to those subscribers that connect directly through the
operator's local network.

NOTE In order to enable the system to distinguish between “local” and “roaming”
sessions, the NetXplorer Administrator must first configure the list of SGSNs
within the network. This is detailed in the SMP Installation and Administration

Guide.
The Session Signaling Report may be viewed as a Pie Graph or as a Table.

: Localization
Network - Home vs. Roaming Volume
9 CHome [41144.731]

[Croaming [20809.651]

Total Volume [GB]

Oct 06 2011 13:00:00 To Oct16 2011 12:59:59

Figure 8-70: Roaming Out Volume Report — Pie Graph
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Network - Home vs. Roaming Volume

Localization

Total Volu... | InVolume | OutVolume | % Total % In % Out
(GB) (GB) (GB) Volume (%) | Volume (%) | Volume (%)
Home 41144731 0.0 41144731 66.4 0.0 66.4
Roaming 20809.651 0.0 20809.651 336 0.0 336

Oct06 2011 13:00:00 To Oct 16 2011 12:59:59

Figure 8-71: Roaming Out Volume Report — Table

To configure a Roaming Out Volume Report:

4.

You may configure the parameters of your report using the three tabs of the dialog

box; Time, Limits and Display.
Date & Time Range

-

@ Show Data for Last: 04 :Hours

(71 Ending at report generation time

@ Ending at midnight at 15| days prior to report generation

™) Show Data in Range: From Date/Time To Date/Time
Movember 28, 2012 - Movember 28, 2012 ©
12 AM = 01PM =
“) Show in Hours: From To
12:00 AM |2 01:00PM =

Ending prior to report generation time

@ Ending 1| days prior to report generation
Data Resolution: '1 Hour

Time Scope

[] Limit to Specific Days and Hours: E]

Figure 8-72: Mobile Analytics: Roaming Out Volume, Time dialog
In the Time dialog, the following fields are displayed:
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e To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

e To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

e Toseta period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

e Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.

e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

_ :
e

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

T
.

Figure 8-73: Mobile Analytics: Time Scope Selection dialog box
5. Inthe Limits dialog the following fields are displayed:
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Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category:

) &

[ Device Model:

Figure 8-74: Mobile Analytics: Roaming Out VVolume, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Available Device Model Categories

BrickPhone Category
SmartPhone Category

Select the Device Model Categories to be Included in the Graph:

Selected Device Model Categories

[Regular Phone Category

OK | Cancel

=l

Figure 8-75: Mobile Analytics: Device Models Selections dialog

6. Inthe Display dialog the following fields are displayed:

Data Structure

@ Data forthe Period as a Whole
Data Over Time

Default Data View

Open Graph on:

Show 'All Cthers'in Graph

Data Splitting

Display Separately for Each:

@) None

Stack Results by: 4

% Total Volume v

Figure 8-76: Mobile Analytics: Roaming Out Volume, Display dialog

e Inthe Data Structure area, only one option, Data for the Period as a

Whole, is available:
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (Total Volume, Incoming Volume,
Outgoing Volume, % Total Volume, % Incoming Volume, %
Outgoing Volume).

e Data Splitting is unavailable and greyed out for this report.
Service Plans Metrics

This report shows the distribution over time of different metrics for service plan/s. Metrics that
can be displayed are the number of active subscribers, sessions or the traffic volume.

The Service Plans Metrics Report may be viewed as a Stacked Area Graph or as a Table.

Device Model Category

Service Plan Metrics Defautt
O silver
1/5/2011 00:00 - 23:00 B Gold

Volume [GB]

1/5/2011 00:00 - 23:00

Figure 8-77: Service Plans Metrics Report — Stacked Area Graph

Network - Senvice Plans Metrics

o vrfb'.er.'"i S Service Plan | Total Vol...| In Volume | Out Volu...| Number of Numberofl
A 1 ' DI "
0t 10 2011 225950 * (GB) (GB) (GB) |Active Su...| Sessions

0ct 10 2011 2359:59 Jaf Default Senvic... 15437.334 0.0  15437.334 1999 1999
Oct 112011 00:59:59 af Gold 15571226 00 15571226 1999 1999
Oct 112011 01:59:59
Oct 11 2011 02:59:59
Oct 112011 03:59:59
Oct 112011 04:59:59
Oct 112011 05:59:59
Oct 112011 06:59:59
Oct 112011 07:59:59 |
Oct 11 2011 08:59:59
Oct 112011 09:59:59 |=
Oct 112011 10:59:59 |
Oct 112011 11:59:59
:—? = Oct 112011 13:00:00 To Oct 112011 13:59:59

Figure 8-78: Service Plans Metrics Report — Table

To configure a Service Plan Metrics Report:

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display.
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Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-79: Mobile Analytics: Service Plan Metrics, Time dialog

7. Inthe Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
‘Wednesday
Thursday
Friday
Saturday

Figure 8-80: Mobile Analytics: Time Scope Selection dialog box
8. In the Limits dialog the following fields are displayed:

Scope Limits
Limit Scope ‘Network’ Further to:

[ Device Model Categaory [:]

[ Device Model:

Figure 8-81: Mobile Analytics: Service Plan Metrics, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

|| -Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories
BrickPhone Category [Regular Phone Category
SmartPhone Category
{ 4 ]
“«
IS =

Figure 8-82: Mobile Analytics: Device Models Selections dialog
9. Inthe Objects dialog the following fields are displayed:

Senmvice Plans

Scope of Graphis: Network

Selectthe Service Plans to be Included in the Graph:

Available Service Plans Selected Service Plans

Block Service Plan -
Default Service Plan F
Dror_Gold1
Dror_Gold10
Dror_Gold2
Dror_Gold3
Dror_Gold4
Dror_Gold5
Dror_Gold6
Dror_Gold7
Dror_Gold8
Dror_Gold9

PackA

PackA1

PackA2

DackA2

m

HEH

Figure 8-83: Mobile Analytics: Service Plans Metrics, Objects dialog
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e Use the arrow keys to select the Service Plans to be included in the
graph, moving Service Plans from the Available list to the Selected
list.

10. In the Display dialog the following fields are displayed:

Data Structure

Data for the Period as a Whole
@ Data Over Time
Default Data View

Open Graph on: Total Volume v
Show "All Others’in Graph

Data Splitting

Display Separately for Each

Stack Results by 4

Figure 8-84: Mobile Analytics: Service Plans Metrics, Display dialog

e Inthe Data Structure area, only one option, Data Over Time, is
available:

e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (Total Volume, In Volume, Out Volume,
Number of Active Subscribers, Number of Sessions).

e Data Splitting is unavailable and greyed out for this report.
Service Plans Transits

NOTE To generate Service Plan Transit reports the SMP must, in addition to being
in PCC mode, be opposite a PCRF.

This report shows the number of transitions that occurred during the report duration,
aggregated for each ‘from — to’ pair. For each pair of service plans, two values will be
displayed: number of transitions from service plan A to B, and number of transitions from B to
A.

In a standard bar graph, the X axis will list each service plan while the Y axis shows the
number of transitions. The data for each service plan will be sorted by the service plan that was
changed to/from.

The Service Plans Metrics Report may be viewed as a Bar Graph or as a Pie Chart.
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:Service Plan
Network - Service Plans Transits

Coefault Service Plan
Number of Transits Ocold
Msilver
o 1E7
g 8000000
E 6000000
24000000
i
g 2000000

0

Silver

Gold

Default Se..

Oct06 2011 13:00:00 To Oct16 2011 12:59:59

Figure 8-85: Service Plans Transits Report — Bar Graph

: Service Plan

Coefault Service Plan
Oaold
Msilver

Network - Service Plans Transits

Number of Transits

Default Se.. Silver

Oct06 2011 13:00:00 To Oct16 2011 12:59:59

Figure 8-86: Service Plans Transits Report — Pie Chart

To configure a Service Plans Transits Report:

You may configure the parameters of your report using the three tabs of the dialog
box; Time, Limits and Display.
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Date & Time Range

@ Show Data for Last: 1015 | Hours A

Ending at report generation time

Show Data in Range: From Date/Time

Movember 28, 2012

12 AM

Show in Hours: From
12:00 AM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

@ Ending at midnight at 11| days prior to report generation

To Date/Time

Movember 28, 2012

To

01PM =

01:00PM =

Figure 8-87: Mobile Analytics: Service Plan Transits, Time dialog

11. In the Time dialog, the following fields are displayed:

e To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

e To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

e Toseta period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of

days previously).

e Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

i
s N TR . B ==

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

_ShaAL

Figure 8-88: Mobile Analytics: Time Scope Selection dialog box
12. In the Limits dialog the following fields are displayed:

Scope Limits
Limit Scope Melwork’ Further to:
["] Device Model Category:

[7] Device Maodel:

[ Semvice Plan:

DB O

Figure 8-89: Mobile Analytics: Service Plans Transits, Limits dialog

13. In the Limits dialog the following fields are displayed:

e Select the Service Plan checkbox to limit the graph to certain Service
Plans.

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.
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Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.

Next to the Service Plan field, click the Browse button to open the
Service Plans Selection dialog box. Use the arrow keys to select the
Service Plans to be included in the graph, moving Service Plans from
the Available list to the Selected list. Any selected Service Plans
will be displayed in the Service Plans field on the Limits tab.

s - = )
Service Plans Selection e

Senvice Plans

Scope of Graphis: Network

Selectthe Senvice Plans to be Included in the Graph:

Available Service Plans
Uﬁ Block Service Plan

% Default Service Plan
£ Unlimited Service Plan

Selected Service Plans

FEE

Figure 8-90: Mobile Analytics: Service Plans Selections dialog
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

[oeneiss i TN, ]

Device Models
Scope of Graphis:  Network

Selectthe Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories

BrickPhone Category Regular Phone Category
SmariPhone Category

HEH

"

OK | Cancel

=t

Figure 8-91: Mobile Analytics: Device Models Selections dialog

14. In the Display dialog the following fields are displayed:

Data Structure
© Data for the Period as a Whole
Data Over Time
Default Data View
Open Graph on: vNumber of Transits x|
Show ‘All Others'in Graph
Data Splitting
Display Separately for Each
©@ Stack Results by: _Service Plan x|

None

Figure 8-92: Mobile Analytics: Service Plans Transits, Display dialog
e Inthe Data Structure area, only one option, Data for the Period as a

Whole, is available:
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e From the Open Graph On dropdown list only one selection is
available, Number of Transits.

e From the Data Splitting area only one selection is available, to
Stack Results by Service Plan.

Top Protocols

This report shows the most active Protocols during the report time period. This data can be
filtered or stacked by specific mobile device features. It is based both on SDR records and on
Conversations tables.

The Top Protocols Report may be viewed as a Bar Graph or as a Table.

Modlie Monitaring X

Device Mode:
Network- Top Protocols EAEG Modei &
Elal Others
DEticsson Mode 3
=rm: s 1

& LG Mocel 7
Selection Based on Wiciss ik
BNCKTA Model 4
WNCKIA Mol 5
Elehiips Model 10
Bl siemens Modei 1

Mobde Monttoring
Displaying: Tatst | Top Protocals on Network

T
:
<
(=
[

Oct252011 11:00.00 To Oct252011 115958

Figure 8-93: Top Protocols Report Stacked by Device — Bar Graph

Network - Top Protocols

Limited to: BrickPhone Categor... ; Selection Based on: Total Volume
Displaying: Total Volume

Protocol

Device Model l Total Volume l In Volume Out Volume l
(MB) (MB) (MB)
%4 Skype All Others 968.255 968.255 0.0
<4 BitTorrent ERICSSON GF 788 [Reg..  610.122 §10.122 0.0
4 ECHO MITSUBISHI MT179XFO.. 475581 475581 0.0
NOKIA 6190 [RegularPh..  264.07 264.07 0.0
SIEMENS G1050 (Regul.. 343547 343547 0.0

Oct 17 2011 00:00:00 To Oct 17 2011 09:59:59

Figure 8-94: Top Protocols Report by Device — Table
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To configure a Top Protocols Report:

You may configure the parameters of your report using the four tabs of the dialog

box; Time, Objects, Limits and Display.
Date & Time Range

@ Show Data for Last: 1015 | Hours A

Ending at report generation time

Show Data in Range: From Date/Time

MNovember 28, 2012 =

12 AM

Show in Hours: From

12:00 AM =

Ending prior to report generation time

Ending 1= days prior to report generation

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: I_l

@ Ending at midnight at 115 days prior to report generation

To Date/Time

Movember 28, 2012

To

55

01PM 2

01:00PM =

Figure 8-95: Mobile Analytics: Top Protocols, Time dialog

15. In the Time dialog, the following fields are displayed:

e To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

e To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

e Toseta period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of

days previously).
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e Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.

e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

i
Treiopesienn . TS . B ==

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

_ShaAL

Figure 8-96: Mobile Analytics: Time Scope Selection dialog box
16. In the Objects dialog the following fields are displayed:

Protocols
) 515 MostActive Protocols Based on: vTotaI Volume |
Specific Protocols

Select Objects for Graph

Figure 8-97: Mobile Analytics: Top Protocols, Objects dialog

e Set the number of protocols you wish listed, and set the parameter
you wish the report to be based on (Total VVolume, Incoming VVolume
or Outgoing VVolume).

17. In the Limits dialog the following fields are displayed:
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Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category:

) &

[ Device Model:

Figure 8-98: Mobile Analytics: Top Protocols, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Available Device Model Categories

BrickPhone Category
SmartPhone Category

Select the Device Model Categories to be Included in the Graph:

Selected Device Model Categories

[Regular Phone Category

OK [ Cancel

=l

k=

Figure 8-99: Mobile Analytics: Device Models Selections dialog

18. In the Display dialog the following fields are displayed:

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on:

[7] Show "All Others' in Graph

Data Splitting

Display Separately for Each
~) Stack Results by:

@ None

Total Volume v

4% :Device Model z

Figure 8-100: Mobile Analytics: Top Protocols, Display dialog
e Inthe Data Structure area, only one option, Data for the Period as a

Whole, is available.
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (Per Total VVolume, Per Incoming
Volume and Per Outgoing Volume).

e Inthe Data Splitting area you may select None or to stack results by
Device Model. You can also select here how many devices to stack
by. None is selected by default.

Subscriber Volume Percentiles

This report displays percentile groups of active subscribers according to the volume of traffic
they use. Active subscribers are grouped into groups based on percentile, sorted from the
group using the most traffic to the group using the least for the whole report period.

For each group, the report shows the total traffic volume that was consumed by that group.
The Subscriber Volume Percentiles Report may be viewed as a Bar Graph or as a Table.

Device Model Category
Subscriber Percentiles by Volume [E Cthers

] Data Card

[ Mobie 3G

W Moble 2G

T :

Oct 17 2011 00:00:00 to Oct 17 2011 09:59:59

Figure 8-101: Subscriber Volume Percentiles Report Stacked by
Device — Bar Graph

To configure a Subscriber Volume Percentiles Report:

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display.
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Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-102: Mobile Analytics: Subscriber VVolume Percentiles, Time
dialog

19. In the Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

_ShaAL

Figure 8-103: Mobile Analytics: Time Scope Selection dialog box
20. In the Objects dialog the following fields are displayed:

Subscriber Volume Percentiles

Percentils Based on: Total Volume ~)|

Percentile Group Interval: | 10% =)

Figure 8-104: Mobile Analytics: Subscriber Volume Percentiles, Objects
dialog

e In the Percentiles Based On field, select Total VVolume, In Volume
or Out Volume from the drop down menu. Total Volume is selected
by default.

e Inthe Percentile Group Interval field, select 5, 10 or 20 percent. 10
percent is selected by default.

21. In the Limits dialog the following fields are displayed:
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Scope Limits

Limit Scope "Metwork’ Further to:
[ Device Model Category:

[ Device Model:

) &

Figure 8-105: Mobile Analytics: Subscriber VVolume Percentiles, Limits
dialog

Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE

The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories

BrickPhone Category [Regular Phone Category

SmartPhone Category

oK Cancel

k= |

Figure 8-106: Mobile Analytics: Device Models Selections dialog

22. In the Display dialog the following fields are displayed:

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on: '% Total Volume v
Show 'All Others' in Graph

Data Splitting

Display Separately for Each
(") Stack Results by: 4% |Device Model Category N

@ None

Figure 8-107: Mobile Analytics: Subscriber VVolume Percentile, Display

dialog
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e Inthe Data Structure area, only one option, Data for the Period as a
Whole, is available.

e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (% Total VVolume or Total Volume).

¢ Inthe Data Splitting area you may select None or to stack results by
Device Model Category. You can also select here how many devices
to stack by. None is selected by default.

NOTE The available Device Model Categories are defined in the TAC file.

Session Bitrate

This report splits the total sessions in the report period according to bitrate ranges. The Bitrate
represents the session bitrate during the time period of the report. The report displays the
number or the percentage of sessions that fall into each range.

The Session Bitrate Report may be viewed as a Bar Graph or as a Table.

Session Bit Rate

2442011 - 31472011

:

Figure 8-108: Session Bitrate Report Stacked by Device — Bar Graph

241412011 - 31/472011

To configure a Session Bitrate Report:

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display.
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Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-109: Mobile Analytics: Session Bitrate, Time dialog

23. In the Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

_ShaAL

Figure 8-110: Mobile Analytics: Time Scope Selection dialog box
24. In the Objects dialog the following fields are displayed.

Session Bitrate Ranges

Bitrate ranges Based on: |Total Bandwidth -
Maximal Bitrate: 10 Mbps
Number of Ranges: 204

Figure 8-111: Mobile Analytics: Session Bitrate, Objects dialog

e Select if you wish the Bitrate Ranges to be based on Total
Bandwidth, In Bandwidth or Out Bandwidth in the drop down menu.

e Set the Maximal Bitrate value to be displayed on the horizontal axis.

e Select the number of Ranges to be displayed in the report from the
drop down menu.

25. In the Limits dialog the following fields are displayed:
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Scope Limits
Limit Scope "Wetwork’ Further to:

7] Device Model Category:

[7] Device Model

B B

[ OK H Cancel ]

Figure 8-112: Mobile Analytics: Session Bitrate, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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Next to the Device Model Category field and the Device Model

field, click the Browse button to open the Service Plans Selection

dialog box. Use the
the graph and move

arrow keys to select an entry to be included in
it from the Available list to the Selected list.

Any selected entries will be displayed in the proper field in the

Limits tab.

Device Models
Scope of Graphis:  Network

Selectthe Device Model Categorie

Available Device Model Categorie

BrickPhone Category
SmariPhone Category

[oeierser o T, ==

s to be Included in the Graph:

s Selected Device Model Categories

Regular Phone Category

—
[ 4 ]
e

=

OK [ Cancel

Figure 8-113: Mobile An

=)

alytics: Device Models Selections dialog

26. In the Display dialog, the following fields are displayed:

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on:
Show Al Others' in Graph

Data Splitting

Display Separately for Each
() Stack Results by:

© None

‘% Number of Sessions

4=

Device Model

Figure 8-114: Mobile Analytics: Session Bitrate, Display tab

Whole, is available.

In the Data Structure area, only one option, Data for the Period as a
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (% Number of Sessions or Number of
Sessions).

e Inthe Data Splitting area you may select None or to stack results by
Device Model. You can also select here how many devices to stack
by. None is selected by default.

Session Duration

This report splits the total sessions into groups according to the session duration. Duration is
the total session duration (start to stop). The report displays the number or percentage of
sessions that fall into each Duration group.

The Session Duration Report may be viewed as a Bar Graph or as a Table.

Device Model Category

Session duration [ Data Card
0 Mobie 3G
240412011 - 31412011 Il Mobie 26
W Others

NI

241412011 - 31/4/2011

Figure 8-115: Session Bitrate Report Stacked by Device — Bar Graph

To configure a Session Duration Report:

You may configure the parameters of your report using the four tabs of the dialog
box; Time, Objects, Limits and Display.
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1.

Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-116: Mobile Analytics: Session Duration, Time dialog

In the Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

T

Figure 8-117: Mobile Analytics: Time Scope Selection dialog box
2. Inthe Limits dialog the following fields are displayed:

Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category: [:]

[ Device Model:

Figure 8-118: Mobile Analytics: Session Duration, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories
BrickPhone Category [Regular Phone Category
SmartPhone Category

[ 4 ]
“«

OK | Cancel

=l

Figure 8-119: Mobile Analytics: Device Models Selections dialog
3. Inthe Objects dialog the following fields are displayed:

Session Duration Ranges

Maximal Duration: 120000 Seconds (maximum available: 200,000)

Number of Ranges: | 205

Figure 8-120: Mobile Analytics: Session Duration, Objects dialog

e Set the Maximal Duration value in seconds (200,000 seconds
maximum).
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e Select the number of Ranges to be displayed in the report from the
drop down menu.

4. In the Limits dialog the following fields are displayed:

Scope Limits

Limit Scope ‘Nelwork’ Further to:

[7] Device Model Category: D

Figure 8-121: Mobile Analytics: Session Duration, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

NOTE The available Device Model Categories are defined in the TAC file.
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e Next to the Device Model Category field, click the Browse button to
open the Service Plans Selection dialog box. Use the arrow keys to
select a Device Model Category to be included in the graph and
move it from the Available list to the Selected list. Any selected
Categories will be displayed in the Device Model Category field in
the Limits tab.

[oeierser o T, ==

Device Models
Scope of Graphis:  Network

Selectthe Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories
BrickPhone Category Regular Phone Category
SmariPhone Category
[ o ]
“
OK [ Cancel
L& —J

Figure 8-122: Mobile Analytics: Device Models Selections dialog
5. In the Display dialog the following fields are displayed:

Data Structure

@ Data forthe Period as a Whole
Data Over Time
Default Data View

Open Graph on: % Number of Sessions i
Show All Others®in Graph

Data Splitting

Display Separately for Each
") Stack Results by: 45 Device Model v

@ None

Figure 8-123: Mobile Analytics: Session Duration, Display dialog

e Inthe Data Structure area, only one option, Data for the Period as a
Whole, is available.
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (% Number of Sessions or Number of
Sessions).

e Inthe Data Splitting area you may select None or to stack results by
Device Model. You can also select here how many devices to stack
by. None is selected by default.

Network Usage

This report shows the mobile network usage over a set period of time by device model or
device model category.

The Session Duration Report may be viewed as a Stack Area Graph or as a Table.
- _______ =]

4 Device Category
"
O Samsung
Network Usage per Device Category O Nokia
Tatal Bandwicth M Balckberry
@ iPhone

Total Bandwidth (Mhps)
[=2)

02:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00

Apr17 2002 08:00:00 To Apr17 2008 17:00:00

Figure 8-124: Network Usage Report by Device — Stack Area Graph

To configure a Network Usage Report:

You may configure the parameters of your report using the three tabs of the dialog
box; Time, Limits and Display.
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6.

Date & Time Range

@ Show Data for Last: 1015 | Hours A

Show Data in Range: From Date/Time To Date/Time

Show in Hours: From To

Data Resolution: 1 Hour -

Time Scope

Limit to Specific Days and Hours: |_|

Ending at report generation time

@ Ending at midnight at 11| days prior to report generation

Movember 28, 2012 Movember 28, 2012

12 AM 01PM =

12:00 AM = 01:00PM =

Ending prior to report generation time

Ending 1~ days prior to report generation

Figure 8-125: Mobile Analytics: Network Usage, Time dialog

In the Time dialog, the following fields are displayed:

To configure the graph to include the data from a specific point in
time and forward, select the Show Data for Last radio button. Then
enter the relevant quantity of time, select the unit of time (days,
hours, minutes, or seconds) in the designated fields and indicate
when you wish the report period to have ended (at the time the report
is generated or at midnight of a specific day previously).

OR

To set a definite starting and end point for monitoring, select the
Show Data in Range radio button. Enter the relevant dates and
times in the From Date Time and to Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show
in Hours radio button. Indicate when you wish the report period to
have ended (at the time the report is generated or a certain number of
days previously).

Select the time intervals at which data points are to be indicated in
the graph from the Data Resolution dropdown list.
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e Select the Limit to Specific Days and Hours checkbox in the Time
Scope area to limit data to a certain time of day.

Clicking the Browse button opens the Time Scope Selection dialog
to set the day of the week and hours for the graph to cover.

Indicate Days and Hours to be Graphed:

Day/Hour 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

T

Figure 8-126: Mobile Analytics: Time Scope Selection dialog box
7. Inthe Limits dialog the following fields are displayed:

Scope Limits
Limit Scope "Metwork’ Further to:

[ Device Model Category: [:]

[ Device Model:

Figure 8-127: Mobile Analytics: Network Usage, Limits dialog

e Select the Device Model Category checkbox to limit the graph to
certain Device Model Categories.

e Select the Device Model checkbox to limit the graph to certain
Device Models.

NOTE The available Device Model Categories and Device Models are defined in
the TAC file.
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e Next to the Device Model Category field or the Device Models field,
click the Browse button to open the Service Plans Selection dialog
box. Use the arrow keys to select an entry to be included in the graph
and move it from the Available list to the Selected list. Any selected
entries will be displayed in the proper field in the Limits tab.

Device Models
Scope of Graphis: Network

Select the Device Model Categories to be Included in the Graph:

Available Device Model Categories Selected Device Model Categories

BrickPhone Category [Regular Phone Category

SmartPhone Category

OK [ Cancel

k= |

Figure 8-128: Mobile Analytics: Device Models Selections dialog

8. Inthe Display dialog the following fields are displayed:

Data Structure

@ Data for the Period as a Whole
Data Over Time

Default Data View

Open Graph on: % Number of Sessions i

Show "All Others’in Graph

Data Splitting

Display Separately for Each
~) Stack Results by: 4% Device Model v

© None

Figure 8-129: Mobile Analytics: Session Duration, Display dialog

e Inthe Data Structure area, only one option, Data for the Period as a
Whole, is available.
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e From the Open Graph On dropdown list, select the parameter you
wish to see Statistics about (% Number of Sessions or Number of
Sessions).

e Inthe Data Splitting area you may select None or to stack results by
Device Model. You can also select here how many devices to stack
by. None is selected by default.

Scheduling a Report

NOTE

NetXplorer's User Defined Report Definition Wizard enables a user with Administrator
privileges to create, save and distribute scheduled, customized reports that monitor
performance data of particular interest to you and your Network. Scheduled reports created
using the Report Definition Wizard may be prepared as email attachments and sent to a
selected recipient or stored on the server rather than appearing in the GUI. In addition a report
may be customized but not scheduled, so that it may be generated at any time from the
Navigation pane.

All NetXplorer Real-Time Monitoring graphs may be generated and sent as reports. In
addition Long-Term Reports may be generated which can encompass a much larger period of
time with a less precise granularity then Real-Time Monitoring graphs. Allot recommends that
due to the fact that Mobile Analytics reports can take a significant amount of time, depending
on the size of your network and the amount of mobile traffic, they be scheduled using the User
Defined Reports feature.

Scheduled Reports may be created by any user with Administrator access. In addition, each
Administrator can see only the Scheduled Reports they have defined, and not the reports
defined by any other Administrator.

Reports are managed in the NetXplorer Reports Navigation panel.

To view a list of available reports, click Reports in the Navigation pane. The available reports
are listed in the upper portion of the Navigation pane.

To view the details of a specific report, select the report in the Navigation pane.

It is possible to see some Reports in Real-Time by right clicking on the
Report and selecting Show in Monitoring.
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B 1entity
Narne:
Description

B scope.
Type
Hare:

B subject
Narme:
Term:

(= Date/Time Cove

Span Coverage
Resolution:

[= Schedule:
Mode:
Details:
Format
Ernail to

Date Modified:

NE dist. hourly

NE dist. hourly
NE distriution on N every hour

Network Tree Entity
Network

NetEnforcers Distribution
Short-Term

rage:

Relative. B0 minutes back
30 Seconds

Perindic
Hourly at 0 minutes into hour
ing

test@allotcom

08:44 02/02/06

8] Real-Time Monitoring |\ Group 1| B Report NE dist. hourly

Figure 8-130: Report tab

Defining a Scheduled Report

NOTE

Not all tabs and fields will appear for all reports.

To define a report:

1. Select Reports in the Navigation Pane.

2. Right-click in the Navigation Pane and select New Report from the
popup menu. The Report Identity dialog of the Report Definition Wizard

is displayed.

Report Definition Wizard - New Report

Indicate name and description

Report Name: Report1|

Descniption

Next >

[l

Cancel

Figure 8-131: Report Identity Window

Enter the name of the report and a brief description of the report in the
designated fields, and click Next.

The Report Topic dialog of the Report Definition Wizard is displayed.
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Report Definition Wizard - New Report 2

Indicate Network tree entity or Group item on which report will be based I |m]

® Network Tree Entity

|87 Network

=& AC-3K-10.43.10

&= MOD_Test
464 VLAN200
4 &2 VLAN100
462 Fallpack

4 % Fallback

&3 AC-3K-104.3.11

Group:

[ <Back Next> Cancel

Figure 8-132: Report Topic

Select the Network entity or Group entity on which the report is to be
based, and click Next. The Report Subject dialog of the Report
Definition Wizard is displayed.

Report Definition Wizard - New Report bd

Indicate topic of report. and if its short of long-term based. I ml

Report Subject

Statistics
NetEnforcers

Lines

Pipes

Virtual Channels
Protocols

Hosts

Internal Hosts
External Hosts
Conversations
Subscribers

Service Plans Popularity
WebSafe Traffic
Cells

VOIP Minutes of Use

Report Term
© Real-Time Long-Term Mobile
Real_Time Typical Time Long-Term Typical Time
<Back Next> Cancel

Figure 8-133: Report Subject
In the Report Subject area, select the topic of the report.

In the Report Term area, select the type of monitoring report to be
produced: Real-Time, Real-Time Typical Time, Long-Term, Long-Term
Typical Time or Mobile.

Click Next. The Report Objects dialog of the Report Definition Wizard
is displayed (if applicable).
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Report Definition Wizard - New Report

Indicate which Objects should be included in the report

NetEnforcers

@ 5/ MostActive NetEnforcers Based on: | Total Bandwidth

Specific NetEnforcers

Available NetEnforcers Selected NetEnforcers

& Net Item Type

<Back

Figure 8-134: Report Objects

Next>

8. Configure the Report Objects, as

Cancel

follows:
report select the upper radio button, set

the number of objects you wish listed, and set the parameter you

e To generate a Most Active
wish the report to be based
e Select the Specific <OBJE

on.
CT> radio button to generate a graph

showing only selected objects. Use the arrow keys to move
individual Objects from the Available list to the Selected list.

9. Click Next. The Report Time dialog of the Report Definition Wizard is

displayed.

Report Definition Wizard - New Report

Indicate when in the pastto report over, and data resolution.

Date & Time Range

@ Show Data for Last 10 5| | Minutes v:

@ Ending at report generation time

Ending at mindnight at 15| days prior to repor

(71 Show Data in Range: From Date/Time

May S, 2012

12:00 AM

Show in Hours From

12:00 AM -

@ Ending prior to report generation time

Ending || 115 days prior to report generation

Data Resolution: .30 Seconds -]

J

w

e

< Back Ment =

=]

[liana

t generation

To Date/Time

May 9, 2012

08:00 AM -

08:00 AM

Cancel
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Figure 8-135: Report Time

10. To configure the graph to include the data from a specific point in time
and forward, select the Show Data for Last radio button. Then enter the
relevant quantity of time, select the unit of time (days, hours, minutes, or
seconds) in the designated fields and indicate when you wish the report
period to have ended (at the time the report is generated or at midnight of
a specific day previously).

OR

To set a definite starting and end point for monitoring, select the Show Data in
Range radio button. Enter the relevant dates and times in the From Date Time and to
Date Time areas.

OR

To set a period of one or more hours for monitoring, select the Show in Hours radio
button. Indicate when you wish the report period to have ended (at the time the report
is generated or a certain number of days previously).

11. Select the time intervals at which data points are to be indicated in the
graph from the Data Resolution dropdown list.

NOTE When generating a long-term monitoring report, the available options are (1
hour, 1 day, 1 month).

12. In the Data Display area select if you wish the data to be displayed by
rate or by volume (if applicable).

13. Click Next. The Report Scope dialog of the Report Definition Wizard is
displayed (if applicable).

Report Definition Wizard - New Report bl

Indicate if the report scope should be limited (optional). I Iﬂ]

Scope Limits
Limit Scope ‘Network Further to;

NetEnforcer

Internal Host:

)

J

External Host: )
Protocol |
]

Subscrider.

<Back Next > Cancel

Figure 8-136: Report Scope

14. Configure the Report Scope, as follows:
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e Scope Limits: Select the entities that the graph will be monitoring.

15. Click Next. The Report Display dialog of the Report Definition Wizard

is displayed.
Report Definition Wizard - New Report =
Indicate dizplay preferences. M_ﬂﬂ_l
Data Structure
@ Data for the Period as a Whale
Data Over Time
Default Data View
Open Graph on Total Banawidin
Show ‘All Others' in Graph
Data Splitting
Display Separately far Each:
Stack Resuits by 4f2] [NetEnforcer
@ None
Data Mode
Show Data by
® Rate Volume
[ <Back N Next> ] Save Cancal

Figure 8-137: Report Display
16. Configure the Report Display, as follows:

o Data Structure: Select if you wish to display Data for the Period as a
Whole or Data Over Time.

e Default Data View: Select the data that the graph will open displaying.

e Data Splitting: Select the way in which the data will be split and
stacked in the graph.

o Data Mode: Select if you wish data to be displayed by Rate or by
Volume (if applicable)

17. Click Next. The Report Schedule dialog of the Report Definition Wizard
is displayed.
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Report Definition Wizard - New Report Ié]

Indicate details for the report run, output format and email dispatch. \_!EEE_E

rSchedule Details

© Periodic Reporting: |Monthly = | |iOn Last Day of Month | +

() Specific Date & Time for Report: 11:59 FM E“ |Sepbember 20, 2012 E

) Don't Schedule Report

Report Format: g~

Send Reportas Email to: [ Ernail Address = s
ayelet@allot.com -
dan@allot.com
gill@allot.com £
rob@allot.com
vic@allot.com Bl

( < Back ] | Next = ] save ] [ cancel

Figure 8-138: Report Schedule

18. In the Schedule Details area you may opt to select a time for this report
to be consistently generated on an hourly, daily, weekly or monthly
basis, a single date and time for this report to be generated, or to leave
the report unscheduled.

If a report is not scheduled, it will be saved in the User Defined Reports

list and may be generated manually at any time.

19. A Report Format must be selected from the drop down menu and one or
more email addresses for the report to be sent to must be entered using
the Add button.

NOTE An email can only be sent if an SMTP server is properly configured.

20. Click Next. The Report Definition Summary dialog of the Report
Definition Wizard is displayed.
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Report Definition Wizard - New Report

Resuilts of Report Wizard session I Im] 1

Name Reportt
Description A

Type Network Tree Entity
Name: Network

Name Most Active NetEnforcers
Term Short-Term

Relative. 10 minutes back
Resolution: 30 Seconds
Schedule:
Mode Not Scheduled
Details: Not Scheduled
Format iog
Emallto NIA

<Back ( Save Cancel

Figure 8-139: Report Definition Summary

21. Click Save. The new report definition is added to the list of available
customized reports.
Editing a Scheduled Report Definition
1. Open Reports in the Navigation Pane.
2. Double click a Report to open the Summary dialog box.
3. Click on the Icon to the left of the area you wish to edit.
4. The appropriate dialog box opens. Make the changes you wish and click
Next or Save to save the changes.
Deleting a Scheduled Report Definition
1. Open Reports in the Navigation Pane.
2. Click a Report to highlight it.
3. Click Delete on the Main Toolbar.

Compound Reports

Compound Reports are pre-defined combinations of User Defined reports. A Compound report
offers a way to conveniently generate multiple reports together in a single PDF file, distributed
via email.

To define a compound report:
1. Select Reports in the Navigation Pane.

2. Right-click on User Defined Reports in the Navigation Pane and select
New > Compound Report from the popup menu.
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OR

Select New Report Entry > Compound Report from the Actions
menu.

The Compound Reports Properties dialog box is displayed.

I3
Report Name
5 Virtual Ck
|
|
< >
Houry ¥ at | 0.3 |Minutes Into the Hour
O Specific Date & Time for Report 11:59PM & march 17, 2008 3@
© Dont Schedule Report
Send Report as Emailto
Save Cancel

Figure 8-140: Compound Report Properties

3. Enter the name of the report and a brief description of the report in the
designated fields.

4, Select those User Designed Reports from the Available Reports list you
wish to include in the Compound Report and add them to the Selected
Reports list using the arrow keys.

NOTE Any report added to a compound report must be configured when created
to be generated as a PDF file.

5. Inthe Schedule Details area you may opt to select a time for this report
to be consistently generated on a hourly, daily, weekly or monthly basis,
a single date and time for this report to be generated, or to leave the
report unscheduled.

NOTE Each simple report that was selected to the compound report, must also, by
itself, be scheduled for generation. It should be understood that what the
compound report does is simply to ‘collect’ the separately generated
simple reports into one pdf. If a simple report is not scheduled, there will be
nothing to include in the compound report pdf, although the report is
included in the compound report definition.

6. An email for the report to be sent to must be entered.

7. Enter an email address for the Report to be sent to once generated.

NetXplorer Operation Guide
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8. Click Save. The new Compound Report is added to the list of available
customized reports shown in the Reports Navigation pane.

Working with Graphs

Data Display Options

Monitoring information can be displayed in monitoring graphs according to the following

criteria:

Total Bandwidth
In Bandwidth
Out Bandwidth
In Packets

Out Packets

Live Connections

New Connections

Dropped Connections

Bandwidth consumed by both incoming and outgoing traffic.
Bandwidth consumed by incoming traffic only.

Bandwidth consumed by outgoing traffic only.

The number of packets in incoming traffic only.

The number of packets in outgoing traffic only.

The number of live connections (30 Second resolution only).
The number of new connections.

The number of dropped connections

To determine the data display criteria, right-click anywhere in the graph and select Show Data
by from the popup menu. Select the required criteria from the submenu is that is displayed. It
is possible to opt to show data by percentage in Most Active... reports.

Clicking a point in a monitoring graph displays the value at the selected point.

i A e
% = =)

Total Bandwidth (Mbps)

3

4

Metwark - Protocols Distribution .eDonkey

Total Bandwicith OrTe

0
10:46:00 10:46:45 10:47:30 10:48:15 10:48:00 10:48:45 10:50:30

Apr17 2008 10:46:00 To Apr17 2008 10:50:30

Real-Time Monitoring

Figure 8-141: Displaying Bandwidth

Displaying All Others Data
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You can opt to include a consolidated entry for multiple items entitled "All Others". For
example, if you are generating a report on the 10 most active pipes, the data for all additional
pipes can be consolidated into an All Others item.

To display consolidated data for all others, right-click anywhere in the graph and select
Display Options | All Others from the popup menu.

Sorting Data in the Graph

You can sort the data in the graph according to total bandwidth, incoming bandwidth, outgoing
bandwidth or according to alphabetical order. For example, if you are generating a bar chart on
the 10 most active pipes, the data for all additional pipes can be shown in alphabetical order
rather than sorted according to relative traffic.

To sort the data in the graph, right-click anywhere in the graph and select Display Options |
Order Display by from the popup menu. Then select the criteria for sorting from the
corresponding submenu. The available options vary according to the type of report.

Drilling Down into Graph Results

NetXplorer enables you to drill down within any Most Active graph to view a cross-section of
data for a specific entity represented in the graph. For example, upon examining a Most Active
Pipes graph for a specific NetEnforcer, you may want to view the breakdown of utilization for
a specific VC or protocol.

There is no limit to the number of times that you can drill down within graphs.

NOTE External Hosts collection is disabled and it is not possible to drill down
into Most Active Conversations or Most Active External Hosts graphs. It is
recommended that HTTP reports be used to access such data.

The following example illustrates one possible progression of drilling down to view further
details.

The first graph, a Long-Term Report, displays the Most Active Virtual Channels on the
network (Figure 8-142).
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Figure 8-142: Most Active Virtual Channels

By right-clicking the corresponding bar and selecting Protocols Distribution from the popup

menu, the example drills down to view the breakdown of protocols for the Virtual Channel
VolP (Figure 8-143).

Real-Time Monitoring
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Figure 8-143: Protocols Distribution on Virtual Channel VolP

By right-clicking the corresponding area in the graph and selecting Most Active Hosts from

the popup menu, the example drills down to view Most Active Hosts for the protocols for the
Virtual Channel VolIP.
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Favorite View

You can display multiple monitoring windows at the same time and arrange them to suit your
own needs. You can save a particular arrangement of monitoring windows as your Favorite
View. Your Favorite View can include both real-time and long-term monitoring graphs.

By default, the following graphs are defined for Favorite View: Statistics on Network, Most
Active Pipes on Network, Most Active VCs on Network, Most Active Protocols on Network,
Most Active Internal Hosts on Network.

To display the Favorite View:

e From the View menu, select Favorite View or click B¢ on the toolbar.
The Favorite View is displayed.

To add a graph to the Favorite View:

1. Display the required graph and then select Add to Favorite View from
the Actions menu or click the Add button on the toolbar.

OR

Right-click the graph and select Add to Favorite View from the popup
menu.

The graph is added to the Favorite View.
2. Display the Favorite View and arrange or resize the graphs, as required.

To delete a graph from the Favorite View:

e Select the graph in the Favorite View and then select Delete from the Edit
menu or click * on the toolbar.

OR

e Right-click the graph in the Favorite view and select Delete from the popup
menu.

The graph is removed from the Favorite view.

Monitoring Groups

NetXplorer's Groups enable you to consolidate monitoring information by defining customized
groups of Line, Pipes or Virtual Channels. Real-time and long-term monitoring graphs
generated for a Monitoring Group treat the members of the group as a single entity.

Separate Groups are defined for Lines, Pipes, and Virtual Channels.
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Viewing Groups
You can view existing Groups in the Groups application.

To view groups:

1. Select Groups in the Navigation pane. The existing Groups are listed in

the Navigation tree. The level of the Group is indicated by the type of
icon in the tree.

NOTE The Groups list is not displayed in hierarchical format. The level of the

Group (Line, Pipe, or Virtual Channel) is indicated by the displayed icon.

2. Select a Group in the Navigation tree. The members of the selected group
are listed in the Application Details pane.

Defining a Line Group

A Line Group enables you to view monitoring graphs for a composite group of Lines.
To define a Line group:

1. From the Actions menu, select New Line Group.
OR

With Groups selected in the Navigation pane, right-click in the Navigation pane and
select New Line Group from the popup menu.

The Group Properties dialog is displayed.

Group Properties

Graup Scope

Group Name:

@ Belectthe Lines ta be Included in the Group:

Available Lines Selected Lines

' Netwark
=8 55400
A Fallback

iterm Path

Date Modified: N/A

Save Cancel

Figure 8-144: Group Properties — Line Group
2. Enter a name for the group in the Group Name field.

3. Configure the Lines to be included in the group, as follows:

e Expand the required NetEnforcer/s or Service Gateway/s(s) in the tree in

the Available Lines list.
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e Select the required Lines in the tree and click to move the Lines to
the Selected Lines list or double click the Line you wish to move.

e Repeat for all additional Lines, as required.

NOTES You can select and move more than one line at a time using standard
Windows multiple selection methods.

Select aline and click to move the line from the Selected Lines list
to the Available Lines list. Click to clear the Available Lines list.

4. When all of the required Lines have been moved to the Selected Lines
list, click OK to save the group. The group is added to the Groups list in
the Navigation pane.

Defining a Pipe Group

A Pipe Group enables you to view monitoring graphs for a composite group of Pipes.

To define a Pipe group:
1. From the Actions menu, select New Pipe Group.

OR

With Groups selected in the Navigation pane, right-click in the Navigation pane and

select New Pipe Group from the popup menu.

The Items Selection dialog is displayed.

Group Properties

Group Scope

Group Name:

@ Selectthe Pipes to be Included in the Group
Available Fipes Gelested Pipes
67 Network item Path
=B 55-400
-4 Fallback
= Fallback

Dale Modified: N/A

Save Cancel

Figure 8-145: Group Properties — Pipe Group
2. Enter a name for the group in the Group Name field.

3. Configure the Pipes to be included in the group, as follows:

e Expand the required NetEnforcer/s or Service Gateway/s(s) in the tree in
the Available Pipes list.
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e Select the required Pipes in the tree and click to move the Pipes to
the Selected Pipes list or double click the Pipe you wish to move.

e Repeat for all additional Pipes, as required.

NOTES You can select and move more than one Pipe at a time using standard
Windows multiple selection methods.

Select a Pipe and click to move the line from the Selected Pipes list
to the Available Pipes list. Click [« Jto clear the Available Pipes list.

4. When all of the required Pipes have been moved to the Selected Pipes
list, click OK to save the group. The group is added to the Groups list in
the Navigation pane.

Defining a Virtual Channel Group

A Virtual Channel Group enables you to view monitoring graphs for a composite group of
Virtual Channels.

To define a Virtual Channel group:
1. From the Actions menu, select New Virtual Channel Group.
OR

With Groups selected in the Navigation pane, right-click in the Navigation pane and
select New Virtual Channel Group from the popup menu.

The Items Selection dialog is displayed.

Group Properties
Group Scope
Group Name:
@ Selectthe Virtual Channels to be Included inthe Group:
Available Virtual Channels Selected Viual Channels
8 Network ~ tern Path
=[5 55-400
H-43k Fallback
=44 Fallpack
2 ap sppicato
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[ b Applic o,
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I wal
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< > < >
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Figure 8-146: Items Selection — Virtual Channel Group
2. Enter a name for the group in the Group Name field.

3. Configure the Virtual Channels to be included in the group, as follows:

e Expand the required NetEnforcer/s or Service Gateway/s in the tree in the
Available Virtual Channels list.
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e Select the required Virtual Channels in the tree and click to move
the Virtual Channels to the Selected Virtual Channels list or double click
the Virtual Channel you wish to move.

e Repeat for all additional Virtual Channels, as required.

NOTE You can select and move more than one Virtual Channel at a time using
standard Windows multiple selection methods.

4, When all of the required Virtual Channels have been moved to the
Selected Virtual Channels list, click OK to save the group. The group
is added to the Groups list in the Navigation pane.
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